Building IBM Business Process Management Solutions Using WebSphere V7 and Business Space

- Create BPM solutions using predefined Business Space widgets
- Develop custom widgets; build clients and servers for them
- Learn by example with practical scenarios

Martin Keen
Bryan Brown
Andy Garratt
Benjamin Käckenmeister
Ahmed Khairy
Kevin O’Mahony
Lei Yu

ibm.com/redbooks
Note: Before using this information and the product it supports, read the information in “Notices” on page xiii.
Contact an IBM Software Services Sales Specialist

Start SMALL, Start BIG, ... JUST START architectural knowledge, skills, research and development . . . that's IBM Software Services for WebSphere.

Our highly skilled consultants make it easy for you to design, build, test and deploy solutions, helping you build a smarter and more efficient business. Our worldwide network of services specialists wants you to have it all! Implementation, migration, architecture and design services: IBM Software Services has the right fit for you. We also deliver just-in-time, customized workshops and education tailored for your business needs. You have the knowledge, now reach out to the experts who can help you extend and realize the value.

For a WebSphere services solution that fits your needs, contact an IBM Software Services Sales Specialist: ibm.com/developerworks/websphere/services/contacts.html
# Contents

Contact an IBM Software Services Sales Specialist ...................................... iii

**Notices** ................................................................................................. xiii

Trademarks .............................................................................................. xiv

**Preface** ................................................................................................... xv

The team who wrote this book ................................................................. xv

Now you can become a published author, too! ........................................ xviii

Comments welcome ................................................................................. xviii

Stay connected to IBM Redbooks ........................................................... xix

## Part 1. Overview .................................................................................. 1

### Chapter 1. Introduction to IBM Business Space powered by WebSphere . 3

1.1 Overview of Business Space powered by WebSphere .......................... 4
   1.1.1 What is Business Space powered by WebSphere .......................... 4
   1.1.2 What IBM products support the development of business spaces ... 5
   1.1.3 Who decides what a business spaces should look like ................. 6
   1.1.4 Who are the creators of business spaces ................................. 6

1.2 Architecture of Business Space .......................................................... 6
   1.2.1 The processing engines of Business Space ............................... 7
   1.2.2 The assembly of business spaces ............................................ 8
   1.2.3 Business Space in the IBM WebSphere Integration Reference
       Architecture ......................................................................................... 8

1.3 Concepts of Business Space ............................................................... 9
   1.3.1 Business spaces ...................................................................... 9
   1.3.2 Page ...................................................................................... 10
   1.3.3 Template ............................................................................... 10
   1.3.4 Widget ................................................................................... 11

1.4 Usage patterns of Business Space ....................................................... 12
   1.4.1 Human-centric business spaces .............................................. 13
   1.4.2 Integration-centric business spaces ....................................... 13
   1.4.3 Common-content business spaces ........................................ 13
   1.4.4 Dynamic business spaces ...................................................... 13
   1.4.5 Business design and review spaces ..................................... 14
   1.4.6 Activity-monitoring business spaces ................................... 14

1.5 Management of Business Space ........................................................ 14
   1.5.1 Business spaces and security .............................................. 14
   1.5.2 Business spaces and performance ....................................... 15
4.3.2 Rating process in Egypt ........................................ 95
4.3.3 Rating process in Germany .................................... 97
4.3.4 Rating process in the UK ...................................... 111
4.3.5 Rating process in the USA ..................................... 115

4.4 Human-centric widgets .............................................. 117
  4.4.1 Configuration windows of the widgets ...................... 118
  4.4.2 Human task widgets ........................................... 119
  4.4.3 Process choreography widgets ............................... 142
  4.4.4 The Send widget ............................................. 147
  4.4.5 The Business Calendars widget ............................. 150
  4.4.6 The team support widgets ................................... 158

4.5 Predefined space templates for human-centric usage .......... 164
  4.5.1 The Managing My Tasks template .......................... 165
  4.5.2 The Advanced Managing of Human Tasks and Workflows template 166
  4.5.3 The Managing My Team’s Tasks template .................. 169

4.6 Movie Rating processes in Business Space ...................... 173
  4.6.1 Performing the movie rating process at the China branch ... 174
  4.6.2 Performing the movie rating process at the Egypt branch ... 186
  4.6.3 Performing the movie rating process at the German branch ... 194
  4.6.4 Performing the movie rating process at the UK branch ....... 207
  4.6.5 Performing the movie rating process at the USA branch ....... 216

Chapter 5. Integration-centric business spaces ...................... 227
5.1 Using Business Space and WebSphere Service Registry and Repository policies to change service endpoint calls ........................................ 228
  5.1.1 Business scenario: Ordering movies ......................... 228
  5.1.2 Technologies used in the scenario .......................... 229
  5.1.3 Business Space widgets used in the scenario ............... 230
  5.1.4 Overview of our example .................................... 230
  5.1.5 Creating the interfaces and services ....................... 232
  5.1.6 WebSphere Process Server design notes .................... 238
  5.1.7 Overview of the Ordering Movies solution and technical notes ... 239
  5.1.8 Setting up WebSphere Service Registry and Repository and creating classifiers for our service endpoints .................. 251
  5.1.9 Importing the WebSphere Process Server artifacts into WebSphere Service Registry and Repository .......................... 259
  5.1.10 Browsing the services in Business Space .................. 260
  5.1.11 Configuring the service endpoints using the Business Space widgets with WebSphere Service Registry and Repository policies .............. 271
  5.1.12 Running the Order Movies scenario ....................... 286
  5.1.13 Changing the policy using Business Space and gate conditions .... 290
  5.1.14 Testing the scenario with gate condition policies .......... 293

5.2 WebSphere Enterprise Service Bus with Store and Forward managed by
Chapter 6. Dynamic business spaces ..................................................... 311
  6.1 WebSphere Business Services Fabric ........................................... 312
    6.1.1 Business scenario: Release movie ........................................ 312
    6.1.2 WebSphere Business Services Fabric Business Space templates .... 314
    6.1.3 Create and share WebSphere Business Services Fabric spaces in Business Space ................................................................. 320
    6.1.4 Authoring WebSphere Business Services Fabric artifacts in Business Space ................................................................. 323
    6.1.5 Assemble WebSphere Business Services Fabric artifacts in WebSphere Integration Developer ............................................. 337
    6.1.6 Adapt runtime behavior in Business Space ............................. 352
  6.2 WebSphere Process Server business rules ...................................... 357
    6.2.1 Business scenario: Age Rating .............................................. 357
    6.2.2 Working with business rules in Business Space ....................... 358

Chapter 7. Activity monitoring business spaces ................................. 363
  7.1 Events ......................................................................................... 364
    7.1.1 When to use CBE versus XSD events ..................................... 364
  7.2 Business monitoring .................................................................... 366
    7.2.1 Business Monitor widgets ...................................................... 368
    7.2.2 Business scenario: ITSO Ticket Sales Monitoring .................. 389
    7.2.3 ITSO Order Tracking .............................................................. 406
  7.3 Service and system health monitoring ......................................... 415
    7.3.1 The Service Monitor widget .................................................. 415
    7.3.2 The System Health widget .................................................... 419
    7.3.3 The Module Health widget ................................................... 422

Chapter 8. Common-content business spaces .................................... 425
  8.1 Common-content widgets supplied with Business Space ............... 426
    8.1.1 Document widget ................................................................. 426
    8.1.2 Presentation widget .............................................................. 429
    8.1.3 Spreadsheet widget ............................................................. 431
    8.1.4 Google Gadget widget .......................................................... 434
    8.1.5 Web Site widget ................................................................. 436
    8.1.6 Web Feed widget ............................................................... 438
  8.2 Combining common-content widgets using wiring ....................... 440
8.2.1 Configuring widgets ............................................................. 441
8.2.2 Wiring widgets ................................................................. 442
8.2.3 Sizing widgets ................................................................. 447
8.3 ITSO Movie case study: Combining human tasks and common-content widgets ................................................................. 448
8.3.1 Assignment and challenge for ITSO Movie ......................................... 448
8.3.2 The solution ................................................................. 449

Chapter 9. Business design and review spaces ................................. 463
9.1 Creating a corporate view of ITSO Movie ...................................... 464
9.2 WebSphere Business Compass: Overview ..................................... 464
  9.2.1 What is WebSphere Business Compass .................................... 464
  9.2.2 Why ITSO Movie uses WebSphere Business Compass .................... 466
  9.2.3 What is the high-level plan to create the corporate vision .................. 466
9.3 Creating the ITSO Movie Business Design space ............................. 467
9.4 Creating a vocabulary ............................................................ 471
  9.4.1 What is a vocabulary .......................................................... 471
  9.4.2 What vocabulary do we need .................................................. 472
  9.4.3 Creating the ITSO Movie Vocabulary in Business Design space ........... 472
9.5 Creating an organization chart ................................................... 487
  9.5.1 Why you need an organization chart .......................................... 487
  9.5.2 Building the ITSO Movie organization chart .................................... 487
9.6 Creating a strategy map ............................................................ 497
  9.6.1 What a strategy map is and why you need one .................................. 498
  9.6.2 Creating the ITSO Movie strategy map ......................................... 498
9.7 Creating a capability map ........................................................ 507
  9.7.1 What a capability map is and why you need one ............................... 507
  9.7.2 Creating the ITSO Movie capability map ....................................... 507
9.8 Documenting services ............................................................ 510
  9.8.1 Why document services in WebSphere Business Compass ............... 510
  9.8.2 Creating the ITSO Movie “Order Movie” scenario services in WebSphere Business Compass ................................................................. 511
9.9 Creating process maps ............................................................ 518
  9.9.1 What processes do we need for ITSO Movie ................................. 518
  9.9.2 Creating the ITSO Movie Process Maps in WebSphere Business Compass ................................................................. 519
9.10 Creating collaboration diagrams ................................................ 537
  9.10.1 What is a collaboration diagram ............................................... 537
  9.10.2 Adding the ITSO Movie Order Movie process and partners to collaboration diagrams ................................................................. 538
9.11 Linking maps together ............................................................ 548
9.12 Sharing documents ............................................................... 556
  9.12.1 How ITSO Movie shares documents and who shares them ............... 556
12.3.2 Add project facets .......................... 659
12.3.3 Create a folder for client code ......... 660
12.3.4 Create a Dojo class .......................... 661
12.3.5 Implement the code for the Dojo Class .. 662
12.4 Packaging, deploying, and testing of a Dojo client . . 675

Chapter 13. Developing a custom widget .............. 677
13.1 Business scenario: ITSO Movie database .......... 678
13.2 Creating a widget definition ...................... 679
  13.2.1 Structure of iWidget XML definition file .... 680
  13.2.2 Creating a widget definition for ITSO Movie DB Detail widget ........ 686
  13.2.3 Creating a widget definition for ITSO Movie DB Browser widget ...... 693
  13.2.4 Creating a widget definition for ITSO Movie DB Connector widget .. 695
13.3 Creating a widget implementation ................. 697
  13.3.1 Implementation of the ITSO Movie DB Detail widget .................. 697
  13.3.2 Implementation for the ITSO Movie DB Browser widget .......... 708
  13.3.3 Implementation for ITSO Movie DB Connector widget .......... 708
  13.3.4 Using endpoints registered in Business Space ................. 710
13.4 Packaging and registering a custom widget .......... 712
  13.4.1 Registration files .......................... 712
  13.4.2 Creating a space with ITSO Movie DB widgets and establishing a wire connection between widgets .. 720
13.5 Creating a help plug-in for a custom widget .......... 724
  13.5.1 Widget catalog file .......................... 725
  13.5.2 Creating a help plug-in .......................... 725
13.6 Testing a widget ................................ 728
  13.6.1 Testing with the Universal Test Client for iWidgets in WebSphere Integration Developer .................. 728
  13.6.2 Testing Universal Test Client for iWidgets in combination with Mozilla Firebug .................. 730

Part 4. Appendixes .................................. 733

Appendix A. IBM Lotus Forms UI ................. 735
Overview of IBM Lotus Forms .................. 736
  What is Lotus Forms .......................... 736
  Who uses Lotus Forms .......................... 736
  Components of Lotus Forms software .......... 737
  Installing Lotus Forms software ............. 738
Lotus Forms client development ................. 738
  Generating Lotus Forms .......................... 738
  Importing Lotus Forms .......................... 743
  IBM Lotus Forms Designer .................. 743
Summary .................................. 745
Appendix B. Additional material ................................................. 747
Locating the Web material .................................................. 747
How to use the Web material ................................................ 747

Abbreviations and acronyms .................................................... 749

Related publications ............................................................ 751
IBM Redbooks ................................................................. 751
Online resources ............................................................... 751
How to get Redbooks .......................................................... 752
Help from IBM ................................................................. 752
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs.


Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both. These and other IBM trademarked terms are marked on their first occurrence in this information with the appropriate symbol (® or ™), indicating US registered or common law trademarks owned by IBM at the time this information was published. Such trademarks may also be registered or common law trademarks in other countries. A current list of IBM trademarks is available on the Web at http://www.ibm.com/legal/copytrade.shtml

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

- Alphablox®
- CICS®
- ClearCase®
- DB2®
- developerWorks®
- FileNet®
- IBM®
- Lotus®
- Rational®
- Redbooks®
- Redpaper™
- Redbooks (logo) ®
- WebSphere®
- z/OS®

The following terms are trademarks of other companies:

Adobe, the Adobe logo, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

Java, and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Microsoft, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of others.
Preface

IBM® Business Space powered by IBM WebSphere® is a common user interface framework for aggregating content and delivering it via a browser. A business space is a collection of related Web content that provides you with insight into your business.

Part 1 of this IBM Redbooks® publication introduces Business Space and provides Business Process Management (BPM) usage patterns for it.

Part 2 of this book uses a fictional business scenario to show how business space widgets can be used to solve a variety of business problems, using products such as IBM WebSphere Process Server, IBM WebSphere Enterprise Service Bus, IBM WebSphere Business Monitor, IBM WebSphere Business Compass, and IBM WebSphere Business Services Fabric.

Part 3 shows how to build custom Business Space widgets, and how to build clients and servers for these custom widgets.

This book addresses Business Space powered by IBM WebSphere Version 7.0.

The team who wrote this book

This book was produced by a team of specialists from around the world working at the International Technical Support Organization, Raleigh Center.

Martin Keen is a Consulting IT Specialist at the ITSO, Raleigh Center. He writes extensively about WebSphere products and service-oriented architecture (SOA). He also teaches IBM classes worldwide about WebSphere, SOA, and ESB. Before joining the ITSO, Martin worked in the EMEA WebSphere Lab Services team in Hursley, U.K. Martin holds a bachelor’s degree in Computer Studies from Southampton Institute of Higher Education.

Bryan Brown is an advisory engineer in the US with the BPM SWAT team. He has 19 years of experience in the software engineering field, and has worked at IBM for 8 years. His area of expertise is the WebSphere Software Portfolio, focusing on deep technical solutions.
Andy Garratt is a Certified Consulting IT Specialist working for IBM Software Services for WebSphere in the UK. He has 19 years of experience in software architecture, design, and development of large strategic IT projects, including 8 years of implementing IBM WebSphere software. His areas of expertise include WebSphere BPM, SOA, and enterprise resource planning (ERP) systems. He holds a degree in Natural Sciences from the University of Durham and is an author of two other IBM Redbooks publications: Patterns: Building Serial and Parallel Processes for IBM WebSphere Process Server V6. and Human-Centric Business Process Management with WebSphere Process Server V6.

Benjamin Käckenmeister is an IT Specialist at IBM Boeblingen Lab in Germany. He belongs to the WebSphere lab services team and provides technical consultancy for WebSphere Business Process Management solutions. He holds a degree in Computer Science from the University of Stuttgart.

Ahmed Khairy is an IT Specialist at the IBM Cairo Lab. He is currently part of the IBM Software Services for WebSphere Worldwide Technology Practice team providing services for the IBM BPM portfolio with a special emphasis on WebSphere Business Monitor. He holds a Bachelor’s degree in Computer Science from Ain Shams University and a Master’s degree in Computing from the American University in Cairo.

Kevin O’Mahony is a Senior Course Developer and Instructor for WebSphere Education based in Vancouver, Canada. He has developed courses for IBM in Java™, WebSphere, SOA, and CICS®. Kevin has worked for IBM for over 30 years. His areas of expertise includes Application Development and Programming Languages. He holds a Bachelor of Commerce degree in Information Systems and a Bachelor of Arts degree in Psychology, both from the University of South Africa.

Lei Yu is a software engineer at the China Software Development Lab in Beijing. He has 3 years of experience in the WebSphere Business Process Management field. He holds a Master’s degree in Computer Science from BeiHang University, Beijing, China. He was worked with WebSphere Business Modeler and WebSphere Business Space and now he is a developer on WebSphere Business Space configuration and migration. He also has three papers published on IBM developerWorks®.
Thanks to the following people for their contributions to this project:

- Samed Ahmed
- Andrea Baader
- Anand Bandaru
- Geoffrey Beers
- Balint Bors
- Kim Clark
- Sergiy Fastovets
- Jonas Freiknecht
- David George
- Ian Hartshorn
- Mohamed Hegazy
- Andrew Humphreys
- Richard Johnson
- PoonKwan Leung
- Fintan McElroy
- Curtis Miles
- Alvin Richardson
- Mohamed Salem
- Ying Sun
- Eric Wayne
Now you can become a published author, too!

Here’s an opportunity to spotlight your skills, grow your career, and become a published author - all at the same time! Join an ITSO residency project and help write a book in your area of expertise, while honing your experience using leading-edge technologies. Your efforts will help to increase product acceptance and customer satisfaction, as you expand your network of technical contacts and relationships. Residencies run from two to six weeks in length, and you can participate either in person or as a remote resident working from your home base.

Find out more about the residency program, browse the residency index, and apply online at:

ibm.com/redbooks/residencies.html

Comments welcome

Your comments are important to us!

We want our books to be as helpful as possible. Send us your comments about this book or other IBM Redbooks publications in one of the following ways:

► Use the online Contact us review Redbooks form found at:
  ibm.com/redbooks

► Send your comments in an e-mail to:
  redbooks@us.ibm.com

► Mail your comments to:
  IBM Corporation, International Technical Support Organization
  Dept. HYTD Mail Station P099
  2455 South Road
  Poughkeepsie, NY 12601-5400
Stay connected to IBM Redbooks

- Find us on Facebook:
  http://www.facebook.com/IBMRedbooks
- Follow us on twitter:
  http://twitter.com/ibmredbooks
- Look for us on LinkedIn:
  http://www.linkedin.com/groups?home=&gid=2130806
- Explore new Redbooks publications, residencies, and workshops with the IBM Redbooks weekly newsletter:
- Stay current on recent Redbooks publications with RSS Feeds:
  http://www.redbooks.ibm.com/rss.html
Overview
Chapter 1. Introduction to IBM Business Space powered by WebSphere

This chapter provides an overview of Business Space powered by WebSphere as a framework for delivering a common user experience across the IBM WebSphere platform of products.

It describes the architecture, concepts, and usage patterns of Business Space. These usage patterns have been created purely from the point of view of separating the types of business spaces and their inherent function into logical groupings. The chapters of this book have been organized around these usage patterns.

Finally, this chapter introduces you to the management of business spaces.
1.1 Overview of Business Space powered by WebSphere

This section provides a general introduction to Business Space powered by WebSphere. It provides information about what it does, who the likely users are, and the runtime technology of Business Space. It then goes on to cover who the owners of the user interface are.

1.1.1 What is Business Space powered by WebSphere

Business Space powered by WebSphere is a common or general user interface framework for aggregating content and delivering it via a browser. In this book, Business Space will be used interchangeably with IBM Business Space powered by WebSphere.

A business space is a collection of related Web content that provides you with insight into your business.

You can have many business spaces present on a Business Space run time, and each space has within it a number of tabbed pages. Each space is set up to provide pages relevant to a particular role or business function. Currently, the primary use of Business Space is within the Business Process Management (BPM) suite. So, for example, you can have a business space for monitoring business processes, and a further space for working on the human tasks within those processes.
Figure 1-1 shows the Business Space welcome page.

1.1.2 What IBM products support the development of business spaces

Business Space supplies the user interface for the Business Process Management (BPM) set of services and tools that support process management.

The activities that you perform to develop and manage your business processes are termed the BPM life cycle. This involves documenting the processes themselves, developing and testing services, and monitoring and improving the results.

A number of different products can be used for developing and monitoring artifacts across the BPM life cycle. These include:

- IBM WebSphere Business Compass
- IBM WebSphere Business Modeler
- IBM WebSphere Business Services Fabric
- IBM WebSphere Business Monitor
- IBM WebSphere Integration Developer
- IBM Business Space powered by WebSphere
The business spaces you create are made up of pages that contain widgets. Widgets are user interface components that are combined to provide the functionality of the pages in your business spaces.

To develop widgets, you need an environment for coding, running, testing, and viewing them. Business Space supplies some of the common widgets, and some of the other IBM WebSphere products mentioned above also provide widgets.

To assemble business spaces, you need a browser linked to an application server running IBM Business Space powered by WebSphere.

### 1.1.3 Who decides what a business spaces should look like

The users of business spaces can configure their own pages and combine the available widgets, for which they have access, to create custom business spaces.

A business user without deep technical skills can build and configure a page and its content quite easily based on the widgets to which he or she has access.

There are also a number of templates that provide pre-configured business spaces. These business spaces contain pages and widgets designed to work with a particular product in a specific way. Even these pre-configured business spaces can be customized to meet business needs.

### 1.1.4 Who are the creators of business spaces

The answer to this question depends on whether you are talking about the business spaces themselves, or the widgets that are used when customizing the business spaces.

In the case of the business spaces, they can be created by the users or the administrator of the business spaces. These business spaces can be created from templates or by assembling different widgets on to the page.

The creation of business space widgets is usually the domain of developers.

### 1.2 Architecture of Business Space

In this section, we review the runtime environments that support Business Space.
1.2.1 The processing engines of Business Space

After you have developed your widgets, you need to deploy them, which means packaging them by creating an Enterprise Archive (EAR) file and, optionally, a Web Archive (WAR) file, and deploying them to a server.

At the most basic level, IBM Business Space powered by WebSphere uses the IBM WebSphere Application Server as its runtime engine. However, if you want to use the pluggable user interface components, or widgets, for mediations, short and long-running business processes, composite business processes, or dynamic business processes, you need a runtime environment that supports the functionality of these business spaces. The supported run times are shown in Figure 1-2.

![Hierarchy of WebSphere run times](image)

Figure 1-2  Hierarchy of WebSphere run times

Likewise, if you intend to perform business activity monitoring from your business spaces, IBM WebSphere Business Monitor will need to be installed in the same profile as the run time you choose from the hierarchy of WebSphere products that support IBM Business Space powered by WebSphere.

You can configure Business Space to work in the IBM WebSphere Portal environment. You still require one of the above-mentioned run times to be installed. For additional information, refer to the topic “Configuring Business Space on WebSphere Portal’ in the WebSphere Business Process Management V7 Information Center found at the following address:

http://publib.boulder.ibm.com/infocenter/dmndhelp/v7r0mx/index.jsp
1.2.2 The assembly of business spaces

A user or an administrator can combine widgets with each other to perform related tasks. Some widgets can communicate with other widgets using events that can alter the contents of the target widgets. Business Space provides a widget palette that contains categories of widgets you can use to configure the pages in your business spaces.

1.2.3 Business Space in the IBM WebSphere Integration Reference Architecture

The WebSphere Integration Reference Architecture shows the key integration functions or services that are required for comprehensive, enterprise-level solutions. Business Space provides the user interfaces (interaction services) that are mostly used by business processes (process services). This architecture is shown in Figure 1-3.

![Figure 1-3  WebSphere Integration Reference Architecture](image)

You can think of Business Space as being the user interaction “space” primarily for the Business Process Management suite of IBM products, because most of the pluggable user interface components that make up a business space are derived from the BPM product stack.
1.3 Concepts of Business Space

In this section, we discuss the concepts and terminology of Business Space.

1.3.1 Business spaces

A *business space* is a collection of related Web content that might include collections of pages that comprise a business process, application, or collaborative user experience.

Business Space can display the contents of one business space at a time. This space is the *open space*.

The open space consists of a banner area and a page area. The top of the banner contains menus that contain options that affect the open business space or options for navigating to another space. Figure 1-4 shows an example of the menus, banner area, and page are for an open space.

![Welcome to Business Space](image)

*Figure 1-4  Welcome to Business Space*

Below the menus, the banner area displays the name of the open space and tabs for the pages in the space.
1.3.2 Page

The page area is below the banner on a open space. The tab for the open page is highlighted. In the example shown in Figure 1-5, the name of the page is Getting Started.

![Getting Started Page](image)

If you are the business space owner or an editor, you can edit a page to add or remove widgets or change where the widgets are displayed on the page. The page shown in Figure 1-5 contains no widgets and is made up purely of HTML.

1.3.3 Template

The templates included with Business Space are examples of how you can use Business Space to accomplish your business goals. They provide walkthroughs for creating the space by using the template to achieve a particular business goal.

Each walkthrough lists the products it requires. These products must be installed and in the same profile as the IBM WebSphere Application Server.

Each product that supports Business Space provides its own set of templates that get added to the available templates when the product is installed in the same profile as the WebSphere Application Server.
The Business Space templates for WebSphere Process Server are shown in Figure 1-6.

If you install IBM WebSphere Business Monitor in the same profile as WebSphere Process Server, you get an additional Business Monitoring template. This template combines WebSphere Business Monitor widgets with the WebSphere Process Server Human Tasks widget and some standard Business Space widgets to create business spaces for monitoring and reporting on business processes.

1.3.4 Widget

_Widgets_ are the pluggable user interface components that you use to define the functionality of your business spaces. Widgets consist of an XML descriptor with optional JavaScript and HTML resources.
You can combine widgets to interact with each other to perform related tasks. A page usually contains a combination of widgets.

Figure 1-7 shows an example of a business space that includes human task widgets.

Figure 1-7  A business space showing human task widgets on the page

Widgets can be developed using a variety Web authoring tools. IBM WebSphere Integration Developer, IBM WebSphere sMash, and IBM Mashup Center provide an authoring environment (editors) for developing widgets.

1.4 Usage patterns of Business Space

Rather than simply providing a list of widgets by product, we have categorized business spaces by their usage patterns. For the most part, many of the product-centric widgets fall neatly into these usage patterns, although in a few cases, widgets from multiple products are found in some usage patterns.
These usage patterns focus on particular business processes or user roles instead of the products that support these functions.

You can use any combination of these usage patterns and their associated widgets in your business spaces, provided that you have the runtime environment that supports the widgets you choose.

1.4.1 Human-centric business spaces

Human-centric business spaces make use of the Human Task Management widgets that are delivered as part of Business Space included with WebSphere Process Server. They provide easily integrated capabilities to check and complete business processes and human tasks.

1.4.2 Integration-centric business spaces

Integration-centric business spaces use some of the Business Space Administration widgets that are provided with WebSphere Process Server and WebSphere Enterprise Service Bus. In particular, we cover the Mediation Policy Administration widget that allows mediation policies to be administered from a business space. In addition, the Service Browser widget allows the business space user to view the services that are stored in the WebSphere Service Registry and Repository.

1.4.3 Common-content business spaces

Common-content business spaces are used to display Web sites, Web feeds, Word documents, presentations, spreadsheets, and third-party gadgets, like Google Gadget, to display maps. These capabilities are part of the Common widgets supplied with Business Space.

1.4.4 Dynamic business spaces

Dynamic business spaces provide predefined Business Space templates that are supplied with WebSphere Business Services Fabric that enable developers to assemble adaptable business processes, and allows business users to change Business Service policies at run time.

Also included under this usage pattern is the Business Rules widget that comes with WebSphere Process Server.
1.4.5 Business design and review spaces

Business design and review spaces provide a Web-based environment for designing and building business documents that visually represent the current business structure and processes, and the future business direction.

Using the WebSphere Business Compass business design widgets, you can collaborate with others to design and document your business strategy using strategy roadmaps and capability roadmaps to help you describe and re-architect your business processes.

1.4.6 Activity-monitoring business spaces

In this usage scenario, you use the Business Monitoring Template to create a space designed for monitoring business activities. This template is provided with WebSphere Business Monitor, and together with some other widgets provided in WebSphere Process Server, creates an intuitive interface for monitoring and reporting on business processes.

1.5 Management of Business Space

The management of business spaces is covered in more detail in Chapter 2, “Managing IBM Business Space powered by WebSphere V7” on page 17. This includes both the user’s ability to customize the look and feel of their own spaces and the administrative tasks that are performed to secure the business space environment.

1.5.1 Business spaces and security

Business Space can make use of the administrative and application security provided by WebSphere Application Server. If you configure global security in WebSphere Application Server, users will be prompted for their credentials when trying to access a business space.
Figure 1-8 shows a business space login challenge.

In addition, you can control access to pages and the authority to perform actions on pages and widgets by user, role, or group.

More detailed information can be found in 2.1.1, “Securing a Business Space environment” on page 29.

1.5.2 Business spaces and performance

Because Business Space is an enterprise archive application running on the WebSphere Application Server, you can exploit the performance and scalability of the WebSphere runtime environment for an enterprise-wide deployment of business spaces.
Managing IBM Business Space powered by WebSphere V7

This chapter details how to manage Business Space. This is done by splitting up the possible tasks according to two main roles:

- Administrator
- User

In this chapter, we discuss the following administration tasks.

- Manage the registration of widgets.
- Securing a Business Space environment
- Managing widgets

The following user tasks are discussed:

- Creating a space
- Adding a widget to a page
- Sharing spaces
- Widget wiring
- Widget visibility
2.1 Administrator tasks

An administrator of Business Space needs to perform different actions. To be able to do so, the administrator should be assigned the role of superuser, which we discuss in “Superuser” on page 32.

The administrator can carry out the following activities in Business Space:

- Customize the look and feel. This allows enterprises to change the user interface as per their specifications so that the interface is in line with the other solutions they might have deployed, giving the user a more consistent user experience.
- Secure a Business Space environment and choose the user repository to use.
- Manage the registration of widgets.
- Customize the look and feel.

Several look and feel aspects can be customized within Business Space. The Business Space administrator can customize the Business Space login page and styles used for spaces, create templates, and assign a home space.

Login page
The Business Space login page is the first page users are directed to when they access Business Space. A prerequisite for changing the look and feel of the login page is to have administrator credentials to log in to the Integrated Solutions Console.

The login page can be customized by performing the following steps.

1. Create a folder to hold all the artifacts for the new login page theme. Enter ITSOLoginStyle as the name for this folder.
2. Create a new cascading style sheet under ITSOLoginStyle. Enter login.css as the file name. This cascading style sheet should define the colors, fonts, sizes, and so on, for your style. It should also reference any custom images that you might want to apply.
3. Copy the content shown in Example 2-1 on page 19 into login.css. A description of the styles that you can set and that are used in login.css is given in Table 2-1 on page 20.
Example 2-1  CSS contents for login.css

@CHARSET "ISO-8859-1";

html {
   overflow-x: hidden;
}

.topDiv {
   height: 100%;
   font: 300 11px Arial, Verdana, Geneva, Helvetica, sans-serif;
   color: #ffffff;
   background-image: url(images/login-page-bg.jpg);
   background-position: center;
}

.login-bg {
   background-image: url(images/login-bg.png);
   background-repeat: no-repeat;
   height: 428px;
   width: 579px;
}

.mumrtl .login-bg {
   background-image: url(images/login-bg-bidi.png);
}

.login-top-spacer {
   height: 160px;
}

.login-copyright {
   height: 42px;
   padding: 15px;
   color: #666666;
}

.dj_ie .login-copyright {
   padding-top: 0px;
   padding-bottom: 0px;
}

.loginText {
   color: #3A6A9A;
Table 2-1  List of styles for the login page

<table>
<thead>
<tr>
<th>Style</th>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.topDiv</td>
<td>background-image: url</td>
<td>Identifies the image used as the overall background that surrounds the login area.</td>
</tr>
<tr>
<td>.login-bg or mumrtl</td>
<td>background-image: url</td>
<td>Identifies the image that is used as the background for the login area that contains the login fields. If you change their size, you might have to adjust the login.css file accordingly. The mumrtl.login-bg setting is for right to left languages such as Arabic and Hebrew.</td>
</tr>
<tr>
<td>.login-top-spacer</td>
<td></td>
<td>Sets the minimum space above the login fields.</td>
</tr>
<tr>
<td>.login-copyright</td>
<td></td>
<td>Sets the color and location of the copyright text.</td>
</tr>
<tr>
<td>.loginText</td>
<td></td>
<td>Sets the look of the labels for the User ID and Password login fields.</td>
</tr>
</tbody>
</table>
4. Create a new folder under ITSOLoginStyle to hold the images referenced in the css. Enter images as the folder name.

5. Copy the set of images provided with the additional materials for this book (refer to Appendix B, “Additional material” on page 747) into images.

6. Log in to the Integrated Solutions Console at the following URL:
   http://<HOST_NAME>:<PORT>/admin

7. Expand Servers → Server Types → WebSphere Application Servers. Click the server hosting Business Space.


10. Define a new environment variable BSPACE_LOGIN_EXT_DIR. The value should be the directory path where your cascading style sheet file (login.css) exists.

11. Save changes to the master configuration and restart the server.

12. Clear your browser cache and login to Business Space at the following URL:

**Note:** Any references in the cascading style sheet file to external files (such as images) should be relative to the location of the file itself.

If you are accounting for right-to-left (RTL) languages, you might need to create different images for RTL and LTR languages. This situation is dictated by the browser’s language preference.
Figure 2-1 shows the customized login page for ITSO Movie.

![ITSO Movie login page after customization](image)

**Figure 2-1  ITSO Movie login page after customization**

**Tip:** Working with cascading style sheet files can be a complex process. Several extensions for Mozilla Firefox exist that ease this process. Mozilla Firebug and the Web Developer toolbar are two such extensions that allow you to examine and manipulate CSS files easily.

A good place to start creating your own CSS files would be the default login.css file, which is located at `<PROFILE_ROOT>\installedApps\<CELL_NAME>\BSpaceEAR_<NODE_NAME>_<SERVER_NAME>.ear\BSpace.war\login`.

To clear the cache in Mozilla Firefox, click **Tools → Clear Recent History**. Select **Cache** and click **Clear Now**.

**Styles**

Styles define the overall look and feel of a certain space in Business Space. Users can assign a style to a space during the creation of a new space or by editing the space settings from the actions link in the banner.
Business Space comes with some predefined styles that can be applied. As an administrator, you can create your own style and register it in Business Space so that users can apply it to their spaces. In order to do so, you need to perform the following steps.

1. Create a JavaScript file that describes your style.
   a. Create a new folder to hold all the style’s artifacts. Enter ITSONoteStyle as the folder name.
   b. Create a new JavaScript file under ITSONoteStyle. Enter itsoCustStyle.js as the file name.
   c. Enter the content of the JavaScript file (shown in Example 2-2). The attributes contained in your JavaScript file are explained in Table 2-2.

   **Example 2-2  Content for itsoCustStyle.js**

   ```javascript
   {
     "id": "itsoCustStyleID",
     "name": "ITSONoteCustom",
     "preview": "itsoCustStyle/itsoCustom_thumb_202x152.png",
     "className": "itsoCustStyle",
     "css": "itsoCustStyle/itsoCustom.css",
     "resourceFile": "itsoCustStyleResources.js"
   }
   ```

   **Table 2-2  Attributes details for JavaScript files for styles**

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>Yes</td>
<td>Identifier for the style.</td>
</tr>
<tr>
<td>name</td>
<td>Yes</td>
<td>The name that is displayed to the user.</td>
</tr>
<tr>
<td>preview</td>
<td>Yes</td>
<td>The file path for thumbnail for the style.</td>
</tr>
<tr>
<td>className</td>
<td>Yes</td>
<td>Identifies the class in the CSS that Business Space uses when this custom style is in use.</td>
</tr>
<tr>
<td>css</td>
<td>Yes</td>
<td>The file path to use for the cascading style sheet file.</td>
</tr>
<tr>
<td>resourceFile</td>
<td>No</td>
<td>Identifies the JavaScript file that contains the translations for the name of the style.</td>
</tr>
</tbody>
</table>
2. Create a new folder to contain the cascading style sheet file and its related artifacts. It will also contain the thumbnail image for your style.
   a. Create a new folder under ITSOMovieStyle. Enter itsoCustStyle as the name.
   b. Create a new cascading style sheet file under itsoCustStyle. Enter itsoCustom.css as the file name.
   c. Copy the contents shown in Example 2-3 into itsoCustom.css.

   **Example 2-3  Content for itsoCustom.css**

   ```
   @CHARSET "ISO-8859-1”;

   .itsoCustStyle .headerDivRepeat{
      background-image:url(Main_Banner/top_banner_left_repeat.png);
   }

   .itsoCustStyle .headerDiv {
      background-image: url(Main_Banner/TopPartOfBanner.png);
   }

   .itsoCustStyle .titleBanner {
      background-image: url(Main_Banner/BottomPartOfBanner.png);
   }

   .itsoCustStyle .titleBannerRepeat {
      background-image:
      url(Main_Banner/lower_banner_left_repeat.png);
   }

   .itsoCustStyle .navigationPanelSeparator {
      background-image: url(Main_Banner/link_divider_top_left.gif);
   }

   .itsoCustStyle .bspaceSkinLeftEdge {
      background-image: url(Widget_border/widget_side_lef.png);
   }

   .itsoCustStyle .bspaceSkinRightEdge {
      background-image: url(Widget_border/widget_side_rig.png);
   }

   .itsoCustStyle .bspaceSkinTopEdgeAndTitleFill {
      background-image: url(Widget_border/widget_title_mid.png);
   }
   ```
.itsoCustStyle .bspaceSkinTopRightCorner{
    background-image: url(Widget_border/widget_title_rig.png);
}

.itsoCustStyle .bspaceSkinTopLeftCorner{
    background-image: url(Widget_border/widget_title_lef.png);
}

.itsoCustStyle .bspaceSkinBottomEdge {
    background-image: url(Widget_border/widget_bot_mid.png);
}

.itsoCustStyle .bspaceSkinBottomLeftCorner {
    background-image: url(Widget_border/widget_bot_lef.png);
}

.itsoCustStyle .bspaceSkinBottomRightCorner{
    background-image: url(Widget_border/widget_bot_rig.png);
}

.dj_ie6 .itsoCustStyle .bspaceSkinLeftEdge2 {
    background-image: url(Widget_border/widget_side_lef.png);
}

.dj_i6 .itsoCustStyle .bspaceSkinRightEdge2 {
    background-image: url(Widget_border/widget_side_rig.png);
}

.itsoCustStyle .bspaceOverEditBar .bspaceSkinTopEdgeAndTitleFill{
    background-image:
    url(Widget_border/widget_title_hov_mid.png);
}

.mashups .itsoCustStyle .navigationPanel,
.mashups .itsoCustStyle .actionsDropDown,
.mashups .itsoCustStyle .commonActionUserName,
.mashups .itsoCustStyle a.commonActionLink1:link,
.mashups .itsoCustStyle a.commonActionLink1:visited,
.mashups .itsoCustStyle .common_action_spliter,
.itsoCustStyle .bannerTitle {
    color: #555555 !important;
}
.mashups .itsoCustStyle .actionsDropDownImage {
  background-image: url(twistie_top.gif);
}

.itsoCustStyle .bspaceFooter {
  background-image: url(Main_Banner/footer_reapeat.png);
}

.dj_ie6 .itsoCustStyle .bspaceSkinRightEdge {
  background-image: url(ie6/widget_side_rig.png);
}

.dj_ie6 .itsoCustStyle .bspaceSkinLeftEdge2 {
  background-image: url(ie6/widget_side_lef.png);
}

.dj_ie6 .itsoCustStyle .bspaceSkinRightEdge2 {
  background-image: url(ie6/widget_side_rig.png);
}

.dj_ie6 .itsoCustStyle .bspaceSkinBottomEdge {
  background-image: url(ie6/widget_bot_mid.png);
}

.dj_ie6 .itsoCustStyle .bspaceSkinBottomLeftCorner {
  background-image: url(ie6/widget_bot_lef.png);
}

.dj_ie6 .itsoCustStyle .bspaceSkinBottomRightCorner{
  background-image: url(ie6/widget_bot_rig.png);
}

.dj_ie6 .itsoCustStyle .bspaceSkinTopLeftCorner {
  background-image: url(ie6/widget_title_lef.png);
}

.dj_ie6 .itsoCustStyle .bspaceSkinTopRightCorner {
  background-image: url(ie6/widget_title_rig.png);
}

.dj_ie6 .itsoCustStyle .bspaceSkinTopEdgeAndTitleFill {
  background-image: url(ie6/widget_title_mid.png);
}
3. Copy the images folders provided with the additional materials for this book (see Appendix B, “Additional material” on page 747) into itsoCustStyle. These folders contain the images referenced in itsoCustom.css.

4. Copy itsoCustom_thumb_202x152.png, which is provided with the additional materials for this book, into itsoCustStyle. This image represents a thumbnail of your style that is used when the user is selecting a style to apply to his business space.

5. Business Space supports internationalization by allowing you to optionally specify different translations for your style. You can do this action by performing these steps:
   a. Create a new folder under ITSOMovieStyle. Enter nls as the name.
   b. In the nls folder, create a JavaScript file. Enter itsoCustStyleResources.js as the name for this file. This file will be loaded when the user's locale is not one of the ones you have defined.
   c. Copy the contents shown in Example 2-4 into itsoCustStyleResources.js. The key represents the ID for your style, and the value represents the text to display as the widget name.

   Example 2-4  Content for itsoCustStyleResources.js

   ```
   {
     "itsoCustStyleID":"ITSO Movie"
   }
   ```

   d. Proceed to define subfolders in the nls subfolder, with each one representing a different locale. In each subfolder, create the corresponding JavaScript file.


7. Expand **Servers** → **Server Types**, then click **WebSphere Application Servers**. Click the server hosting Business Space.

8. Under Server Infrastructure, expand **Java and Process Management**, and then click **Process definition**.

9. Under Additional properties, click **Environment Entries**.

10. Define a new environment variable BSPACE_STYLE_EXT_DIR. The value should be the path to your ITSOMovieStyle folder.
Templates
Templates in Business Space are used to define a set of pages and widgets that are geared towards certain scenarios. They enable users to quickly define their own business spaces with potentially minor adjustments to the template they choose.

Business Space comes with several predefined templates, but administrators can create and share new templates in Business Space.

To create a template, perform the following steps:
1. Create a new space. The name for the space will be the name for the template.
   a. Select Manage Spaces → Create Space.
   b. Enter ITSOTemplate as the space name.
   c. Select a space style and a space icon.
   d. Click Save.
2. Create your pages and widgets. Configure the layout and any configuration you might need for the widgets. This is discussed in 2.2, “Business Space user tasks” on page 37.
3. Click Manage Spaces.
4. Click Actions link for the space you just created.
5. From the menu, click Save as Template. A success message should now display at the top of the Space Manager, as shown in Figure 2-2.

Business Space users should now see your newly created template when creating a new space.

Note: To update a custom style, simply update the files for your style with the new files and restart the server.
Home space
When users log in to Business Space for the first time, they are shown, by default, the space Welcome to Business Space as the home space. As an administrator, you can change the home space to any other space. This is accomplished by sharing the space with everyone as viewers and setting it as the home space. You can accomplish this task by performing the following steps:

1. Open the Space Manager by clicking Manage Spaces.
2. Select Actions → Share for the space you want to set as the home space.
3. Change the search scope to Group Search.
4. Enter All in the search text field and click the magnifier glass to start the search.
5. Click All Authenticated Users and click Add to View.
6. Click Save.
7. Select Actions → Set as Home for the space you shared, then click OK and Done.

2.1.1 Securing a Business Space environment

In order to authenticate users to allow them to access your business space environment, you need to enable both administrative and application security. After you have configured security for your Business Space environment, users will be prompted for their credentials when trying to access Business Space. These credentials will be checked against your user registry.

A user registry is an abstraction that is used to represent the various implementations that exist for user and group repositories. The choice of user registries will also affect some of the functionality you have in Business Space, as we discuss in this section.
The authorization process, which is responsible for controlling the access of users to spaces and pages, is not part of this section, but will be discussed in 2.2, “Business Space user tasks” on page 37.

Perform the following steps to enable security for Business Space:

1. Log in to the Integrated Solutions Console.
2. Expand Security, and then click Global security. Click Enable administrative security and Enable application security.
3. Under User account repository, select one of the available realm definitions:
   - Federated Repositories: Allows the configuration of various user repositories and presenting them as a single user repository. The actual implementations that can be federated are LDAP, custom repositories databases, and file-based implementations.
   - Local Operating System: Users and groups are retrieved from the operating system itself. This is a typical practice when using IBM z/OS®.
   - Stand-alone LDAP: Users and groups are retrieved from an LDAP repository using the LDAP protocol.
   - Custom Registry: Can be written and integrated with WebSphere Application Server. You can obtain information about writing a custom registry at the following address:

Your choice of the user registry will have a direct impact on some of the functionality provided by Business Space. You should consider the following items when deciding on the type of user repository to use:

- The Standalone LDAP registry does not work for Managing Tasks and Workflows widgets or other human task-related widgets.
- Federated repositories for Business Space will provide you with additional capabilities in your widgets and framework, such as enhanced search capabilities. When searching for users to share spaces and pages, the search scope includes e-mail, a user's full name, and user ID.

4. If Business Space is hosted in a different cell from where the rest of your products that use Business Space are, you will need to configure single sign-on by performing the following steps:
   a. In the Global security menu, under Authentication, expand Web and SIP security.
   b. Click Single sign-on (SSO) and make sure Enabled is selected.
c. From the Global security menu, under Authentication, click LTPA. Under the Cross-cell single sign-on menu, enter a password for the key file and a name, including the file path where the file is to be generated.

d. Click Export keys. The key file is now generated in the path you specified.

5. Import the keys on the other nodes. If you are using HTTPS in the endpoints file, the endpoint location is on a different node than Business Space, and the Secure Sockets Layer (SSL) certificate is self-signed, you must import the SSL certificate.

a. Log in to the Integrated Solutions Console for the server that contains Business Space and import the SSL certificate that is used by the remote nodes where the endpoint is located.

   i. Under Security, click SSL certificate and key management.

   ii. Under Related items, click Key stores and certificates.

   iii. On the Key stores and certificates page, click NodeDefaultTrustStore.


   v. Click Retrieve from port.

   vi. Enter the host and port from where the certificate should be imported. and enter an alias.

   vii. Click Retrieve signer information. The retrieved signer information is shown.

   viii. Click OK.

   ix. Save the changes to the master configuration.

b. Log on to the Integrated Solutions Console for the cell where the remote endpoint is located and import the SSL certificate that is used by the cell where Business Space is running.

   i. Repeat steps i. through v. above.

   ii. On the Retrieve from port page, under the General Properties menu, enter the host and port for the server where Business Space is running. Click the Retrieve signer information button and then click OK.

   iii. Restart both servers.
User roles
There are four main roles that any user can have in Business Space:

- Superuser
- Owner
- Editor
- Viewer

Superuser
The superuser has administrative privileges that allow him to see all spaces and pages. Furthermore, the superuser is the only user with the ability to manage templates.

In order to grant someone the superuser role, you need to perform the following steps.

1. Open a command prompt and change the directory to `<PROFILE_ROOT>/bin`, where `<PROFILE_ROOT>` is the directory for the profile hosting Business Space.
2. Enter the following command into the command prompt:

   ```
   wsadmin -lang jython -user <ADMIN_USER_NAME> -password <ADMIN_PASSWORD> -f <INSTALL_ROOT>\BusinessSpace\scripts\createSuperUser.py <USER_ID> <PASSWORD>
   ```

Where `<USER_ID>` is the unique identifier for a user in your user repository and `<PASSWORD>` is the password for that user. If that user exists in VMM, the user is added to the administrator group.

**Note:** Before running the previous command, you need to make sure of the following items:

- The default administrators group name is not changed.
- Use the default repository for the user registry.
- Start the server or the deployment manager for your Business Space environment for the profile where Business Space is installed.

For more information regarding how to change and assign superusers in environments that are clustered or with security disabled, refer to the Information Center found at the following address:

Owner
An owner of a space is initially the person who created it. The owner can create pages in that space and assign viewer and editor privileges to these pages. Furthermore, he can delete or transfer ownership and share or export the space.

Editor
An editor can add and share pages in a space. Furthermore, he can add widgets to pages and customize these widgets. A user is assigned the editor privileges by the owner of that space or the administrator.

Viewer
A viewer can access the pages of a space and resize widgets. The viewer can not add pages or share them.

2.1.2 Managing widgets

As an administrator, you manage the widgets available for users of your Business Space. This includes installing new widgets, updating already existing ones, and deleting obsolete widgets. Widget management is discussed in Chapter 13, “Developing a custom widget” on page 677.

There are two administrative tasks that allow you to manage widgets:

- installBusinessSpaceWidgets
- updateBusinessSpaceWidgets

Installing widgets
To install widgets, perform the following steps:

1. Create a compressed folder with the following structure to package all elements of a widget:
   
   - ear\<WIDGET.EAR>
   - catalog\<WIDGETCATALOG.XML>
   - endpoints\<ENDPOINT.XML>
   - templates\<TEMPLATE.ZIP>
   - help\eclipse\plugins\*

2. From a console window, run `wsadmin.bat`, which is located under `<PROFILE_ROOT>/bin`:

   `wsadmin -user <USER_NAME> -password <PASSWORD>`
3. Make sure that the server you will run the command against is up and running.

If you are installing to a non-clustered environment, issue the following command:

```
wsadmin>$AdminTask installBusinessSpaceWidgets {-nodeName <NODE_NAME> -serverName <SERVER_NAME> -widgets <PATH_TO_WIDGET_FOLDER>}
```

If you are installing to a clustered environment, issue the following command:

```
wsadmin>$AdminTask installBusinessSpaceWidgets {-clusterName <CLUSTER_NAME> -widgets <PATH_TO_WIDGET_FOLDER>}
```

Where `<NODE_NAME>` is the name of the node hosting Business Space, `<SERVER_NAME>` is the name of the server hosting Business Space, `<CLUSTER_NAME>` is the name of the cluster hosting Business Space, and `<PATH_TO_WIDGET_FOLDER>` points to the compressed folder.

4. Restart the server.

5. You might need to refresh the browser cache to see the new widgets.

**Tip:** During development time, it maybe faster to create the catalog and installation scripts directly within the module hosting your widget(s) and to run them as an administrative script from WebSphere Integration Developer.

**Note:** More information about installing Business Space widgets in a clustered environment and about the installBusinessSpaceWidgets command can be found in the Information Center found at the following address:


**Updating widgets**

Updating widgets allows you to update any of the artifacts that are associated with your widget. You can update any element of a widget package, such as the widget binaries, the endpoint files, or the help plug-in.

You will need to create a compressed file with the same structure that was used for the installation of widgets. You can install or update each widget artifact on its own. Refer to Chapter 13, “Developing a custom widget” on page 677 for more information.
Perform the following steps:

1. From a console window, run `wsadmin.bat`, which is located under `<PROFILE_ROOT>/bin run:
   
   ```
   wsadmin -user <USER_NAME> -password <PASSWORD>
   ```

2. Make sure that the server you will run the command against is up and running. If you are updating widgets in a non-clustered environment, issue the following command:
   
   ```
   wsadmin>AdminTask updateBusinessSpaceWidgets {-nodeName <NODE_NAME> -serverName <SERVER_NAME> -widgets <PATH_TO_WIDGET_FOLDER>}
   ```

   If you are updating widgets in a clustered environment, issue the following command:
   
   ```
   wsadmin>AdminTask installBusinessSpaceWidgets {-clusterName <CLUSTER_NAME> -widgets <PATH_TO_WIDGET_FOLDER>}
   ```

3. Restart the server.

4. You might need to refresh the browser cache to see the new widgets.

Note: At the time of the writing of this book, there was no command to uninstall widgets. In order to do so, refer to the IBM TechNote found at this address:


Note: More information about updating Business Space widgets in a clustered environment and about the `updateBusinessSpaceWidgets` command can be found at the Information Center found at the following address:


### 2.1.3 Integration with IBM Mashup Center

Business Space, as a common user interface for WebSphere BPM products, is built on top of the IBM Mashup Center widget container and page assembly technology. Business Space does not include the entire set of functionality that is supplied with IBM Mashup Center as an end-to-end general purpose mashup product, but you can integrate Business Space and IBM Mashup Center to get the full range of capabilities that IBM Mashup Center provides.
By integrating Business Space with IBM Mashup Center, you can benefit from the additional capabilities of IBM Mashup Center:

- **IBM Mashup Center catalog**
  
  All assets, such as spaces, pages, or widgets available in IBM Mashup Center, are published in a centralized catalog where they can be retrieved, rated, tagged, and searched. Access to the catalog is directly integrated into the Business Space navigational menu.

- **IBM Mashup Center widgets**
  
  IBM Mashup Center provides a set of out-of-the-box widgets that can be used in addition to the widgets provided with Business Space. For example, widgets for aggregated data feeds from multiple sources can be displayed on a page together with WebSphere BPM widgets.

To integrate Business Space with IBM Mashup Center, perform the following steps:

1. Export all Business Space templates and import them to the IBM Mashup Center repository.
2. Enable single sign-on between the Business Space server and the server that hosts IBM Mashup Center, if they are not running on the same server (you must use a federated repository as the user registry for this action).
3. Update the Business Space configuration file:
   
   ```
   <PROFILE_ROOT>/BusinessSpace/<NODE_NAME>/<SERVER_NAME>/mm.runtime.pr
of/config/ConfigService.properties.
   ```
   
   Modify the following properties in the file:
   
   - **com.ibm.mashups.hub.url**: Specify the URL to your Mashup Hub server, for example, http://localhost:9080/mashuphub.
   - **createSpaceOnTemplateMode**: Set this property to true. Business Space will now use the repository of IBM Mashup Center instead of its own.
4. Propagate the changes to the runtime environment. Run the following `wsadmin` command as an admin user on the Business Space server:
   
   ```
   $AdminTask updatePropertyConfig {-serverName <SERVER_NAME> -nodeName
   <NODE_NAME> -propertyFileName
   "<PROFILE_ROOT>/BusinessSpace/<NODE_NAME>/<SERVER_NAME>/mm.runtime.p
   rof/config/ConfigService.properties" -prefix "Mashups_"}
   ```

**Note:** To use IBM Mashup Center, you need to purchase an IBM Mashup Center license separately from the WebSphere product that includes Business Space.
In a clustered environment, instead of pointing to a server and node, use -clusterName <CLUSTER_NAME> instead and run the command on the deployment manager.

5. Save the configuration changes by running the $AdminConfig save command.

6. Restart your Business Space server or cluster.

For further information, go to the following address:

http://www-01.ibm.com/support/docview.wss?uid=swg21414646

2.2 Business Space user tasks

A space in Business Space represents a set of pages, each containing a number of widgets. Each space should combine a set of functionality that addresses certain related user scenarios. For example, you can have a different space for each department in your organization with one page for accounting, one page for human resources, and so on, or you can have spaces that combine a set of pages, such as using WebSphere Business Monitor widgets to monitor key aspects of your business and another space using WebSphere Process Server widgets allowing users to claim and work on their tasks.

2.2.1 Creating a space

To create a space, perform the following steps:

1. Log in to Business Space.
2. Select **Manage Spaces** → **Create Space** or **Actions** → **Create Space**. The Create Space window opens. This window is split into three main parts, as shown in Figure 2-3.

![Create Space window](image)

**Figure 2-3  Create Space window**

3. Enter a name for your space and a description (optional). This name will appear on the banner for your space and will be used to refer to the space in the Space Manager.

   **Note:** You cannot use the following characters for a space name: @, /, \, :, *, ?, "", <, >, and |.

4. You can create a space based on a template or based on another space. Both options provide a drop-down menu to select either a template or a space. Click either **Create a new space using a template** or **Duplicate an existing space**.

5. Select a style from the style pane for the space. This will define the overall look and feel of the space.
6. Select an icon for your space. This icon will appear beside the space name in the banner. Figure 2-4 shows the Create Space window with the information for ITSO Movie Order Tracking space.

![Create Space window with data for ITSO Movie Order Tracking space](image)

**Figure 2-4** Create Space window with data for ITSO Movie Order Tracking space

7. Click **Save**.

Figure 2-5 shows the newly created space with the customized style.

![Customized ITSO Ticket Sales space](image)

**Figure 2-5** Customized ITSO Ticket Sales space

---

**Note:** At the time of the writing of this book, you could not add your own custom icons to the Space icon palette.

---

Once you have created a space, the first page is automatically created for you.
You cannot delete all the pages in a space. A space must have at least one page at any time.

Pages have two modes:

- Edit mode
- View mode

In view mode, you will not be able to modify the layout of the page or to configure, add, or remove widgets in that page. In order to do so, you will have to click either the Edit Page button or Edit Page link to go to edit mode.

### 2.2.2 Adding pages to a space

You can add new pages to your space either by clicking the Add Page icon (see Figure 2-6) or by either selecting Actions → Create Page or Manage Spaces → Actions → Create Page, as shown in Figure 2-7 on page 41.

![Figure 2-6 Adding page using the Add Page icon](image-url)
You can control the layout of widgets on your page based on one out of six predefined layouts. The layout will define sections into which you can drag and drop your widgets; each section can hold more than one widget. You will need to be in edit mode in order to define your layout.

To add pages to a space, perform the following steps:

1. Click the page menu arrow to open the page context menu.
2. Click **Layout**.
3. Choose a layout from the six available layouts, as shown in Figure 2-8.

![Figure 2-8  Changing the layout of the page](image)

### 2.2.3 Adding a widget to a page

To add a widget to a page, perform the following steps:

1. Click **Edit Page** in the top right corner to display the widgets palette. The widgets palette displays all the widgets that have been registered in Business Space that you can use, as shown in Figure 2-9. A preview is also visible on the right side of the palette with a small description of the functionality provided by the widget.

![Figure 2-9  Widget palette](image)

**Note:** You can quickly access widgets by filtering them according to the categories in the drop-down menu at the top left of the palette. Categories can be added as needed by the administrator. Alternatively, you can filter by entering your keywords in the filter text menu besides the drop-down menu.

2. Drag and drop the widget from the palette to your page. The area to which the widget will be assigned is highlighted.

3. After you have added all the widgets to the page, click **Save** or **Finish Editing**.
2.2.4 Sharing spaces

There are several ways to share a space. In this section, we discuss how to share a space and pages with other users with different roles, how to export and import spaces and pages, and how to show pages in external sites.

Sharing spaces and pages
In Business Space, you have the capability to share a space or a page with a set of users. As the owner of a space or an administrator, you can assign users either a viewer role or an editor role for your space or page. By default, the permissions you set on a space are inherited by all its pages. If a user is an editor for your space, he is an editor for all pages within that space.

To share spaces and pages, perform the following steps:

1. Click Manage Spaces.
2. From for the Space Manager, for the space you want to share, select Actions → Share, as shown in Figure 2-10.

![Figure 2-10  Sharing a space from within the Space Manager](image)
3. A window opens (Figure 2-11) where you can search for users or groups of users with whom you want to share your space.

![Figure 2-11  Sharing ITSO Movie Order Tracking space](image)

4. You can change the search scope by clicking the button to the left of the search field. Enter a search term and click the magnifying glass to start the search.

**Leading practice:** Assign permissions by groups rather than by users as much as possible.
5. After you have chosen your users or group, assign them to one of the two aforementioned roles by selecting them and clicking either **Add to View** or **Add to Edit**, as shown in Figure 2-11 on page 44.

6. Click **Save**.

7. In order to share specific pages from within a certain space, expand the space and then select **Actions → Share** for the page you want to share, as shown in Figure 2-12.

![Figure 2-12 Sharing EMEA Tracking page without inheriting user permissions from space](image-url)
After users have access to a space or page, you can send them a direct link to a page so that after they log in they are directed to that page. You can set up this link by performing these steps:

1. In the page context menu, click **Show Link**.
2. Copy the link that appears in the window and send it to the user. When the user uses this link, the user should then see your page after he logs in.

**Note:** The user should already have privileges to see that page. If the user you are sending the link to is not a viewer or an editor for that page, he will not be able to see it.

### Exporting and importing spaces and pages

As the owner of a space, you can export the space. This will export the space along with its pages and widget configurations. This is very useful for quickly recreating the space on different machines. For example, when going from a development environment to a test environment, exporting and re-importing the space is a great time saver because you do not have to recreate the space in the test environment.

Spaces are exported as compressed files. You can also export and import pages. Pages are exported as XML files. This includes any customization you have made to the page and the widgets it contains. Users can then proceed to import these pages into their own spaces.

### Export a space

To export a space, perform the following steps.

1. Open the Space Manager by clicking **Manage Spaces**.
2. Select **Actions → Export** on the space you want to export.
3. Save the compressed file.

### Import a space

To import a business space, perform the following steps.

1. Open the Space Manager by clicking **Manage Spaces**.
2. Click **Import Space**.
3. Browse for the compressed file and click **OK**.
Export a space
To export a page, perform the following steps.
1. Open the Space Manager by clicking Manage Spaces.
2. Expand the space that contains the page you want to export and select Actions → Export for that page.
3. Save the XML file.

Import a space
To import a page, perform the following steps.
1. Open the Space Manager by clicking Manage Spaces.
2. Select Actions → Import Page on the space to which you want to add the page.
3. Browse to the XML file and click OK.

Note: You can import spaces and pages from Business Space V6.2.0.1 by browsing to the DATA file.

Displaying a page in another Web page
A new feature in Business Space V7 is the ability to show Business Space pages in external Web pages. This is done by creating a JavaScript snippet that you can then use in any external Web page to display your Business Space page.
To generate the script for a page, perform the following steps.

1. For the page you want to share, click the page menu icon to open the page context menu and click **Display on a Web Page**. You are then presented with a window from which you can change various aspects of the script that will be generated, as shown in Figure 2-13.

![Figure 2-13 Display on a Web Page window](image)

2. Customize the attributes of the script and click **Refresh Markup**. Clicking **Preview** displays another window that shows how the snippet would render the page in an external page.

3. Copy the generated script and use it in your external Web page.

**Leading practice:** The Web application should be hosted on the same HTTP server as Business Space. Some widgets might not work properly if this is not the case, due to cross-site scripting security enforced by Web browsers.
2.2.5 Widget wiring

Business Space allows you to define wires between your widgets so that an event occurring in one widget affects the behavior of another widget. Each widget defines a set of events that it can send and a set of events that it can receive. The source widget is the widget that sends out the event, and the target widget is the widget that receives the event. When a target widget receives an event, it performs an action based on the payload of the incoming event. For example, you can define a wire between a widget that lists orders that have shipped today and a widget that displays details for an order, so that when a user selects an order from the listing widget, its details are displayed in the details widget.

Business Space also attempts to automatically wire your widgets. When you drop a new widget on to your page, Business Space checks if any of the already existing widgets emits an event that matches one of the events the new widget can receive. If there is a match, Business Space wires those two widgets together, with the pre-existing widget as the source widget and the new widget as the target.

You can visually inspect and define widget wiring from the Widget Wiring window.

Adding wires
There are a number of scenarios where you might need to manually define your wiring:

- If automatic wiring is disabled.
- If the event names of the events are different, you might use a wire to map the source event to the target event.
- If multiple instances of the same widget exist on the same page. For example, if you have several widgets that list orders depending on the geography and several widgets that display order details, you might want to manually define which listing widgets send events to which details widgets.
- If you need to transform event data using a hidden widget, which acts as an intermediary between two widgets.

In order to add wires, you need to go into edit mode for the page hosting your widgets.

Tip: You should give your widgets unique names so that they are easily identifiable in the Widget Wiring window.
To add wires, perform the following steps:

1. Click **Edit Page**.

2. In the widget’s context menu, click **Edit Wiring**. The Widget Wiring window opens, as shown in Figure 2-14. The drop-down menu at the top left contains all the widgets on the page and the widget with the current focus. The arrow coming out of the widget represents the events that this widget can emit. The arrow going into the widget represents the events that this widget can handle.

3. Click the appropriate arrow based on whether your widget should be the source or target widget. A list of widgets that have events defined that match those of your widget appears (Figure 2-15).
4. Click the widget you want to wire to yours. The widget you wired to is now shown in the window and a wire is created between your widget and the new one (Figure 2-16).

You can change the source/target event between the widgets by clicking the wire menu icon and selecting the appropriate event from the drop-down menu.

![Figure 2-16 Widgets wired in the Widget Wiring window](image)

5. Click **Save**.

**Tip:** You can quickly toggle between widgets using the drop-down menu at the top left of the Widget Wiring window.
Deleting wires
You can delete wires between widgets so that they are no longer correlated (Figure 2-17) by performing the following steps:

1. In the widget’s context menu, click **Edit Wiring**. The Widget Wiring window opens.
2. Hover over the wire you want to remove until the remove wire button appears. Click the remove wire button (x).

![Widget Wiring](image)

*Figure 2-17  Deleting wires in the Widget Wiring window*

3. When you are done, click **Save**.

Disabling automatic wiring
As an administrator, you can disable automatic wiring so that Business Space does not attempt to wire widgets automatically and users will have to explicitly wire widgets. You can accomplish this task by performing the following steps:

1. Log in to the Integrated Solutions Console.
2. Expand **Resources → Resource Environment** and then click **Resource Environment Providers**.
3. Select **Mashups_ConfigService → Custom properties**.
4. Change the value of autoWiringDefaultEnabled to false.
5. Save the changes to the master configuration and restart the server.
2.2.6 Widget visibility

As a page owner, editor, or administrator, you can control the visibility of widgets in a space. Hidden widgets are typically used to act as an intermediary between any two widgets or ones that do not provide any user interface a user should see. A typical usage scenario for this would be using the Script Adapter widget as a hidden widget for data transformation.

Hide widgets
To hide widgets, perform the following steps:

1. Set the state of the page to edit mode by clicking Edit Page.
2. For the widget you want to hide, open the context menu and click Hide. The widget is no longer visible on your page.
3. Click Save or Finish Editing if you have finished all the editing to that page.

Tip: If you are setting a large number of widgets to hidden, open up the Hidden Widgets window (Figure 2-19 on page 54) and drag and drop the widgets to the Hidden Widgets dialog.

Reveal hidden widgets
To reveal hidden widgets, perform the following steps:

1. Set the state of the page to edit mode by clicking Edit Page.
2. Click the Hidden Widgets icon located on the top right corner of the palette, as shown in Figure 2-18. The Hidden Widgets window appears. In this window, you can edit the settings for hidden widgets, change its visibility, or configure its wiring.

Figure 2-18 Hidden Widgets icon
3. Click the arrow for the widget you want to display. From the displayed menu, click **Display**. Alternatively, you can drag and drop the widget from the Hidden Widgets window to the page, as shown in Figure 2-19.

![Figure 2-19   Displaying a hidden widget from the Hidden Widgets window](image)

4. Click **Save** or **Finish Editing** if you have finished all the editing to that page.
Scenarios
Chapter 3. Business scenario example

This chapter describes the business scenario we use in this book. Our scenario is not meant to be fully representative of a real company; it provides a common framework for the rest of the book and allows us to show how our technical IBM Business Space powered by WebSphere V7 examples solve real-world business problems.

Within this chapter, we give an overview of the processes, scenarios, and roles that we use for our Business Space examples.
3.1 Welcome to ITSO Movie

ITSO Movie is a distributor of movies to movie theaters all over the world. Based in Raleigh, North Carolina, USA, it has offices in the UK, the People's Republic of China (which we refer to as China), Canada, Egypt, and Germany, with plans for more offices in the near future.

ITSO Movie's key business activities are:

- Taking orders for movies from its theater customers and shipping the movies out via its logistics partners, ITSOShipping and ClipsAndTacksFreight.
- Obtaining age ratings for its movies for each country in which the movie will be shown. This is a country-specific activity and requires a local process for each location.
- Receiving details of ticket sales and revenue from its movie theater customers and analyzing the data to identify opportunities and resolve issues.
- Creating and packaging marketing and publicity collateral to distribute with its movies, such as posters, trailers, reviews, or cast interviews. This includes creating Web sites to publish these details.
- Maintaining movie details for all its movies on a movie database, including budgets, actors, directors, and the availability of the movie for shipping.

Though it is only a relatively small organization at present, ITSO Movie is a dynamic company with a worldwide reach and an agenda for growth.

ITSO Movie has decided to use Business Space and related IBM WebSphere products to create a smart business with dynamic processes and a fully integrated supply chain.

In addition, ITSO Movie has a strong focus on its business performance and uses Business Space to monitor its activities, to identify issues, and to spot and exploit trends.

3.2 How this scenario relates to the rest of this book

The business scenarios described in this chapter are used to link together all of the information in this book. We cover a number of different technologies and techniques. You do not have to read all of this book at once, as each chapter is largely self-contained; this section helps you to find the information you need.
3.2.1 Where to look for what information

If you want to skip straight to the part of the book where a specific Business Space feature is discussed, the following list gives some pointers:

▶ To learn about creating, editing, and managing Business Spaces, refer to Chapter 2, “Managing IBM Business Space powered by WebSphere V7” on page 17.

▶ To learn about installing custom widgets, refer to Chapter 2, “Managing IBM Business Space powered by WebSphere V7” on page 17 and Chapter 13, “Developing a custom widget” on page 677.

▶ To learn about human tasks, with the new V7 group voting functionality, refer to Chapter 4, “Human-centric business spaces” on page 77.

▶ To learn about collaborative scope human tasks, refer to Chapter 4, “Human-centric business spaces” on page 77.

▶ To learn about WebSphere Service Registry and Repository and policies, refer to Chapter 5, “Integration-centric business spaces” on page 227.

▶ To learn about WebSphere Enterprise Service Bus and dynamic endpoint lookups with policy resolution, refer to Chapter 5, “Integration-centric business spaces” on page 227.

▶ To learn about WebSphere Business Services Fabric and dynamic assemblies, refer to Chapter 6, “Dynamic business spaces” on page 311.

▶ To learn about WebSphere Business Monitor, refer to Chapter 7, “Activity monitoring business spaces” on page 363.

▶ To learn about System Health Monitoring, refer to Chapter 7, “Activity monitoring business spaces” on page 363.

▶ To learn about using common widgets, refer to Chapter 8, “Common-content business spaces” on page 425.

▶ To learn about WebSphere Business Compass, refer to Chapter 9, “Business design and review spaces” on page 463.

▶ To learn about WebSphere Publishing Server, including publishing and commenting on WebSphere Business Modeler processes, refer to Chapter 9, “Business design and review spaces” on page 463.

▶ To learn about REST and RESTful services, refer to Chapter 11, “Developing a service for a custom widget” on page 601.

▶ To learn about building clients for services, AJAX, and JAX-WS, refer to Chapter 12, “Developing a client for a custom widget” on page 655.

▶ To learn about JavaScript and DOJO, refer to Chapter 13, “Developing a custom widget” on page 677.
To learn about creating custom widgets, refer to Chapter 13, “Developing a custom widget” on page 677.

### 3.2.2 Which scenarios are used in which chapters

As a useful cross-reference, Table 3-1 shows how our scenarios link to the chapters in this book.

**Table 3-1  How our scenarios link to our chapters**

<table>
<thead>
<tr>
<th>Scenarios</th>
<th>Release movie</th>
<th>Obtain age ratings</th>
<th>Ordering movies</th>
<th>Monitor ticket sales</th>
<th>Maintain marketing collateral</th>
<th>Business design and review</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4, “Human-centric business spaces” on page 77</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 5, “Integration-centric business spaces” on page 227</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Chapter 6, “Dynamic business spaces” on page 311</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 7, “Activity monitoring business spaces” on page 363</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Chapter 8, “Common-content business spaces” on page 425</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 9, “Business design and review spaces” on page 463</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 9, “Business design and review spaces” on page 463</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
### Table 3-2 Products used in our chapters

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Release movie</th>
<th>Obtain age ratings</th>
<th>Ordering movies</th>
<th>Monitor ticket sales</th>
<th>Maintain marketing collateral</th>
<th>Business design and review</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 13, “Developing a custom widget” on page 677</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

### 3.2.3 Which products are used in which chapters

Table 3-2 shows a list of products used in each chapter.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>WebSphere Integration Developer</th>
<th>WebSphere Process Server</th>
<th>WebSphere Business Monitor</th>
<th>WebSphere Business Services Fabric</th>
<th>WebSphere Service Registry &amp; Repository</th>
<th>WebSphere Business Modeler</th>
<th>WebSphere Business Compass</th>
<th>WebSphere Enterprise Service Bus</th>
<th>Lotus® Forms</th>
<th>Query Table Builder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4, “Human-centric business spaces” on page 77</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 5, “Integration-centric business spaces” on page 227</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Chapter 6, “Dynamic business spaces” on page 311</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 7, “Activity monitoring business spaces” on page 363</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 3.3 ITSO Movie business scenarios used in this book

This section introduces the ITSO Movie business scenarios.

- Business drivers: Why we chose our scenarios
- Scenario detail: Obtaining age ratings for movies
- Scenario detail: Taking orders for and shipping movies
- Scenario detail: Monitoring ticket sales details from movie theaters
- Scenario detail: Maintaining and reviewing the movie marketing collateral
- Scenario detail: Becoming a smart collaborative corporation

---

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Common-content business spaces on page 425</th>
<th>Business design and review spaces on page 463</th>
<th>Developing a custom widget on page 677</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- One of these products is used as a run time for the custom widgets.

---

**Table:**

<table>
<thead>
<tr>
<th>Component</th>
<th>WebSphere Integration Developer</th>
<th>WebSphere Process Server</th>
<th>WebSphere Business Monitor</th>
<th>WebSphere Business Services Fabric</th>
<th>WebSphere Service Registry &amp; Repository</th>
<th>WebSphere Business Modeler</th>
<th>WebSphere Business Compass</th>
<th>WebSphere Enterprise Service Bus</th>
<th>Lotus® Forms</th>
<th>Query Table Builder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 8</td>
<td>Common-content business spaces</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 9</td>
<td>Business design and review spaces</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 13</td>
<td>Developing a custom widget</td>
<td>X</td>
<td>+a</td>
<td>+a</td>
<td>+a</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3.3.1 Business drivers: Why we chose our scenarios

In this book, we use the example of ITSO Movie to show how a company can exploit Business Space for their own benefit. We created our business scenarios and flows to demonstrate various Business Space features and how they are used.

The scenarios are used to demonstrate the Business Space features shown in the following sections.

Scenario: Releasing movies
This scenario shows how to create dynamic business processes. By using WebSphere Business Services Fabric, ITSO Movie selects the process appropriate for that country depending on policy and the business context of the request. As ITSO Movie expands further into more countries, WebSphere Business Services Fabric allows processes to be added dynamically to fulfil local business requirements.

Scenario: Obtaining age ratings for movies
This scenario shows how the human task features of Business Space and WebSphere Process Server are used. It also demonstrates some of the new V7 human task features.

Rating a movie for age is done differently in different countries. Our (fictional) country variant processes are shown in the following sections.

Country variant: Majority vote (China)
This scenario shows the use of the “voting” functionality, where Business Space allows a group of people to vote on a request and WebSphere Process Server collects the votes and determines the majority opinion. Using the majority vote, a minimum percentage of raters must respond with a rating for that rating to “win” the vote.

Country variant: Maximum response (Egypt)
This scenario is similar to the majority vote, only here the most common rating is used and there is no percentage response variable.

Country variant: Single person workflow (USA)
This scenario shows the complete-and-claim-next WebSphere Process Server workflow functionality and the new “Next” Business Space buttons, allowing a single person to complete a series of related human tasks. For example, they might need to rate the dialogue, the pictures, and the marketing material as separate tasks. In this case, one person rates all three items for the same movie.
**Country variant: Hierarchical Escalation (Germany)**
This scenario shows the use of hierarchies in an organization, where WebSphere Process Server can escalate tasks or assign them to “managers of” style relationships. Business Space allows the users to action the tasks at the correct level.

**Country variant: Collaborative Scope (UK)**
This scenario shows how Business Space and WebSphere Process Server are used to allow a group of people to collaborate together and create dynamic workflows without needing them to be explicitly modelled beforehand.

**Country variant: Business Rules (Canada)**
As a further option to create configurable business processes, the Canadian approval process uses Business Space and WebSphere Process Server to create and configure business rules that apply the correct rating based on predefined movie criteria.

**Scenario: Ordering and shipping movies**
This scenario demonstrates the use of multiple service endpoints using WebSphere Service Registry and Repository and looking them up in a mediation flow component. It also shows the monitoring of a long-running process in real time with WebSphere Business Monitor and the use of Key Performance Indicator (KPIs) and alerts in Business Space if the process does not progress sufficiently in the amount of time expected.

**Scenario: Monitoring ticket sales details from movie theaters**
This scenario demonstrates the use of Business Space and WebSphere Business Monitor to analyze data based on multiple dimensions, allowing drill-downs and aggregations. It also demonstrates the ability of Business Space to show historic trends and create future predictions based on a large amount of discrete data events.

**Scenario: Maintaining marketing collateral and movie details**
This scenario shows how Business Space can be used to manage documents, spreadsheets, presentations, and other content, such as Web pages. We also show how to create and use a custom widget to maintain a database of movie information, such as actors, directors, and so on.
Scenario: Business design and review
This scenario shows the use of Business Space and WebSphere Business Compass to document the structure, roles, vocabulary, capabilities, services, and processes used in an organization. It also shows the sharing and versioning of documents and the use of Publishing Server to publish and comment on WebSphere Business Modeler models.

3.3.2 Scenario detail: Obtaining age ratings for movies

Each country has different rules and processes for rating movies and the age rating that a movie receives might be different in each country.

As far as ITSO Movie is concerned, obtaining an age rating for a movie is part of a larger distribution process. The parent process calls a service to “obtain age rating”; it is up to the automated process to determine how to carry out this action.

In our example, we use WebSphere Business Services Fabric to apply policies and use the context of the message to call the correct variant of the service. Business Space allows us to create and manage these policies without having to change and redeploy code.

Process variations by country
The different process variations for each country are described in the following sections. (Note that these are fictitious processes that we have created for this book.)

**China: Use the ratings of the majority of reviewers**
- Identify a group of movie reviewers.
- Each reviewer rates the movie.
- When a rating receives 60% of the vote, that rating is used.

**Egypt: Use the maximum age rating of all of the reviewers**
- Identify a group of movie reviewers.
- Each reviewer rates the movie.
- The most common rating is used.

**USA: One person reviews multiple aspects of the movie**
- Review the dialog.
- Review the visual content.
- Review the marketing material.
- Calculate the overall rating.
Germany: Reviewer rates the movie and it is then approved by a manager

- The reviewer rates the movie.
- The manager either approves or changes the rating.

UK: Lead approver decides the process

In this case, the movie is rated collaboratively and the lead approver decides what process shall be used. The lead reviewer then uses the Business Space collaborative capabilities to create or modify an approval workflow that best fits the movie in question.

Canada: The movie is rated automatically using business rules

In Canada, the studio provides certain information about the movie, for example, a level of violence or offensive language that the movie contains. The Canadian local office of ITSO Movie has created a set of business rules that rate the movie depending on this information.

The example business rules in this book refer only to those business rules supplied with WebSphere Process Server and configured using Business Space.

Process diagrams

The process and collaboration diagrams for the age rating scenario have been modeled in WebSphere Business Compass and are reproduced in this section. (To discover how we produced these diagrams, see Chapter 9, “Business design and review spaces” on page 463.)

These diagrams are intended to show the process and collaboration flows at a business level and are not necessarily identical to the implementation of the processes in our examples.
**Release movie process**
The release movie process is as shown in Figure 3-1. Note that for space reasons, the rating variant choices for UK, Canada, USA, and Germany are not shown in the rate movie subprocess.

![Figure 3-1](image)

**Country-Specific Rate Movie variants**
- Majority Vote (China) is shown in Figure 3-2.

![Figure 3-2](image)

- Maximum age rating (Egypt) is shown in Figure 3-3.

![Figure 3-3](image)
3.3.3 Scenario detail: Taking orders for and shipping movies

The process for ordering a movie and shipping it to a movie theater is fully automated and integrates ITSO Movie with its logistics partners.

The order process is kept simple for the purposes of this book. For example, exception handling is not implemented, and it does not check for the existence of a movie or whether it has been rated in the requesting country.
The process is as follows:

1. ITSO Movie receives a request for a movie from a movie theater. The request contains details of the theater, the movie, the number of copies required, and the shipping address.

2. ITSO Movie then places a shipping request with a logistics partner. ITSO Movie has two logistics partners:
   - ITSOShipping
   - ClipsAndTacks Freight
   The process looks up the required partner’s shipping service using WebSphere Service Registry and Repository and places the request as an automated service call.

3. The logistics partner returns a tracking ID and an estimated shipping date.

4. ITSO Movie returns these details back to the movie theater but keeps the process running.

5. The process waits for the logistics partner to send a “Movie Shipped” message.

6. The process waits for the logistics partner to send a “Movie has arrived in the target country” message.

7. The process waits for the logistics partner to send a “Movie has been delivered to the movie theater” message. The process then ends.

ITSO Movie uses WebSphere Service Registry and Repository to store and manage their services, using Business Space to present a view to the user. The details of both internal and external services (such as those of logistics partners) are stored, with such details as service level agreements (SLAs), the description of the service through the Web Services Description Language (WSDLs), and endpoints and service usage details.

The entire process is long-running, as shipping a package internationally can take a few days. At all points, the process is monitored using WebSphere Business Monitor and Business Space. ITSO Movie uses Business Space to create KPIs and alerts so that any late shipments can be identified and resolved quickly.

**Process diagrams**

The process and collaboration diagrams for ordering and shipping movies have been modeled in WebSphere Business Compass. The diagrams are shown in this section.
The collaboration diagram for the movie ordering process is shown in Figure 3-8. Note that this does not show all of the process, due to space reasons.

**Figure 3-8** The movie ordering collaboration diagram
The actual OrderMovie process is shown in Figure 3-9.

Figure 3-9  The OrderMovie Process
3.3.4 Scenario detail: Monitoring ticket sales details from movie theaters

As well as shipping movies, ITSO Movie must decide which movies to buy from the studios in future. ITSO Movie needs to base their decisions on a number of factors, but one of the most important for them is ticket sales and revenue.

ITSO Movie monitors the ticket sales from all of their customer movie theaters on a daily basis, automatically. The theaters send the details of the ticket sales based on the following criteria:

- Movie
- Theater
- City
- Country
- Type (ITSOBigScreen, 3D, and regular screen)
- Peak or Off-Peak (Before 6 p.m. is cheaper)

The ticket sales data is received as messages and are read by a WebSphere Enterprise Service Bus mediation. The mediation then emits a Common Business Event (CBE) event over the Common Event Infrastructure (CEI), which is read by WebSphere Business Monitor. WebSphere Business Monitor then stores the data and processes it so that it can be viewed in a number of dimensions using Business Space.

Business Space allows the ITSO Movie business leaders to analyze the data, identify trends, view historical data, and ‘slice and dice’ a number of views through the data, all interactively. They can also produce reports to allow them to have a complete picture of their ticket sales around the world.

3.3.5 Scenario detail: Maintaining and reviewing the movie marketing collateral

ITSO Movie not only supplies the actual movies themselves, it also collects and supplies marketing collateral for the movie. These might take the form of posters, reviews, cast interviews, and trailers. Marketing material is published on Web sites for the movies.

ITSO Movie uses Business Space human tasks to assign the creation of collateral, such as movie previews. The human task widgets then interact with the common content widgets to link to the appropriate Web sites and other materials.
In addition, ITSO Movie maintains a database of movie information, including budget, actors, directors, and whether or not a movie is available for shipping. The database is maintained using Business Space and a custom widget that provides the maintenance GUI.

### 3.3.6 Scenario detail: Becoming a smart collaborative corporation

ITSO Movie is a relatively new corporation and is committed to being an agile smart organization. To this end, ITSO Movie has chosen to use WebSphere Business Compass and Business Space to allow its employees to collaborate on key aspects of its business at the corporate level.

The areas for which they want to use WebSphere Business Compass are as follows:

- Creating a common vocabulary for ITSO Movie so that common terms, roles, and definitions are used across the organization.
- Creating, publishing, and maintaining the ITSO Movie organization chart so that everyone knows the structure of the organization and how they fit into it.
- Creating, publishing, and maintaining the corporate strategy. ITSO Movie believes that having a strong vision and clear goals can only make a corporation successful if they are successfully communicated.
- Documenting services. In conjunction with WebSphere Service Registry and Repository, ITSO wishes to use SOA to create a set of services that can be re-used within the organization and also by partners. They also want to document the services which their business partners provide to them.
- Creating and documenting processes and collaborations, so that the business processes upon which the company is built are documented, published, and agreed to.

### 3.4 ITSO Movie: Roles and responsibilities

ITSO Movie has a number of different roles, groups, and users within the organization, which we will be using within this book.

Some of the roles have user groups defined for them, which are shown within brackets. We also show the users within that group. Roles without user groups are used as pure role descriptions within our WebSphere Business Compass example.
**Note:** We provide a .jacl script to add these users and groups to your environment with the additional material provided with this book (refer to Appendix B, “Additional material” on page 747).

The procedure for loading the users into a file-based repository managed by WebSphere is described in Chapter 8, “Common-content business spaces” on page 425.

The starting point for our examples is the WebSphere Process Server Integrated Test Environment configured with Global security set on and with an administrative user called admin.

The names used for the users in this book are purely fictitious names.

**Business analyst / leader (ITSOMovieBusinessAnalysts)**

This role is the business scenario designer and analyst for ITSO Movie. They create processes, collaborations, and organization charts in WebSphere Business Compass and policies, processes, and vocabulary in WebSphere Business Services Fabric. In our example, this role is held by:

- admin: (refer to the examples shown in Chapter 9, “Business design and review spaces” on page 463)
- Bob Allen: user ID=boballen

**Business administrator (ITSOMovieBusinessAdministrators)**

This role is primarily concerned with administering the processes and policies created by the Business Analyst / Leader. For example, in this book, the business administrator is the person who creates WebSphere Business Services Fabric spaces from the templates. This role also approves and publishes the changes that have been authored by the business analyst/leader. In our example, this role is held by Brian Ali: user ID=brianali.

**Business user (ITSOMovieBusinessUsers)**

These are the users who have visibility of the business processes and organization within WebSphere Business Compass. The business user modifies the business policies at run time using Business Space and WebSphere Business Services Fabric. In our example, this role is held by Belinda Underhill: user ID=belindaunderhill.
Solution developer (ITSOMovieSolutionDevelopers)
This role develops the WebSphere Business Services Fabric solution within WebSphere Integration Developer. In our example, this role is held by Simon Davies: user ID=simondavies.

Country head (ITSOMovieCountryManagers)
Each of the countries where ITSO Movie operates has a country head role. This person is responsible for any country-specific activities, for example, the age rating process for a movie in their country.

Corporate exec/approver
This role is the person who has the final approval for business processes and policies at the corporate level. In our examples, this is the CEO.

Division head
This role is the person who has the final approval for business processes and policies at the divisional level, for example, the head of distribution.

Movie rater (ITSOMovieMovieRaters<<Country>>)
This role is someone who actually rates a movie. Within the ITSO Movie country-specific rating process, this person might operate individually or as part of a member of a voting group.

(Canada does not have movie raters, as they rate by business rule.)

ITSOMovieMovieRatersUK
- Mark Usher: user ID=markusher
- Mary Unwin: user ID=maryunwin
- Millie Urant: user ID=millieurant

ITSOMovieMovieRatersChina
- Ming Chen: user ID=mingchen
- Mo Chong: user ID=mochong
- Meng Chang: user ID=mengchang
- Man Che: user ID=manche
- Mu Chun: user ID=muchun

ITSOMovieMovieRatersGermany
- Martin Geiger: user ID=martingeiger
- Michael Graf: user ID=michaelgraf
- Miriam Gross: user ID=miriamgross
**ITSOMovieMovieRatersUSA**
Marcia Umberger: user ID=marciaumberger

**ITSOMovieMovieRatersEgypt**
- Mohamed Essam: user ID=mohamedessam
- Mahmoud Ehsan: user ID=mahmoudehsan
- Mona Emam: user ID=monaemam
- May Emad: user ID=mayemad
- Mina Ehab: user ID=minaehab

**Tip:** Our users have been given initials related to their roles to help us remember who does what. For example, Mona Emam is a Movie-Rater for Egypt, Belinda Underhill is a Business User, and so on.
This chapter describes all the human-centric interfaces provided with IBM Business Space powered by WebSphere V7. We discuss the human-centric widgets, which include:

- Human task widgets
- Process choreography widgets
- Business calendar widget
- Team work support widgets

We also discuss the human-centric space templates in Business Space:

- Managing My Tasks
- Advanced Managing of Human Tasks and Workflows
- Managing My Team’s Tasks

We introduce the ITSO Movie company movie rating processes used in six different countries (five of them are using human tasks), so that we can explain in detail the human workflow and tasks in our processes using Business Space.

We also demonstrate the usage of user roles, business forms and query tables in Business Space.
4.1 Human-centric Business Process Management

Human-centric is one of the key developing topics in the Business Process Management (BPM) domain. The challenge for BPM today is not to simply automate processes, but to deliver the human-centric capabilities people need in order to fully embrace the new, more efficient work processes.

BPM’s main aim is to focus more on managing and optimizing the business processes and the human tasks, instead of just automating and integrating them, which makes human activities and human interactions important in human-centric BPM processes.

4.1.1 Overview

Human tasks are services that are implemented by people. They allow the integration of people into service-oriented applications and business processes.

A human task has two interfaces:

- One interface exposes the service offered by the task, like a translation service or an approval service.
- The second interface allows people to deal with tasks, for example, to search for human tasks waiting for them, and to work on these tasks.

A human task has people assigned to it. These assignments define who should be allowed to play a certain role in that task. Human tasks might also specify how task metadata should be rendered on different devices or applications making them portable and interoperable with different types of software. Human tasks can be defined to react on timeouts, triggering an appropriate escalation action.

This also holds true for notifications. Notifications are a special type of task that allows the sending of information about noteworthy business events to people. Notifications are always one-way, that is, they are delivered in a fire-and-forget manner: the sender pushes out notifications to people without waiting for these people to acknowledge their receipt.

4.1.2 Concepts

This section introduces business processes, human tasks, and roles.
**Business processes**
A business process or business method is a collection of related, structured activities or tasks that produce a specific service or product (serving a particular goal) for a particular customer or customers. It often can be visualized as a flowchart, showing a sequence of activities.

**Human tasks**
Human tasks are services “implemented” by people. They allow the integration of people in service-oriented applications and business applications.

**Roles**
A role is a set of connected behaviors, rights, and obligations as conceptualized by actors in a social situation. It is an expected behavior in a given individual social status and social position. Roles are used when dealing with human tasks to show which people or groups of people are allowed to perform particular actions on a task or tasks.

A role is one or more responsibilities that can be assigned to a user, or to a group of users, for example, “approver” or “verifier”.

**4.1.3 Standards and specifications: BPEL4People and WS-HumanTask**

In June 2007, the BPEL4People and WS-HumanTask specifications were published, describing how human interaction in BPEL processes can be performed.

The BPEL language specifies the behavior of business processes as long as the service calls of the processes are automated. Human interactions are not in its domain. Despite wide acceptance of automated services in distributed business applications, the absence of human interactions is a significant gap for many real-world business processes. To fill this gap, BPEL4People extends BPEL from orchestration of services alone to orchestration of role-based human activities as well.
Within the context of a business process, BPEL4People:

- Supports role-based interaction of people
- Provides means of assigning users to generic human roles
- Takes care to delegate ownership of a task to a single person
- Supports scenario such as:
  - Four eyes scenario
  - Nomination
  - Escalation
  - Chained execution

It performs all these services by extending BPEL with additional syntax and semantics.

The BPEL4People specification introduces a WS-BPEL extension to provide human interactions in WS-BPEL with advanced functionality. It defines a new type of basic activity that uses human tasks as an implementation, and allows the specification of tasks as local to a process or the use of tasks defined outside of the process definition. This extension is based on the WS-HumanTask specification.

The WS-HumanTask specification introduces the definition of human tasks and notifications, including their properties, behaviors, and a set of operations used to manipulate human tasks. A coordination protocol is introduced in order to control the autonomy and life cycle of service-enabled human tasks in an interoperable manner.

### 4.1.4 Human-centric solutions from the WebSphere Business Process Management portfolio

In WebSphere Process Server, human tasks are stand-alone components that you can use to assign work to employees. Additionally, the human task manager supports the *ad hoc* creation and tracking of tasks. You can use existing LDAP directories (as well as operating system repositories and the WebSphere user registry) to access staff information.
In WebSphere Process Server, the human tasks component is on the Service Components layer, and based on the SOA Core layer and Supporting Services layer (Figure 4-1).

![Service Components Diagram](image)

*Figure 4-1  Human tasks: A key service component*

WebSphere Process Server also supports multi-level escalation for human tasks, including e-mail notification and priority aging. WebSphere Process Server includes an extensible Web client that you can use to work with process tasks. This Web client is based on a set of reusable Java Server Faces (JSF) components that you can use to create custom clients or embed human task functionality into other Web applications.

With the ability to involve people in business processes in WebSphere Process Server, you can capture both simple and complex business processes that include a mixture of automated and human steps. By treating a human task as another kind of service, you can build flexible processes that evolve to become more automated over time (for example, replacing a current human task with an automated service) without significantly reworking the original process.
Types of tasks

There are four kinds of human tasks:

- **Invocation task:** This task is shown in Figure 4-2. This is where a human can assign a task to a service component. In such a case, a human is invoking an automated service such as a business process. It is also known as a people-to-machine task.

  ![Figure 4-2 Invocation task](image)

- **To-do task:** This task is shown in Figure 4-3. This is where a service component (such as a business process) assigns a task to a human as something for that person to do. It is also known as a machine-to-people task.

  ![Figure 4-3 To-do task](image)

- **Collaboration task:** This task is shown in Figure 4-4. This is where a human assigns a task to another human. It is also known as a people-to-people task.

  ![Figure 4-4 Collaboration task](image)
Administration task: This task is shown in Figure 4-5. This type of task grants a human administrative powers, such as the ability to suspend, terminate, restart, force-retry, or force-complete a business process. Administration tasks can be set up on either an invoke activity, or the process as a whole. This type of task is only available within a business process (inline task).

![Figure 4-5 Administration task](image)

**States of the tasks**
Different types of tasks might have slightly different states, but basically, tasks will have these states in common:
- Inactive: The task is not initiated yet.
- Running: The task is initialized and not completed.
  - Ready: The task is ready for somebody to work on, but no one has claimed it yet.
  - Claimed: Somebody claimed the task and is working on it.
- Terminated: The task is terminated by the task administrator.
- Completed: The task finished successfully.
- Failed: The task failed during the execution.

Figure 4-6 shows the general state transfer diagram, but it might be slightly different for the different types of tasks.

![Figure 4-6 The states of the human tasks](image)
4.1.5 Role-based human tasks

In general, a human task will have several user roles, and for each role there will be several users or groups assigned to it.

We have the following roles for a particular human task. You can add users or groups to the roles in WebSphere Integration Developer, as shown in Figure 4-7.

<table>
<thead>
<tr>
<th>People Assignment (Originator)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Potential Creators</td>
<td>Everybody</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>People Assignment (Receiver)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrators</td>
</tr>
<tr>
<td>Potential Owners</td>
</tr>
<tr>
<td>Editors</td>
</tr>
<tr>
<td>Readers</td>
</tr>
</tbody>
</table>

*Figure 4-7  Add roles for human tasks in WebSphere Integration Developer*

- Potential Creators: Only the potential creators of a task have the authorization to create a task instance of the human task definition, but they cannot start an instance.
- Potential Starters: Only the potential starters have the authorization to start or initiate a task instance of the human task definition.
- Administrators: The administrators of a task instance will be able to administer or manage the execution of the task instance.
- Potential Owners: Potential owners are the members that will be focused on working on the task instances. Any of them can accept and work on the task if the ownership is single, or all of them will receive the task and work on it simultaneously and concurrently if the ownership is parallel.
- Owners: Potential owners who claim the task will become the owner of the task. The owner has the ability to work on and complete the task.
- Readers: Readers will have authorization to view a task.
- Editors: Editors will have authorization to edit a task.
There are several options for assigning the roles to an individual task. As shown in Figure 4-8, you can assign the task to everybody, some users, a certain group, and so on.

![Staff role - Administrators (Single ownership)](image)

**Figure 4-8 Options for assigning roles to a task**

### 4.2 Human-centric processes in Business Space

In this section, we describe the relationship between human-centric processes and IBM Business Space powered by WebSphere.

#### 4.2.1 How Business Space support human-centric business spaces

By using human task widgets, escalation widgets, process choreography widgets, business calendars widgets, and team support widgets, Business Space can provide a varied and flexible user interface for the business users to manage human tasks and business processes, as well as the business calendars.

Business Space is a role-based interface framework; different users with different roles will have different content shown in the widgets.
**4.2.2 Business forms for Business Space**

Business Space supports two kinds of business forms to display the human task input and output messages that are shown in the Task Information widget:

- Lotus Forms
- HTML-Dojo

In WebSphere Integration Developer, we can add the forms to a task as its user interfaces, as shown in Figure 4-9.

![User Interface]

**Figure 4-9  Adding forms for a task in WebSphere Integration Developer**

### Lotus Forms

Forms using the Lotus Forms format can be shown in Business Space. You can create or edit a form with a Lotus Forms Designer, and view them with Lotus Forms Viewer. You can also set up a Lotus Webform Server to place all the forms on the server side instead of the client side (you do not need to install any client software on your client machine).

Please refer to Appendix A, “IBM Lotus Forms UI” on page 735 for more details.

We are using Lotus Forms forms in the scenarios for Germany, UK, and USA. Refer to 4.3, “Business scenario: Rate Movies” on page 87 for more usage details.
**HTML-Dojo forms**

HTML-Dojo forms are in HTML format, which will contain both Dojo elements and HTML elements in them, to display the human task inputs and outputs. Figure 4-10 shows a generated HTML-Dojo form in WebSphere Integration Developer.

![HTML-Dojo form in WebSphere Integration Developer](image)

We are using HTML-Dojo forms in the scenarios for China and Egypt. Refer to 4.3, “Business scenario: Rate Movies” on page 87 for more usage details.

For more details, refer to the following addresses:


### 4.3 Business scenario: Rate Movies

The ITSO Movie company has a process for rating the age level for every upcoming movie. There are five main branches of this process for five of the ITSO Movie countries:

- China
- Egypt
- Germany
- UK
- USA
These branches use human-centric workflows and tasks to fulfill this rating process. The process will have the movie’s information as the input, the rating result as the output, and will use specific business logic for the branches’ own age ratings.

The rating result will be one of the following:

- G
- PG
- PG-13
- R
- NC-17

Refer to Chapter 3, “Business scenario example” on page 57 for more details about these scenarios.
In WebSphere Integration Developer, we have the five movie rating process definitions included in the assembly diagram to make them ready to execute in WebSphere Process Server, as shown in Figure 4-11. This will enable the ITSO Movie headquarters to choose the specific branches to rate a movie according to the country information using WebSphere Business Services Fabric. Refer to Chapter 6, “Dynamic business spaces” on page 311 for details.

Figure 4-11  The assembly diagram in WebSphere Integration Developer

Import the PI file attached to this book (ITSOMovie_HTM.zip) into WebSphere Integration Developer. You can find this file in the additional material supplied with this book (refer to Appendix B, “Additional material” on page 747). You will then be able to view the ITSOMovie project in WebSphere Integration Developer, and you can view and use the processes we describe below.
4.3.1 Rating process in China

In the process branch for China, we use the voting mechanism to rate the upcoming movies.

**Parallel ownership**

Tasks with parallel ownership allow potential owners to work simultaneously on a task. A common example of parallel ownership is when a set of potential owners need to approve a to-do task in a business process. Parallel ownership can be specified for to-do tasks and collaboration tasks.

When a task with parallel ownership is started, a subtask for each potential owner is created and started, and the parent task goes into the running state. The subtasks are always collaboration tasks. The input message and all other relevant information for the parent task are copied to each subtask.

After the subtasks are started, they go into either the ready state or, if automatic claim is specified for the parent task, the claimed state. When the subtasks are created, the parent task goes into the waiting-for-subtask substate. The subtasks then go through the normal life cycle of a collaboration task; the parent task remains in the waiting-for-subtask substate until all of its subtasks reach an end state. If the completion condition for the parent task becomes true, all of the subtasks, which are not yet in an end state, are terminated.

Because parent tasks do not have an owner, you cannot use the API operations, such as claim or cancelClaim, on them. If the parent task is modeled so that its subtasks are claimed automatically, the subtasks are automatically assigned to each of the potential owners.

For more details about parallel ownership, refer to the following address:


**Voting**

Voting is a kind of parallel ownership method used so that every potential owner can work on his own subtask. The final result will be calculated by aggregating the results beyond a certain percentage.
Roles, users, and groups
The roles, users, and groups are as follows:

- **Roles:**
  There will be several movie raters who will be the potential owners of the StaffRating task and one movie rating manager who will work on the ManagerRating task.

- **Users and groups:**
  - There is a group called ITSOMovieMovieRatersChina, which contains five movie raters: Ming Chen, Mo Chong, Meng Chang, Man Che, and Mu Chun.
  - There is a group called ITSOMovieMovieManagersChina, which contains one movie rating manager: Min Cun.

**Process description: MovieRatingProcessVoting**
The process diagram we build in WebSphere Integration Developer is shown in Figure 4-12.

![Figure 4-12 Rating process in China](image-url)
There are four main steps in this process:

1. VotingRatingStart: In this task, at the start of the process, the process inputs are entered.
   a. We assign the IRateAge interface to VotingRatingStart, as shown in Figure 4-13.

![Figure 4-13 Interface of VotingRatingStart](image1)

b. We also create an authorization task for VotingRatingStart, as shown in Figure 4-14.

![Figure 4-14 Authorization task of VotingRatingStart](image2)
c. We also add business forms to the task. For the China branch, we use HTML-Dojo forms as the business forms. Open the authorization task and add a HTML-Dojo form to it, as shown in Figure 4-15 and Figure 4-16.

![Figure 4-15  HTML-Dojo form 1](image1)

![Figure 4-16  HTML-Dojo form 2](image2)

d. All of the other tasks in this process will use HTML-Dojo forms. Refer to 4.6, “Movie Rating processes in Business Space” on page 173 for more details.
2. **StaffRating**: The raters in the ITSOMovieMovieRatersChina group receive the rating tasks and vote for the rating, as shown in Figure 4-17. The aggregation method indicates that this uses voting logic. Voting means that the choice can only be the final result if the percentage of choices are beyond a certain value (Figure 4-18). In our example, at least 60% of the voters must vote for a choice before the choice becomes the final result.

![Figure 4-17 Potential owners of the StaffRating task](image)

**Note**: For group names, you must use the uniqueName of the group.

![Figure 4-18 Voting result aggregation](image)

**Note**: If you see a red X error, which says “The mandatory parameter ‘include subgroups’ in assignment criteria ‘group members’ is not set in the ‘Assign People’ tab”, ignore it.

3. **ManagerRating**: After all of the raters complete their movie rating task, the process continues to the next step. Managers review the staff rating result and merge the comments, and then complete the manager rating, as shown in Figure 4-19.

![Figure 4-19 Potential owners of the ManagerRating task](image)

4. **Reply**: The final rating result is returned as the result of the process, that is, the manager rating result.
4.3.2 Rating process in Egypt

In the process branch for Egypt, we use the maximum business logic, that is, the most frequent occurrence, to rate the upcoming movies.

Parallel ownership
Refer to 4.3.1, “Rating process in China” on page 90 for more information about parallel ownership.

Maximum
Maximum is a kind of parallel ownership method that every potential owner can use to work on his own subtask, and then the final result will be aggregated using the method of most frequent occurrence.

Roles, users, and groups
The roles, users, and groups are as follows:

- Roles:
  There will be several movie raters for the MaximumRating task.

- Users and groups:
  We use a group called ITSOMovieMovieRatersEgypt, which contains five movie raters: Mohamed Essam, Mahmoud Ehsan, Mona Emam, May Emad, Mina Ehab.

Process description: MovieRatingProcessMaximum
The process diagram in WebSphere Integration Developer is shown Figure 4-20.
There are three main steps in this process:

1. **MaximumRatingStart**: In this task, at the start of the process, the process inputs are entered.
   
   a. We assign the IRateAge interface to the task, as shown in Figure 4-21.

   ![Figure 4-21 Interface of MaximumRatingStart](image)

   b. We then create an authorization task for it, as shown in Figure 4-22.

   ![Figure 4-22 Authorization task of MaximumRatingStart](image)

   c. We then add business forms to the task. We use HTML-Dojo forms.

   d. We used HTML-Dojo forms for all of the tasks in this process.
2. MaximumRating: The raters in the group ITSOMovieMovieRatersEgypt receive the rating tasks and vote for the rating, as shown in Figure 4-23. The aggregation method indicates that this is a maximum logic (maximum means the most frequent occurrence). The choice that the raters choose the most will be the result of this task, as shown in Figure 4-24.

![Figure 4-23 Potential owners of the MaximumRating task](image)

![Figure 4-24 Maximum result aggregation](image)

3. Reply: After all of the raters complete their movie rating task, the process returns with the MaximumRating task result.

4.3.3 Rating process in Germany

In the process branch for Germany, we use the escalation mechanism to rate the movies. We will define two escalations and a custom property to show the function of query tables.

**Escalations**

Refer to “The Escalations List widget” on page 139 for more details about this topic.

**Query tables**

In our scenario, we define a query table for the Tasks List widget.
**Overview**

Query tables support task and process list queries on data that is contained in the Business Process Choreographer database schema. This includes human task data and business process data that is managed by Business Process Choreographer, and external business data. Query tables provide an abstraction of the data of Business Process Choreographer that can be used by client applications. In this way, client applications become independent of the actual implementation of the query table. Query table definitions are deployed on Business Process Choreographer containers, and are accessible using the query table API.

Query tables enhance the predefined database views and the existing query interfaces of Business Process Choreographer, and they:

- Are optimized for running process and task list queries, using performance optimized access patterns
- Simplify and consolidate access to the information needed
- Allow for the fine-grained configuration of authorization and filter options

You can customize the query tables. For example, you can configure a query table so that it contains only those tasks or process instances that are relevant in a particular scenario. You can use query tables where performance is important, such as with high volume process list and task list queries.

**Note:** For details about query tables, refer to the following address:


**Query Table Builder**

Query Table Builder is a WebSphere Integration Developer plug-in tool that provides the following functions:

- A wizard and editor to create and modify query tables.
- A wizard for deploying, un-deploying, and testing query tables on a WebSphere Process Server.
- Import and export query table definitions in XML format.
There are three kinds of query tables that you can create using Query Table Builder:

- Composite query tables
- Composite query tables for Business Space Human Workflow
- Supplemental query tables

Developing query tables for Business Space

You can develop a query table using Query Table Builder by performing the following steps:

1. Create a project. You can have your query tables in any kind of project. We use the ITSOMovie project to create the query table.

   Note: You can see the sample query table ESCALATIONTASK.CPROPS in the root folder of the ITSOMovie project.

2. Create a query table definition file.
   a. Right-click the project in the project tree view and select New → Other. The New window opens.
b. In the New window, select **Business Process Choreographer** → **Composite Query Table Definition for Business Space** for your query table type and click **Next**, as shown in Figure 4-25.

![Composite Query Table Definition for Business Space option](image)

*Figure 4-25  Composite Query Table Definition for Business Space option*
iv. Enter the name of the query table ESCALATIONTASK.CPROPS and click **Next**, as shown in Figure 4-26.

![Figure 4-26](image)

**Figure 4-26 Name of the query table**

c. Select the widget you want to apply to the query tables. There are five widgets enabled:

i. Tasks List: Query tables for task instances.


iii. Escalations List: Query tables for escalations.

iv. Task Definitions List: Query tables for task definitions.

d. In our scenario, we choose **Tasks List** to create our query table, as shown in Figure 4-27. Click **Finish**

![Create a composite query table definition for Business Space](image)

**Figure 4-27  Widget to apply to the query table**

- **Tasks List**
  - Used for display in the Tasks List widget.
  - Primary query table: TASK
  - Instance-based authorization is enabled.
  - Added attributes: KIND, STATE, CONTAINMENT_CTX_ID, TKTID, IS_WAIT_FOR_SUB_TK

- **Processes List**
  - Used for display in the Processes List widget.
  - Primary query table: PROCESS_INSTANCE
  - Instance-based authorization is enabled.
  - Added attributes: PTID, STATE, PARENT_PID, TOP_LEVEL_PID

- **Escalations List**
  - Used for display in the Escalations List widget.
  - Primary query table: ESCALATION
  - Instance-based authorization is enabled.
  - Added attributes: STATE, KIND

- **Task Definitions List**
  - Used for display in the Task Definitions List widget.
  - Primary query table: TASKTEMPL
  - Attached query table: PROCESS_TEMPLATE
  - Role-based authorization is disabled.
  - Added attributes from TASKTEMPL: VALID_FROM, KIND, STATE
  - Added attributes from PROCESS_TEMPLATE: PTID, STATE

- **Process Definitions List**
  - Used for display in the Process Definitions List widget.
  - Primary query table: PROCESS_TEMPLATE
  - Role-based authorization is disabled.
  - Added attributes: VALID_FROM, EXECUTION_MODE, STATE

![Figure 4-27](image)

**Figure 4-27  Widget to apply to the query table**

e. Click **Yes** if you are prompted to choose the perspective. The query table will display in the editor.

There are several parts of the editor:

- On the left side is the palette, where you can choose the predefined and supplemental query tables that can be attached to the primary query table.

- On the main canvas, the primary query table displays in the upper left corner, in green, and the attached query tables displays on the right, in blue. There is a join connection between the primary and the attached table.

- There is an attribute table at the bottom of the window, in which you can create, edit, and delete the attributes.
In the Properties view, you can edit the properties of the elements in the window.

f. Drag TASK_CPROP from the palette. There will be an attached query table, TACP, in the window.

In the Properties view, enter Name='Budget' in the Selection Criteria field.

h. Drag the STRING_VALUE attribute to the attribute table and change the name to BUDGET in the Properties view.

After completing these steps, you see the query table shown in Figure 4-28.
**Deploying and testing query tables**

To deploy and test query tables, perform the following steps:

1. In the Query Tables window, right-click the query table definition file `ESCALATIONTASK.CPROPS.qtd` and select **Test on local WebSphere Process Server**, as shown in Figure 4-29.

*Figure 4-29  Test on local WebSphere Process Server*
2. The deploy and testing window opens, as shown in Figure 4-30.

![Deploy and testing window](image)

**Figure 4-30  Deploy and testing window**

- Make sure the WebSphere Process Server server is running.
- Browse to the WebSphere Process Server profile directory and enter the user ID and password.
- Click the **Deploy** button to deploy the query table to the WebSphere Process Server profile, the **Undeploy** button to undeploy the query table from the WebSphere Process Server profile, and the **Update** button to update the query table.
- Click **List Composites** to see a list of all deployed composite query tables. Click **List Supplementals** to see a list of all deployed supplemental query tables.
- Click **Query** to query the result for the query table.
- Click **Clear Console** to clear the console messages.
g. The Console view will show all the console messages and the Query Result view will show all the returned data of the query table.

**Custom properties**

Custom properties are used to categorize a task, and can be useful for querying, sorting, and filtering tasks. Search criteria can be defined for tasks, escalations, and for the dynamic people assignment via custom properties.

In our scenario, we define a custom property called “Budget” and use it along with the query table.

**Roles and users**

The roles and users are as follows:

- **Roles:**
  
  There will be two movie raters to rate movies and an escalation receiver for the StaffRating task to handle all the escalations.

- **Users:**
  
  There are two users defined as the movie raters: Martin Geiger and Michael Graf. We do not use groups for the German branch.
  
  There is one user defined as the escalation receiver: Miriam Gross.

**Process description: MovieRatingProcessEscalation**

The process diagram in WebSphere Integration Developer is shown Figure 4-31.

![Figure 4-31 Rating process in Germany](image)

Figure 4-31  Rating process in Germany
There are three main steps in this process:

1. EscalationRatingStart: In this task, at the start of the process, the process inputs are entered.
   a. We assign the IRateAge interface to EscalationRatingStart, as shown in Figure 4-32.

   ![Figure 4-32 Interface of EscalationRatingStart](image)

   b. We created an authorization task for EscalationRatingStart, as shown in Figure 4-33.

   ![Figure 4-33 Authorization task of EscalationRatingStart](image)
c. We then added business forms to the task. We use Lotus Forms in Germany. To use Lotus Forms, open the authorization task and add a Lotus Forms form to it, as shown in Figure 4-34 and Figure 4-35.

![Lotus Forms form 1](image)

Figure 4-34 Lotus Forms form 1

![Lotus Forms form 2](image)

Figure 4-35 Lotus Forms form 2

d. All of the other tasks in this process will use Lotus Forms forms. Refer to 4.6, “Movie Rating processes in Business Space” on page 173 for more details.

2. StaffRating: All of the raters will receive the rating tasks, but this task can only be claimed by only one of the raters, which means if Martin claims the task, the task will belong to Martin. Michael will then not be able to, and have no need to, work on it. One of the raters will rate the movie after he claims the task.

We define two escalations in this process:

- For the ready state of the task.
- For the claimed state of the task.
If the escalation conditions are met, certain escalations will start up and be sent out to the escalation receiver. We also define a custom property called Budget, which reflects the budgetMillionDollar attribute in the Movie object, as shown in Figure 4-36, Figure 4-37, and Figure 4-38.

**Figure 4-36** Potential owners of the StaffRating task

**Figure 4-37** Escalations defined

**Figure 4-38** Receiver of the escalations
a. Custom Property: We define a custom property called Budget, which is used to highlight the budget value of the movies. The value of it is “%htm:input\in/movie/budgetMillionDollar%”, which means it is one of the input parameters of the task. The property XPATH is in budgetMillionDollar, as shown in Figure 4-39.

![Figure 4-39 The custom property Budget](image1)

b. ReadyEscalation: If the task is not claimed after it is ready for one day, the ReadyEscalation will start, as shown in Figure 4-40.

![Figure 4-40 ReadyEscalation](image2)
c. ClaimEscalation: If the task is not completed after it is claimed for one day, the ClaimEscalation will start, as shown in Figure 4-41.

![Figure 4-41 ClaimEscalation](image)

3. Reply: After the movie rating task is completed by one of the raters, the process will return the result of the StaffRating task.

### 4.3.4 Rating process in the UK

In the process branch for the UK, we will use the BPEL collaboration scope element to rate the movies.

**Collaboration scope**

Collaboration scopes allow you to create *enhanced dynamic workflows*.

Enhanced dynamic workflows are business processes in which the business logic can be adapted at run time. For example, the assigned worker might decide to repeat an activity, to launch a subtask, or to skip some steps in the business process.

When, in the runtime environment, the business process is stopped at an activity that is nested within a collaboration scope or a scope for which dynamicity is configured, an authorized individual can skip, undo, or redo that nested activity.
The ability to dynamically modify a process that has already been deployed to a runtime environment is especially useful in cases where the process describes a series of steps that are not always necessary. For example, perhaps a business process models the sequence of steps in an insurance claim. There might typically be five steps in the insurance claim process being modelled, but what about situations where it can be settled in just three? What about situations where one of the steps has to be repeated? Enabling a dynamic business process means that an authorized user can make changes such as these after the process has been deployed.

**Roles and users**
The roles and users are as follows:

- **Roles:**
  There will be two movie rater roles, one for ratingStep1 and one for ratingStep2. There will also be one administrator to manage the collaboration scope.

- **Users:**
  There are two users that we will use as the movie raters: Mark Usher for ratingStep1, and Mary Unwin for ratingStep2.
  Millie Urant will be the administrator of the collaboration scope.

**Process description**
The process diagram in WebSphere Integration Developer is shown Figure 4-42.

![Figure 4-42 Rating process in UK](image)
There are three main steps in this process:

1. **CollaborationScopeRatingStart**: In this task, at the start of the process, the process inputs will be entered.
   
a. We assigned the IRateAge interface to CollaborationScopeRatingStart, as shown in Figure 4-43.

![Figure 4-43 Interface of CollaborationScopeRatingStart](image)

   **Figure 4-43 Interface of CollaborationScopeRatingStart**

b. We created an authorization task for CollaborationScopeRatingStart, as shown in Figure 4-44.

![Figure 4-44 Authorization task of CollaborationScopeRatingStart](image)

   **Figure 4-44 Authorization task of CollaborationScopeRatingStart**

c. We then assign business forms to the task. We use Lotus Forms in this process. We add the forms to the task in a similar way to how we added them for the German process.

d. All of the other tasks in this process will use Lotus Forms forms.
2. Collaboration Scope: The process will enter the collaboration scope steps. One administration task is defined for the collaboration scope. Our administrator, millieuurant, will be able to manage the scope using the task, as shown in Figure 4-45.

![Administration Task]

<table>
<thead>
<tr>
<th>Name</th>
<th>CollaborationScopeAdministrationTask</th>
<th>Display Name</th>
<th>Not Applicable</th>
</tr>
</thead>
</table>

![People Assignment (Originator)]

<table>
<thead>
<tr>
<th>Administrators</th>
<th>Users by user ID</th>
<th>UserID</th>
<th>millieuurant</th>
</tr>
</thead>
</table>

Figure 4-45 The administration task of the collaboration scope

a. ratingStep1: This is the first step of the rating process. It does some basic rating, as shown in Figure 4-46.

![To-do Task]

<table>
<thead>
<tr>
<th>Name</th>
<th>RatingTask1</th>
<th>Display Name</th>
<th>Not Applicable</th>
</tr>
</thead>
</table>

![Service Interface]

![People Assignment (Receiver)]

<table>
<thead>
<tr>
<th>Potential Owners</th>
<th>Users by user ID</th>
<th>Ownership: Single</th>
<th>UserID</th>
<th>markusher</th>
</tr>
</thead>
</table>

Figure 4-46 ratingStep1

b. ratingStep2: This is the second step of the rating process. It does some advanced ratings, as shown in Figure 4-47.

![To-do Task]

<table>
<thead>
<tr>
<th>Name</th>
<th>RatingTask2</th>
<th>Display Name</th>
<th>Not Applicable</th>
</tr>
</thead>
</table>

![Service Interface]

![People Assignment (Receiver)]

<table>
<thead>
<tr>
<th>Potential Owners</th>
<th>Users by user ID</th>
<th>Ownership: Single</th>
<th>UserID</th>
<th>maryrunwin</th>
</tr>
</thead>
</table>

Figure 4-47 ratingStep2

3. Reply: After the two-step collaboration scope is completed, the process will return the result of ratingStep2.
4.3.5 Rating process in the USA

In the process branch for the USA, we will use a single person to rate each movie; this will enable the person to work continuously on one task after another.

The reason why we use one person is so that we can have a three-step rating, we can provide a clear log for the whole rating process, we can see many more details about how the movies are rated, and we can see exactly what each step does for the rating and what is its result.

Roles and users
The roles and users are as follows:

► Roles:
   There will be only one movie rater for all the movie ratings.

► Users:
   Marcia Umberger will be the only movie rater.

Process description
The process diagram in WebSphere Integration Developer is shown Figure 4-48.

![Diagram](image)

*Figure 4-48  Rating process in USA*
There are three main steps in this process:

1. SinglePersonRatingStart: In this task, at the start of the process, the process inputs are entered.
   a. We assigned the iRateAge interface to SinglePersonRatingStart, as shown in Figure 4-49.

   ![Figure 4-49 Interface of SinglePersonRatingStart](image)

   b. We then created an authorization task for SinglePersonRatingStart, as shown in Figure 4-50.

   ![Figure 4-50 Authorization task of SinglePersonRatingStart](image)

   c. We add business forms to the task. We use Lotus Forms in the USA. We add the forms to the task in a similar way to how we added them for the German process.

   d. All of the other tasks in this process use Lotus Forms forms.
2. Movie rating: All three rating tasks are owned by a single person, as shown in Figure 4-51. They have the same potential owner.

![People Assignment (Receiver)](image)

Figure 4-51 The potential owner of the tasks

- BriefRate: Make a brief rating of the movie, according to the movie information.
- DetailRate: Make a detailed rating of the movie, according to the movie information and the BriefRate results.
- FinalRate: Make a final rating of the movie, according to the movie information and the BriefRate and DetailRate results.

3. Reply: After all three rating steps are complete, the process will return the result of FinalRate.

### 4.4 Human-centric widgets

There will be several human-centric widgets provided in Business Space after the installation of WebSphere Process Server. They can be divided into several varieties:

- Human Task widgets that are used for human task related management.
- Process Choreography widgets that are used for process and human workflow related management.
- A Business Calendar widget that is used for personal business calendars management.
- Team Support widgets that are used in team support to accelerate human task execution, where multiple people are working together.
Figure 4-52 shows all the human-centric widgets and their relationships.

**Note:** The My Work Organizer widget is new in V7, but you can also see it in the feature pack for V6.2.

**Note:** The arrows here do not reflect the wirings; they just show the high-level relationships between the widgets and widget groups.

**4.4.1 Configuration windows of the widgets**

Most of the widgets have their own configuration windows where business users can change the settings of the widgets, customize the preferences of the widgets, and integrate their own data with the widgets.
Perform the following steps to enable a configuration window:

1. Create a new space and then a new page, and then add a widget to the page. You can also use the existing spaces that are created from one of your space templates.

2. Make sure the page is in edit mode; if it is not, click the **Edit Page** button at the top right.

   **Note:** If you cannot find that button, you might lack the privilege to that space or page. If this is the case, you cannot enable a configuration window to configure a widget.

3. Click the drop-down menu icon at the right top corner of a widget and select the **Edit Settings** option. If the widget does not have a configuration window, this option will be grayed out. For those kind of widgets, the settings are fixed and you cannot change them.

4. The configuration window opens, where you can edit the configuration settings of the widget.

   **Note:** You need to click **OK** or **Apply** to save your changed settings. If you need to, you can click **Restore** to ignore your settings.

### 4.4.2 Human task widgets

The set of human task widgets includes the following widgets:

- Task Definitions List
- Tasks List
- Create Tasks
- Tasks I Created
- Available Tasks
- My Tasks
- Task Information
- Human Workflow Diagram
- My Work Organizer
- Escalation List

All of these widgets co-operate together to provide the capabilities for the business users to complete their tasks.
The Task Definitions List widget
The Task Definitions List widget contains a list of task templates that you can use to create your own task instances. It can be considered the starting point for creating tasks and working on tasks associated with specific task definitions.

Note: Task Definitions List is a new widget in Business Space V7.

Configuration window of Task Definitions List
There are three tabs in the configuration window of the Task Definitions List widget. For details about how to access the configuration windows, refer to the 4.4.1, “Configuration windows of the widgets” on page 118.
The three tabs are:

- The Content tab, which configures which task definition lists the user can view. It is shown in Figure 4-53.

Figure 4-53  Content tab
Use the “Select task definition list to display” option to select which task definition lists the user can view. When you choose **Select task definition lists**, you will be prompted to select one of all the available lists, as shown in Figure 4-54.

Select the task definition properties that you want to display in the widget as the columns, and which one you want the task definitions to be grouped by.

![Selecting task definitions list](image1)

**Figure 4-54   Selecting task definitions list**

- The Actions tab, which configures which actions are available to the user. It is shown in Figure 4-55.

![Actions tab](image2)

**Figure 4-55   Actions tab**
Use the Actions tab to configure which user actions are available for the Task Definitions List. The user interactions that are chosen will be included in the top left drop-down menu in the widget, as shown in Figure 4-56.

![Figure 4-56   User interactions](image1)

- The Display tab, which configures how the Task Definitions List is displayed. It is shown in Figure 4-57.

Use the Display tab to select whether to display the Task Definitions List as a table or a list, and to configure whether the widget content is to be refreshed automatically at a specified time interval or manually.

- The Layout link is shown in Figure 4-57.

![Figure 4-57   Display tab](image2)
– The Refresh link is shown in Figure 4-58.

**Figure 4-58  Refresh part**

**Using the Task Definitions List**

As shown in Figure 4-59, the Task Definitions List will list all the task definitions (we can also call them task templates) that you can use to create task instances, for yourself or others. You can also open the tasks of this definition.

**Figure 4-59  Task Definitions List**

These four task definitions (Approval, Inquiry, Review, and To-do), are called out-of-box space definitions, and are examples here. You can see your own task definitions when you develop them with WebSphere Integration Developer and then deploy them to your WebSphere Process Server.
If you select a task definition and then click **Create** in the Action drop-down menu, the Task Information widget will display the upcoming task instance information and you will be able to enter the input data for that task instance.

If you select a task definition and then click **Open** in the Action drop-down menu, the Tasks List widget will display all the task instances using this task definition.

Beside the column headers of each column, there are two icons:

- The icon on the left is used to filter.
- The icon on the right is used to change the sort order.

Figure 4-60 shows these icons.

Refer to our scenarios in 4.6, “Movie Rating processes in Business Space” on page 173 for more usage details.

**The Tasks List widget**

Use the Tasks List widget to work with different types of tasks, for example, tasks that you own, or tasks that are available for you to work on.

**Note:** Tasks List is a new widget in Business Space V7.

**Configuration window of the Tasks List widget**

Use the Tasks List configuration window to specify which tasks are available to the widget user and which tasks the widget user owns, creates, manages, or can view.
The configuration window of Tasks List (Figure 4-61) is almost the same as the configuration window of the Task Definitions List widget.

![Configuration window of Tasks List](image)

*Figure 4-61  Configuration window of Tasks List*
There is a Priority section of the Display tab that is different than what is in the Task Definitions List widget. It is used to set some priority settings, as shown in Figure 4-62.

![Figure 4-62: The Priority section of the Display tab](image)

Adapt how the content in the task list is displayed and refreshed, and how the priority of tasks is shown.

Specify the sort order for the priority settings:
- high < low, for example, high=1 and low=5.
- high > low, for example, high=5 and low=1.

Specify how the priority settings are represented:
- Numeric representation, for example, 1,2,3,...
- Graphic representation as low, medium, and high.

Specify numeric values for low, medium, and high priority ranges:
- Low: MIN to 2, 2 to 4, 4 to MAX
- Medium: MIN to 2, 2 to 4, 4 to MAX
- High: MIN to 2, 2 to 4, 4 to MAX
The Personal tasks list shown in the available task lists filter shows the tasks you created in the My Work Organizer widget. In other words, if you select to display the personal tasks list, it will list all the tasks in your My Work Organizer widget, as shown in Figure 4-63.

Using the Tasks List widget

When using the Task List widget, you can perform several actions:

- If you click All in the Actions tab of the configuration window, you will be shown several user interactions, as shown in Figure 4-64 on page 129.
  - Work on tasks: You can view the tasks that you own that are not completed.
  - Assess available tasks: You can view the tasks that are in Ready status and for which you are one of the potential owners. You can open the tasks to assess or accept them.
  - Check status of tasks: You can check the status of all the tasks you created.
  - Assess and work on tasks: You can see both the available tasks and those tasks on which you are working.
  - Browse all: You can see all the existing tasks for which you have the correct authorization.
  - Manage tasks: You can see all the tasks that you manage, that is, for which you are the administrator of the tasks.
If you select one task, and then click the **Actions** button, there will be several actions you can perform on the task, as shown in Figure 4-65.

- **Edit**: Edit a task. You can edit the task if you are the owner.
- **Transfer**: Transfer the task to others. You can only transfer a task when you are the task owner or administrator.
- **Return**: Return a task. You can return a task if you are the owner; it will be returned to the task assignee.
- **Delete**: Delete a task. This option will only be enabled when you are the task administrator. If you want to delete a task, click this option and the window shown in Figure 4-66 opens.

![Do you want to delete the selected task?](image)

- **Open**: Shows detailed task information.
Accept: Accept the task. After you accept the task, you will be the owner of it.

Escalate: Add an escalation to this task if you have the authorization to do so.

**Note:** The window shown in Figure 4-67 opens if the task does not have any escalations.

![No escalations window](image)

Figure 4-67  No escalations window

Two icons will appear if you apply any filters, as shown in Figure 4-68.

- Icon on the left: Pin the current filter to the list menu.
- Icon on the right: Clear the current filter settings.

![Pin and Clear icons](image)

Figure 4-68  Pin and Clear icons

Please refer to our scenarios in 4.6, “Movie Rating processes in Business Space” on page 173 for more usage details.

**The Create Tasks widget**

Use the Create Tasks widget to initiate work for another person, or to initiate a business process or a service.

**Note:** The Create Tasks Widget is deprecated in Business Space V7 and will be replaced by the Task Definitions List widget.
The Tasks I Created widget
Use the Tasks I Created widget to manage and track the tasks that you created. When you create a new task, the new task is sent to the relevant users and is also added to your Tasks I Created widget so that you can track the progress of the work.

Note: Tasks I Created is deprecated in Business Space V7 and will be replaced by the Tasks List widget.

The Available Tasks widget
Use the Available Tasks widget to display the tasks that are not yet assigned to anyone and that are available for you to work on.

Note: The Available Tasks widget is deprecated in Business Space V7 and will be replaced by the Tasks List widget.

The My Tasks widget
Use the My Tasks widget to work with the tasks that you own.

Note: The My Tasks widget is deprecated in Business Space V7 and will be replaced by the Tasks List widget.

The Task Information widget
The Task Information widget shows detailed information about tasks. It interacts with the other human task widgets when business users request to edit or view the task details.
Configuration window of the Task Information widget

The configuration window of the Task Information widget is used to set how the task details will be shown in this widget. You can choose from the following tabs:

- Content tab: This tab shows the Accept next available task check box, as shown in Figure 4-69. If it is checked, the user will be automatically assigned the next available task to work on from the selected task list.

  ![Figure 4-69 Configuration window of Task Information widget: Content tab](image)

- Display tab: Here you can choose to use Lotus Forms Viewer or Lotus Webforms Server to display the Lotus Forms, as shown in Figure 4-70.

  ![Figure 4-70 Configuration window of Task Information widget: Display tab](image)

Using the Task Information widget

In the Task Information widget, detailed information of the tasks will be displayed. If you choose to edit or open a task in one of the other human task widgets, the task will also be opened in this widget. In the widget, there are forms embedded for the tasks.
There are two kinds of forms for the task inputs and outputs, as shown in 4.2.2, “Business forms for Business Space” on page 86:

- Lotus Forms format
- HTML/Dojo format

When you open a task in the Task Information widget, you see:

- The Form tab, which includes user input/output form information (Figure 4-71). You can click Submit to submit a task when you complete your input and outputs, or Save/Save as Draft to save a task as a temporary version. When multiple tasks are open in the Task Information widget at the same time, they will be displayed under different tabs that you can switch to view or edit them.

![Task Information and Form tab](image)

*Figure 4-71  Task Information and Form tab*
The Details tab, which includes detailed information about the owner, date, status, priority, task history, and so on (Figure 4-72).

Figure 4-72 Details tab

The Notes tab, in which you can add some additional notes, in the rich-text format (Figure 4-73).

Figure 4-73 Notes tab
If the task has some related tasks, the related tasks information will be shown in the Related Tasks tab (Figure 4-74).

![Related Tasks tab](image)

There is also an Action drop-down menu in the Task Information widget. You can choose to Submit, Save, New, Transfer and Return a task, as shown in Figure 4-75.

![Actions in Task Information](image)

Refer to our scenarios in 4.6, “Movie Rating processes in Business Space” on page 173 for more usage details.

**The Human Workflow Diagram widget**

In the Human Workflow Diagram widget, you will be able to see the whole human task workflow, with all the human tasks in it.

A human workflow consists of tasks and various other interactions that control the processing of the workflow. The Human Workflow Diagram shows only the tasks. Other interactions involved in the workflow are indicated by icons. Workflows can also contain collections of tasks, which are indicated by shaded areas in the diagram. In these areas, you can perform additional actions specific to the type of collection.
A human workflow is shown in Figure 4-76. In addition to the Human Workflow Diagram itself, at the top right, there is:

- A slider that you can use to change the size of the diagram.
- A Refresh icon that you can use to refresh the status of the diagram.
- A Details icon that you can use to see the details of the diagram.

Also at the bottom right, there is an overview window, which you can use to navigate around larger diagrams by moving the yellow rectangle.

![Human Workflow Diagram](image)

*Figure 4-76  Human Workflow Diagram*
If you hover over a task in the diagram, the task will be highlighted. If you click it, you can perform several actions, such as viewing the information in Task Information or see details of the task execution, as shown in Figure 4-77. If you have collaboration scopes in your workflow, you will have more options available to you in the diagram; for more details, refer to 4.3.4, “Rating process in the UK” on page 111.

Refer to our scenarios in 4.6, “Movie Rating processes in Business Space” on page 173 for more usage details.

**Note:** The Human Workflow Diagram widget does not have a configuration window.

**The My Work Organizer widget**
The My Work Organizer widget enables the business users to manage their own to-do lists and to create and track tasks for themselves and others. It interacts with the Task Information widget.
As shown in Figure 4-78, in the My Work Organizer widget, you can:

- Create a new task, as shown in Figure 4-79, The Task Information widget will have all the task template information available for you to create your new task, which you can assign to yourself or any other user.

**Figure 4-78  The My Work Organizer widget**

**Figure 4-79  Creating a new task for My Work Organizer**
▶ Open a new task or edit a task if you have the authority.
▶ Transfer a task if you have the authority.
▶ Delete a task if you have the authority.

Refer to our scenarios in 4.6, “Movie Rating processes in Business Space” on page 173 for more usage details.

**Note:** The My Work Organizer widget does not have a configuration window.

### The Escalations List widget

**Note:** Escalations List is a new widget in Business Space V7.

An escalation is a course of action that is implemented when an expected result from a task has not been achieved within a set period of time. There might be some points in the business process when an activity does not get finished and so moves to a state of incomplete. We usually need to escalate this to a manager or administrator. We have the capability to send an escalation, such as a customized e-mail message or raise an additional work item. This means that we can alert a manager or administrator.

An escalation can result in any one of the following actions:

▶ The creation of a work item for a set of users
▶ Notification of an appropriate staff member via e-mail
▶ Notification using an event handler
There are several states for the escalations (Figure 4-80):

- **Inactive**: The relevant task is not activated.
- **Waiting**: The task is activated, but the timeout is not reached. In Business Space, it will show as Set.
- **Escalated**: The expected state of the task is not reached when the timeout happens. In Business Space, it will show as Started.
- **Superfluous**: The expected state of the task is reached when the timeout happens. In Business Space, it will show as Obsolete.
- **Subtasks_Completed**: The related tasks have reached a complete state. In Business Space, it will show as Related tasks completed.

*Figure 4-80  States of the escalations*
In WebSphere Integration Developer, you can define escalations for a human task. You can create an escalation for the task statuses of Ready, Claimed, and Subtask started. In the Properties view, you can set detailed information, such as the time periods and users. Figure 4-81 and Figure 4-82 show a ready escalation.

![Figure 4-81 Create an escalation in WebSphere Integration Developer](image1)

With Business Space, you can use the Escalation List widget to view the escalation and its relevant task information. You can display a list of escalated tasks that you own in the Escalations List widget. You can view information about the escalations and also filter, order, and configure the list. You can also see which tasks are escalated to you and whether tasks that you own are escalated or whether you should escalate them immediately.

**Note:** The Escalations List widget does not have a configuration window.
You can manually start an escalation if you do not want to wait for it to start automatically, as shown in Figure 4-83.

**Note:** An escalation will only available to start manually if it has the status of “Set”.

![Escalations List widget](image)

**Figure 4-83 Escalations List widget**

Refer to our scenarios in 4.6, “Movie Rating processes in Business Space” on page 173 for more usage details.

### 4.4.3 Process choreography widgets

This section provides an overview of the following widgets:

- The Process Definitions List widget
- The Processes List widget

**The Process Definitions List widget**

In the Process Definitions List widget, you will be able to see all the process definitions that you can use to create the process instances. Use the Process Definitions List widget as the starting point for working on tasks associated with specific process definitions.

**Note:** Process Definitions List is a new widget in Business Space V7.
Configuration window of the Process Definitions List widget

The configuration window of the Process Definitions List widget looks quite similar to that of the Task Definitions List widget (Figure 4-84). Except for the exclusion of Actions tab, the functions are the same.

![Configuration window of the Process Definitions List widget](image)

**Figure 4-84** Configuration window of Process Definitions List
**Using the Process Definitions List widget**

If you choose a process definition in the Process Definitions List widget, and then click **Open** or click the icon on the right side of the row, as shown in Figure 4-85, you can see the workflow diagram of the process definition in the Human Workflow Diagram widget and existing process instances using this process definition listing in the Processes Definitions List widget.

Similar to the Task Definitions List widget, you can use the filter and sort functions for the Process Definitions List widget.

Refer to our scenarios in 4.6, “Movie Rating processes in Business Space” on page 173 for more usage details.

**The Processes List widget**

In the Process List widget, you can see all the related processes.

**Note:** Processes List is a new widget in Business Space V7.

**Configuration window of the Processes List widget**

The configuration window of the Processes List widget is the same as that for the Process Definitions List widget.
Using the Processes List widget

In the Processes List widget, when you click a process in the list and then click Open or the icon on the right side of the row, as in Figure 4-86, the process will be opened.

Figure 4-86  Processes List
a. The workflow diagram is shown in the Human Workflow Diagram widget (Figure 4-87).

![Human Workflow Diagram](image)

*Figure 4-87  Workflow diagram for the process*

b. The related tasks of this process instance are shown in the Tasks List Widget, as shown in Figure 4-88

<table>
<thead>
<tr>
<th>Name</th>
<th>Owner</th>
<th>Start date</th>
<th>Due time</th>
<th>Priority</th>
<th>Status</th>
<th>Pending</th>
</tr>
</thead>
<tbody>
<tr>
<td>HumanTask1</td>
<td></td>
<td>Mar 1, 2010 9:41:11 PM</td>
<td></td>
<td>Low</td>
<td>Available</td>
<td></td>
</tr>
<tr>
<td>HumanTask21</td>
<td>admin</td>
<td>Mar 1, 2010 9:41:11 PM</td>
<td></td>
<td>Low</td>
<td>Completed</td>
<td></td>
</tr>
<tr>
<td>HumanTask22</td>
<td>admin</td>
<td>Mar 1, 2010 11:28:35 PM</td>
<td></td>
<td>Low</td>
<td>In Progress</td>
<td></td>
</tr>
<tr>
<td>HumanTask3</td>
<td></td>
<td>Mar 1, 2010 9:41:11 PM</td>
<td></td>
<td>Low</td>
<td>Available</td>
<td></td>
</tr>
<tr>
<td>Receive</td>
<td></td>
<td>Mar 1, 2010 9:41:08 PM</td>
<td></td>
<td>Low</td>
<td>In Progress</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 4-88  Tasks for the process*
Refer to our scenarios in 4.6, “Movie Rating processes in Business Space” on page 173 for more usage details.

### 4.4.4 The Send widget

The Send widget is a temporary widget that creates a task that you can send to another person as a message. Unlike other widgets, which remain on the page until someone removes them, the Send widget is temporary. The Send widget is only on the page until you click **Submit**, or switch to another page or space.

There are four widgets in Business Space called *attachable widgets*, which can support send messages and attach them as an attachment. These are:

- Business Rules from WebSphere Process Server
- Web Feeds, which is a common widget
- KPI and Alerts from WebSphere Business Monitor

**Note:** You cannot create a Send widget from the widget list; instead, you need to create it from the configuration drop-down menu of an attachable widget.

Let us take the Web Feeds widget as an example and perform the following steps:

1. Create a new space and then a new page (you can also use an existing space or page).
2. Edit the page and add a new Web Feeds widget to it.
3. Finish editing, and make sure the page is no longer in the edit mode. Click the drop-down menu of the Web Feed widget. You can see the Send Widget option, as shown in Figure 4-89.

![Web Feed](image)

*Figure 4-89  Send Widget option using Web Feed*
4. Select the Send Widget option. The Send Widget window, as shown in Figure 4-90.

![Send Widget window](image)

**Figure 4-90  Send Widget window**

5. The following fields are available:
   a. The priority field is used to set the priority of the task that will be created using this widget. Using the Due date field, you can set the due date of this task.
   b. In the Form tab, you are able to
      i. Add this widget as an attachment. Only the attachable widgets residing on the current page are shown on the Attachments drop-down menu.
      ii. Enter the user ID you want to assign this task to, or you can choose Me if you want to assign this task to yourself.
      iii. Write a message and the subject for the task.
   c. In the Details tab, you can see some additional information.
4.4.5 The Business Calendars widget

The Business Calendars widget is used to show the timetables of the business applications. In WebSphere Integration Developer, we can use the New Business Calendar wizard to create business calendars (we can also do the same thing in WebSphere Business Modeler, which calls them *TimeTables*).

Business calendars are used to model non-contiguous time intervals (intervals that do not proceed in a sequential manner) and allow these intervals to be further composed into a single semantically meaningful interval as opposed to simply using elapsed time for date and time computations. For example, a business calendar defining Regular Working Hours might refer to non-overtime regular working hours of Monday to Friday, 9:00 a.m. to 5:00 p.m., and exclude weekends.
In WebSphere Integration Developer, the New Business Calendar wizard is used to create new business calendars. For example, we created a calendar called WorkingHours, which contains the entries shown in Figure 4-92.

---

**Figure 4-92  A Business Calendar called “WorkingHours”**
Figure 4-93 shows a time interval of 9 a.m. to 5 p.m. every weekday, Monday to Friday.

\begin{figure}
\centering
\includegraphics[width=\textwidth]{figure4-93}
\caption{Details of the time interval of 9 a.m. to 5 p.m. Monday to Friday}
\end{figure}
Figure 4-94 shows an exception of a 1 day holiday for New Year’s Day (January 1).

Figure 4-94  Details of the exception of New Year’s Day

Figure 4-95 shows the exception of a 1 day holiday for Valentine’s Day (February 14).

Figure 4-95  Details of the exception of Valentine’s Day
Figure 4-96 shows the exception of a 3 day holiday for Christmas (December 24 to 26).

<table>
<thead>
<tr>
<th>Details for the Selected Exception</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule the unavailable period.</td>
</tr>
<tr>
<td>Christmas</td>
</tr>
<tr>
<td>Schedule: Once</td>
</tr>
<tr>
<td>Examples</td>
</tr>
</tbody>
</table>

**Occurrence**

- For one day

  - Begins On: Friday, Dec 24, 2010
  - Ends On: Monday, Dec 27, 2010

  - Duration:
    - 3 days

*Figure 4-96  Details of the exception of Christmas*

**Note:** For details about creating business calendars in WebSphere Integration Developer, refer to the WebSphere BPM Information Center at the following address:


In Business Space, when using this Business Calendars widget, we can check the timetables, and create, modify, and delete a time interval or an exception for the timetables.

You need to have the authority to perform the operations on Business Calendars, which you can configure by using the Security Roles widget. For details about the Security Roles, refer to Chapter 2, “Managing IBM Business Space powered by WebSphere V7” on page 17.
If you want to modify the Business Calendars widget, perform the following steps:

1. Open the Business Calendars widget. You can see the timetable `WorkingHours` that we created in WebSphere Integration Developer, as shown in Figure 4-97.

![Figure 4-97   All Timetables shown in Business Calendars](image)

2. By clicking the timetable name, you can see the detailed information of that timetable. You can edit or delete an existing entry using the icons to the right of each row, or you can create a new one using the Create Time Interval button, as shown in Figure 4-98.

![Figure 4-98   Details of the timetable](image)
a. If you click the edit icon of one of your entries, the edit window appears, as shown in Figure 4-99.
b. If you click the **Create Time Interval** button, you will be guided to the Create page, in which you will be able to create a new time interval or an exception, as shown in Figure 4-100.

i. If you want to create a new time interval, you need to check the **Available time** check box.

ii. If you want to create a new exception, you need to clear the **Available time** check box.

![Create a new entry (time interval or exception)](image)

**Figure 4-100**  Create a new entry (time interval or exception)

c. If you want to create an exception called May Day and have the day of May 1 in it, you need to complete the fields shown in Figure 4-101 and then click **Save**.

![Create a new exception called May Day](image)

**Figure 4-101**  Create a new exception called May Day
d. You can now see that there is one more entry in your timetable (Figure 4-102).

![Business Calendars]

Figure 4-102  Showing May Day in the timetable

4.4.6 The team support widgets

Business Space has two widgets (the My Team's Tasks widget and the Team List widget) that provide the support for the tasks within a team. The concept of a team means a set of people who are the potential owners of a specific task.

The My Team’s Tasks widget

The My Team’s Tasks widget shows all the tasks for which you are one of the administrators. Using this widget, you can manage all the tasks that you administrate.

Configuration window of the My Team’s Tasks widget

You can configure the My Team’s Tasks widget's content, action, and display through its configuration window. Refer to 4.4.1, “Configuration windows of the widgets” on page 118 for more details.

There are three tabs in the configuration window:

- Content
- Actions
- Display
These tabs are explained in the following list:

- In the Content tab, shown in Figure 4-103, you can select the task list to display, choose to show all the tasks you have the authority to see, or personalize your own lists. Also, you can choose which properties of the tasks you want to show in the widget, and show them by groups.

![Figure 4-103  Content tab](image)
In the Actions tab, shown in Figure 4-104, you can choose which user interactions to enable. The choices in the tab are shown in the widget, as shown in Figure 4-105.

Figure 4-104  Actions tab

Figure 4-105  Choices of the Actions tab
In the Display tab, you can choose the display style of the widget.

- For the Layout part, you can choose to show the tasks in Table or List form, and show them in a whole page with a scroll bar or multiple pages, as shown in Figure 4-106.

![Figure 4-106  Display tab: Part 1](image1)

- In the Refresh part, you can choose whether to refresh the task list automatically or manually in the widget, as shown in Figure 4-107.

![Figure 4-107  Display tab: Part 2](image2)
In the Priority part, you can sort the order for the tasks by their priorities, and set the ranges of high, medium and low, as shown in Figure 4-108 on page 162.

![Figure 4-108 Display tab: Part 3](image)

**Using the My Team’s Tasks widget**

When you use this the widget, you can see the task list, which includes all the tasks you can administrate.

If you choose a task (by checking the check box in front of the task name), the Team List widget shows all the potential owners of the task. Refer to the Team List part, and you will be able to perform the following actions on that task:

- **Edit**: Edit the task.
- **Transfer**: Transfer the task to a particular potential owner.
- **Return**: Return the task to the task assigner. You can only return it when you are the owner of this task.
- **Delete**: Delete the task.
- **Open**: Open the task information in the Task Information widget.
Accept: Accept the task. You will be the task owner when you accept it. The accept option is only enabled when the task status is ready.

Escalate: Create an escalation for this task.

Refer to 4.6.3, “Performing the movie rating process at the German branch” on page 194 for more details about our scenario. We use the My Team’s Tasks widget to manage the task.

**The Team List widget**

The Team List widget shows the information about all of the potential owners and their status, such as how many tasks the potential owners are working on right now.

**Configuration window of the Team List widget**

In the configuration window of the Team List widget, shown in Figure 4-109, you can configure whether the User image, Display name, Name, E-mail, and Telephone number information of the users will be displayed. By default, all the information will be shown.

![Team List Edit Configuration window](image)

*Figure 4-109  Configuration window of Team List*

**Using the Team List widget**

The Team List widget will only interact with the My Team’s Tasks widget. When a task in the My Team’s Task widget is selected, all the potential owners of this task will be shown in the Team List widget, along with the basic information for that task. Users can also drag a task from My Team’s Tasks to Team List widget to transfer a task to a potential owner.

The user name, together with the task number, will be shown in the widget. If you hover over any user, the detailed information will be prompted.

Refer to 4.6.3, “Performing the movie rating process at the German branch” on page 194 for more details about our scenario. We use the Team List widget to manage the task.
4.5 Predefined space templates for human-centric usage

There are three space templates in Business Space for human-centric usage:

- Managing My Tasks
- Advanced Managing of Human Tasks and Workflows
- Managing My Team’s Tasks

You can use the Create Space window to create spaces using any of the templates, as shown in Figure 4-110. For details, refer to Chapter 2, “Managing IBM Business Space powered by WebSphere V7” on page 17.

**Note:** If you choose everyone to be the potential owners of a task in the Team List widget, it will display “Any users can be a potential owner for...”.

Figure 4-110  Create spaces using templates
4.5.1 The Managing My Tasks template

The Managing My Tasks space template is mainly used for a business user to manage his own human tasks or create tasks for himself and others.

**Note:** This space template is mainly a human-centric template, but it is also a cross-product space template, which means there will be both WebSphere Process Server and WebSphere Business Monitor widgets involved, so if you only install WebSphere Process Server, the WebSphere Business Monitor widgets will be shown as not available.

As shown in Figure 4-111, the space will have two windows:

- The My Work window is used to check and manage the existing tasks, as shown in Figure 4-112. For the usage of the KPI and Alerts widgets on Monitoring, refer to Chapter 7, “Activity monitoring business spaces” on page 363.
The Create Tasks window, which is used to create a new task, or view the previous tasks created by you, as shown in Figure 4-113.

![Figure 4-113 The Create Tasks window](image)

4.5.2 The Advanced Managing of Human Tasks and Workflows template

The Advanced Managing of Human Tasks and Workflows space template is a new template in Business Space V7, and is enhanced with work organizing support and continuous working support, as well as process instance creation support. Business users can use this space to create tasks for other people and to initiate services and processes, as shown in Figure 4-114.

![Figure 4-114 Space using the Advanced Managing of Human Tasks and Workflows template](image)
The space has six windows:

- The Work on Tasks window is used for a business user to work on his own tasks or escalations, as shown in Figure 4-115.

![Figure 4-115 Work on Tasks window](image)

- The Work Continuously window lets the business user work on his tasks one by one, using a particular sequence. The system will automatically generate a new task for him to do when he completes the previous task. With this functionality, a business user will not have to switch to other windows and accept or work on tasks manually, as shown in Figure 4-116.

![Figure 4-116 The Work Continuously window](image)

- Using the Organize Work window, the business user can easily create a new To Do item, for himself or others. He can also view, transfer or delete the item, as shown in Figure 4-117.

![Figure 4-117 The Organize Work window](image)
Similar to the Create Tasks window in the Managing My Tasks template, the Create Tasks window can be used to create a new task or navigate the existing tasks, as shown in Figure 4-118.

Using the Manage Human Workflows window, a business user can work on the process definitions and process instances, as shown in Figure 4-119.
The Manage Human Tasks window covers the widgets of Process Definitions List, Task Definitions List, Tasks List, Escalations List, Task Information, Human Workflow Diagram, and Team List, as shown in Figure 4-120.

![Figure 4-120 The Manage Human Tasks window](image)

### 4.5.3 The Managing My Team’s Tasks template

The Managing My Team’s Tasks space template is used by business users to manage human tasks within a team scope. The administrators of the human task are able to assign, accept, or transfer a task to any team members in the team, in order to balance each member's work load, and improve the task's completion efficiency, as shown in Figure 4-121.

**Note:** As with the Managing My Tasks template, this template is also a cross-product space template, so if you only install WebSphere Process Server, the WebSphere Business Monitor widgets will be shown as not available.

![Figure 4-121 Space using the Managing My Team’s Tasks template](image)
The space has five windows:

- The My Work window, where the functionality is the same as the identically named page Managing My Tasks template. Business users can view and manage their own tasks, as shown in Figure 4-122.

![Figure 4-122 The My Work window](image)

- The Create Tasks window has the same functionality as the window with the same name in the Managing My Tasks template. Business users can create tasks using this window, as shown in Figure 4-123.

![Figure 4-123 The Create Tasks window](image)
Using the Task Status window, a business user will be able to see the status of all the human tasks related to him, as shown in Figure 4-124.

![Figure 4-124 The Task Status window](image)
The Manage Team Tasks window provides the capability for task administrators to manage the tasks from a team point of view, as shown in Figure 4-125.

The Analysis window, shown in Figure 4-126, is used to do the analysis, using different dimensions and to create the data report. Refer to Chapter 7, “Activity monitoring business spaces” on page 363 for the Monitoring widgets.
4.6 Movie Rating processes in Business Space

After you deploy the five movie rating process definitions in the ITSOMovie module to the WebSphere Process Server, you can use them to rate movies using Business Space. You can accomplish this task by performing these steps:

1. Log in to Business Space as the process starter (you can use your WebSphere Process Server administrative user or create a new user to start the processes) and create a space using the space template of Advanced Managing of Human Tasks and Workflows, and then open it.

2. Go to the Manage Human Workflows window. You can see the five process definitions in the Process Definitions List widget, as shown in Figure 4-127.

- MovieRatingProcessVoting
- MovieRatingProcessMaximum
- MovieRatingProcessEscalation
- MovieRatingProcessCollaborationScope
- MovieRatingProcessSinglePerson

Refer to 4.4, “Human-centric widgets” on page 117 for details about the Process Choreography widgets.

![Process Definitions List window](image)
3. In the Create Tasks window, in the Task Definitions List widget, you will find the five task definitions that are used to start these processes, as shown in Figure 4-128.

- VotingRatingStart
- MaximumRatingStart
- EscalationRatingStart
- CollaborationScopeRatingStart
- SinglePersonRatingStart

4.6.1 Performing the movie rating process at the China branch

Here we perform the movie rating process at the China branch. Refer to 4.3.1, “Rating process in China” on page 90 for more details about the process design.

Perform the following steps:

1. Log in as the process start user.
2. Select the **MovieRatingProcessVoting** process definition in the Process Definitions List widget. The process diagram appears in the Human Workflow Diagram widget window, as shown in Figure 4-129.

![Human Workflow Diagram in Business Space](image)

*Figure 4-129  Human Workflow Diagram in Business Space*
3. Start a process instance to rate a movie.
   a. Log in to Business Space as the process starter, for example, the administrative user, who can start a process instance.
   b. Start a new process instance by creating a new task instance of VotingRatingStart in Task Definitions List in the Manage Human Tasks page, as shown in Figure 4-130.
      i. Check the VotingRatingStart check box.
      ii. Click the Actions menu and then select Create.
   c. In the Task Information widget window, the task information displays and you can enter the movie inputs.
      i. Enter 2 into the Priority field and 3/12/2010 into the Due date field.
      ii. Click the Add link to add a movie’s information.
      iii. Enter ITSO1 into the id field, ITSO Sci-Fi into the title field, and complete the other fields.
      iv. Click Add to add the directors and actors.
      v. Enter 3/5/2010 into the releaseDate field and select China from the releaseCountry drop-down menu.
vi. Click **Submit** after you entered all the information or **Save as Draft** so that you can submit it later, as shown in Figure 4-131. In our scenario, click **Submit**.

*Figure 4-131  Task Information window*
4. The process instance will be started (you can see it in the Processes List widget in the Manage Human Workflows window, as shown in Figure 4-132).

![Processes List](image)

**Figure 4-132  Processes List**

5. Meanwhile, the tasks of the process, StaffRating task instances, will be sent to all the potential owners in the ITSOMovieMovieRatersChina group:
   - Ming Chen
   - Mo Chong
   - Meng Chang
   - Man Che
   - Mu Chun
a. As shown in Figure 4-133, there are a number of StaffRating tasks that are generated. The task without an owner is called the main task.

**Note**: If you do not see the list, check that you have all of the users and groups loaded into your process server. If you need to load them now, you might need to republish your applications in the WebSphere Integration Developer ITE.

![Tasks List](image)

*Figure 4-133  Tasks List*
b. If you select the main task and then open it, the Task Information widget will show its details. Select the **Related Tasks** tag and you will be able to see all the related tasks. Those are the tasks that were sent to all the potential owners, as shown in Figure 4-134.

![Related Tasks Table]

*Figure 4-134  Related tasks of the main task*
c. As shown in Figure 4-135 and Figure 4-136, you can see the whole process instance in the Human Workflow Diagram widget. Click the **StaffRating** node and select **Show related tasks**. The related task nodes will display.

![Figure 4-135 Show related tasks in Human Workflow Diagram](image)

![Figure 4-136 All related task nodes shown](image)
6. We now need to rate the movie using the login of each movie rater.
   a. Log in as each movie rater into Business Space. Create a space using the space template of Managing My Tasks, and then open it.

   **Note:** We can also use the Business Space share function to share one space to all the users so they can work on a single space. Refer to “Sharing spaces and pages” on page 43 for details.

   b. For each user, open the My Work window in the My Tasks widget. Each user will see their own tasks, as shown in Figure 4-137.

   ![Figure 4-137](image)

   "Task for each potential owner"

   c. Select the task and select **Edit** to edit it. The Task Information widget will display all of the task’s information.
d. Rate the movie and make comments about it, as shown in Figure 4-138.

![Figure 4-138 Rate the movie](image)

In our example, the ratings of the five raters are:

- Ming Chen: PG
- Mo Chong: PG-13
- Meng Chang: G
- Man Che: G
- Mu Chun: G

After all the movie raters have completed their ratings, the StaffRating task is completed. The rating results will be voted at a percentage of 60% and the comments will be concatenated.

The result of the StaffRating task will be G.

The process then moves to the next task, that is, ManagerRating.

7. Rating the movie using one of the movie rater managers logins.

a. The ManagerRating task is a single task and only one potential owner can work on it at one time.

b. One of the movie rater managers (in our scenario there is only one manager called mincun) logs into Business Space. Create a space using the space template of Managing My Tasks, and then open it.
c. Go to the My Work window. In the My Tasks widget, you can see the task assigned to mincun, as shown in Figure 4-139.

![Figure 4-139 The ManagerRating task](image)

8. The process is complete and the result G is returned to the process starter.
   a. Log on with the process start user.
b. In the Processes List widget window, you can see the process is in the Finished state, as shown in Figure 4-141.

![Processes List](image)

*Figure 4-141  The process is in the Finished state*

c. Click the icon to the right of the process, and you can see all the tasks are completed, as shown in Figure 4-142.

![Human Workflow Diagram](image)

*Figure 4-142  Human Workflow Diagram window*

d. In the Tasks List widget window, select **All** and **Check Status of tasks** for the task list. You can see the VotingRatingStart task is in the Completed state, as shown in Figure 4-143.

![Tasks List](image)

*Figure 4-143  VotingRatingStart task in the Completed state*
e. Click the icon to the right of the task. You can see that the task result is G, as shown in Figure 4-144, so this is the process result.

![Task Information](figure)

**Figure 4-144**  The result is G

### 4.6.2 Performing the movie rating process at the Egypt branch

Here we perform the movie rating process at the Egypt branch. Refer to 4.3.2, “Rating process in Egypt” on page 95 for more details about the process design.

Perform the following steps:

1. Log in as the process start user.
2. Select the **MovieRatingProcessMaximum** process definition in the Process Definitions List widget window. The process diagram in the Human Workflow Diagram widget is shown in Figure 4-145.

![Human Workflow Diagram](image)

*Figure 4-145  Maximum workflow in Business Space*
3. Start a process instance to rate a movie by creating an instance of the MaximumRatingStart task definition in the Task Definitions List widget.
   a. Enter the following information, as shown in Figure 4-146.
      i. Enter 2 into the Priority field and 3/11/2010 into the Due date field.
      ii. Click the Add link to add a movie’s information.
      iii. Enter ITSO3 in the id field, ITSO BioPic into the title field, and complete the other fields.
      iv. Click Add to add the directors and actors.
      v. Enter 3/8/2011 into the releaseDate field and select Egypt the releaseCountry drop-down menu.

![Task Information](image)

*Figure 4-146  Movie Information*
b. Add some additional notes to the task. Click the Notes tab and enter the information “This task is going to start the rating movie process.”, as shown in Figure 4-147.

![Figure 4-147 Additional notes](image)

Figure 4-147 Additional notes

c. Click Submit after you enter all the information or Save as Draft so that you can submit it later, as shown in Figure 4-131 on page 177. Click Save as Draft for our scenario.

d. After you save the task as a draft, you can see that it is in the Draft state in the Tasks List widget window, as shown in Figure 4-148. Click the icon to the right to open the task again.

![Figure 4-148 MaximumRatingStart in the Draft state](image)
e. In the Task Information widget window, change the task priority to 1 and click **Submit**, as shown in Figure 4-149.

![Task Information](image)

*Figure 4-149  Change the priority*
4. Rate the movie by each movie rater that is working on the MaximumRating tasks. While this process is similar to the China branch’s process, at the Egypt branch, the aggregation method is mostFrequentOccurrence(), that is, the most frequent result will be the final result, as shown in Figure 4-150.

![Task Information Image]

Figure 4-150 Tasks assigned to each rater respectively

In our example, enter the following ratings:
- Mohamed Essam: R
- Mahmoud Ehsan: PG
- Mona Emam: G
- May Emad: R
- Mina Ehab: NC-17
The result of the MaximumRating task will be R, as shown in Figure 4-151.

---

**Figure 4-151  The result of the MaximumRating is R**

5. The process is complete and the result is returned.
   a. Log on as the process start user.
   b. In the Processes List widget window, you can see the process is in the Finished state, as shown in Figure 4-152.

---

**Figure 4-152  The process is in the Finished state**
c. Click the icon to the right of the process, and you can see that all the tasks are completed, as shown in Figure 4-153.

![Human Workflow Diagram](image)

*Figure 4-153  Process diagram*

d. In the Tasks List widget window, select **All** and **Check status of tasks** for the task list. You can see the MaximumRatingStart task is in the Completed state, as shown in Figure 4-154.

![Tasks List](image)

*Figure 4-154  MaximumRatingStart task is in the Completed state*
e. Click the icon to the right of the task. You can see that the task result is R, as shown in Figure 4-155.

![Task Information](image)

*Figure 4-155 The result is R*

### 4.6.3 Performing the movie rating process at the German branch

Here we perform the movie rating process at the German branch. Refer to 4.3.3, “Rating process in Germany” on page 97 for more details about the process design.

Perform the following steps:

1. Log in as the process start user.
2. Select the **MovieRatingProcessEscalation** process definition in the Process Definitions List widget window. The process diagram in the Human Workflow Diagram widget is shown in Figure 4-156.

*Figure 4-156  Escalation workflow in Business Space*
3. Start a process instance to rate a movie by creating an instance of the EscalationRatingStart task definition. In Germany, we use the Lotus Forms format to show task inputs and outputs.

   a. Enter the inputs information, as shown in Figure 4-157.
      i. Enter 1 into the Priority field and 3/6/2010 into the Due date field.
      ii. Click the Add link to add a movie’s information.
      iii. Enter ITSO2 into the id field, ITSO Western into the title field, and complete the other fields.
      iv. Enter 280 into the BudgetMillionDollar field.
      v. Click Add to add the directors and actors.
      vi. Enter 3/8/2010 into the releaseDate field and select Germany in the releaseCountry drop-down menu.

   b. Submit the task after you enter the task information.

Figure 4-157   Task Information with Lotus Forms

   c. Configure the Tasks List widget to use the defined query table ESCALATIONTASK.CPROPS, as shown in Figure 4-158 on page 197. Refer to “Configuration window of the Tasks List widget” on page 125 for more details.
i. In the configuration window, check the `ESCALATIONTASK.CPROPS` check box.

![Task Lists](image)

*Figure 4-158  Choose ESCALATIONTASK.CPROPS in the list*

ii. Make sure the `BUDGET` property check box is checked, as shown in Figure 4-159

![Properties](image)

*Figure 4-159  Properties*

iii. Click **OK** to save the settings for the configuration window.
d. After setting the configuration settings, select **ESCALATIONTASK.CPROPS** from the drop-down menu, as shown in Figure 4-160.

![Figure 4-160 ESCALATIONTASK.CPROPS in the drop-down menu](image)

e. The Budget property will be shown in the widget's window, as shown in Figure 4-161.

![Figure 4-161 Budget property shown in Business Space](image)

4. After the process is started, it will display the StaffRatingWithEscalation task, and the task will be set to the status of Available, as shown in Figure 4-161.

a. If the task is in the Available state for more than one day, the ReadyEscalation task will automatically start, as we defined in the scenario. At this point, the assignee of the escalation receives the escalation, as shown in Figure 4-162.

![Figure 4-162 ReadyEscalation is started](image)
b. All of the potential owners (Martin and Michael) can receive the task and will be able to work on it by accepting it.

c. Assuming that Martin accepts the task, the status will become Claimed, and Michael will not be able to accept it from this point.

d. Meanwhile, the escalation of ClaimEscalation will be set to the Set status. If you want, you can start the escalation before it is set to the Start status automatically, as shown in Figure 4-163.

Fig. 4-163 ClaimEscalation in Set status

e. If Martin does not finish this task in one day, the ClaimEscalation escalation will start automatically, as shown in Figure 4-164.

Fig. 4-164 ClaimEscalation starts automatically
f. Martin can also choose to transfer or return the task, as shown in Figure 4-165.

![Image of Tasks List]

*Figure 4-165 Return or Transfer a task*

i. If the task is returned, it will return to the Available state.

ii. An owner needs to be defined if the task is transferred. In the Transfer Task window, all the potential owners will be listed, as shown in Figure 4-166.

![Image of Transfer Task]

*Figure 4-166 All the potential owners will be listed*

g. As the owner of the task, the process start user will also be able to transfer or return the task, using the My Team’s Tasks and Team List widgets.

i. Log in as the process start user, for example, the administrative user.

ii. Create a space using the Managing My Team’s Tasks template.

iii. Go to the Manage Team Tasks window. You can see the My Team’s Tasks and Team List widgets.
iv. Check the check box next to the task and select **Transfer** or **Return** from the Actions drop-down menu shown in Figure 4-167. If **Return** is selected, the task return to the Available state and one of the potential owners needs to claim it again; if **Transfer** is selected, as shown in Figure 4-168, the Transfer Task window opens, and you can choose one of them to transfer the task; after the transfer, that potential owner will become the owner of the task.

![My Team's Tasks](image)

**Figure 4-167 Transfer or Return a task**

![Transfer Task](image)

**Figure 4-168 Transfer Task dialog**
v. All the potential owners and their workloads will be shown in the Team List widget window, as shown in Figure 4-169.

![Team List](image)

*Figure 4-169 Team List*

h. In our scenario, Martin rates the movie as a PG-13.

5. After the StaffRatingWithEscalation task is finished, the process is completed and the result is returned as a PG-13.

**Showing images in the widgets**

Both the My Team's Tasks and Team List widgets have the capability to show images of the task owners, as shown in Figure 4-167 on page 201 and Figure 4-169. To enable this function, you need to perform the following steps:

1. Develop an enterprise application, which contains a Java Servlet and the user image files.
   a. Create an Enterprise Application Project in WebSphere Integration Developer.
   b. Create a Dynamic Web Project for your Enterprise Application Project.
   c. Copy the image files to the WebContent folder in your Web project. The image names should be the same as the user names, and the extensions should always be .jpg.
   d. In the Dynamic Web Project, create a Java Servlet, which will contain the logic to redirect to the images.

*Note: We provide a sample enterprise application project with this book called UserImagesApp.ear. You can add images to the .ear file in the UserImagesWeb.war/images folder and then deploy the application to WebSphere Process Server.*
2. Create a new endpoint file that will be used to find your images, which will point to the Servlet you create. An example endpoint file is shown in Example 4-1.

Example 4-1 The endpoint file for the user images

```xml
<?xml version="1.0" encoding="UTF-8"?>
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://com.ibm.bspace/BusinessSpaceRegistry BusinessSpaceRegistry.xsd ">
<tns:Endpoint>
<tns:id>{com.ibm.bspace.htm}bspaceUserImageServiceRootId</tns:id>
<tns:type>{com.ibm.bspace.htm}bspaceUserImageServiceRootId</tns:type>
<tns:version>1.0.0.0</tns:version>
<tns:url>URL</tns:url>
<tns:description>Location of user image services</tns:description>
</tns:Endpoint>
</tns:BusinessSpaceRegistry>
```

Note: In the `<tns:url>` field, you should enter the actual value of your full servlet root context.

3. Link your application and the endpoint file.
   a. In WebSphere Integration Developer, export your enterprise application project to an .ear file, and then install and start your application on WebSphere Process Server.
   b. Use the wsadmin task of `UpdateBusinessSpaceWidgets` to register your endpoint file.
      i. Run `wsadmin.bat/sh` under the folder of `<profileRoot>/bin`. For Network Deployment environments, you should run it under the DMGR profile.
      ii. Run `$AdminTask updateBusinessSpaceWidgets {-nodeName <yourNode> -servername <yourServer> -endpoints <yourFilepath>}`, if you are using a stand-alone profile, or run `$AdminTask updateBusinessSpaceWidgets {-clusterName <yourCluster> -endpoints <yourFilepath>}` if you are using an ND environment.

4. Configure the widgets to show the images.
   a. You must configure both the My Team's Tasks and Team List to get the images shown in them.
b. If you must have a window with both of the widgets, create a space using the template of Managing My Team’s Tasks. If you perform this action, both of the widgets will be already in the Manage Team Tasks window.

**Note:** Click the *Edit Page* button and then click *Edit Settings* in the widget drop-down menu to access the widget configuration window.

c. For the Team List widget, make sure the User image check box is checked, as shown in Figure 4-170.

![Team List Edit](image)

*Figure 4-170  Configuration window of Team List widget*
d. For the My Team's Tasks widget:

i. In the Content tab of the configuration window, make sure the Group by Owner check box is enabled, as shown in Figure 4-171.

![Figure 4-171  Content tab of the configuration window](image)
ii. In the Display tab of the configuration panel, select **Table** for the layout of the tasks, as shown in Figure 4-172.

![My Team's Tasks Edit](image)

Adapt how the content in the task list is displayed and refreshed, and how the priority of tasks is shown.

Select a layout for the tasks:
- Table
- List

Choose a navigation style:
- Fit to view (Multiple pages)
- View all (Scroll bar)

*Figure 4-172  Display tab of the configuration window*

5. You should be able to see the user images show up in the following widgets:
   a. Team List Widget: Hover over the user names and the user images will appear in a window, as shown in Figure 4-169 on page 202.
   b. My Team's Tasks Widget: Select the task and the owner image will appear, as shown in Figure 4-167 on page 201.
4.6.4 Performing the movie rating process at the UK branch

Here we perform the movie rating process at the UK branch. Refer to 4.3.4, “Rating process in the UK” on page 111 for more details about the process design.

Perform the following steps:
1. Log in as the process start user.
2. Select the **MovieRatingProcessCollaborationScope** process definition in the Process Definitions List widget window. The process diagram is displayed in the Human Workflow Diagram widget, as shown in Figure 4-174.

![Human Workflow Diagram](image)

*Figure 4-174  Collaboration scope workflow in Business Space*

3. Start a process instance to rate a movie by creating a CollaborationScopeRatingStart task. In the UK, we use Lotus Forms to show task inputs and outputs, as we did for the German branch.
a. Enter the inputs information shown in Figure 4-175.

![Task Information](image)

Figure 4-175 Task Information

i. Enter 5 into the Priority field and 3/31/2010 into the Due date field.

ii. Click Add link to add a movie’s information.

iii. Enter ITSO4 into the id field, ITSO RomCom into the title field, and complete the other fields.

iv. Click Add to add the directors and actors.

v. Enter 4/10/2010 into the releaseDate field and select UK in the releaseCountry drop-down menu.

b. Submit the task when you complete entering all the task inputs.
4. Rate the movie: We have a collaboration scope in the movie rating process. In a collaboration scope, tasks can be skipped or redone.

a. The process goes to ratingStep1, which is owned by Mark Usher, so when Mark logs in to Business Space, he will see a task in his Tasks List widget (the task is automatically assigned to him), as shown in Figure 4-176.

![Figure 4-176 ratingStep1 for Mark Usher](image)

b. The administrator of this process, that is, the process start user, is able to see the status of the whole process in the Human Workflow Diagram widget window. The use can also choose to skip this step, as shown in Figure 4-177. In our scenario, Mark does not skip the task.

![Figure 4-177 Skipping of the task node](image)
c. Mark rates the movie as G and makes some comments, as shown in Figure 4-178.

![Figure 4-178 ratingStep1 with Mark Usher's rating](image-url)
d. After the ratingStep1 is completed, the administrator can choose to have Mark do the task again, as shown in Figure 4-179. For example, in our scenario, the administrator is told that Mark is not performing his task carefully, so the administrator can select Redo to send the task back to Mark back again.

Figure 4-179 Redo the task node
e. Mark will receive the same task again. This time, he needs to be more careful when he rates the movie, as shown in Figure 4-180.

*Figure 4-180  Another rating from Mark*
f. Now the process has reached ratingStep2. Mary can see Mark’s rating and comments, but she can also make her own rating, as shown in Figure 4-181.

![Figure 4-181 Mary’s rating](image)

5. The process is complete and produces a result of G.
   a. Log on with the process start user.
   b. In the Processes List widget window, you can see that the process is in the Finished state, as shown in Figure 4-182.

![Figure 4-182 The process is in the Finished state](image)
c. Click the icon on the right of the process. You can see all the tasks are completed, as shown in Figure 4-183.

![Process Diagram](image)

*Figure 4-183  Process Diagram*

d. In the Tasks List widget window, select **All** and **Check status of tasks** for the task list. You see that the **CollaborationScopeRatingStart** task is in the Completed state, as shown in Figure 4-184.

![Tasks List](image)

*Figure 4-184  CollaborationScopeRatingStart task in Completed state*
e. Click the icon to the right of the task. You see that the task result is G, as shown in Figure 4-185.

![Task Information](image)

Figure 4-185 The result is G

### 4.6.5 Performing the movie rating process at the USA branch

Here we perform the movie rating process at the USA branch. Refer to 4.3.5, “Rating process in the USA” on page 115 for more details about the process design.

Perform the following steps:

1. Log in as the process start user.
2. Select the **MovieRatingProcessSinglePerson** process definition in the Process Definitions List widget window. The process diagram displays in the Human Workflow Diagram widget window, as shown in Figure 4-186.

![Human Workflow Diagram](image)

*Figure 4-186  Single person workflow in Business Space*
3. Start a process instance to rate a movie by starting the SinglePersonRatingStart task. In the USA, we use Lotus Forms to show task inputs and outputs.
   a. Enter the task input information, as shown in Figure 4-187.

   ![Task Information](image)

   Figure 4-187  Task Information

   i. Enter 3 into the Priority field and 3/18/2010 into the Due date field.
   ii. Click Add link to add a movie’s information.
   iii. Enter ITSO5 into the id field, ITSO Courtroom Drama into the title field, and complete the other fields.
   iv. Click Add to add the directors and actors.
   v. Enter 3/25/2010 into the releaseDate field and select USA in the releaseCountry drop-down menu.

   b. Submit the task when you complete all the task inputs.

4. Rate the movie: This process has three steps: BriefRate, DetailRate and FinalRate. All of them are owned by the same rater, Marcia Umberger.
   a. Log in to Business Space as marciaumberger.
   b. Create a new space using the Advanced Managing of Human Tasks and Workflows template, then go to the Work Continuously window.
c. BriefRate: The BriefRate task is shown in the Task Information window, as shown in Figure 4-188. Marcia performs a brief rating, according to the brief introduction part of the movie, and sets a rating of R. Click **Submit** to submit the rating.

![Figure 4-188 BriefRate](image)

d. DetailedRate: The DetailRate task will automatically be shown in the Task Information widget window.

i. For the detailed rating step, Marcia needs to do a detailed rating according to the detailed information and the result of briefRate.
ii. Marcia finds a problem with the detailed information. She can create a subtask for another user (for example, the administrative user) to inquire about more information, as shown Figure 4-189.

![Figure 4-189 Create a subtask](image)

iii. Select Actions → New. The New Task window opens. Choose the task template Inquiry and click OK, as shown in Figure 4-190.

![Figure 4-190 New Task window](image)
iv. Enter the information and **Submit**, as shown in Figure 4-191.

![Task Information](image1)

Figure 4-191  The Inquiry subtask

v. The task can be found in the **Related Tasks** tab of the detailed rating task. It also can be canceled from there, as in Figure 4-192.

![Task Information](image2)

Figure 4-192  Related Tasks tab

vi. Only if the related tasks are complete or canceled can Marcia work on and submit the detailed rating task. If she wants, she can still save the task.
vii. The administrative user logs in and sees this task in the Tasks List widget, as shown in Figure 4-193.

![Figure 4-193  The Inquiry task in the list](image)

viii. Click the icon at the right, provide the detailed information, and click **Submit**, as shown in Figure 4-194.

![Figure 4-194  Provide the detailed information](image)
ix. Log in with Marcia again. she can see the inquiry task is in the Complete state, as shown in Figure 4-195. Click the icon at the right, and she can see the result of the inquiry task (Figure 4-196).

**Figure 4-195  Inquiry state in Complete state**

**Figure 4-196  Details of the inquiry task**
x. Do the detailed rating (using the result of R) and click **Submit**, as shown in Figure 4-197.
e. FinalRate: Once the detailRate task has been completed, the FinalRate task automatically will be shown in the Task Information widget window, as shown in Figure 4-198. Do a final rating and click Submit. The final rating result is also R.

Figure 4-198  Final rating
f. When there is no task for Marcia, the widget window will show no task in it, as shown in Figure 4-199.

![Figure 4-199 No task for Marcia](image)

5. The process is complete with the result of R.
Integration-centric business spaces

In this chapter, we discuss the use of IBM Business Space powered by WebSphere V7 in integration scenarios, using WebSphere Enterprise Service Bus, WebSphere Process Server, WebSphere Service Registry and Repository, and WebSphere Integration Developer.

We show how Business Space can be used with WebSphere Service Registry and Repository (WSRR) to change mediation policies and hence service endpoints to choose different service providers based on business needs without changing code.

We also show how to configure and manage the Store and Forward functionality with WebSphere Enterprise Service Bus and Business Space. This allows us to use Business Space to manage the calls to a service that has gone down or is undergoing planned maintenance.
5.1 Using Business Space and WebSphere Service Registry and Repository policies to change service endpoint calls

In this section, we show the use of Business Space to change the endpoint of a service call made using WebSphere Process Server without redeploying the module.

To do this task, we use mediation policies stored in WSRR and managed with Business Space. We apply these policies to a mediation flow component (MFC) using Business Space to allow us to change the behavior of the MFC without having to change any code.

**Note:** Although our example uses BPEL and WebSphere Process Server, the technique is exactly the same for a WebSphere Enterprise Service Bus implementation with no WebSphere Process Server.

5.1.1 Business scenario: Ordering movies

In our business scenario, ITSO Movie receives orders for movies from movie theaters around the world and ships the movies through a shipping partner.

ITSO Movie has two shipping partners:

- ITSOShipping
- ClipsAndTacksFreight

Both partners provide shipping services that are exposed using the same Web service interface, therefore making it easy for ITSO Movie to switch between partners without remapping the service calls.

ITSO Movie want to use Business Space to allow them to switch between their shipping partners using WebSphere Service Registry and Repository policies without having to redeploy any modules.

The business scenario is described in full in Chapter 3, “Business scenario example” on page 57.
5.1.2 Technologies used in the scenario

The technologies used in the scenario are described in this section.

**WebSphere Business Process Management products**

In this scenario, we use a combination of the following products:

- WebSphere Process Server / WebSphere Enterprise Service Bus
- WebSphere Service Registry and Repository
- Business Space

Although we use a MFC in our example, for simplicity we will not use a separate WebSphere Enterprise Service Bus run time; instead, we deploy the mediation to the same WebSphere Process Server run time as our BPEL processes. In a production environment, the MFC may be deployed onto a separate WebSphere Enterprise Service Bus cluster.

**BPEL processes**

These processes are used here purely to enable an ITSO Movie process to call a logical shipping service, which then chooses either an ITSOShipping or a ClipsAndTacksFreight service destination. For this example, the actual process logic is not important.

**Mediation Flow Component with WebSphere Service Registry and Repository policy resolution and endpoint lookup**

The SelectShipper MFC uses WSRR together with the Policy Resolution and Endpoint Lookup primitives to decide which service endpoint will make the actual shipment service call.

**Mediation policies**

The mediation policy allows us to select the correct endpoint at run time by changing the policy used by the SelectShipper MFC by using the Business Space Mediation Policy Administration widget.
5.1.3 Business Space widgets used in the scenario

We will use following Business Space widgets:

- **Service Browser**
  This widget allows us to view the services that we have stored in WSRR.

- **Module Browser**
  This widget allows us to view the modules that we have deployed.

- **Mediation Policy Administration**
  This widget allows us to create and apply mediation policies to our service calls to change their behavior without changing their code.

Business Space provides a Service Administration space, which has a Service Administration window with both the Service Browser and Mediation Policy Administration widgets preconfigured. We show this space by using it to browse our services.

To change the policies in our example, we use our own space and window, which will show the Module Browser and the Mediation Policy Administration widgets being used together.

5.1.4 Overview of our example

As this chapter is quite long, we start with an overview of how we will build our example.

**Using the additional material supplied with this book**

Our example solution is supplied as a project interchange file that contains a complete solution, including the solution diagram, modules, and the library required for our examples. You can obtain this file by referring to Appendix B, “Additional material” on page 747 for instructions on how to do so.

You should import the solution into WebSphere Integration Developer and build the projects.

As our solution uses Web services, it is important to make sure that the Web service calls use the correct port. By default, if WebSphere Process Server is the first server installed on a node, it will use port 9080 or 9443 for the Web services. This port number might increase if you have multiple profiles installed.
We provide two solution files, one with the ports bound to 9080 and 9443 and one with the ports bound to 9081 and 9444. If your ports are different, you will need to change the Web service import bindings in the modules to use the correct port for your system.

**Build and test approach**

Our build approach assumes that you have loaded the solution project interchange file into WebSphere Integration Developer. If you do not have WebSphere Integration Developer, you might be able to use the supplied .ear file for some of the steps, such as the import into WSRR and the creation of policy attachments, but you will not be able to test the solution.

Our build and test approach consists of the following steps:

1. We review the interfaces and services that we use. All of the artifacts that are already built for you are in the ITSOMovies_lib file, which is supplied as part of the project interchange file for the solution.

2. We then review the modules and processes that we use for the solution. These are all prebuilt for you, so we do not explore the overall solution in too much detail; if you want to investigate further, browse the solution in WebSphere Integration Developer.

3. We then focus on the MFC. The MFC is used to dynamically look up the service endpoint based on WSRR policy attachments. We explore the policy resolution and endpoint lookup primitives, and how to configure them to use policies.

4. Next, we ensure that our Web Services have user-friendly names and look at the WSDL services and bindings. Again, these are preconfigured for you.

5. We then set up some classifiers in WSRR. We search for the correct endpoint using these classifiers.

6. Next, we export the SCA module as an .ear file and import it into WSRR. We then explore the imported information and view the services using Business Space. At this point, we discuss how to configure Business Space to connect to WSRR to ensure the two can communicate with each other.

7. We then apply the classifiers to our module services that we have imported. These classifiers will be used by the mediation flow component to look up the correct endpoint.

8. We use Business Space to create policies and apply the policy attachments. The policies that we create tell the mediation flow component which endpoint to choose, depending on the business data in the message. We show how policies can be created, applied, and changed using Business Space alone, with no need to use WebSphere Integration Developer or redeploy modules.
5.1.5 Creating the interfaces and services

In this section, we describe the interfaces and services used in the scenario, together with the business objects and attributes.

The interfaces, WSDLs, and business objects can be downloaded into the WebSphere Integration Developer library ITSOMovies_lib, which is contained within the additional material supplied with this book (refer to Appendix B, “Additional material” on page 747 for more information).

What are the services and interfaces
In this scenario, we use four services and two interfaces.

The IOrderMovie interface
This interface allows the ordering of a movie. It contains details of the movie to be ordered, the quantity, and the details of the theater to where the movies should be shipped. The interface is shown in Figure 5-1.

![Figure 5-1 The IOrderMovie Interface shown in WebSphere Integration Developer](image-url)
Figure 5-2 shows the OrderMovieReq business object. For this scenario, the actual fields are not that important: they are used in Chapter 7, “Activity monitoring business spaces” on page 363, which deals with the monitoring of the processes.

Figure 5-2  The Order Movie Request business object
Figure 5-3, Figure 5-4, Figure 5-5, and Figure 5-6 on page 235 show the child business objects of the OrderMovieRequest object.

Figure 5-3   The Country Rating business object

Figure 5-4   The Media business object

Figure 5-5   The Person business object
Figure 5-6   The Address business object

Figure 5-7 shows the Order Movie Response business object. The response object has a tracking identifier and an estimated shipping date.

Figure 5-7   The Order Movie Response business object

The **IShippingStatus interface**

This interface allows the shipping provider to update the shipment status as the shipment progresses. The interface is shown in Figure 5-8.

Figure 5-8   The IShippingStatus Interface shown in WebSphere Integration Developer
In our scenario, we use the logisticsProvider field to indicate which shipping provider has been used. Figure 5-9 shows the fields in the interface.

![Figure 5-9 The UpdateShippingStatus interface request business object](image)

### The ITSOMovieOrderMovie service

This service allows movie theaters to order movies from ITSO Movie. It uses the IOrderMovie interface and is shown in Figure 5-10.

![Figure 5-10 The ITSOMovieOrderMovie Service](image)

**Note:** Even though the service is shown at localhost:9081 (that is, using port 9081) in the service definition, it will actually use the server and Web service port of the server onto which it is deployed. For example, on a stand-alone WebSphere Integration Developer ITE server with only one profile, it will most likely use port 9080.

### The ITSOShippingOrderMovie service

This service is provided by ITSO Shipping, a logistics partner of ITSO Movie, and uses the IOrderMovie interface.
It allows ITSO Movie to ship a movie using the ITSOShipping partner. The
service has a callback function that calls the ITSOMovielShippingStatus Service
to update ITSO Movie with the status of the movie shipment. This service uses
the same IOrderMovie interface, operations, and parameters as the
ITSOMovielIOrderMovie service.

*The ClipsAndTacksFreightOrderMovie service*

This service is provided by ClipsAndTacksFreight, another logistics partner of
ITSO Movie and uses the same IOrderMovie interface.

The service uses the same interface as ITSOShipping so that ITSO Movie can
easily switch between ClipsAndTacksFreight and ITSOShipping. The service
also has the same shipping status callback function as the
ITSOShippingOrderMovie Service.

*The ITSOMovieShippingStatus service*

This service uses the IShippingStatus interface and allows shipping partners to
update ITSO Movie with the status of a movie shipment. It is shown in
Figure 5-11.

![Figure 5-11 The ITSOMovieShippingStatus Service](image)

The shipping statuses are:

- **Shipped**: When a movie has been sent on its way.
- **Arrived in destination country**: When a movie has arrived in the country of the
  movie theater.
- **Delivered**: When the movie is at its final movie theater destination.
5.1.6 WebSphere Process Server design notes

This section describes things we consider when designing the services, processes, and modules.

Processes, services, and module relationships
For this section, we are using the Ordering Movies scenario to show how services can be defined in WSRR and browsed using the Service Browser and Module Browser Business Space widgets. We also show how the endpoint for a service can be changed using the Mediation Policy Administration widget. The actual business process is not as important as the structure of the modules and services.

The ITSOOrderMovie logic is in a single module, as are the ClipsAndTacksFreight and the ITSOShipping shipping services.

The ITSOOrderMovie process uses a SelectShipper mediation to select which of the two shipping modules it will call.

This can be seen in the ITSOMovie Assembly diagram shown in Figure 5-13 on page 240.

The service term
A service has been defined many times within SOA, often to varying degrees of rigor and no small amount of controversy! In this chapter, the word service applies to a business function defined by a WSDL exposed over HTTP using a Web service, or by using SCA.

Service exposition and bindings
The services are all exposed and consumed using Web service bindings. This is typically how inter-company service calls are exposed, although Web services are not necessarily the optimal choice due to concerns over reliable delivery and transactionality.

In this scenario, the ITSOOrderMovie process calls an internal SCA service exposed by the SelectShipper mediation, which then chooses the correct external service via WSRR. This allows the business process (ITSOOrderMovie) to be designed independently of the actual service provider, as long as the internal service contract is not changed. This allows us to use Business Space to add further shipping providers without changing the business process.
Use of a single library
In our example, we use a single library, ITSOMovies_lib, for simplicity. In a production environment, each service provider (ITSOShipping and ClipsAndTacksFreight) would typically use a separate library to expose their public services and share this library with the service consumer (ITSOMovie).

5.1.7 Overview of the Ordering Movies solution and technical notes

Note: This section provides a high-level overview of the Ordering Movies solution and discusses some of the technical issues that are relevant to this scenario. We expect you to download the project interchange files from the additional material supplied with this book (see Appendix B, “Additional material” on page 747) and import the modules into WebSphere Integration Developer. This section does not discuss how to create these modules from scratch.

The ordering movies solution consists of the following three modules:

- ITSOOrderMovie: The main order movie process and the endpoint selection mediation.
- ITSOShipping: This is a stub module that provides a shipping service that ITSOOrderMovie can call.
- ClipsAndTacksFreight: This is another stub module that is the same as the ITSOShipping module and gives us a choice of services to call that implement the same interface.

All of the modules use the ITSOMovies_lib library, which contains all of the interfaces, business objects, and Web services used in the solution.
The relationship between the modules is shown by the solution diagram in Figure 5-12.

**Integration Solution - OrderMovieSolution**

![Diagram](image)

*Figure 5-12  The OrderMovieSolution solution diagram*

**The ITSOOrderMovie Assembly Diagram**

The ITSOOrderMovie Assembly Diagram is shown in Figure 5-13. This module is owned and run by ITSO Movie, which is the exported Web services link to partner companies and theaters.

![Diagram](image)

*Figure 5-13  ITSOOrderMovie Assembly Diagram*

**ITSOMovieIOrderMovieExport Web service**

This export Web service is called by the movie theatre to order a movie. It is the entry point for the process.
OrderMovieProcess BPEL process

This is the main Order Movie process used by ITSO Movie. The BPEL is shown in Figure 5-14.

![Figure 5-14  OrderMovieProcess BPEL](image)

The process calls the shipping service via the SelectShipper mediation flow component, which provides it with a tracking ID and an estimated shipping date. The tracking ID and date is then passed back to the caller.

The process then waits for three more status updates:

- Shipped: SHIPPED
- Arrived into the destination country: INCOUNTRY
- Delivered to the destination movie theater: DELIVERED

With each status update, the present location city of the movie package is reported.

The process is long-lived and uses a correlation of trackingID to ensure the receives correlate to the correct process instance. Even though the process appears to do nothing with the status update events, these are used in WebSphere Business Monitor for tracking the progress of the shipment. See Chapter 7, “Activity monitoring business spaces” on page 363.
ITSOMovieShippingStatusExport: Web service
This export is used by the shipping partners to send their shipping status updates to ITSO Movie.

ITSOSShippingIOrderMovieImport: Web service
This is the import of the ITSOSShipping Web Service, used to ship a movie using ITSOSShipping.

ClipsAndTacksFreightIOrderMovieImport: Web service
This is the import of the ClipsAndTacksFreight Web Service, used to ship a movie using ClipsAndTacksFreight.

SelectShipper: Mediation Flow Component
This MFC uses Mediation Policies and Endpoint Lookups to select the correct endpoint for the shipping service.

The flow, in which the WebSphere Service Registry and Repository is used for policy resolution, is shown in Figure 5-15.

![SelectShipper MFC request flow](image)

Figure 5-15 The SelectShipper MFC request flow

We have made all of the services use the IOrderMovie interface for simplicity, so the MFC contains no mapping components.

The SelectShipper MFC uses the following primitives:
- PolicyResolution primitive
- EndpointLookup primitive
**PolicyResolution primitive**

The PolicyResolution primitive is used to enable mediation policies for any component that follows it. We have configured the primitive in our example as shown in Figure 5-16.

Note: It is important to have the PolicyResolution primitive in the flow before you import the module into WSRR, as it ensures that the correct policy definitions are created and exported from WebSphere Integration Developer and are ready for import.

![PolicyResolution primitive properties](image)

In our example, we left the Registry Name as the default repository as defined in the Integrated Solutions Console of our WebSphere Process Server. If you want to use a different repository than the default, you need to change this field.

Note: We discuss how to define a service repository within WebSphere Process Server and how to connect WebSphere Process Server to WSRR in “Linking WebSphere Service Registry and Repository to the Business Space server” on page 260.
The Policy Scope is set to Module. This is a simplicity decision, but the option is available to set this to Target Service or Intersection of Module and Target Service if you require a higher degree of granularity.

We also created two Policy conditions:

- Country
- Region

These condition values will be populated with the contents of the Service Message Object (SMO) referenced by the XPath shown. In our example, we want to use the values of the Country and Region fields in the message to add policy conditions later.

**EndpointLookup primitive**

The EndpointLookup primitive is where the actual routing of the request is evaluated. The endpoint is looked up in WSRR with the relevant policy applied and the correct endpoint returned.

The detail properties of the EndpointLookup primitive are shown in Figure 5-17.

![Figure 5-17 EndpointLookup primitive properties](image)

Again, we use the default registry for the Registry Name.
We set the Match Policy to Return first matching endpoint and set routing target, the Binding type to Web Services and the Version to 1.0. We only have one matching Web service endpoint in our example, so the first setting will not make much difference. If your WSRR contains more than one matching endpoint, you will need to insert additional logic after the EndpointLookup primitive to determine which is the correct one.

**Note:** In a production environment, you would usually wire the “nomatch” and “error” terminals of the EndpointLookup primitive so that some error handling logic is called in the event of the endpoint lookup failing. We have not done this in our example in order to keep the mediation flow as simple as possible.

If there is an error in your endpoint lookup when running our example mediation flow, you will see an error indicating that the nomatch terminal is not wired; this indicates that the primitive cannot find the endpoint requested.

In the Advanced properties (Figure 5-18), we have added a Classification URI:

The Classification URI is how we determine which service the primitive chooses from those available in WSRR. We create a classification in WSRR that matches the one we enter here and add the classification to the ITSOShippingShippingService. This way, when we search by classification, the correct service will be returned.

We also create another classification in WSRR and apply it to the ClipsAndTacksFreight shipping service.

We then use a mediation policy to change the classification used by the mediation to search for the endpoint in WSRR, which changes the endpoint returned, and hence changes the shipping company used.

We also make the Classification URI that we just defined into a promotable property, so that is can be altered by the policy. This is done using the Promotable Properties tab and checking the Promoted check box.

Important: If the property is not promotable, it cannot be changed by a policy and cannot be altered in Business Space.

Figure 5-19 shows the Promotable Properties tab for the EndpointLookup primitive in our example.

![Figure 5-19 The Promotable Properties tab](image-url)
Note that for space reasons, we had to truncate the columns in the screen capture. Figure 5-20 shows the field values that are present when the Edit button is clicked. Note that the Promoted check box is checked.

![Modify Promotion Properties](image)

**Figure 5-20  Modifying the Promoted Property**

**Note:** It does not actually matter what value is set in the Alias value field at this point in our example. This value will be overwritten by the EndpointLookup primitive at run time.

Finally, we made sure that the Use dynamic endpoint, if set in the message header check box in the properties of the IOrderMoviePartner callout, is set as shown in Figure 5-21.

![Setting the Use dynamic endpoint if set in the message header check box](image)

**Figure 5-21  Setting the Use dynamic endpoint if set in the message header check box**
If this box is not checked, the dynamic endpoint call will not be used and the hard wired call wired to the Callout in the flow diagram will be used instead. It will look like your policies are not being applied. If you find that your endpoint lookups are not working, ensuring that this box is checked is a good debugging start point.

**Tip:** In a production project, you might want to set the default endpoint to be an invalid one, with policies overriding to valid endpoints. This way, if your policies are not set correctly, the call will not be accidentally made to an incorrect endpoint.

**Web service ports and service names**

In our example, all of our services are exposed as Web services. To allow the use of the services across all three modules, the Web service ports are stored in the ITSOMovies_lib library, as shown in Figure 5-22.

![Web service ports in ITSOMovies_lib](image)

**Figure 5-22** Web service ports in ITSOMovies_lib

By default, when Web service exports are created using WebSphere Integration Developer, the WSDL service names are not very user friendly and can look similar. As we want to use Business Space to apply policies to our services, we decide to give them useful names.

To edit the WSDL service names in WebSphere Integration Developer, double-click the Web Service Port whose name you want to change. The WSDL editor (shown in Figure 5-23) then allows you to change the service name. Our example shows the ClipsAndTacksFreight Shipping Service.

![Using the WSDL editor to change the service name](image)

**Figure 5-23** Using the WSDL editor to change the service name
Table 5-1 shows the service names that we have used, corresponding to each Web service port name.

**Table 5-1  WSDL Service Names in the ITSOMovies_lib library**

<table>
<thead>
<tr>
<th>Service name</th>
<th>Web service port</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClipsAndTacksFreightShippingService</td>
<td>ClipsAndTacksFreightIOrderMovieExport_IOrderMovieHttpPort</td>
</tr>
<tr>
<td>ITSOMovieOrderMovieService</td>
<td>ITSOMovieIOrderMovieExport_IOrderMovieHttpPort</td>
</tr>
<tr>
<td>ITSOShippingOrderMovieService</td>
<td>ITSOShippingIOrderMovieExport_IOrderMovieHttpPort</td>
</tr>
<tr>
<td>ITSOMovieShippingStatusService</td>
<td>ITSOMovieIShippingStatusExport_IShippingStatusHttpPort</td>
</tr>
</tbody>
</table>

**Important:** When you change the service name using the WSDL editor, you need to update the export within WebSphere Integration Developer so that it reflects the updated service name.

If you do not do this task, the export will have an address of Port is not resolved; this will not show up as an error in WebSphere Integration Developer, but will prevent the deployment of the module. To resolve this issue and update the exports if you change the services names, follow the steps below.

To rebind the port correctly to the Web service exports, perform the following steps:

1. Select the export and view the properties in the Properties tab, as shown in Figure 5-24 on page 250. Note that the Address field shows Port is not resolved.
2. Click **Browse**. In the Service Port Selection box, select the correct port; in our example here, we select **ITSOSShippingIOrderMovieExport_IOrderMovieHttpPort** and click **OK**.

The port is now rebound, as shown in Figure 5-25.

This needs to be repeated for all of the exports for which you change the service name.
5.1.8 Setting up WebSphere Service Registry and Repository and creating classifiers for our service endpoints

**Dynamic lookup technical checklist:** This is our checklist to make sure that your mediation is correctly set to use mediation policies and endpoint lookups. It is also a useful list of things to troubleshoot.

- Is the “Use dynamic endpoint id set in the message header” check box checked in the Callout primitive? If it is not checked, your mediation will call the hardwired import from the assembly diagram.

- Is the PolicyResolution primitive given priority before any primitives that use the policy? (Usually, the PolicyResolution primitive is set before the Endpoint Lookup primitive.)

- Are the properties that you want to change promotable? Is the Promoted check box checked next to the Property in the Promotable Properties tab?

- Are all the Policy conditions you want to use defined? If they are not defined here, they cannot be used in conditions in WebSphere Service Registry and Repository or Business Space.

- Are Web services being used? As the WSDL used by SCA exports does not contain the service tag, it will not currently show up as a service in WSRR.

- Check your port numbers. Are your Web services exposed on port 9080 or 9081 or 9443 or 9444? Make sure they all match, for both imports and exports.

**Note:** This book does not cover WSRR in detail. In addition, the use of WSRR is purely to show how to use the related Business Space widgets, and might not represent WSRR leading practices.

For further details about WSRR, refer to *Service Lifecycle Governance with IBM WebSphere Service Registry and Repository*, SG24-7793.

Now that we have reviewed the Order Movie technical solution components, we can import the relevant artifacts and endpoints into WSRR. We can also apply classifiers to the endpoints and configure WSRR to allow us to use policies to change the endpoints.
Setting up WebSphere Service Registry and Repository: Loading a configuration profile

In this book, we assume that you have a working WSRR installation.

Note: We installed WSRR as an augmentation of the WebSphere Integration Developer Integrated Test Environment (ITE) run time. You might want to use a separate instance. As long as the correct configuration is applied to your WebSphere Process Server run time to point at your WSRR instance, either configuration will work.

We use the WSRR GovernanceEnablementProfile for our examples. If you use an existing WSRR installation, check with your WSRR administrator before using any of our examples, as your configuration might be different.

If you have an simple, unmodified installation of WSRR, for example, if you have installed it on your workstation, then you can use the following steps to load the GovernanceEnablementProfile. If someone else owns and administers your WSRR installation, consult with them as to how they have configured it.

Perform the following steps:
1. Log in to WSRR using an administrator logon.
2. Switch to the Configuration Perspective by clicking to the right of the word Perspective at the top right corner of the browser and selecting Configuration, as shown in Figure 5-26.

3. Select Manage Profiles → Configuration Profiles.
4. In the Configuration Profiles window, click Load Configuration Profile.
5. Enter or browse to the Configuration item file GovernanceEnablementProfile_V70.zip. By default, this is located in the <WSRRInstall>\WSRR\config directory.

6. Enter a name for the Profile configuration item. We chose GovernanceEnablementProfile, as shown in Figure 5-27.

**Note:** In our installation, we tried naming the configuration item Governance Enablement Profile (with spaces), but had issues with this spelling. Your configuration might give different results.

![Figure 5-27 Loading the Configuration item](image)

7. Click **OK**. (The file might take some time to load.)
8. Review the Configuration Profiles window. If the Status is not Active, check the Select box next to the profile and click Make Active. The window should now look like Figure 5-28.

![Configuration Profiles window](image)

**Figure 5-28  Configuration Profiles with GovernanceEnablementProfile Active**

Creating classifiers for our services

In our example, we choose our services by using classifiers. This allows us to group our services as we see fit and to select them using names that we decide. We define the following classifiers:

- **ITSOMoviePartnerServices**: For all partner services
- **ITSO Movie Shipping Partners**: For those partners who provide shipping
- **ITSOShipping**: For all ITSOShipping services
- **ClipsAndTacksFreight**: For all ClipsAndTacksFreight services

**Note**: If you want, you can skip the creation of the classifiers by importing our classifiers from the .owl file supplied with the additional material of this book (see Appendix B, “Additional material” on page 747).

Perform the following steps:

1. If not already logged in, log in to WSRR as an administration user.
2. Ensure that the Configuration Perspective is selected.
3. Select **Active Profile → Classification Systems**.
4. If you have the default Classification set from the GovernanceEnablementProfile, you will see something similar to Figure 5-29.

![Figure 5-29](image1)

**Figure 5-29  The GovernanceEnablementProfile Classification Systems**

5. Click **New**. In the Classification system tab, enter http://com.ITSOMovie.PartnerServices into the URI field and enter ITSOMoviePartnerServices into the Name field, as shown in Figure 5-30.

![Figure 5-30](image2)

**Figure 5-30  Adding the ITSOMoviePartnerServices Classification**
Under our new classification system, we will define some classification classes:

g. Click the **Classes** tab.

h. Click **Add Root Class**. (Both of the Add Root Class buttons perform the same function.)

i. In the Class ID field, enter `http://com.ITSOMovie.PartnerServices.Shipping`; in the Name field, enter ITSO Movie Shipping Partners, as shown in Figure 5-31.

![Figure 5-31 Adding the new root class](image)

**Note:** The dialog box will, by default, have a # symbol at the end of the class ID field. Make sure that you remove this #, as the Class ID will need to match our search criteria exactly when we use it in our policies.

j. Click **OK**.
The window should now look like Figure 5-32.

![Classification system](image)

**Figure 5-32  The new root class added**

We have a root class for shipping services; we add our shipping partners as child classes underneath them:

k. Check the **Select** box next to ITSO Movie Shipping Partners and click **Add Child**. (Both Add Child buttons perform the same function.)

l. In the New Child Class window, type

m. Enter ITSOShipping into the Name field and click **OK**.
The window should now look like Figure 5-33. Note that ITSOSShipping is a child of the ITSO Movie Shipping Partners root class.

![Classification system](image1)

*Figure 5-33   ITSOSShipping as a child of shipping services*

n. Add another child to the ITSO Movie Shipping Partners root class. Enter http://com.ITSOMovie.PartnerServices.Shipping.ClipsAndTacksFreight into the Class ID field and ClipsAndTacksFreight into the Name field.

The classes should now appear as shown in Figure 5-34.

![Classification system](image2)

*Figure 5-34   The finished classes*
6. Click **Save and Commit**.

The ITSOMovie Classification System has now been created. Each of the classes has been assigned a unique URI so that we can reference them from Business Space and from our MFCs.

### 5.1.9 Importing the WebSphere Process Server artifacts into WebSphere Service Registry and Repository

Now that we have our classification system created in WSRR, we need to import our ITSOOrderMovie module and its associated services.

It might seem logical to also import the shipping services modules. We do not need to import them for two reasons:

- In real life, we will not have the module implementations of these services available to use as they are implemented by external partners. We will only have the WSDLs.
- The service definition WSDLs that we require are held in the `ITSOMovies_lib` library, which will be imported with the ITSOOrderMovie module.

#### Preparing to import the module

You can either use the our .ear file supplied with the additional material of this book, or you can export the ITSOOrderMovie module as an .ear file yourself from WebSphere Integration Developer.

#### Importing the module into WebSphere Service Registry and Repository

**Note:** If you experience issues when importing, or you want to make changes to your module and re-import it into WSRR, ensure that you do not end up with multiple unwanted versions. Consult the WSRR documentation to learn how to review and manage imported module versions.

Perform the following steps:

1. Log in to WSRR as an administrative user.
2. Set the Perspective to **Administrator**.
3. In the Load Documents section, either enter or browse to the location of the ITSOOrderMovieApp.ear file.
4. Ensure the document type is SCA Integration Module.
5. Enter ITSO Order Movie Module in the document description

6. Enter 1.0 in the document version field, as shown in Figure 5-35.

![Figure 5-35  Loading the ITSOOrderMovieApp .ear file](image)

7. Click **OK**. (This operation might take some time.)

The SCA Integration module, together with all of the services defined in it, is now loaded into WSRR. You might want to browse the WSRR GUI to ensure that all of the services you expect to see are loaded.

As this is a Business Space book, we will now leave the WSRR GUI and discuss using the Service Browser widget to check that the services exist in WSRR. If you want, you can now log out of WSRR.

**5.1.10 Browsing the services in Business Space**

We use Business Space to browse the services we have added to WSRR.

**Linking WebSphere Service Registry and Repository to the Business Space server**

To ensure that we can see the WSRR services from Business Space, we must ensure that the service registry is defined in the cell on which Business Space is running. If this is already set up, then skip to “Using the Service Browser widget to view the services” on page 269.
Perform the following steps:

1. Log in as an administrator to the Integrated Solutions Console (you might know this as the Administration Console) of the cell where Business Space is installed.

2. In the Service Integration section, click **WSRR definitions**, as shown in Figure 5-36.

![Figure 5-36 The WSRR definition link in the Integrated Solutions Console](image)

The WSRR definitions window is shown as in Figure 5-37. Note that in our screen capture, we already have the ITSOMovieWSRR definition configured. Also note that in our example that the ITSOMovieWSRR definition is configured as the default definition.

![Figure 5-37 The WSRR definitions in the Integrated Solutions Console](image)
If you do not have a WSRR definition already created, the steps to create one will vary depending on how your WSRR is installed and configured. We discuss how we configured our example, which uses a WSRR augmentation of the WebSphere Process Server profile in the WebSphere Integration Developer Integrated Test Environment (ITE).

Note: Our ITSOMovieWSRR definition is configured to be the default WSRR definition. When we create our SelectShipper mediation with the endpoint lookup and policy resolution primitives, we configure it to use the default WSRR definition.

If you want to use our examples with a WSRR definition that is not the default, you need to change the configuration of the primitives. This is discussed in “SelectShipper: Mediation Flow Component” on page 242.

Note: If you already have a WSRR definition, then you can use this definition as long as it is configured correctly. To test this configuration, check the Select check box and click Test connections. If your connection works, you can skip to “Using the Service Browser widget to view the services” on page 269. If your connection test does not work, some of the information below might help you troubleshoot the problem.

If you do not have a WSRR definition already created, the steps to create one will vary depending on how your WSRR is installed and configured. We discuss how we configured our example, which uses a WSRR augmentation of the WebSphere Process Server profile in the WebSphere Integration Developer Integrated Test Environment (ITE).
To create the WSRR definition, perform the following steps:

1. Either click **New** to create a new definition, or click the name of the definition to edit/review an existing definition. Figure 5-38 shows the WSRR definition window for our ITSOMovieWSRR connection.

   **Note:** If you are creating a new definition, rather than editing an existing definition, you will not see the Additional Properties section yet.

   ![WSRR definition window](Image)

   **Figure 5-38** The ITSOMovieWSRR connection

   We used the default connection type of Web service and entered a WSRR definition name and description. We also left the cache timeout at the default value of 300 seconds.
2. If you are creating a new WSRR definition, click **OK**. You will then be prompted with message informing you that a WSRR definition has been created. Click **Save** at the prompt. You should not need to restart your server. At this point, click the name of your new definition in the WSRR definitions list. You will see the window shown in Figure 5-38 on page 263, and you will now have the Additional Properties section visible.

3. In the Additional Properties section, click **Connection properties**.

You will see the window shown in Figure 5-39. This shows that the Connection type is Web service. The other fields depend on your configuration, which we discuss in the following sections.

![Figure 5-39 The ITSOMovieWSRR connection properties](image)

**Registry URL**

This is the location of the registry SDO port. It also indicates if the connection is http or https and what the host name and port are.
The default Registry URL is:


This URL points to a WSRR installation on the local machine (localhost) on an unsecured connection (http) using the default Web service port of 9080. The rest of the URL shows the Web service endpoint, which is the default for WSRR.

In Version 7, WebSphere Application Server has security set on by default and security should certainly be set on in a production environment. In this case, and in our examples, WSRR will have security switched on.

You should change the Registry URL to a secure one. You can accomplish this task by performing the following steps:

1. If you have security enabled on your WSRR server, change http to https to indicate a secure connection. Change the port from 9080 to 9443, which is the default secure Web Service Port. Our example URL, shown in Figure 5-39 on page 264 has security enabled and uses https.
Notes on connecting to WSRR: The port number might not be 9080 (http) or 9443 (https). If you have more than one WebSphere Application Server profile installed (for example, a WebSphere Enterprise Service Bus and a WebSphere Process Server profile in the WebSphere Integration Developer ITE), then the port number might be higher.

In our example, we have a WebSphere Business Monitor server installed as well as the WebSphere Process Server on which WSRR is running. As the WebSphere Business Monitor server has already used ports 9080 and 9443, our WSRR server is using 9444, as shown in Figure 5-39. For an http connection, it would use port 9081.

Your WSRR administrator might also have changed the port number and other connection details, so make certain that you have the correct connection URL.

If your WSRR is in a different cell than your WebSphere Process Server where Business Space is running, you might need to configure a secure connection by importing the WSRR certificate by performing these steps:

1. Change the URL from http:// to https://.
2. Import the WSRR certificate to the WebSphere Application Server running Business Space trust store by performing these steps:
   a. From the WebSphere Application Server Administration Console, select Security → SSL certificate and key management → Key stores and certificates.
   b. In the Key stores and certificates window, click NodeDefaultTrustStore.
   c. In the NodeDefaultTrustStore window, click Signer certificates under Additional properties.
   d. Click Retrieve from port and supply the following information:
      - Host: <<WSRR host name or IP address>>
      - Port: <<WSRR Secure port - normally 9443 or above>>
      - SSL configuration for outbound connection: NodeDefaultSSLSettings
      - Alias: wsrr_signer
   e. Click Retrieve signer information, then OK, and then Save.

3. If your WSRR server is not installed on your local machine, change localhost to the address of your WSRR server.
**Authentication alias**

The authentication alias carries the user ID and password for the WSRR server. In our example, as we are using the WebSphere Integration Developer ITE, we use the BPC_Auth_Alias so that we do not have to explicitly create a new one. If you are connecting to a different secure server, you need to create an authentication alias with the correct credentials by performing the following steps:

1. Click **JAAS - J2C authentication data**.
2. In the JAAS - J2C authentication data window, click **New**.
3. Enter an Alias name into the Alias field. Enter the user ID and password for the WSRR server. Enter a Description if you want. An example is shown in Figure 5-40.

![Figure 5-40  Creating an authentication alias](image)

4. Click **OK**.
5. Click **Save** to save the new Alias to the master configuration.
6. Click **Web service** to return to the Connection properties window.
7. Select your new alias in the Authentication alias drop-down menu.

**SSL configuration**

We used the default NodeDefaultSSLSettings to connect to the local WSRR server. If you have a different configuration, you will need to change this setting. Configuring SSL is a complex topic that we do not intend to cover in detail here, but the following notes might help you get started.
Click **SSL Configurations**, and then click your SSL configuration (in our example, **NodeDefaultSSLSettings**) or create a new one. You will see a window similar to Figure 5-41.

![SSL configuration window](image)

**Figure 5-41** The SSL configuration window

We used the NodeDefaultTrustStore and the NodeDefaultKeyStore as we used a local WSRR installed as a profile augmentation on the same server and node as our ITE WebSphere Process Server instance.

Our SSL Settings do not have any information stored in the Additional Properties section.
If you click **Key stores and certificates**, you can see where the NodeDefaultKeyStore and NodeDefaultTrustStore are held (Figure 5-42) in the Path column. If you want to use these keystores, it is worth remembering that the default password for both of these is WebAS.

![WSRR definitions](image)

**Figure 5-42   The SSL Key and Trust stores**

### Using the Service Browser widget to view the services

In this section, we open Business Space and view our services in the Service Browser widget.

**Note:** For details of the URL for Business Space, how to log in, and how to navigate spaces and pages, see Chapter 2, “Managing IBM Business Space powered by WebSphere V7” on page 17.

To accomplish this task, perform the following steps:

1. Log in to Business Space.
2. Go to the Service Administration space (Use the Go To Spaces menu) and click the **Service Administration** window. It should look like Figure 5-43. This window shows the Service Browser widget on the left and the Mediation Policy Administration widget on the right.

![The Service Administration window showing the Service Browser widget](image)

The Service Browser widget shown in Figure 5-44 shows the WSRR definition used (in our example, this is ITSOMovieWSRR; if you have more than one, you can select which one you want to use).

This is the WSRR definition that is defined in the Integrated Solutions Console that we discussed in “Linking WebSphere Service Registry and Repository to the Business Space server” on page 260.

![The Service Browser Widget](image)

The Service Browser widget also shows the services that we defined in WebSphere Integration Developer in “Web service ports and service names” on page 248 and imported to WSRR in 5.1.9, “Importing the WebSphere Process Server artifacts into WebSphere Service Registry and Repository” on page 259.

(Do not worry if the order of the services is not the same as those in our screen capture.)
3. Click the icon next to the service names to expand the service tree. Our example tree fully expanded looks like Figure 5-45. This shows the Mediation Policies, the services, the Web Service Ports, and the operations.

![Expanded Service Browser tree](image)

**Note:** If you change the service definitions in WSRR, click **Refresh** on the Service Browser widget to ensure that it re-reads the new WSRR definitions.

Now that we have our services loaded into WSRR and can see them in the Service Browser widget, we use the Module Browser and Mediation Policy Administration widgets to apply policies to our modules and change the endpoints for the shipping services.

### 5.1.11 Configuring the service endpoints using the Business Space widgets with WebSphere Service Registry and Repository policies

Let us quickly review the key components and configuration in our scenario:
We have two Web services, exposed by two providers: ITSOShipping and ClipsAndTacksFreight. These are provided in our two modules: ITSOShipping and ClipsAndTacksFreight.

Both of these services have the same interface (IOrderMovie) and provide the same service. The only difference is the service name and URL. We do not need to provide any mappings when changing from one service to another service.

We have a MFC called SelectShipper in the ITSOOrderMovie module. This component calls a Web service using the IOrderMovie interface.

Inside the SelectShipper MFC, we have two mediation primitives:

- **PolicyResolution**: This defines a module-scoped policy that is created in WSRR when the ITSOOrderMovie module is imported. It also defines two conditions:
  - Country: Using xpath /body/orderMovie/in/theater/address/country
  - Region: Using xpath /body/orderMovie/in/theater/address/region

- **Endpoint Lookup**: This returns the first matching endpoint from WSRR and sets that as the routing target. It uses a WSRR classification URL as a search criteria, which is defined as a promotable property. The promotable property name is Shipping.EndpointLookup.classifications.

So, what does this mean in practice?

**Understanding how the dynamic endpoint is calculated from WebSphere Service Registry and Repository by the MFC using policies and endpoint lookups**

Logically, the process of applying a policy goes like this:

1. Define the endpoints in WSRR.
2. Create a method of searching for the endpoints in WSRR. We can use properties or classifications. In our example, we use classifications.
3. Apply the classifications to the endpoints.
4. Ensure that the callout is configured to use a dynamic endpoint lookup.
5. Add an EndpointLookup primitive to the mediation. Define the endpoint search criteria using a classification URI. Make this classification URI a promoted property so that it can be changed.
6. Add a PolicyResolution primitive. This means that when the module is loaded into WSRR, the promoted properties appear in WSRR at the module level in a default policy. It also applies the policy in the MFC.
Chapter 5. Integration-centric business spaces

7. Load the module into WSRR. This creates the default policy and allows WSRR to use policies to override the promoted properties of the module.

8. Use Business Space to create policies and policy attachments for the module. The policy attachments will define what value WSRR will use to override the promoted property. When the policy attachments are applied, the value of the promoted property will come from the policy.

Let us now follow the endpoint resolution step by step as it happens in the run time of our example:

1. The OrderMovieProcess calls the SelectShipper MFC using the IOrderMovie interface. This happens over SCA in our example, although the transport here is not important.

2. The Service Message Object (SMO) arrives at the SelectShipper MFC through the IOrderByMovie interface.

3. The PolicyResolution primitive populates the Policy conditions (Country and Region) from the content of the SMO.

4. The PolicyResolution primitive makes WSRR use the currently applied policy to override the promoted properties of the module defined in the policy. In our case, the overridden property is the Classification URI for the SelectShipper MFC.

5. The EndpointLookup mediation has a promoted property of a Classification URI. The selected policy changes this promoted property to the value defined in the policy. This is where the policy makes the difference.

6. The EndpointLookup mediation uses the Classification URI to look up endpoints with that classification in WSRR.

7. WSRR returns the list of endpoints that have the requested Classification applied to them.

Note: Remember that the policy resolution primitive must come before the endpoint lookup in the mediation flow.
8. The EndpointLookup mediation chooses the first matching endpoint and makes the call to that endpoint.¹

9. The endpoint Web Service is called and the process continues as though the endpoint had been hardcoded.

**Applying classifiers to endpoints in WebSphere Service Registry and Repository**

We have our two Shipping service endpoints defined in the Service Browser widget tree (Figure 5-46). The services we are interested in are ClipsAndTacksFreightShippingService and ITSOShippingOrderMovieService.

![Service Browser](image)

Figure 5-46 The service browser showing ClipsAndTacksFreightShippingService and ITSOShippingOrderMovieService

¹ Strictly speaking, the EndpointLookup primitive populates the dynamic endpoint information in the SMO. The SMO is then passed to the Callout to IOrderMoviePartner primitive. As we have set the Use dynamic endpoint if set in the message header property to true, the Callout primitive reads the endpoint from the SMO and makes the call.
We need to apply classifiers to our endpoints so that we can search for the correct endpoint using the Classification URI that we set in our EndpointLookup primitive in the SelectShipper MFC.

These services are not the actual endpoints. The endpoints are the Web service ports, also shown in the Service Browser. The two Web service ports we need are:

- ClipsAndTacksFreightIOrderMovieExport_IOrderMovieHttpPort
- ITSOShippingIOrderMovieExport_IOrderMovieHttpPort

When we look up the endpoints, we do not use their names; we use WSRR classifiers to locate them, so we need to apply our classifiers to our Web service ports by performing the following steps:

1. Log in to WSRR and select the **Administrator** perspective.
2. Click **WSDL Services** in the Service Metadata section (Figure 5-47). We could go directly to WSDL Ports, but our WSDL services have more friendly names, so we will go through this route.

---

**Figure 5-47**  Selecting WSDL services in WebSphere Service Registry and Repository
3. The list of services is shown in Figure 5-48. Click **ITSOShippingOrderMovieService**.

![Figure 5-48 The list of WebSphere Service Registry and Repository WSDL Services](image)
4. The ITOSShippingOrderMovieService is shown as in Figure 5-49. We need the Web Service port, so, in the Relationships section, under Ports, click ITOSShippingIOrderMovieExport_IOrderMovieHttpPort.
5. The Port details are shown in Figure 5-50. Note that there might already be an Offline classifier defined. This is due to the Governance profile in WSRR, which we can ignore at this time. Do not worry if your WSRR does not show the Offline classifier. Click **Edit Classifications**.

![Figure 5-50 The Web Service Port details](image)
6. The Classifications window opens, as shown in Figure 5-51.

7. Expand fully the ITSOMoviePartnerServices Classification tree. Check the ITSOShipping check box and click Add >>> to add it to the classification list. Click OK.

8. The classification is now added to the port, as you can see in the Classifications section of the Port window.

9. Use a similar sequence of steps to apply the ClipsAndTacksFreight Classification to the ClipsAndTacksFreightIOrderMovieExport_IOrderMovieHttpPort WSDL port in the ClipsAndTacksFreightShippingService WSDL Service.

We now have our classifications applied to our endpoint Web service ports. The next thing we need to do is to create some policy attachments and apply them to the mediation.

Creating and applying policy attachments to the mediation
A policy contains details of what will be done to the module when it is applied; in our example, it changes the Classification URI used to search for the shipping service endpoint.
A policy attachment attaches a policy to a module. Multiple policies can be attached to a module at one time, as long as they do not conflict.

We use Business Space to create and apply policy attachments to the module. To accomplish this task, we need to use the Module Browser widget and the Mediation Policy Administration widgets.

**Note:** The Module Browser widget needs the modules to be deployed to a running WebSphere Process Server server or cluster before they are visible. You need to deploy the ITSOOrderMovie module before you can continue following our example. In our example, we also deploy the ClipsAndTacksFreight and ITSOShipping modules, as you can see from our screen captures.

In our example, we created a new Space named ITSMovie Policy in a window named ITSMovie Mediation Policy Management. This window has both the Module Browser and Mediation Policy Administration widgets placed in it (Figure 5-52). (If you need to know how to create a new Business Space window, see Chapter 2, “Managing IBM Business Space powered by WebSphere V7” on page 17.)

![Figure 5-52](image)

**Figure 5-52** The ITSMovie Mediation Policy Management window

Perform the following steps:

1. If you do not see the ITSOOrderMovie module, deploy the module to the server or cluster you are using and refresh the Module Browser widget.
2. Expand the **ITSOOrderMovie** module and select **Module Policies**.
The Module Browser widget sends a message to the Mediation Policy Administration widget, which then loads the Mediation Policy Attachment details from WSRR.

At the moment, we have no policy attachments, so the window looks like the one shown in Figure 5-53. Note that the Mediation Policy Administration Widget shows the Module name and the WSRR definition used; in our example, this is ITSOMovieWSRR, which is the default service registry defined for Business Space.

![Image of Module Browser and Mediation Policy Administration](image)

*Figure 5-53 The mediation policy attachments for ITSOMovie

We need to create a new policy attachment for our module. We first create one to always choose ITSOShipping as the shipping partner.
3. In the New policy attachment box, enter AlwaysChooseITSOShipping and click Create.

The Mediation Policy Administration widget displays the group name for this policy attachment. The Group name shown is the group name that applies to the promoted properties that this policy attachment will change. Our promoted property looks like Figure 5-54, so we can see that our group name is ITSOOrderMovie.SelectShipper.

![Figure 5-54](image) The endpoint lookup Classification URI promoted property with the group name
4. Our Mediation Policy Administration widget now looks like Figure 5-55 (note the matching group name).

![Image of Mediation Policy Administration window]

Figure 5-55 The Mediation Policy Administration window showing the promoted property group name

5. Click the group name **ITSOOrderMovie.SelectShipper**. It is important that the Group Name line is highlighted or you will not see an existing policy in the drop-down menu.

**Note:** If you do not see the group name, you might want to try clearing the service registry cache by clicking the **Clear all active caches** button in the Service Registries section of the Integrated Solution Console of your Business Space server.
6. If we click the **Use Existing** radio button and pull down the list, we can see the default policy that has been automatically created in WSRR (Figure 5-56). We will not use an existing policy; instead, we create a new one.

![Policy Selection](image)

*Figure 5-56 The default policy*

For our example, we create a new policy that always selects ITSOShipping as the shipping service endpoint provider.

7. Click the **Create new** radio button and enter SelectITSOShippingEndpoint for the name of the policy. Click **Next**.

The Mediation Policy Administration widget now displays as shown in Figure 5-57.

![Mediation Policy Administration](image)

*Figure 5-57 Adding an Assertion value to the policy*

You can see that the Policy attachment name, the Policy name, and the Module name are displayed to help ensure that you are in the right place. The window now prompts you to add assertions.
An assertion is what WSRR uses as the value to override the promoted property when a policy is applied. In our example, we have a promoted Property called ShippingEndpointLookup.Classifications in a group called ITSOOrderMovie.SelectShipper. We need to enter the value that we want to apply to this promoted property when our SelectITSOShippingEndpoint policy is applied.

In “Creating classifiers for our services” on page 254, we create a classification called ITSOShipping that had a classification URI of http://com.ITSOMovie.PartnerServices.Shipping.ITSOShipping. We then apply this classifier to our ITSOShipping service endpoint in “Applying classifiers to endpoints in WebSphere Service Registry and Repository” on page 274.

We need to enter our Classification URI for our ITSOShipping service into our assertion value.

Note: It is important that you enter the URI of the classification and not the classification name. The URI is a unique identifier, whereas the name is just a human readable description.


9. The assertion is added. Click Save.

At this point, especially if you are running everything on a single workstation and things could be running slowly, you might see some status messages to the effect that the policy is being created, and then that the new attachments are being loaded. This is Business Space communicating with WSRR.

The new policy attachment is now complete (Figure 5-58). This means that our SelectShipper mediation will now always choose ITSOShipping when this policy and attachment are in place.

Figure 5-58 The new AlwaysChooseITSOShipping Policy Attachment
5.1.12 Running the Order Movies scenario

In this section, we test the Order Movies scenario.

**Note:** This section assumes that you are familiar with WebSphere Integration Developer, WebSphere Process Server, and the Integrated Test Environment (ITE). Only high-level instructions will be given at the relevant points.

The modules that we use in this test are:
- ITSOOrderMovie
- ITSOShipping
- ClipsAndTacksFreight

These should now be deployed to your test server or cluster.

**Note:** In our example, we place all three modules into a Integration Solution named OrderMovieSolution. We run the test from the Solution view in WebSphere Integration Developer, as this actions allows us to trace the cross-module calls.

If you run the test from the assembly diagram, by default you will not see the traces for the other modules unless you explicitly configure them in the testing framework.

1. From the OrderMovieSolution solution diagram, start the test from the OrderMovieProcess BPEL component in the ITSOOrderMovie module (right-click the OrderMovieProcess component and click **Test Component**).
2. Ensure you are testing the IOrderMovie interface and the orderMovie Operation.
3. The solution requires certain fields to be populated. We used the values in our example shown in Table 5-2.

<table>
<thead>
<tr>
<th>Object path</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>quantity</td>
<td>1</td>
</tr>
<tr>
<td>theater/id</td>
<td>MyTheaterID</td>
</tr>
<tr>
<td>theater/name</td>
<td>MyTheaterName</td>
</tr>
<tr>
<td>theater/address/addressLine</td>
<td>MyAddress1</td>
</tr>
<tr>
<td>Object path</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>theater/address/city</td>
<td>Toronto</td>
</tr>
<tr>
<td>theater/address/postcode</td>
<td>MyPostcode</td>
</tr>
<tr>
<td>theater/address/country</td>
<td>Canada</td>
</tr>
<tr>
<td>theater/address/region</td>
<td>NORTHAMERICA</td>
</tr>
<tr>
<td>theater/numberOfScreens</td>
<td>1</td>
</tr>
<tr>
<td>theater/type</td>
<td>ITSOBIGSCREEN</td>
</tr>
<tr>
<td>movie/id</td>
<td>MyMovieID</td>
</tr>
<tr>
<td>movie/title</td>
<td>MyMovieTitle</td>
</tr>
<tr>
<td>movie/shortDescription</td>
<td>MyShortDesc</td>
</tr>
<tr>
<td>movie/longDescription</td>
<td>MyLongDesc</td>
</tr>
<tr>
<td>budgetMillionDollar</td>
<td>0</td>
</tr>
<tr>
<td>violenceIndicator</td>
<td>0</td>
</tr>
<tr>
<td>languageIndicator</td>
<td>0</td>
</tr>
<tr>
<td>sensualityIndicator</td>
<td>0</td>
</tr>
<tr>
<td>releaseDate</td>
<td>2010-02-24-0500</td>
</tr>
</tbody>
</table>
4. Start the test. Our Events window in the ITE is shown in Figure 5-59 on page 289.
Figure 5-59  Results of the test
We can see, in the event trace, that the ITSOShipping module was called, as defined in the policy and policy attachment that we created.

Some other useful things to note about the test trace:

- In the PolicyResolution trace, we see, in the context/dynamicProperty/propertySets[0] section, the names of the group and the properties that we are using.
- In the EndpointLookup trace, in the context/primitiveContext/EndpointLookupContext/EndpointLookupContext[0], we see the endpoint address in the endpoint reference. We also see the registryAnnotations section, which show us the classification details.

This policy and policy attachment calls ITSOShipping. We now need to change the policy attachment to call ClipsAndTacksFreight instead.

### 5.1.13 Changing the policy using Business Space and gate conditions

We delete the existing policy attachment, and add a new one to choose ClipsAndTacksFreight as the shipping service endpoint, but this time we also add a gate condition selection so that ClipsAndTacksFreight is only chosen for the region of NORTHAMERICA. We add another policy attachment that chooses ITSOShipping where the region is not NORTHAMERICA.

Gate conditions use the condition values that we defined in our PolicyResolution primitive in Figure 5-16 on page 243. We defined two conditions: Country and Region. We will use the Region condition in the following steps:

1. In the meditation Policy Administration widget, for the ITSOOrderMovie module, click the X to the right of the AlwaysChooseITSOShipping Policy Attachment. This deletes it. Click *OK* in the confirmation window.

   **Note:** This only deletes the policy attachment; it does not delete the policy itself.

2. In the New policy attachment field, enter ClipsAndTacksForNORTHAMERICA. Click *Create*.

3. Create a new policy called ClipsTacksNORTHAMERICA.

4. Add an assertion by entering the following URI:


   This is the URI of the classification of our ClipsAndTacksFreight shipping service.
5. In the Gate Conditions section, enter OnlyNorthAmerica in the Gate condition name field (so that it reads medGate_OnlyNorthAmerica) and enter a value of Region = NORTHAMERICA.

**Note:** The medGate_ name is only a name; the value field is where the condition is defined. Do not make the mistake of assuming that the medGate entry is the field name and the value is the value that corresponds to the field when the policy is applied.

Also, in our environment, it did not seem to make a difference whether you placed spaces or not on each side of the = sign.

6. Click **Add Gate Condition**. The resulting widget is shown in Figure 5-60.

![Figure 5-60  Adding the assertion and gate condition](image)

7. Click **Save** to save the policy and attachment.

The policy attachment and policy are created. We now create another policy and attachment to use ITSOShipping if the region is not NORTHAMERICA.

8. Create a new policy attachment named ITSOShippingEMEA_ASIA.

9. Create a new policy named ITSOShippingNonNorthAmerica.

10. Add an assertion of value


11. Add a gate condition of name NotNorthAmerica and value Region ! = NORTHAMERICA.
12. The widget should now look like the one shown in Figure 5-61.

*Note:* the != means ‘is not equal to’

**Figure 5-61** Adding the assertion and gate condition to choose ITSOShipping if the region is not North America
13. Click **Save** to save the policy and attachment.

You can now see that there are two policies attached to the ITSOOrderMovie module (Figure 5-62).

![Figure 5-62 The two policy attachments](image)

Now we need to test that our new policy attachments achieve the desired results.

### 5.1.14 Testing the scenario with gate condition policies

As with all good tests, we need to document our expected results up front:

- If the Region is NORTHAMERICA, the ClipsAndTacksFreight shipping service will be called.
- If the Region is EMEA or ASIA, the ITSOSShipping shipping service will be called.

We can use the same test data for both tests; we just need to change the region (and country and city, for consistency).

**Test1: Region=NORTHAMERICA**

Here we can use the same data as we did for the previous test (as shown in Table 5-2 on page 286):

1. Run the test, starting at the OrderMovieProcess component.
2. The results should look like Figure 5-63, showing that the ClipsAndTacksFreight Shipping service was called.

![Diagram of test results showing ClipsAndTacksFreight call](image)

*Figure 5-63  Test results showing that we called ClipsAndTacksFreight*
In our test output, we have tested while in the solution view, which shows the trace from the shipping provider module, so that you can verify which shipping partner was called. If you test from the assembly diagram, you can look at the logisticsProvider field in the ITSOMovieIShippingStatusExport trace to verify which partner was used, as shown in Figure 5-64.

**Test2: Region=EMEA**

For this test, we need to change the region to EMEA, so let us order a movie from London in the UK by performing the following steps:

1. Run the test, starting at the OrderMovieProcess component, but use the data in Table 5-3 (only the country, region, and city have changed from the previous test).

<table>
<thead>
<tr>
<th>Object path</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>quantity</td>
<td>1</td>
</tr>
<tr>
<td>theater/id</td>
<td>MyTheaterID</td>
</tr>
<tr>
<td>theater/name</td>
<td>MyTheaterName</td>
</tr>
</tbody>
</table>

(Table 5-3  Test data for TEST2 with a London, UK. EMEA destination)
<table>
<thead>
<tr>
<th>Object path</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>theater/address/addressLine</td>
<td>MyAddress1</td>
</tr>
<tr>
<td>theater/address/city</td>
<td>London</td>
</tr>
<tr>
<td>theater/address/postcode</td>
<td>MyPostcode</td>
</tr>
<tr>
<td>theater/address/country</td>
<td>UK</td>
</tr>
<tr>
<td>theater/address/region</td>
<td>EMEA</td>
</tr>
<tr>
<td>theater/numberOfScreens</td>
<td>1</td>
</tr>
<tr>
<td>theater/type</td>
<td>ITSOBIGSCREEN</td>
</tr>
<tr>
<td>movie/id</td>
<td>MyMovieID</td>
</tr>
<tr>
<td>movie/title</td>
<td>MyMovieTitle</td>
</tr>
<tr>
<td>movie/shortDescription</td>
<td>MyShortDesc</td>
</tr>
<tr>
<td>movie/longDescription</td>
<td>MyLongDesc</td>
</tr>
<tr>
<td>budgetMillionDollar</td>
<td>0</td>
</tr>
<tr>
<td>violenceIndicator</td>
<td>0</td>
</tr>
<tr>
<td>languageIndicator</td>
<td>0</td>
</tr>
<tr>
<td>sensualityIndicator</td>
<td>0</td>
</tr>
<tr>
<td>releaseDate</td>
<td>2010-02-24-0500</td>
</tr>
</tbody>
</table>

2. The results are shown in Figure 5-65 on page 297, showing that we have called the ITSOShipping shipping service.
Figure 5-65  Test results calling the ITSO Shipping shipping service
Summary
We have shown how to change the endpoint used for a service without changing the code by defining and applying policies and policy attachments to a module using Business Space.

We have also shown how to use Business Space to create and apply policies that choose different endpoints depending on the contents of the message.

5.2 WebSphere Enterprise Service Bus with Store and Forward managed by Business Space

This section describes how to use WebSphere Enterprise Service Bus and Business Space to create a Store and Forward solution.

5.2.1 Business scenario: Ticket sales

The ticket sales scenario is a very simple one:

- Ticket sales events are received from movie theaters by ITSO Movie.
- ITSO Movie wants to monitor the ticket sales using WebSphere Business Monitor, so it receives the sales data and then uses a mediation to send a Common Business Event (CBE) over CEI to WebSphere Business Monitor.

We create a generator module that creates and sends ticket sales events to the ticket sales module. We use the interface between the two modules to show how the WebSphere Enterprise Service Bus and WebSphere Process Server Store and Forward functionality can control requests to a service and how the Store and Forward state can be managed using Business Space.

This scenario is described more fully in Chapter 3, “Business scenario example” on page 57. The details of the monitoring are discussed in Chapter 7, “Activity monitoring business spaces” on page 363.

Note: Before you follow our example, load the project interchange file from the \TicketSales folder (this file can be found with the additional materials supplied with this book; refer to Appendix B, “Additional material” on page 747 for more information) into WebSphere Integration Developer. If you already have the OrderMovie modules loaded, the ITSOMovies_lib library is the same for both solutions.
5.2.2 Design notes: Things to consider when designing the integration

This is a very simple scenario, but demonstrates one of the key integration issues: What do you do if a service you want to call is unavailable?

What you do depends on your Service Level Agreement (SLA) and your business process, but in general, you have the following choices:

- Return a ‘service unavailable’ error to the caller.
- Catch the error and re-route the requests to an alternate service.
- Store the requests until the service is available again.

In our example, we use the last option. This is known in Business Space and WebSphere Enterprise Service Bus as Store and Forward.

It should be noted that Store and Forward is only available for requests that can be sent asynchronously. If you have a synchronous-only request, especially within a transaction, then Store and Forward might not be an option, as you (as the caller) have no control over when the target service will become available again.

5.2.3 Creating the interfaces and services

In a production environment, we store and govern the services we want to use within WSRR. For our simple example, we just create the interfaces using WebSphere Integration Developer.

We receive details of ticket sales through an interface called ITicketSales. The interface is a simple one-way interface and is defined in WebSphere Integration Developer, as shown in Figure 5-66.

![Figure 5-66 The ITicketSales interface](image)
The interface uses the business object ReportTicketSalesReq, which is shown in Figure 5-67. The Movie and Theater business object details are expanded fully in “What are the services and interfaces” on page 232.

As this is a one-way interface, and we connect to it over SCA, it is a candidate for Store and Forward when it is called asynchronously.

![Image of ReportTicketSalesReq business object]

**Figure 5-67  The ReportTicketSalesReq business object**

**Note:** The actual details of the interface and the fields are not important for this example; they are just listed for the sake of completeness.

### 5.2.4 Widgets used by the scenario

This scenario uses the widgets shown in this section.

**Store and Forward widget**

This widget provides an overview of any Store and Forward qualifiers deployed in the cell. It also allows the Store and Forward status to be changed from Store to Forward and vice-versa.
Store and Forward Details widget
This widget lists the details of a single service control point. We use the information from the Store and Forward widget to select which service point is displayed.

We create a page with both of these widgets so that we can use the wiring between them.

5.2.5 Design and implementation of the modules

Our solution consists of two modules:
- One to receive the ticket sales events and create CBE events for WebSphere Business Monitor
- One to generate ticket sales events, simulating theaters sending their ticket sales to ITSO Movie

The TicketSalesSolution solution diagram is shown in Figure 5-68. Both modules depend on the ITS0Movies_lib library.

The ITSOTicketSales Module
The ITSOTicketSales assembly diagram is shown in Figure 5-69.
It is a simple module that exports an SCA interface and then takes a message and emits a CBE over CEI. The flow is as shown in Figure 5-70.

![Figure 5-70 The ReportTicketSales MFC flow](image)

**The CreateTicketSalesEvents Module**
The CreateTicketSalesEvents assembly diagram is shown in Figure 5-71.

![Figure 5-71 The CreateTicketSalesEvents assembly diagram](image)

This module is purely a message generator that creates ticket sales events at random. It takes an input parameter for the number of ticket sales messages to generate and then uses a simple BPEL to loop around a Java class that generates the random events. The BPEL is shown in Figure 5-72.

![Figure 5-72 The TicketSalesGenerator BPEL](image)
The Store and Forward qualifier

The key part of this section is the use of the Store and Forward qualifier. We use the qualifier to allow us to stop and start the flow of events between our two modules by placing the qualifier on the SCA interface between them.

We placed our Store and Forward qualifier on the ITicketSales interface of the TicketSalesImport (Figure 5-73). Clicking the ‘I’ icon will open the window shown in Figure 5-74 on page 304.

Note: This section only requires WebSphere Enterprise Service Bus, but we use a BPEL process to show an easy to understand diagram, which requires WebSphere Process Server. The WebSphere Integration Developer ITE normally includes WebSphere Process Server, so this should not be a problem.

If you want to run this example on WebSphere Enterprise Service Bus, most of the random-movie-sales-generation logic is in a Java class that you can reuse in a mediation or your own Java logic.

The Store and Forward qualifier

The key part of this section is the use of the Store and Forward qualifier. We use the qualifier to allow us to stop and start the flow of events between our two modules by placing the qualifier on the SCA interface between them.

Note: This is not a very typical example of when to use the Store and Forward qualifier. As we have a one-way asynchronous call between the modules, the messages would queue up anyway if the target module is stopped. Typically, the Store and Forward qualifier would be used in a request/reply scenario with calls that would return a failure if the target was down.

As this section focuses on using Business Space to administer the qualifier, rather than the mechanics of Store and Forward itself, we have chosen to reuse this scenario simply to show Business Space viewing and changing the Store and Forward state.

We placed our Store and Forward qualifier on the ITicketSales interface of the TicketSalesImport (Figure 5-73). Clicking the ‘I’ icon will open the window shown in Figure 5-74 on page 304.
Now we have a Store and Forward qualifier applied to our solution, we need to use Business Space to administer it.

5.2.6 Using Business Space for Store and Forward management

In our example, we create a custom space for administering the Store and Forward qualifiers. This is for simplicity’s sake and to make our example more clear.

This book contains information about creating spaces and pages (see Chapter 2, “Managing IBM Business Space powered by WebSphere V7” on page 17), so we only describe the key details here.

The ITSOMovieStoreAndForward space

We create a space called ITSOMovieStoreAndForward. In this space, we create a page called StoreAndForwardManager. In this page, we add the Store and Forward and Store and Forward Details widgets.
Our Store and Forward Manager space is shown in Figure 5-75.

Note that we have already deployed our modules; you can see the CreateTicketSalesEvents module in Figure 5-75.
In the Store and Forward widget, you can see all of the service control points for any deployed modules that have Store and Forward qualifiers defined. The status can be either Store or Forward. Forward is the normal state, with events flowing through the interface. Store is used when the target is not available and allows WebSphere Enterprise Service Bus or WebSphere Process Server to store up the events ready for when the target is available again.

**Testing the solution with the Store and Forward functionality managed by Business Space**

To show the use of Business Space Store and Forward widgets, we run three tests:

- **Test1:** Ensure the solution works normally. We leave the qualifier unchanged from when we deploy the solution.
- **Test2:** Ensure the Store functionality works. We set the qualifier to Store and make sure events are not passed to the target.
- **Test3:** Ensure that stored events are forwarded after being stored. We change the Store qualifier to Forward and check that the stored events reach the target.

**Test1: Normal operation**

Perform the following steps:

1. Deploy the two modules `CreateTicketSalesEvents` and `ITSOTicketSales`.
2. Use the Store and Forward widget to ensure that the status of the ITSOMovieDefault service control point in the CreateTicketSalesEvents module is Forwarding.
3. Start the test client on the TicketSalesGenerator BPEL component of the CreateTicketSalesEvents module in the TicketSalesSolution solution diagram. We test at the solution diagram level, as it shows us traces over both modules.
4. Enter 2 as the numberOfTickets and start the test.
The Integration Test Client events are shown in Figure 5-76.

Figure 5-76  The results of Test1

In the event trace, we can see the BPEL loop running. We can also see the two messages being received by the ReportTicketSales module and the two EmitTicketSalesEvent events being sent.

**Note:** We ran our test from the solution diagram view so that our trace shows both modules. Performing this action makes it easy to see when each module is being called. If you test from the assembly diagram, you might need to configure monitors to show the cross-module calls.
**Test2: Enable the store functionality**

In normal usage, the store functionality will often be enabled automatically when the target system goes down. There are circumstances, however, for example, during scheduled downtime, when you might need to manually enable the store state. If you need to do that task, perform the following steps:

1. Using the Store and Forward widget, set the status of the ITSOMovieDefault service control point in the CreateTicketSalesEvents module to Storing. Do this by checking the **ITSOMovieDefault Service Control point** check box and clicking **Store**.

Now the status has changed to Storing and the Status icon has changed from a green arrow to a storage container (Figure 5-77).

![Figure 5-77 The Service Control point, now in a Storing state](image-url)
2. Run the test client again in the same way you did for Test1. The results in the events trace window as shown in Figure 5-78.

![Integration Test Client: CreateTicketSalesEvents_Test](image)

*Figure 5-78  Results of Test2*

We can see that the BPEL has run again and that we have two requests sent to TicketSalesImport, but this time the messages have not been sent to the target ITSOTicketSales module. This is because we have stored the messages at the service control point using Business Space to set the status to Store.

Do not shut down the test at this point, as we will use our stored messages in Test3.

**Test3: Reenable the Forward state**

Now that we have stored the messages, we need to reenable the forwarding and check that the stored messages reach their target.

Perform the following steps:

1. Use Business Space to reenable the Forward state. This time, use the Store and Forward details widget and click the **Forward** button. (This is just another way of changing the state; you can use the Store and Forward widget if you want.)
2. Check the Integration Test Client events. The stored messages have now been sent to the ITSOTicketSales module, as shown in Figure 5-79.

![Integration Test Client: CreateTicketSalesEvents_Test](image)

**Figure 5-79  Results of Test3**

**Summary**

We have shown how to use the Business Space Store and Forward widgets to view and manage the Store and Forward qualifier, showing how to place the qualifier into the Store state for scheduled maintenances of a target system and to revert to the Forward state when a target system becomes available again.
Dynamic business spaces

This chapter shows how to author adaptable business processes with IBM WebSphere Business Services Fabric and how to influence their runtime behavior. Additionally, it describes how to work with business rules in IBM Business Space powered by WebSphere V7.

This chapter addresses the following Business Space templates and widgets:

- Fabric Administration template
- Fabric Authoring template
- Fabric Process Agility template
- Business Rules widget

This chapter is divided into two main sections. The sections are targeted at two point of variability types a business process could have:

- The first one describes how to compose dynamic Business Applications with the help of WebSphere Business Services Fabric.
- The second section outlines the capabilities business rules offer in Business Space.
6.1 WebSphere Business Services Fabric

WebSphere Business Services Fabric leverages WebSphere Process Server by giving it the capability to dynamically assemble business processes. It consists of the tooling environment (Business Services Tool Pack) and a runtime component (Business Services Foundation Pack).

Business Services Tool Pack integrates into WebSphere Integration Developer. It gives IT developers the tooling environment called Composition Studio to develop the necessary runtime artifacts for WebSphere Business Services Fabric.

Business Services Foundation Pack extends WebSphere Process Server with a dynamic service binding engine called Dynamic Assembler. Based on a given business situation, Dynamic Assembler evaluates the best-suited variation of a Business Service to be chosen and executed. Additionally, it governs the modification of Business Service policies to adapt runtime behavior without needing to redeploy business processes.

WebSphere Business Services Fabric includes predefined Business Space templates. Business leaders and analysts create the core vocabulary, Business Services, Application or Business Service policies, and Business Applications at a high level. These artifacts will be used by IT developers to assemble adaptable Business Service-based business processes. In addition to the authoring capabilities, WebSphere Business Services Fabric provides a Business Space template that allows business users to change Business Service policies at run time.

Along with the core product, optional industry content packs offer prebuilt assets based on industry standards and frameworks that allow a quick-start to implement solutions based on these assets.

6.1.1 Business scenario: Release movie

The business scenario used for this chapter is ITSO Movie’s business process to release movies. ITSO Movie releases each movie produced through the following business process. Several steps need to be carried out until a movie is released in a country:

1. To start the release process, a business user enters all the movie information.
2. The Business Service Age Rating is used to get the age rating for the movie. This part of the release process is executed differently for each country.
3. After the age rating is determined, the movie's final approval is handled by a second Business Service called Final Approval. Based on the age rating returned by the former Business Process, the movie gets approved automatically or needs manual approval by an ITSO Movie representative.

Figure 6-1 shows the release movie business process.

![Figure 6-1 ITSO Movie's release movie business process](image)

The project interchange files used with this scenario are the following files. They are supplied in the additional materials accompanying this book (see Appendix B, “Additional material” on page 747 for more details):

- dynamicspaces.zip
- stubs.zip
- ITSOMovie_HTM.zip (This file is optional. You can learn more about the file in Chapter 4, “Human-centric business spaces” on page 77.)
- businessrules.zip (optional)
The project interchange files contain modules that serve as starting points for the steps described in the following sections.

6.1.2 WebSphere Business Services Fabric Business Space templates

WebSphere Business Services Fabric provides three predefined Business Space templates:

- Fabric Administration
- Fabric Authoring
- Fabric Process Agility

ITSO Movie has a Business Administrator named Brian Ali. He uses the Fabric Administration template to manage all WebSphere Business Services Fabric related Business Spaces and the artifacts created with these spaces.

ITSO Movie’s Business Analyst is Bob Allen. He uses the Fabric Authoring template shared by Brian Ali to author ITSO Movie’s Release Movie business processes.

Finally, when the Release Movie business process is deployed and running in production, the Business User Belinda Underhill adapts and tunes the business process with the Fabric Process Agility template.

Fabric Administration template

The Fabric Administration template is a governance and administration space for business administrators. It offers the widgets to manage changes and access artifacts created for WebSphere Business Services Fabric. It is the central management space for business administrators. The template is made up of the following pages (Figure 6-2).

- Business Service Lifecycle Management
- Governance
- Application Details
- Vocabulary Details
- Business Service Details

The user that works with the Fabric Administration space must be in the FabricAdministrators group.
**Business Service Lifecycle Management**

The Business Service Lifecycle Management space contains the Business Service Lifecycle Management widget. It shows all Business Applications, Business Services, and Vocabularies that are stored in the Business Service Repository. A business administrator can grant or revoke access to those artifacts by adding or removing spaces for them. Figure 6-3 shows the spaces that have access to the Business Application Release Movie.

![Figure 6-3](image)

*Figure 6-3  Grant and revoke access to WebSphere Business Services Fabric artifacts*

**Governance**

The Governance window contains the Change Set widget. This widget is used to work with change sets that contain all changes that should be approved. New change sets can be created and existing change sets can be submitted and approved or rejected.

**Application Details**

The Application Details window contains the Application Details widget. The business administrator can view detailed information about any Business Application but he cannot modify Business Applications.

**Vocabulary Details**

The Vocabulary Details window contains the Vocabulary Details widget, which allows the user to view details about vocabularies stored in the Business Service Repository.

**Business Service Details**

The Business Service Details window contains the widget Business Service Details to view details about Business Services.

All three detail windows give an overview of WebSphere Business Services Fabric artifacts for a business administrator.
**Fabric Authoring template**

The Fabric Authoring template is designed for a business analyst to author coarse grained Business Service based business processes. The template is comprised of multiple windows:

- Getting Started
- Governance
- Application Browser
- Application Detail
- Business Service Browser
- Business Service Detail
- Vocabulary Browser
- Vocabulary Detail
**Getting Started**

The Getting Started window contains the Getting Started with WebSphere Business Services Fabric Authoring widget. It outlines a quick overview of how to model business applications in Business Space. Figure 6-4 shows the content of the widget.

![Getting Started with WebSphere Business Services Fabric Authoring widget](image)

**Governance**

In contrast to the Governance window in the Fabric Administration space, the Governance widget here only offers read access to change sets. Change sets can be viewed but not approved and published.
**Application Browser**

The Application Browser window contains the Application Browser widget. It shows all Business Applications on which you are entitled to work. These can be Business Applications created by the logged in user or Business Applications the logged in user has been granted access to by the Business Administrator in the Fabric Administration template. Within this widget, new Business Applications can be created. By selecting a Business Application, the Application Detail window opens and displays detailed information about a Business Application.

**Application Detail**

The Application Detail window contains the Application Details widget. All information about a Business Application is displayed. The General section shows who created the Business Application and when it was created. Additionally, the Business Services section shows the overall application flow of Business Services used in the Business Application. A list of Business Application policies (these are business policies that apply to the entire application or to a Business Service used in this specific Business Application) is shown in the Application Policies section. A business analyst models the application flow on this page and creates or modifies Business Application policies.

**Business Service Browser**

The Business Service Browser window contains the Business Service Browser widget, which displays a list of available Business Services and allows the business analyst to create new Business Services. When selecting a specific Business Service, the Business Service Detail window opens.

**Business Service Detail**

The Business Service Detail window contains the Business Service Detail widget. It shows the properties of a Business Service in the Overview section, a list of Business Service policies that apply to the Business Service (Business Service Policies section), and all Business Service variations in the Business Service variations section. With this window, a business analyst can add and edit Business Service policies and work with Business Service variations.

**Vocabulary Browser**

The Vocabulary Browser window contains the Vocabulary Browser widget. This widget shows all available Vocabulary sets. A Business Analyst can create a new Vocabulary set within this page. To view details for a Vocabulary set, select the Vocabulary set and the Vocabulary Detail window opens.
Vocabulary Detail
The Vocabulary Detail window contains the Vocabulary Detail widget. It shows all vocabulary items that belong to the Vocabulary set. The vocabulary items are split into these categories:

- Channels
- Roles
- Business Concepts

The Vocabulary Detail widget allows a Business Analyst to add and modify vocabulary items.

Fabric Business Process Agility template
The Fabric Business Process Agility template gives a business user the capability to adapt business processes to changing needs and demands. He can make dynamic changes to Business Application policies to control the performance of a Business Application.

The Fabric Business Process Agility template is made up by the following windows:

- Business Policy Configuration
- Business Variable Configuration
- Governance

Business Policy Configuration
The Business Policy Configuration contains the Application Flow and Business Policies widgets. It empowers business users to change business policies for a specific Business Application / Business Service combination. In the Application Flow widget, a business user can select a Business Application and the application flow is displayed. The Business Policies widget reflects the selected Business Application and shows Application Policies for the entire Business Application or a specific Business Service if a Business Service is selected in the Service drop-down menu.

The Business Policies widget is designed to allow a business user to modify Application policies dynamically.

Business Variable Configuration
The Business Variable Configuration space contains the Business Variables widget. This widget shows a list of Business Variables and gives a user the capability to change them.
**Governance**

This widget is equal to the Governance window in the Fabric Authoring template. The Governance window shows a read-only list of change sets.

### 6.1.3 Create and share WebSphere Business Services Fabric spaces in Business Space

Now that we have presented an overview of the different templates offered by WebSphere Business Services Fabric, let us use them to implement the scenario for this chapter. As business administrator, Brian Ali needs to control user access to WebSphere Business Services Fabric spaces.

**Note:** The users used in this scenario can be created with the `addUsersAndGroups.jacl` script. Run the script as an admin user on your server to create the users if you have done so already:

```bash
wsadmin.bat -user <USER_NAME> -password <PASSWORD> -f <PATH_TO_ADDUSERSANDGROUPSJACL>
```

**Create Fabric Administration space**

Brian Ali needs a Fabric Administration space to have a global view on all objects created for WebSphere Business Services Fabric and to govern them. Additionally, Brian Ali manages access to WebSphere Business Services Fabric objects created in Business Space.

It is sufficient to have one Fabric Administration space for all administrative users.

**Note:** The business administrator that manages WebSphere Business Services Fabric artifacts and spaces in Business Space needs to be member of the FabricAdministrators group. Add Brian Ali to the FabricAdministrators group using the Integration Solution Console. You might need to create the group first.

If the user is not a member of the FabricAdministrators group, an error window will open when you are working with the Fabric Administration template, as shown in Figure 6-5 on page 321.
To create a Fabric Administration space (Figure 6-6), log in to Business space as Brian Ali (user id brianali) and perform the following steps:

1. Select **Actions → Create Space**.
2. Enter ITSO Movie Fabric Administration as the name of the space.
3. Click the **Create a new space using a template** radio button and select **Fabric Administration**.
4. You can select a specific space style and space icon or leave it as the default.
5. Click **Save**.

*Figure 6-5  Error window for users that are not members of the FabricAdministrators group*

*Figure 6-6  Create an administration space based on the Fabric Administration template*
Create Fabric Authoring and Fabric Business Process Agility spaces

Create a Fabric Authoring and Fabric Process Agility space for Bob Allen (ITSO Movie business analyst) and Belinda Underhill (ITSO Movie business user) by performing these steps:

1. Select **Actions** → **Create Space**.
2. Enter ITSO Movie Fabric Authoring as the name of the space.
3. Click the **Create a new space using a template** radio button and select **Fabric Authoring**.
4. You can select a specific space style and space icon or leave the default.
5. Click **Save**.
6. Select **Actions** → **Create Space**.
7. Enter ITSO Movie Fabric Business Process Agility as the name of the space.
8. Click the **Create a new space using a template** radio button and select **Fabric Business Process Agility**.
9. You can select a specific space style and space icon or leave it as the default.
10. Click **Save**.

Share Fabric Authoring and Fabric Business Process Agility spaces

To give Bob Allen and Belinda Underhill the capability to work on the spaces Brian Ali created, perform the following steps:

1. Click **Manage Spaces**.
2. The Space Manager window opens. Select **Actions** → **Share** for ITSO Movie Fabric Authoring.
3. Enter Bob in the search box and click the magnifier glass 🕵️.
4. Select **boballen** in the Search Results list and click **Add to Edit** to give him editor rights for the ITSO Movie Fabric Authoring space.
5. Click **Save**.

Repeat the steps for Belinda Underhill and the ITSO Movie Business Process Agility space. Click **Done**.
6.1.4 Authoring WebSphere Business Services Fabric artifacts in Business Space

Bob Allen, ITSO Movie's business analyst, uses the Fabric Authoring space to create the Business Application Release Movie. This is usually done with a bottom-up approach. Bob Allen starts modeling the business vocabulary, which is then used by the Business Services and business policies. Eventually, the Business Application Release Movie uses the Business Services in the application flow.

To start authoring WebSphere Business Services Fabric objects in Business Space, log in to Business Space as Bob Allen (user ID boballen).

Create a business vocabulary
First, a vocabulary needs to be created, as shown in Figure 6-7. It contains all the terms and concepts used for WebSphere Business Services Fabric.

![Create New Vocabulary Window](image)

Figure 6-7 Create vocabulary window
Perform the following steps:

1. Click **Go to Spaces** and click **ITSO Movie Fabric Authoring**.
2. Click **Start working with vocabularies** to open the Application Browser window.
3. In the Vocabulary Browser widget, select **Actions → New Vocabulary**.
4. Enter ITSO Movie Vocabulary as the name for the vocabulary.
5. Click the **Create new** radio button for the change set and enter ITSO Movie Change Set as the change set name.
   - All actions that will be done in the following steps will be reflected in this change set.
6. Click **OK**.
7. Click **ITSO Movie Vocabulary** to open the Vocabulary Detail window.

To share a vocabulary with other spaces, perform the following steps:

1. Click **Overview** in the General section.
2. Click **Edit**.
3. Select the radio button **Public** for Access.
4. Click **Save**.

The Business Application Release Movie contains the Business Services Age Rating and Final Approval. Bob Allen needs to create vocabulary items for these Business Services comprising input and output vocabulary items (of complex type) and vocabulary items used in business policies (of simple type).

Perform the following steps:

1. Create a channel.
   a. Click **Add** in the Channels section.
   b. Enter ITSO Standard Channel as name of the channel.
   c. Leave all other defaults and click **OK**.
2. Create the Country business concept.
   a. Click **Add** in the Business Concepts section.
   b. Enter Country as name of the business concept.
   c. Select **Set of Fixed Values (Enumeration)** in the Type drop-down menu.
   d. Leave all the other defaults as is and click **OK**.
3. Specify a list of possible values for the Country business concept.
      a. Click Edit.
   b. Under Values in the Concept Information section, specify the values shown in Table 6-1 and display the labels by clicking Click to set new value and Click to set new name.

   Table 6-1: Values for the Country business concept

<table>
<thead>
<tr>
<th>Value</th>
<th>Display label</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>United States of America</td>
</tr>
<tr>
<td>Canada</td>
<td>Canada</td>
</tr>
<tr>
<td>Germany</td>
<td>Germany</td>
</tr>
<tr>
<td>China</td>
<td>China</td>
</tr>
<tr>
<td>UK</td>
<td>United Kingdom</td>
</tr>
<tr>
<td>Egypt</td>
<td>Egypt</td>
</tr>
</tbody>
</table>

c. Click Save.

4. Create the Age Rating Request business concept.
   a. Click add in the Business Concepts section.
   b. Enter Age Rating Request as name of the business concept.
   c. Select Complex Object in the Type drop-down menu.
   d. Leave all the other defaults as is and click OK.

5. Create the Age Rating Response business concept.
   a. Click Add in the Business Concepts section.
   b. Enter Age Rating Response as the name of the business concept.
   c. Select Complex Object in the Type drop-down menu.
   d. Leave all the other defaults as is and click OK.

6. The Country business concept is part of Age Rating Request business concept. Establish this relationship by performing these steps:
   b. Click Edit.
   c. Click Add in the Relationships section.
   d. Click Click to set type in the column Relationship Type and select Has.
e. Click **Click to set name** in the column Relationship Name and enter hasCountry.

f. Click **Click to set cardinality** in the column Cardinality and select **Exactly one**.

g. Click **None selected, click to select** in the column Target Concept.

h. Select **Country** and click **OK**, as shown in Figure 6-8.

![Select Concept window](image)

**Figure 6-8 Select Concept window**

i. Click **Save**.

7. Create the Age Rating business concept.
   a. Click **Add** in the Business Concepts section.
   b. Enter Age Rating as the name of the business concept.
   c. Select **Set of Fixed Values (Enumeration)** in the Type drop-down menu.
   d. Leave all the other defaults as is and click **OK**.

8. Specify list of possible values for the Age Rating business concept.
   a. Select **Age Rating** in the Business Concepts section.
   a. Click **Edit**.
b. Under Values in the Concept Information section, specify the values shown in Table 6-2 and display labels by clicking **Click to set new value** and **Click to set new name**.

<table>
<thead>
<tr>
<th>Value</th>
<th>Display label</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>G - General Audiences</td>
</tr>
<tr>
<td>PG</td>
<td>PG - Parental Guidance Suggested</td>
</tr>
<tr>
<td>PG-13</td>
<td>PG-13 - Parents Strongly Cautioned</td>
</tr>
<tr>
<td>R</td>
<td>R - Restricted</td>
</tr>
<tr>
<td>NC-17</td>
<td>NC-17 - No one 17 and under admitted</td>
</tr>
</tbody>
</table>

c. Click **Save**.

9. Create the Final Approval Request business concept.
   a. Click **Add** in the Business Concepts section.
   b. Enter Final Approval Request as the name of the business concept.
   c. Select **Complex Object** in the Type drop-down menu.
   d. Leave all the other defaults as is and click **OK**.

10. Create The Final Approval Response business concept.
    a. Click **Add** in the Business Concepts section.
    b. Enter Final Approval Response as the name of the business concept.
    c. Select **Complex Object** in the Type drop-down menu.
    d. Leave all the other defaults as is and click **OK**.

11. The Age Rating business concept is part of the Final Approval Request business concept. Establish this relationship by performing the following steps:
    a. Click **Final Approval Request** in the Business Concepts section.
    b. Click **Edit**.
    c. Click **Add** in the Relationships section.
    d. Click **Click to set type** in the column Relationship Type and select **Has**.
    e. Click **Click to set name** in the column Relationship Name and enter hasAgeRating.
    f. Click **Click to set cardinality** in the column Cardinality and select **Exactly one**.
g. Click **None selected, click to select** in the Target Concept column.

h. Click **Age Rating** and click **OK**.

i. Click **Save**.

**Create Business Services**

After creating the vocabulary, create two Business Services Age Rating and Final Approval by performing these steps:

1. Click **Business Service Browser** in the Page tab.

2. In the Business Service Browser widget, select **Actions → New Business Service**.

3. Enter Age Rating as name for the first Business Service.

4. Leave all the other defaults as is and click **OK**.

5. Click **Age Rating**. The Business Service Detail window opens.

6. Click **Overview** in the Overview section and click **Edit**.

7. Click the **Public** radio button for Access.

8. Click **Add** in the Business Service Inputs and Outputs section.

9. Click **Click to set a name for this input or output** and enter in.

10. Click **Click to choose a business concept**.

11. Select **Age Rating Request** and click **OK**.

12. Click **Add** in the Business Service Inputs and Outputs section.

13. Click **Click to set a name for this input or output** and enter out.

14. Click **Click to choose a business concept**.

15. Select **Age Rating Response** and click **OK**.

16. Click **Input** and select **Output** in the drop-down menu.

17. Click **Save**.
The Age Rating Request and Age Rating Response business concepts are assigned as inputs and outputs of Business Service Age Rating. The Vocabulary Used section gets automatically updated and shows the name of the vocabulary used by the Business Service, as shown in Figure 6-9.

```
<table>
<thead>
<tr>
<th>General Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: Age Rating</td>
</tr>
<tr>
<td>Description: none</td>
</tr>
<tr>
<td>Tags: none</td>
</tr>
<tr>
<td>Access: Public</td>
</tr>
<tr>
<td>Created: Feb 19, 2010 5:47:46 PM by boballen</td>
</tr>
<tr>
<td>Last modified: Feb 19, 2010 5:54:31 PM by boballen</td>
</tr>
<tr>
<td>Status: Changes pending (change set: ITSO Move Change Set)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>External Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Business Service Inputs and Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>in Age Rating Request input</td>
</tr>
<tr>
<td>out Age Rating Response output</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vocabularies Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSO Movie Vocabulary</td>
</tr>
</tbody>
</table>
```

Figure 6-9  Business Service Age Rating details

The Business Service Age Rating behaves differently depending on the country for which the age rating should be evaluated. The following evaluation methods to rate the age for a movie are available (see Chapter 4, “Human-centric business spaces” on page 77 for more information).

- Voting
- Single-Person workflow
- Maximum percentage
- Collaboration
- Business Rules
- Escalation

Each variation is modeled as its own Business Service variation. You can set a variation by performing the following steps:

1. Click Add in the Business Service Variations section.
2. Enter Voting as name of the Business Service variation.

3. Leave all the other defaults as is and click **OK**.

Repeat steps 1 through 3 and be sure to enter Single-Person workflow, Maximum percentage, Collaboration, Business Rules and Escalation as the name of each Business Service variation.

After you complete these steps, you should have a list of six Business Service variations, as shown in Figure 6-10.

![Business Service Variations](image)

*Figure 6-10  Business Service Variations*

Repeat the steps to create a second Business Service Final Approval that has the properties shown in Table 6-3.

**Table 6-3 Properties for Business Service Final Approval**

<table>
<thead>
<tr>
<th><strong>Property name</strong></th>
<th><strong>Property value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Service name</td>
<td>Final Approval</td>
</tr>
<tr>
<td>Access</td>
<td>Public</td>
</tr>
<tr>
<td>Input name</td>
<td>in</td>
</tr>
<tr>
<td>Input business concept</td>
<td>Final Approval Request</td>
</tr>
<tr>
<td>Output name</td>
<td>out</td>
</tr>
<tr>
<td>Output business concept</td>
<td>Final Approval Response</td>
</tr>
</tbody>
</table>

The Business Service Final Approval has two Business Service variations:

- Approval by Human Task
- Automatic Approval

Create them by repeating the steps outlined above.
Create Business Service policies
Business Services behave differently based on the Business Service policies defined for them. Business Service policies define the default characteristics for a Business Service. They cannot be modified from within the Fabric Business Process Agility space. However, they might be overridden by Application policies that are adaptable at run time and specify the behavior of a Business Service for a specific Business Application.

**Business Service policies for Business Service Age Rating**
Because the Business Service Age Rating varies based on the country, Bob Allen now needs to model the decision logic for each country. Perform the following steps to specify which age rating method should be used for which country:

1. Select the **Age Rating** Business Service in the drop-down menu at the top of the Business Service Details widget.

1. Click **Add** in the Business Service Policies section.

2. Enter USA Age Rating as name for the Business Service policy.

3. Leave all the other defaults as is and click **OK**.

4. Click **USA Age Rating** in the Business Service Policies section and click **Edit**.

5. Specify the Business Service policy details. They are defined in a when-then syntax style, where when a business condition matches, then the specified business result happens. At the beginning, no logic is specified for the Business Service policy USA Age Rating (Figure 6-11).

![Policy Details](image)

*Figure 6-11  Policy details*
To specify the business logic, perform the following steps:

a. Specify the business condition (Figure 6-12).
   i. Click *(No conditions, click to add).*
   ii. Select *Country* in the Field Name drop-down menu.
   iii. Select *is equal to* in the Comparator drop-down menu.
   iv. Select *United States of America* in the Value drop-down menu.
   v. Click OK.
b. Specify the business result (Figure 6-13).
   i. Click *(No results, click to add).*
   ii. Select the *Select a process variation* radio button.
   iii. Select *Single-Person workflow* in the Service Variation drop-down menu.
   iv. Click **OK**.

![Create Result](image)

*Figure 6-13 Create a business result for a Business Service policy*

c. Click **Save**.
Repeat the steps to specify Business Service policies for the remaining five countries. Table 6-4 shows the properties for all six Business Service policies.

Table 6-4 Properties for Business Service policies

<table>
<thead>
<tr>
<th>Business Service policy name</th>
<th>Country</th>
<th>Business Service variation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canada Age Rating</td>
<td>Canada</td>
<td>Business Rules</td>
</tr>
<tr>
<td>Germany Age Rating</td>
<td>Germany</td>
<td>Escalation</td>
</tr>
<tr>
<td>China Age Rating</td>
<td>China</td>
<td>Voting</td>
</tr>
<tr>
<td>UK Age Rating</td>
<td>UK</td>
<td>Collaboration</td>
</tr>
<tr>
<td>Egypt Age Rating</td>
<td>Egypt</td>
<td>Maximum percentage</td>
</tr>
</tbody>
</table>

Create a Business Application
Model the Business Application Release Movie by performing the following steps;

1. Click Application Browser in the Page tab.
2. In the Business Application Browser widget, select Actions → New Application.
3. Enter Release Movie as the Business Application name.
4. Leave all the other defaults as is and click OK.
5. Click Release Movie. The Application Detail window opens.
6. Click Overview in the General section and click Edit.
7. Click the Public radio button for Access.
8. Click Save.
9. Model the application flow.
   a. Click Application Flow in the General section and click Edit.
   b. Click New to add a channel.
   c. Select ITSO Standard Channel and click OK.
   d. Click to add a Business Service.
   e. Select Age Rating and click OK.
   f. Click between the inserted Business Service and the end of the application flow to add a second Business Service.
   g. Select Final Approval and click OK.
   h. Click Save.
Create Application Policies

In addition to Business Service policies that model default behavior, Application Policies can be used to determine the behavior of a Business Service in a specific Business Application. Application Policies can be adapted at run time in the Fabric Business Process Agility space.

In this scenario, the modeled Application Policies define the behavior of the Final Approval Business Service. The Application Policies define which final approval type is necessary for each age rating (Table 6-5).

Table 6-5 Properties for Application policies

<table>
<thead>
<tr>
<th>Age rating</th>
<th>Final approval type</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Automatic Approval</td>
</tr>
<tr>
<td>PG</td>
<td>Automatic Approval</td>
</tr>
<tr>
<td>PG-13</td>
<td>Automatic Approval</td>
</tr>
<tr>
<td>R</td>
<td>Approval by Human Task</td>
</tr>
<tr>
<td>NC-17</td>
<td>Approval by Human Task</td>
</tr>
</tbody>
</table>

Create the Application Policies that apply to the Business Application Release Movie by performing these steps:

1. Click **Add** in the Application Policies section.
2. Enter Automatic Approval as the name for the Application Policy.
3. Select **Final Approval** in the Business Service drop-down menu.
4. Leave all the other defaults as is and click **OK**.
5. Click **Automatic Final Approval** in the Business Service Policies section and click **Edit**.
6. Specify the business conditions.
a. Click **(No conditions, click to add)**.
b. Select **Age Rating** in the Field Name drop-down menu.
c. Select **is equal to** in the Comparator drop-down menu.
d. Select **G - General Audiences** in the Value drop-down menu.
e. Click **OK**.
f. Hover over the created business condition and click **add** to its right to create a second condition on the same level.
g. Select **OR** in the Condition drop-down menu.
h. Select **Age Rating** in the Field Name drop-down menu.
i. Select **is equal to** in the Comparator drop-down menu.
j. Select **PG - Parental Guidance Suggested** in the Value drop-down menu.
k. Click **OK**.
l. Hover over the created business condition and click **add** to its right to create a third condition on the same level.
m. Select **OR** in the Condition drop-down menu.
n. Select **Age Rating** in the Field Name drop-down menu.
o. Select **is equal to** in the Comparator drop-down menu.
p. Select **PG-13 - Parents Strongly Cautioned** in the Value drop-down box.
q. Click **OK**.

7. Specify the business result.
   a. Click **(No results, click to add)**.
   b. Click the **Select a process variation** radio button.
   c. Select **Automatic Approval** in the Service Variation drop-down menu.
   d. Click **OK**.

8. Click **Save**.

Repeat the steps to add a second Application Policy called Approval by Human Task for the Business Service Final Approval with Age Rating of R - Restricted and or NC-17 - No one 17 and under admitted for the business condition and Approval by Human Task as Business Service variation for the business result.
Submit and publish a change set
After all the artifacts have been created in Business Space, they need to be published in the Business Service Repository. To do so, log in as ITSO Movie’s business administrator Brian Ali (user id brianali) and perform the following steps:

1. If the ITSO Movie Fabric Administration space is not opened, perform the following steps; otherwise, continue with step 2.
   a. Click **Go to Spaces**.
   b. Click **ITSO Movie Fabric Administration**.
2. Click **Governance** in the Page tab.
3. Click **ITSO Movie Change Set**.
4. Click **Submit Change Set**.
5. Enter “Initial Business Application is ok” in the Comment field and click **OK**.
6. Click **Approve Change Set**.
7. Click **OK**.
8. Click **Publish Change Set**.
9. Click **OK**.

All artifacts contained in the change set are now published in the Business Service Repository.

6.1.5 Assemble WebSphere Business Services Fabric artifacts in WebSphere Integration Developer

In the previous section, Bob Allen created a Business Application from a business analyst’s point of view. To get to deployable runtime module that exploits WebSphere Business Services Fabric’s capabilities, a solution developer from ITSO Movie (Simon Davies) needs to assemble the artifacts created by Bob Allen in Composition Studio in WebSphere Integration Developer.
Import the project interchange file `dynamicspaces.zip`, which is part of the additional materials that accompany this book (see Appendix B, “Additional material” on page 747). It contains a module for the implementation of the Business Application Release Movie called `ITSOMovieReleaseMovie_mod`. The module contains the SCA components, as shown in Figure 6-15.

![Assembly diagram for the ITSOMovieReleaseMovie_mod module](image)

**Figure 6-15** Assembly diagram for the ITSOMovieReleaseMovie_mod module

The ReleaseMovie business process corresponds to the Business Application Release Movie. It contains an invoke activity to call the Business Service Age Rating, which maps to the Dynamic Assembler SCA component `DAAgeRating`. It also has an activity to call the Business Service Final Approval, which corresponds to the Dynamic Assembler SCA component `DAFinalApproval`. Before invoking the Dynamic Assembler, two mediations extract context information from the message payload so that the Dynamic Assembler can decide which Business Service variation to invoke.

The two implementations for the Business Service variations for the Business Service Final Approval are implemented in this module as well. Import the `stubs.zip` project interchange file into WebSphere Integration Developer.

### Configure Business Service Repository for the Context Extractor mediation primitive

The artifacts modeled in Business Space need to be accessible from WebSphere Integration Developer. Configure the connection properties to the Business Service Repository by performing the following steps:

1. Select **Window** → **Preferences**.
2. Navigate to **Business Integration** → **Mediation Flow Editor** → **Context Extractor**.

**Note:** The user that is used to connect to the Business Service Repository needs to be in the FabricAdministrators group. ITSO Movie’s solution developer Simon Davies is used in this scenario to connect to the Business Service Repository. Add this user to the FabricAdministrators group.
3. Specify the connection properties to match to your server, as shown in Figure 6-16, and click **Update Vocabulary**.

![Figure 6-16 Business Service Repository connection properties](image)

4. Click **OK** to close the Update Vocabulary confirmation window (Figure 6-17).

![Figure 6-17 Update Vocabulary confirmation window](image)

5. Click **OK** to close the Preferences window.

**Note:** Every time new vocabulary items are modeled in Business Space, they should be accessible from the Context Extractor mediation primitive, so these steps need to be repeated.
Implement context extractors
A new functionality introduced with WebSphere Business Services Fabric V7 is the Context Extractor mediation primitive. It simplifies the extraction of information from the message request and makes it available for the Dynamic Assembler’s Business Service variation selection process.

To accomplish this task, perform the following steps:

1. Open the request flow for the ContextExtractorDAgeRating mediation (Figure 6-18), which is part of the module ITSMovieReleaseMovie_mod.

![Figure 6-18  Context extractor mediation request flow](image)

2. Select the **CtxExtractorAgeRating** mediation primitive.
3. Open the Details section in the Properties tab.
4. Click **Add** under Context Mappings.
5. Click Select and select the **Country** vocabulary term under ITSO Movie Vocabulary for the context key (Figure 6-19).

![Figure 6-19  Vocabulary Term Selection window](image)
6. Click **OK**.

7. Click **Edit**.

8. Specify the `/body/rateAge/in/releaseCountry` path for the context value path, as shown in Figure 6-20, and click **OK**.

![Simple XPath Expression Builder](image)

*Figure 6-20 Specify the context value path*

9. Click **Finish** and save your changes.

Repeat the steps with the second mediation (ContextExtractorDAFinalApproval). Specify the Age rating context key and the corresponding context value path `/body/approveMovieRelease/in/movie/countryRating[1]/ageRating`. 
Assemble the solution in Composition Studio
Simon Davies now needs to map the business artifacts to their IT representation to align the business and IT view.

Note: The user that is used to connect to the Business Service Repository needs to be in the FabricAdministrator or FabricStudioUser role for the WebSphere enterprise application Fabric_Tools. ITSO Movie's solution developer Simon Davies is used in this scenario to connect to the Business Service Repository. Map the user to the FabricStudioUser security role.

Additionally, if has not already been done, map Brian Ali to the FabricAdministrator security role.

To access WebSphere Business Services Fabric projects in WebSphere Integration Developer, the user used to replicate with the Business Services Repository needs to be part of the project team. To accomplish this task, perform the following steps:

1. Open the WebSphere Business Services Fabric administrative console and log in as Brian Ali (user ID brianali).
2. Select Governance Manager → Manage Teams → Create a Team to create a new team and add Simon Davies to it. Enter ITSO Movie Team and click Save.
3. Select Governance Manager → Manage User Accounts → Create a User to create a user for Simon Davies that maps to Simon Davies' WebSphere user ID.
4. Enter simondavies into the User ID field, Simon into the First Name field, Davies into the Last Name field, and simon.davies@itsomovie.com into the Email Address field. Add ITSO Movie Team to the list of Selected Teams and click Save.
5. Select Governance Manager → Manage Projects. Select Release Movie → Project Team. Select ITSO Movie Team in the Team drop-down menu and click Save. This action assigns the team as a project team for the Release Movie project, which was created when we create the Business Application Release Movie in Business Space.

Create Fabric project
To create the Create Fabric project, perform the following steps:

1. Switch to the Business Service perspective.
2. Select File → New → Project.
3. Select Business Services Fabric → Fabric Project.
4. Click **Next**.
5. Enter ITSOMovieReleaseMovie_fab as the project name.
6. Click **Next**.
7. Click **Configure**. If the connection properties are already specified, click **Update Project**.
8. Specify the connection properties. Use Simon Davies to connect the Business Service Repository to your server, as shown in Figure 6-21.
9. Click **OK**.

![Business Services Repository Connection window](image)

**Figure 6-21** Business Services Repository Connection window

**Note:** The replication process with the Business Services Repository might take some time.

10. Click **Next**.
11. Select **Release Movie** from the Fabric Project drop-down menu and click **Finish**.
Figure 6-22 shows all imported artifacts that belong to the Release Movie Business Application.

Figure 6-22   Imported artifacts

*Import a composite service*

To import a composite service, perform the following steps:

1. In the Business Application Browser, right-click **Composite Service**.
2. Select New → Composite Service. The window shown in Figure 6-23 opens.

![New Composite Service](image)

**Figure 6-23** Import composite service


4. Click Finish.

The composite service is created based on the selected SCA project. The following artifacts are imported:

- Composite service
  - ITSOMovieReleaseMovie_mod
- Dynamic assembly components
  - DAAgeRating
  - DAFinalApproval
- Service interfaces
  - IAgeRating
  - IReleaseMovie
  - IReleaseMovieFinalApproval
Endpoints
- ReleaseMovieExport
- ReleaseMovieFinalApprovalAutomaticallyExport
- ReleaseMovieFinalApprovalByHTExport

Map composite service to Business Application
Map the composite service to a Business Application in the opened composite service editor by performing the following steps:
1. Click the Business Application tab.
2. Click Maps to a Business Application Module.
3. Click Browse.
4. Click Release Movie and click OK.
5. Click Browse in the Business Service Mapping section for DAAgeRating.
6. Click Age Rating and click OK.
7. Click Browse in the Business Service Mapping section for DAFinalApproval.
8. Click Final Approval and click OK.
9. Click Browse in the Channel Mapping section for ReleaseMovieExport.
10. Click ITSO Standard Channel and click OK.
11. Save the changes.
Figure 6-24 shows the mapping to the Business Application Release movie.

![Composite Service](image)

**Create context specifications**

To specify the set of context information that the Dynamic Assembler uses at run time to evaluate the most suitable Business Service variation, a context specification needs to be created and attached to the dynamic assembly components.

To have access to the vocabulary items in Composition Studio, it might be necessary to add the corresponding namespace to the Release Movie Business Application. To accomplish this task, perform the following steps:

1. Open the WebSphere Business Services Fabric administrative console and select **Governance Manager → Configure Projects**.
2. Click **Release Movie** and click the **Namespaces** tab. Check if the namespace ITSO Movie Vocabulary (Business) appears in the Imported Namespaces list. If not, perform the following steps:
   a. Click **Import Namespaces** and select **Business Glossary** in the Project drop-down menu.
   b. Click **ITSO Movie Vocabulary (Business)** and click **Import Namespace**.
   c. In Composition Studio, right-click **ITSOMovieReleaseMovie_fab** and click **Update Project**.
   d. Click **ITSOMovieReleaseMovie_fab** in the Fabric Project drop-down menu and click **Finish**.

To create a context specification, perform the following steps:

1. In the Business Application Browser, right-click **Context Specification**.
2. Select **New → Context Specification**.
3. Click **ITSOMovieReleaseMovie_fab** in the Project drop-down menu. Enter **DAAgeRating_CS** in the Name field and click **Release Movie (Technical)** in the Namespace drop-down menu.
4. Click **Finish**.
5. The context specification editor opens. Click the **Dimensions** tab.
6. Click **Add** in the Vocabulary Dimensions section.
7. Click **Country** in the Matching Vocabulary Dimensions drop-down menu.
8. Click **OK**.
9. Save the changes.
10. Open the dynamic assembly component editor by double-clicking **DAAgeRating**.
11. Click **Browse** in the Dynamic Assembly Component section to browse for a context specification.
12. Select **DAAgeRating_CS** and click **OK**.
13. Save the changes.

Repeat the steps to create a second context specification called **DAFinalApproval_CS** for the Dynamic Assembly Component **DAFinalApproval**. Add the vocabulary dimension Age Rating to it and attach it to **DAFinalApproval**.
Create endpoints for Business Service variations

Create the implementation endpoints for each Business Service variation for the Business Service Age Rating authored in Business Space by Bob Allen before. Table 6-6 lists all required endpoints for the Business Service Age Rating.

Table 6-6   Endpoints for Business Service Age Rating

<table>
<thead>
<tr>
<th>Endpoint name</th>
<th>Address</th>
<th>Variation</th>
</tr>
</thead>
<tbody>
<tr>
<td>AgeRatingVoting</td>
<td>sca://ITSOMovieAgeRatingStubs_mod/VotingStubExport</td>
<td>Voting</td>
</tr>
<tr>
<td>AgeRatingSPWorkflow</td>
<td>sca://ITSOMovieAgeRatingStubs_mod/SinglePersonWorkflowStubExport</td>
<td>Single-Person workflow</td>
</tr>
<tr>
<td>AgeRatingMaxPercentage</td>
<td>sca://ITSOMovieAgeRatingStubs_mod/MaximumPercentageStubExport</td>
<td>Maximum percentage</td>
</tr>
<tr>
<td>AgeRatingCollaboration</td>
<td>sca://ITSOMovieAgeRatingStubs_mod/CollaborationStubExport</td>
<td>Collaboration</td>
</tr>
<tr>
<td>AgeRatingEscalation</td>
<td>sca://ITSOMovieAgeRatingStubs_mod/EscalationStubExport</td>
<td>Escalation</td>
</tr>
</tbody>
</table>

To create the endpoints, perform the following steps:

1. In the Business Application Browser, right-click **Endpoint**.
2. Select **New → Endpoint**.
3. Select **ITSOMovieReleaseMovie_fab** in the Project drop-down menu. Enter AgeRatingVoting in the Name field. Select **Release Movie (Technical)** in the Namespace drop-down menu and **SCA** in the Address drop-down menu.
4. Click **Next**.
5. Enter sca://ITSOMovieAgeRatingStubs_mod/VotingStubExport as the SCA Address.
6. Click **Finish**.
7. The endpoint editor opens. Click the **Interfaces** tab.
8. Click **Add Existing**.
9. Click **IAgeRate** and click **OK**.
10. Click the **Assertions** tab.
11. Click **Add**.
12. Click **Process Variation Assertion** and click **OK**.
13. Click **Required** in the Assertion Options section. Select **Age Rating** in the Business Services drop-down menu and select **Voting** in the Variations drop-down menu (Figure 6-25).

![Process Variation Assertion window](image)

Figure 6-25  Process Variation Assertion window

14. Click **OK**.

15. Save the changes.

Repeat the steps for the remaining five endpoints listed in Table 6-6 on page 349.

**Note:** The **stups.zip** project interchange file delivered with this book implement simple stubs for the endpoints. Alternatively, the **ITSOMovie_HTM** and **businessrules.zip** project interchange files provide more elaborate implementations. To use those endpoints, import and deploy the modules and modify the SCA address for each endpoint definition in the Protocol tab in Composition Studio according to the following structure:

```
sca://<ModuleName>/<ExportName>
```
The endpoints for the Business Service variations for the Business Service Final Approval were already imported when creating the composite service, so the SCA address is already entered. Attach the assertions to the endpoints listed in Table 6-7.

Table 6-7  Endpoint assertions for Final Approval Business Service variations

<table>
<thead>
<tr>
<th>Endpoint name</th>
<th>Variation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReleaseMovieFinalApprovalAutomaticallyExport</td>
<td>Automatic Approval</td>
</tr>
<tr>
<td>ReleaseMovieFinalApprovalAutomaticallyExport</td>
<td>Approval by Human Task</td>
</tr>
</tbody>
</table>

**Publish changes to Business Service Repository**

You must publish the changes to the Business Service Repository, which you can do by performing the following steps:

1. Right-click **ITSOMovieReleaseMovie_fab** in the Repository Changes view.
2. Click **Submit Change Set**.
3. Click **ITSOMovieReleaseMovie_fab** and click **Next**.
4. Click **Add All**.
5. Enter Release Movie - initial IT artifacts as Change Set Short Description.
6. Click **Finish** and confirm your choice by clicking **Yes**. If the status of the change set is not published, the change set needs to be approved by ITSO Movie’s business administrator Brian Ali. Click **OK**.

**Note:** When using the WebSphere Business Services Fabric WTE as a runtime environment, change sets get published automatically by default. To enable governed approval, set the name space binding wbsf.gov.skip to false in the Integration Solutions Console. It is set to false by default for the WebSphere Business Services Fabric Foundation Pack runtime environment.

If auto-publishing is not enabled, after submitting a change set, ITSO Movie’s business administrator Brian Ali (user ID brianali) needs to log in to ITSO Movie Fabric Administration space and approve the publication of the change set manually.

7. Right-click **ITSOMovieReleaseMovie_fab** in the Repository Changes view.
8. Click **Update Project**.
9. Select **ITSOMovieReleaseMovie_fab** and click **Finish**.
10. Click **OK**.
The Business Application is now ready for deployment. All artifacts for WebSphere Business Services Fabric have been modeled in Business Space from a business analyst’s point of view and aligned with the corresponding IT artifacts in Composition Studio. Deploy the modules ITSOMovieReleaseMovie_mod and ITSOMovieAgeRatingStubs_mod to the server and start an instance of the business process.

6.1.6 Adapt runtime behavior in Business Space

One of the main benefits of WebSphere Business Services Fabric is its ability to influence the performance of Business Applications at run time. Belinda Underhill, ITSO Movie’s business user and owner of the Business Application Release Movie, uses the Fabric Business Process Agility space to adapt and tune the Business Application.

In this scenario, Belinda Underhill wants to change the way how movies that are age rated as PG-13 and R are approved. ITSO Movie’s policy changes from automatic approval to manual human approval for PG-13 age rated movies and from manual human approval to automatic approval for movies that are age rated R - Restricted.

Before Belinda Underhill can perform the modifications, she needs to get access to the Business Application Release Movie.

Enable access to Business Application Release Movie
Access to WebSphere Business Services Fabric artifacts is controlled by the business administrator. Log in to Business Space as Brian Ali (user ID brianali) and perform the following steps:

1. Click Go to Spaces.
2. Click ITSO Movie Administration.
3. Click Business Service Lifecycle Management in the Page tab.
4. The Business Service Lifecycle Management widget shows a list of available WebSphere Business Services Fabric objects in the Business Service Repository, as shown in Figure 6-26.

![Business Service Lifecycle Management widget](image)

Figure 6-26 Business Service Lifecycle Management widget

5. Click **Release Movie**.
6. Click **Add Space**.
7. Select **ITSO Movie Business Process Agility** and click **Add**.
8. Click **OK**. The authorized spaces are updated (Figure 6-27).

![Authorized spaces for Business Application Release Movie](image)

Figure 6-27 Authorized spaces for Business Application Release Movie
Modify Application policies

Belinda Underhill now has access to the Business Application Release Movie and can modify its performance in Business Space because she has access to the ITSO Movie Business Process Agility space. Log in to Business Space as Belinda Underhill (user ID belindaunderhill) and perform the following steps:

1. Click Go to Spaces.
2. Click ITSO Movie Fabric Business Process Agility.
3. The Business Policy Configuration window opens and the Application Flow shows the application flow. Note the callout next to the Business Service Final Approval; it indicates that two Application Policies are attached to this Business Service in the Business Application Release Movie.
4. Click the callout to see a list of attached Application Policies, as shown in Figure 6-28.

![Figure 6-28 Callout showing the attached Application Policies](image)

5. Select Final Approval in the Service drop-down menu in the Business Policies widget.
6. Click Approval by Human Task in the Application Service Policy list and click Edit.
7. Enter PG-13 to HT changes in the Name field for the new change set and click OK.
8. Hover over the first line (where Age Rating is equal to R - Restricted) of the when section and click the pencil .
9. Select PG-13 - Parents Strongly Cautioned in the Value menu and click OK.
10. Click Save.
11. Click Automatic Final Approval in the Application Service Policy list and click Edit.
12. Hover over the third line (where OR Age Rating is equal to PG-13 - Parents Strongly Cautioned) of the when section and click the pencil.

13. Select **R - Restricted** in the Value menu and click **OK**.

14. Click **Save**.

The changes performed by Belinda Underhill need approval by ITSO Movie's business administrator to be published and make effective. To accomplish this task, perform the following steps:

1. Log in to Business Space as Brian Ali (user ID brianali).
2. Click the **Governance** tab in the ITSO Movie Fabric Administration space.
   The Change Set widget shows the change set that contains Belinda Underhill's Application policy modifications (Figure 6-29).

3. Click **Submit Change Set**.
4. Enter Everything ok in the Comments field and click **OK**.
5. Click **Approve Change Set**.
6. Click **OK**.
7. Click **Publish Change Set**.
8. Click **OK**.

---

*Figure 6-29* Change Set widget
The changes are now published and active for the Business Application. You could now run a next business process instance to see the modified behavior.

**Add a new Business Service variation**

Beside modifying existing Application Policies, another use case a Business Application benefits from when using WebSphere Business Services Fabric is to add an additional Business Service variation and make it available for the Dynamic Assembler endpoint selection algorithm without redeploying the business process.

This task cannot be done in the Fabric Business Process Agility space; it needs to be done within the Fabric Authoring space. The detailed steps are not explained here because they follow the steps outlined earlier in this book to create and assemble the WebSphere Business Services Fabric artifacts. Instead, a brief table of the necessary steps to add a new Business Service variation called 4-Eyes Rating to the Business Service Age Rating is listed below:

- Create a new Business Service variation called 4-Eyes Rating for Business Service Age Rating within the Fabric Authoring template (refer to “Create Business Services” on page 328).
- Modify the existing Business Service policy Canada Age Rating to use the Business Service variation 4-Eyes Rating instead of Business Rules within the Fabric Authoring template (refer to “Create Business Service policies” on page 331).
- Publish the changes.
- In WebSphere Integration Developer, create a new implementation for the 4-Eyes Rating Business Service variation implementing the interface IRateAge.
- In Composition Studio, create a new endpoint (called AgeRating4EyesRating) for the interface IRateAge. Add the process variation assertion 4-Eyes Rating and specify the SCA address (refer to “Create endpoints for Business Service variations” on page 349).
- Publish the changes.

From that point, the Business Application Release Movie uses the Business Service variant 4-Eyes Rating for the Business Service Age Rating when a movie is released in Canada.
6.2 WebSphere Process Server business rules

Business rules are part of the WebSphere Process Server. They allow you to model and configure business logic and decision points outside of business processes. There are two types of rule logic.

- Rule sets
- Decision tables

Rule sets offer the capability to design the logic in an if-then syntax and the logic can be based on business rule templates with parameters that can be changed at run time. Decision tables allow business logic in table-based style to be designed, specifying conditions in cells and having the result in a bottom row.

6.2.1 Business scenario: Age Rating

This section uses the same business scenario used in Chapter 4, “Human-centric business spaces” on page 77. Instead of having human-centric age rating business processes for a movies, business rules are used to determine the age rating.

The businessrules.zip project interchange file provided with this book is used for this section. It contains the ITSOMovieAgeRatingBusinessRules_mod module, which contains the AgeRatingRuleGroup rule group SCA component, as shown in Figure 6-30.

Figure 6-30  Assembly diagram for module ITSOMovieAgeRatingBusinessRules_mod

Import the businessrules.zip project interchange file. The rule group AgeRatingRuleGroup consists of two rule sets:

- RateAgeViolenceRuleSet
- RateAgeLanguageSensualityRuleSet
RateAgeViolenceRuleSet is the default rule logic active in 2010 and RateAgeLanguageSensualityRuleSet is active in 2011 (Figure 6-31).

**Figure 6-31** AgeRatingRuleGroup rule group

### 6.2.2 Working with business rules in Business Space

The Business Rules widget only allows users to work with rule sets based on templates. Decision tables are not included in this widget.

Deploy the ITSOMovieAgeRatingBusinessRules_mod module and log in to Business Space as Belinda Underhill (user ID belindaunderhill) to work with the Business Rules widget.

Perform the following steps:

1. Select **Actions → Create Space**.
2. Enter ITSO Movie Business Rules as the name of the space.
3. Click the **Create a new space using a template** radio button and select **Blank** in the drop-down menu. You may select a specific style and icon or leave the defaults. Click **Save**.
4. The new space is created with a blank page Page 1. Click **Edit Page** and drag the Business Rules widget to the page.
5. Click **Save** and **Finish Editing**.
The Business Space widget shows the AgeRatingRuleGroup rule group with the two rule sets, as shown in Figure 6-32.

Figure 6-32  Rule group in the Business Rules widget
To show details for a specific rule set, click its name. The right part of the widgets then shows detailed information about the business rules used in the rule set (Figure 6-33).

**Figure 6-33  Business rule details for a rule set**
When you click **Details**, detailed information about a rule set is displayed, as shown in Figure 6-34. If a schedule for a rule set is specified, it is displayed as well.

Belinda Underhill now wants to lower the limit for a movie age rated PG. To modify the template parameters in the business rules used in the rule set, perform the following steps:

1. Click **RateAgeViolenceRuleSet** in the Business Rules widget.
2. Click **Rules**. All changeable parameters for each business rule are highlighted in blue. Click 20 on the second business rule from the top to modify the lower limit for a movie age rated PG.
3. A number input field is shown in Figure 6-35.

Enter 10 as the value.

4. Click **Save**.

The business rule is now updated with the modified value.
**Note:** When uninstalling an enterprise application that contains business rules, the server does not delete the business rules from the repository. They are still accessible from the Business Rules widget. To delete business rules from the repository, refer to the information found at the following address:

Activity monitoring business spaces

This chapter discusses the two main types of activity monitoring: Business Monitoring and Service and System Health Monitoring. It describes the widgets that come with IBM WebSphere Business Monitor, their leading practices, and how activity monitoring was implemented for ITSO Movie. It contains the following sections:

- Events
- Business Monitoring
  - Business Monitor widgets
  - ITSO Movie scenarios
- Service and System Health Monitoring
7.1 Events

Events are the method of communication between any monitoring-enabled application and WebSphere Business Monitor. A monitoring-enabled application generates a series of events that are carried by the Common Event Infrastructure (CEI) and delivered to WebSphere Business Monitor, which receives and extracts required information from the events and updates the business measures metrics defined in the monitor model.

Each event in the monitor model refers to a particular event definition that defines its structure. Event definitions can be defined as:

- Common Base Event (CBE)
- XML Schema Definition (XSD)
- Web Services Description Language (WSDL) files

In Version 6.0.2, WebSphere Business Monitor could monitor only one type of event, the Common Base Event. In later versions, WebSphere Business Monitor can monitor XSD events as well as Common Base Events. The XSD type is a generic XML Schema Definition.

WSDL files can contain embedded XML schemas within the WSDL types section, and the types in these schemas can be referenced as event definitions by events emitted by Business Execution Process Language (BPEL) processes and other WebSphere Process Server components.

To create different event definition files, use the following editors:

- For Common Base Event files, the default editor in IBM WebSphere Integration Developer is the event definition editor. The default editor in IBM Rational® Application Developer is the text editor.
- For XSD files, the default editor is the XML schema editor.
- For WSDL files, the default editor in WebSphere Integration Developer is the interface editor. The default editor in Rational Application Developer is the WSDL editor.

7.1.1 When to use CBE versus XSD events

If you are creating a new application, you might prefer to use XSD event definitions. XSD definitions are more robust than Common Base Event definitions.
If you want the outbound event to be received by the action services in WebSphere Business Monitor and to generate an alert in the dashboards, the event must contain an extended data element named BusinessSituationName with a corresponding value. A default Common Base Event named ActionServicesEvent with the required BusinessSituationName element is provided for you. Because event definition can be a mixture of Common Base Event and XSD types, use the provided Common Base Event and also add one or more event parts in XSD format.

**Leading practice**

In an XSD file, you should create an element declaration along with a data type definition, and use the element declaration as the event part data type in the Monitor Model editor. Figure 7-1 shows ReportTicketSalesReq.xsd in the XML schema editor. Notice how an element declaration named ticksales has been created, and assigned the complex type ReportTicketSalesReq.

![ReportTicketSalesReq.xsd](image)

*Figure 7-1  ReportTicketSalesReq.xsd*
Figure 7-2 shows how you might select this type as the data type for an event part. Notice that two constructs from the XSD file are displayed in the window and are available for selection. However, if you select the element declaration, the path attribute of the event part can be inferred by the Monitor Model editor and completed for you.

![Select Event Part Data Type](image)

Figure 7-2  Selecting the event part

7.2 Business monitoring

Business monitoring solutions are used to give an indication of the overall health of an organization with regards to various key performance indicators and business measures. These could be the number of items delivered on time, the average turn over rate, the average time to handle a call, and so on.

In order for organizations to change quickly and dynamically to account for a new market strategy, detect potential problems before they occur, and identify opportunities, access to both real-time and historical data is of the utmost importance.
Business monitoring attempts to collect relevant events by which it can aggregate the event data in order to present real-time, role-based information. This information is then shown in dashboards.

By monitoring business events, existing business processes can be improved. The continual process of measuring and analyzing business processes is crucial to optimizing the efficiency of an organization and defining potential areas for cost-cutting. This can be the case, for example, in identifying areas of the business that require large amounts of manpower but account for only a small percentage of overall revenue.

It is also essential to account for the different user roles that exist in any organization when designing a business monitoring solution. This affects your modelling and dashboard design. When roles in an organization are taken into account, it allows quick and effective action to be taken by delivering what is needed to the person who has the authority to act on it.

You should generally account for the following roles:

- **Business leaders and line of business (LOB) managers:** Users in this role are responsible for ensuring that the organization meets its targets and fulfills its business mission. They usually need to have access to both analytical and operational data. They are interested in drilling down to pinpoint the root of problems, generating reports, and defining their own KPIs and alerts on the fly.

- **BPM experts and business analysts:** Users in this role are responsible for making sure that business processes are as efficient as possible by identifying potential areas of improvement in the business processes deployed across the organization. They require access to reports, KPIs, and dimensional analysis widgets with the ability to drill down. They also require access to specific instance data.

- **Operational staff:** These users represent the bulk of the users in any organization. They can be split up into either process users or IT experts.
  - **Process users:** These users use the solution on a daily basis. They can claim and work on human tasks, receive alerts, transfer human tasks, and view KPIs. Users of this role generally do not need access to historical data.
  - **IT Experts:** These users are interested in viewing the actual monitored data. This aids them in managing the IT infrastructure in a way that aids the organization in achieving its goals.
IBM has a large portfolio of different products that can be used for business monitoring based on your specific requirements. This products are:

- Cognos: This product delivers the complete range of Business Intelligence (BI) capabilities using a single service-oriented architecture (SOA). Users can capture and manage multiple hierarchies, structures, and definitions in a centralized store for use across performance management applications.

- WebSphere Business Monitor: This product is a comprehensive Business Activity Monitoring system that offers real-time insight into business processes. It provides users with real-time, end-to-end views of business process performance via customizable dashboards, portals, and mobile devices. It also provides users with historical analysis and prediction capabilities and allows users to create their own KPIs and alerts.

- Lombardi: Lombardi Blueprint provides simple Web-based authoring for business users, allowing them to define their processes. Lombardi Teamworks provides extensive levels of caching to optimize runtime performance. Process execution is dynamic, evaluating each step and transition within the process diagram in real time.

- WebSphere Business Events: This product allows users to define and manage business events. It enables business users to detect, evaluate, and respond effectively to events or patterns of events. It provides powerful correlation capabilities and can effectively process high volumes of events generated by disparate systems.

For this chapter, we focus on using WebSphere Business Monitor as our business activity monitoring platform.

### 7.2.1 Business Monitor widgets

WebSphere Business Monitor comes with a set of easily integrated widgets that aim to decrease the time to deploy and use WebSphere Business Monitor in your environment. WebSphere Business Monitor widgets fall into one of three categories:

- Operational widgets
- Analytical widgets
- Configuration widgets

Operational widgets are concerned with displaying the current state of the business operations in the organization. Having that data in near real time is crucial to the success of the organization.
Analytical widgets attempt to analyze historical data from which conclusions can be made as to how to improve the current business processes. Furthermore, predictions can also be made based on the historical data.

Operational widgets in WebSphere Business Monitor are represented by:
- The Instances widget
- The KPIs widget
- The Alerts widget
- The Diagrams widget
- The Human Tasks widget

Analytical widgets in WebSphere Business Monitor are represented by:
- The Dimensions widget
- The Reports widget
- The History and Prediction widget

Configuration widgets in WebSphere Business Monitor are represented by:
- The KPI Manager widget
- The Alerts Manager widget
- The Export Values widget

**Instances widget**
The Instances widget is the lowest level of the operational widgets, from which you can see the data for specific instances of a monitoring context along with its related metrics. This can be configured so that only a subset of the metrics are shown, a time or data filter is applied, certain columns can be formatted, and so on.

The Instances widget is commonly used in the following scenarios:
- As a target widget in which you can show the details of specific instance(s).
- To view the descendant information of child monitoring contexts from the parent monitoring context.
- To view monitoring context instances for a specific monitor model version.
- To export the data in the instances view to a CSV file.
From the view mode, you can view the instance data. You can also search within the data from the search text box at the top of the widget, as shown in Figure 7-3. It is also possible to search within a specific field only by clicking the plus sign beside the Search for label and then using the drop-down menu that shows the list of fields you can search by.

![Instances widget in view mode showing search criteria](image)

You can also export the data in the Instances widget as a CSV file by performing these steps:

1. Click **Export**. You are then prompted to choose whether to export the current page or all the pages with the ability to specify a maximum number of instances to export.

2. Set your export criteria and click **OK**.

3. Save the generated CSV file.
In Edit mode, the configuration is split into five main tabs, as shown in Figure 7-4.

![Instances widget configuration](image)

*Figure 7-4   Instances widget configuration*

**Show/Hide tab**

This tab allows you to specify which monitor models the Instances widget should display. You also specify which metrics should be displayed for that monitor model with the number of rows to display and the refresh rate in seconds.

**Filter tab**

This tab allows you to define filters to apply to the monitoring context instances so that only a subset is displayed. Two types of filters can be applied:

- Data filters
- Time filters

Data filters can be applied to the metrics of the monitor model that are to be displayed in the widget. Any number of data filters can be added and the results are AND-ed from all of the filters.

Time filters can also be added and can take on one of four behaviors:

- Last completed or current period: Used to view data of a specific length, which can be a year, a quarter, a month, or a day. You must also select whether to evaluate data for the last completed full period or for the period in progress.
- Sliding interval: Used to view data over a period of years, months, days, hours, and minutes, which moves continuously based upon the period you specify.
- Fixed interval: Used to view data of a single time period. You specify a start date and an end date.
An Instances widget can have only one time filter.

**Note:** When events are passed to the Instances widget in order to display specific instances (for example, show instances from a Dimensions widget), the filters defined in the instances widget are not applied.

**Sort tab**
This tab allows you to define which metrics to use to sort the displayed data.

**Format tab**
This tab allows you to define formatting for number metrics. This allows you to define the decimal precision and any currency symbol that should be applied.

**Wiring tab**
This tab allows the Instances widget to emit events.

**KPIs widget**
The KPIs widget displays the key performance indicators (KPIs) defined in your monitor model using a variety of different visual indicators (gauges, bars, tables, and so on).

The KPI widget is typically used when:

- You need to convey aggregated data in a quick and easy to understand manner.
- You need to show where the current state of a certain aspect of the organization is with respect to its target state or within certain ranges.
- You need to display data from multiple models in the same widget.
From the view mode, you can see the different values for the different KPIs. For KPIs of particular interest, you can show instances by clicking the menu icon at the top right of the KPI, as shown in Figure 7-5, and then click Show Instances, or by clicking the show instances icon if the widget is in tabular form. Similarly, you can show the History and Prediction and alerts configuration options for that KPI.

Figure 7-5  KPI widget with menu options

In the edit/configuration mode, the widget is split into three tabs:

- KPIs
- Layout
- Wiring

**KPIs tab**
This tab allows you to define which KPIs should be shown in the widget. These can be KPIs from different monitor models or from different versions of the same monitor model.

**Layout tab**
This tab allows you to define the visual representation of the KPIs (gauges, half gauges, bars, or tables) and their size and orientation. From this tab, you can also define the refresh interval for the widget.

**Wiring tab**
This tab allows you to enable this widget to send events.
**Alerts widget**

The Alerts widget displays alert notifications of predefined business situations. These alerts can be sent to a dashboard, pager, cell phone, or e-mail address. A predefined business situation is a situation of particular interest that should elicit an action from one of the system users to take the necessary corrective action. There are two ways a user can receive an alert:

- By model design
- By subscription (during run time)

The Alerts widget is used when:

- You need to display alerts to users in the dashboards based on certain business situations.
- Users need to be able to manage their alerts and forward them.

From the view mode, a user can view the alerts that he has received. The user can then proceed to click the alert of interest and be presented with a window with the details of the alert. Once a user has seen the alert details, it is marked as read, as shown in Figure 7-6.

From the view mode, a user can also mark an alert as read/unread, remove the alert, or forward it to another user. This could be the case for a manager who would like to be notified of certain business events, and then decide on delegating or forwarding it to other employees so that they can act on it.

![Figure 7-6  Alerts widget showing four alerts, two of which have been read](image)

The edit/configuration is split up into two tabs:

- Format
- Wiring
Format tab
From this tab, you can set the colors for read and unread alerts, limit the number of rows to display, and specify the refresh rate, as shown in Figure 7-7.

![Figure 7-7 Alerts Widget configuration](image)

Wiring tab
This tab allows you to enable this widget to send events.

Diagrams widget
The Diagrams widget allows you to show information visually, with cues that represent the status of the process. A diagram can be associated either with a KPI or a monitoring context. In order to use the Diagrams widget, your monitor model should have a visualization element defined in it based on an SVG diagram.
The Diagrams widget is used when you need to display process related information visually (for example, a flow chart diagram data related to a map).

In the configuration mode, users can specify which monitoring context or KPI context to use. They can also specify the refresh rate for the widget and enable widget wiring.

**Human Tasks widget**

The Human Tasks widget displays human task instances. These can be inline human tasks or stand-alone human tasks. Users use this widget in order to claim and work on their tasks.

The Human Tasks widget is used in the following scenarios:

- You need to provide users with the ability to work on and delegate their assigned tasks.
- You need to view the properties of all available human tasks.
- You need to view all available human tasks events for different models.

From the view mode, users can see a list of human tasks. They can then proceed to claim, release, transfer, or assign a task. All these functions are accessed by selecting the human task you want to work on, and then clicking **Actions** and selecting the action you want from the menu, as shown in Figure 7-8.

![Human Tasks widget](image)

**Figure 7-8  Human Tasks widget**

---

**Note:** You will need to have an SVG viewer installed. If your system does not have one installed, you can download Adobe®’s SVG viewer from the following address:

http://www.adobe.com/svg/
In the edit/configuration mode, the widget is split into four main tabs (Show/Hide, Filter, Sort, and Advanced), as shown in Figure 7-9.

![Human Tasks widget configuration](image)

**Figure 7-9  Human Tasks widget configuration**

**Show/Hide tab**
This tab allows you to specify which attributes of the human tasks to show, the refresh rate for the widget, and the number of rows to display per page.

**Filter**
This tab allows you to define data and time filters to be applied so as to show only a subset of the human tasks. You can have multiple data filters, but you can only have one time filter.

**Sort**
This tab allows you to define the sorting order for the human tasks.

**Advanced**
This tab allows you to define the connectivity details for the WebSphere Process Server hosting your business process choreographer. In order to do so, you need to specify the WebSphere Process Server host name and RMI port.
Dimensions widget
The Dimensions widget displays data in tabular and chart forms. It is one of the most powerful widgets, providing you with the ability to drill down using multiple dimensions in order to better understand key aspects of your business performance.

A dimension is a grouping criteria used to collectively refer to a set of data. For example, a dimension on a sales model can be geography, with multiple levels representing the hierarchy for this data. Level one would be region, level two would be country, level three would be city, and so on.

Here are some scenarios that use the Dimensions widget:
- You need to provide the user with the ability to drill down and “slice and dice” the data so as to reach the root cause of problems.
- You need to provide users with charts to indicate certain aspects of the business.
- You need to provide data in an aggregated and summarized form.
- You need to allow the drilling down on multiple dimensions.
- You need to allow users to export the data as PDF or Excel files.

**Note:** In order to use the Dimensions widget, you must have Alphablox® installed and correctly configured.

In view mode, users can drill down in the displayed data by double-clicking the corresponding area of the chart. If there are multiple dimensions, the user is prompted to choose which dimension to drill down. Furthermore, users can export the current state as either a PDF file or as a Microsoft® Excel file.

Users can also view details of specific instances by right-clicking the cell and then clicking **Show instances**. The details of the instances will show in the instances widget.
The type of chart can also be changed by selecting **Chart → Types** and selecting the type required. Users can also pivot row dimensions to column dimensions and vice versa, as shown in Figure 7-10.

*Figure 7-10  Dimensions widget*
In edit mode, users specify how they want to view their data by specifying the row and column dimensions. The page dimension adds a drop-down menu to the diagram that allows user to restrict the data to the values set in that drop-down menu, as shown in Figure 7-11.

![Figure 7-11 Dimensions Widget configuration](image-url)
Reports widget
The Reports widget is very similar to the Dimensions widget in that it too allows the user to drill down in order to see the data at varying degrees of granularity. However, reports add the concept of time, where data can be viewed relative to a time frame. Furthermore, using reports, you can export the data as PDF or Excel files.

Note: In order to use the Reports widget, you must have Alphablox installed and correctly configured.

Here are some scenarios that use the Reports widget:
▶ Users need to view data in graphical form relative to a certain time frame.
▶ Users need to be able to drill down on the data and see specific instances.
▶ Users need to generate and export reports in PDF or Excel formats.

In the view mode, users can drill down on the dimension they have configured. Being a report, time is implicitly a dimension. This allows users to inspect data according to a time frame of their choosing. Users can also change the type of chart, or pivot data so that the pivoted row becomes a column or vice versa. From the File menu, users can also export the data and chart.

In the edit mode, users define the measure(s) which they want to analyze and the time frame and the dimension on which they want to drill down. They also select an analysis type (which we discuss later) and the frequency to display the data points.

Note: You can only define one dimension in a report.

History and Prediction widget
The History and Prediction widget displays historical values for KPIs in graphical format. Furthermore, based on different prediction models, predictions can be made and plotted on the graph indicating what the future values might be.

Viewing historical data for KPIs can be enabled either during run time or during the design of the monitor model itself.

A snapshot is taken of the values for KPIs with history enabled every hour and persisted to the database. You can manage the KPI History calculation service from Monitor Scheduled Services in the Integrated Solutions Console.
Here are some scenarios where the History and Prediction widget is used:

- Users need to view historical trends of certain KPIs.
- Users need to be able to predict the future performance of certain KPIs.
- Users need to proactively address business situations by defining alerts based on predicted values.
- Users need to define their own time frame and granularity for a KPI’s history.

In the view mode, users can change the time frame and granularity for the points plotted. Users can also view the prediction by clicking **Prediction**, as long as prediction is enabled for this KPI. Figure 7-12 shows the historical data, denoted by the blue line, the target value, denoted by the black line, and the prediction, denoted by the orange dots. The ranges are shown by the different colors for the graph's background.

![Figure 7-12   KPI History and Prediction widget with historical and predicted data](image-url)
Furthermore, users can view the actual data used to plot the graph, as shown in Figure 7-13, by clicking **Show data table**.

![Figure 7-13  Data table for the history and prediction widget](image)

History and prediction can be enabled from the KPI Manager or during monitor model development.
In edit mode, users are presented with two tabs (KPI and History and Prediction), as shown in Figure 7-14.

![Figure 7-14 History and Prediction widget configuration](image)

**KPI**

This tab allows users to choose which KPI to display in the widget. Users can also specify if they need to have values for this KPI from all versions or only from the latest monitor model version.

**History and Prediction**

This tab allows users to choose the prediction model to apply and whether to show prediction points by default or not. Users can also choose the default granularity and time zone and specify the height of the chart area.
Alert Manager widget

The Alert Manager widget enables users to configure their own alerts during run time. This allows them to define new alerts, subscribe to existing ones, and specify how you should receive the notification. You can manage the alert service from Monitor Scheduled Services in the Integrated Solutions Console.

Scenarios where the Alerts Manager widget is used:

- You need to allow users to define and share alerts during run time.
- You need to allow users to subscribe to alerts at run time.
- You need to allow users to manage how they receive alerts during run time.

The Alerts Manager widget has only one state, which is the view state. You can see a list of alerts that you can manage, as shown in Figure 7-15.

![Figure 7-15 Alerts Manager widget displaying the number of alerts a user can configure](Image)
From this window, a user can subscribe to new alerts or modify how he receives the alerts. Furthermore, a user can create a new alert and share it with other users by performing these steps:

1. Click **New Alert** at the top right corner of the widget. The New Alert window opens, as shown in Figure 7-16.

![Figure 7-16  The Create New Alert window](image)

2. From the Conditions tab, specify the situation that should trigger the alert and how often should it be checked. Click the **Alert Content** tab. In this tab, you have the ability to define your own content that might be of relevance to the business situation raising the alert. Click the **Notifications** tab. In this tab, you can define how you want receive this alert. If you have enabled this alert for sharing from the first tab, you will be able to add users to the alert in this step.

3. Click **OK**.
KPI Manager widget
The KPI Manager allows users to manage KPIs during run time. From the KPI Manager, users can create new KPIs, copy existing ones, create alerts for KPIs, and enable history and prediction for a KPI. The KPI Manager is shown in Figure 7-17 with a list of our scenario example KPIs that the user can modify.

![KPI Manager](image)

Figure 7-17 KPI Manager with list of KPIs that the user can manage

Scenarios when the KPI Manager widget is used:
▶ You need to allow users to define their own KPIs at run time.
▶ You need to give users the ability to modify KPIs to which they have access.

Similar to the Alerts Manager, the KPI Manager has only one state, which is a view state. In this state, you can carry out all the aforementioned tasks by accessing the widget actions menu by clicking **Actions**.
When creating a new aggregate KPI from the actions menu, you are presented with five tabs, as shown in Figure 7-18.

![New Aggregate KPI Properties](image)

**Name**
This tab allows you to enter a name and specify whether this KPI is personal or shared. A personal KPI cannot be seen by anyone else other than the owner. A shared KPI is available to all users.

**Definition**
This tab allows you to define the aggregation function to use, which metric should be used to calculate this KPI, and any data filters you might need.

**Range**
This tab allows you to define the ranges and target value for this KPI.

**Other**
This tab allows you to specify decimal precision, currency symbol, and so on.

**Preview tab**
This tab allows you to see how your KPI would appear in a window.
Export Values widget
The Export Values widget allows you to export, as an XML file, the monitored value for metrics and KPIs defined with the trackingKey attribute. This XML can then be re-imported into WebSphere Business Modeler to update the model with actual monitored values, enabling the analyst to pinpoint potential areas of improvement in the business processes.

The Export Values widget has only one mode, which is the view mode. In this mode, users can choose the model from which they want to export the data. They can also select to export data either from all the versions or the current version only and apply a time filter. The Export Values widget is shown in Figure 7-19.

![Export Values widget](image)

Figure 7-19   Export Values widget

7.2.2 Business scenario: ITSO Ticket Sales Monitoring

For this scenario, ITSO Movie would like to keep track of ticket sales in order to enhance their operations and predict market changes. ITSO Movie would like to have advanced analytical capabilities so that they can correlate ticket sales figures with other attributes, such as the geography (which country generated the most revenue, which city in that country, and so on), the types of theaters, whether regular screen theaters or 3D theaters generate more revenue, and other factors.
The design of the monitoring solution will be centered around two main axes:

- An operational axis
- An analytical axis

You need to log in to Business Space with a user who has administrator credentials. The Ticket Sales scenario is more geared towards the analytical axes, so we discuss only the analytical part of the ticket sales module. The order handling module focuses on the operational axes.
**Note:** We will not discuss the actual monitor model development, as it is outside the scope of this book. We assume that the monitor model was previously developed and only the related Business Space aspects and tasks will be discussed.

The monitor models are available for download from the additional material provided with this book (see Appendix B, “Additional material” on page 747). You need to deploy the monitor models to your WebSphere Business Monitor instance before you can follow our example.

To follow the widget examples, you also need to generate some ticket sales and to order some movies using the modules provided.

For the ticket sales scenario, in order to generate the ticket sales events, you need to deploy the following items:

- ITSOTicketSalesApp: A mediation module
- ITSOMovieTicketSalesMMApplication: The monitor model
- CreateTicketSalesEventsApp: A Ticket Sales generator

After you have deployed these items, log into the Business Process Choreographer and perform the following steps:

1. Click **Currently Valid**.
2. Click **TicketSalesGenerator**.
3. Click **Start Instance**.
4. Enter the number of tickets you want to generate and click **Submit**.

For the Order Movie scenario, you need to deploy the following items:

- ClipsAndTacksFreightApp: A BPEL process
- ITSOShippingApp: A BPEL process
- ITSOOrderMovieApp: A BPEL process
- ITSOMovieOrderTrackingMMApplication: A monitor model

After you have deployed these items, log into the Business Process Choreographer and start instances of the OrderMovieProcess.

You also need to change the Web Service Ports to match the ports on your server.
Create the business space

To create the business space, perform the following steps:

1. Log in to an WebSphere Business Monitor Business Space with the credentials for an administrator.

2. Select **Actions → Create Space**.

3. Enter ITSO Ticket Sales Business Space in the Space name field.

4. Select a theme for your business space. If you have created the ITSO Movie Theme in Chapter 2, “Managing IBM Business Space powered by WebSphere V7” on page 17, select that theme as the Space style.

5. Select an icon for the new space.

6. Click **Save**.

Figure 7-20 shows the Create Space window.

![Create Space Window](image)

**Figure 7-20 Creating the ITSO Ticket Sales business space**

Share the business space

To share the business space, perform the following steps:

1. Click **Manage Spaces**.

2. In the Space Manager, select **Actions → Share** for the ITSO Ticket Sales space.

3. Change the search scope to **Group search**.

4. Enter ITSOMovie in the search input to display a list of all ITSO related groups.
5. Select **ITSOMovieBusinessAnalysts** and **ITSOMovieCountryManagers**. (If you cannot see the full group name in the window, hover the mouse over the name to view it.)

6. Click **Add to Edit**. Both groups should now be added to the editors list, as shown in Figure 7-21.

**Leading practice:** Share business spaces and pages with groups rather than individual users.

*Figure 7-21*  *Sharing ITSO Ticket Sales business space with groups*
7. Click **Save**.
8. Click **Done**.

**Creating pages**
After creating the business space and sharing it with the target audience, the next step is to create the pages for the ITSO Ticket Sales business space. The creation of the ITSO Ticket Sales business space has already created the first page (page1). We will need to rename this page to host the operational widgets and create a second page to host the analytical widgets.

**Rename page1**
To rename page1, perform the following steps:
1. Open the page menu by clicking the action button, which is the arrow beside the page name on the page tab.
2. Click **Edit Settings**.
3. Enter Operational View in the page name field.
4. Click **Save**.

**Create the analytical page**
To create the analytical page, perform the following steps:
1. Click **Manage Spaces**.
2. Click **Actions** → **Create Page** for the ITSO Ticket Sales business space.
3. Enter Analytical View into the Page name field and This page contains the analytical widgets for ITSO Ticket Sales in the Page description field, as shown in Figure 7-22.

![Figure 7-22 Creating the analytical page](image)

4. Click **OK**.

5. Click **Done**.

You have now created the basic structure for the ITSO Ticket Sales business space and shared it with users registered as business analysts and managers.

**Adding widgets to the Analytical page**

The Analytical page is more concerned with the analysis of historical data rather than showing real-time scorecards representing the overall health of the organization. Users expect analytical pages to be very flexible in the sense that they would like to view data across different axes, change the time frame for the data they are viewing, and inspect instances of particular interest.
Three different types of widgets are used in this page to provide the aforementioned functionality:

- The Dimensions widget
- The Reports widget
- The KPI History and Prediction widget

**Note:** You should generate some instance data before configuring the diagrams and reports widgets using the TicketSalesGenerator.

Before adding the widgets to the analytical page, we need to configure monitor data security so that the users can access the monitor model. To accomplish this task, perform the following steps:

1. Log into the Integrated Solutions Console.
2. Select **Security → Monitor Data Security → root**.
3. Select **ITSOMovieTicketSalesMM**.
4. Select **KPI Administrator**.
5. Click **Users**.
6. Search for and add your business space administrator.
7. Click **OK**.
8. Click **Personal-KPI-Administrator**.
9. Click **Groups**.
10. Search for and add **ITSOMovieBusinessAnalysts** and **ITSOMovieCountryManagers**.

**Note:** In order to find these two groups, you have to run the `addUsersAndGroups.jacl` script provided with this book.

11. Click **OK** twice.

**Note:** For information regarding the different KPI user roles, refer to the relevant Information Center at the following address:

Adding the Dimensions widgets

For the Dimensions widgets on the Analytical page, ITSO Movie would like to have the ability to analyze revenue based on location and movie details. They would also like to analyze the amount of tickets sold by violence indicator and theater details. Based on this scenario, we can conclude that the Dimensions widget is the widget most suitable to fulfill the requirements, as it is the only widget capable of multidimensional analysis. We create the widget for revenue analysis by location and movie details first, and then create the widget for ticket sales by age rating and theater details.

Perform the following steps:

1. Navigate to the Analytical View page and click Edit Page.
2. Drag and drop the Dimensions widget from the widget palette.
3. Click the widget menu icon and select **Edit Settings**.

The dimensions configuration window is displayed, as shown in Figure 7-23. Here you will be able to define your rows, columns, and page dimensions. A list of the dimensions and measures defined in the monitor model is displayed under Available Dimensions.

![Dimensional widget configuration window](image)

**Figure 7-23** Dimensional widget configuration window

4. Select the ticket sales monitor model (ensure you select **All Versions**).
5. Select **Movie Dimension** and **Measures** and add them as Row dimensions.

6. Select **Location** and add it as a Column dimension.

   **Tip:** Modelling dimensions can sometimes be quite complicated. An easy way to identify your measures and dimensions is as follows:

   *Function measure group by dimensions*

7. Click **OK**. You should now be presented with the Dimensions widget, as shown in Figure 7-24. The monitor model has defined three measures in this cube; however, we are only interested in one, that is, the revenue.

![Dimensions widget after configuration](image)

**Figure 7-24** Dimensions widget after configuration

8. Because we are only interested in the total revenue, we hide everything else and show only the bar for the total revenue. Right-click the **Total Revenue** cell. In the window that appears, click **Show Only**.

9. ITSO Movie users do not require the toolbars and will mostly work with the grid and chart to drill down, so they would like to remove the toolbars from their view. Select **View → toolbar → Standard** to accomplish this task.

10. Click **View → toolbar → Navigation**.

11. Click **Save Format**.

12. Click **Finish Editing**.
13. Your Dimensions widget should appear as shown in Figure 7-25.

**Note:** Any customization done to the dimensions widget needs to be preserved by clicking **Save Format**. If you do not press **Save Format**, you will lose all your changes at the next refresh.

If you would like to revert all the changes you have made, after having clicked **Save Format**, simply click the widgets menu icon, select **Edit Settings**, and click **OK**.

![Dimensions widget](image)

Figure 7-25  Final dimensions widget for ticket sales analysis by violence indicator

To add the second Dimensions widget, perform the following steps:

1. Perform steps 1-4 from the previous widget's configuration.
2. Add Measures and Theater as Row dimensions.
3. Add ViolenceIndicator Dimension as a Column dimension.
4. Click **OK**.
5. Right-click the **No of tickets sold** cell. In the window that opens, click **Show Only**. However, ITSO Movie requires that, as a default view, that the number of tickets sold for each theater type is presented as the default.
6. Double-click the **No of tickets sold** bar in the chart. In the window that opens, select the **Theater:All Theater** dimension.

**Note:** If you do not see the window, check that your browser is not blocking the window. You will need to allow pop-ups from your Business Space server.
7. Select View → tool bar → Standard.

8. Select View → toolbar → Navigation. Click Save.

9. Click Finish Editing. Your Dimensions widget should now look like the window shown in Figure 7-26.

![Figure 7-26](image)

Figure 7-26 Final Dimensions widget for ticket sales analysis by age rating and theater type

**Leading practice:** You should not display excessive detail. The data should be presented in a manner that is easy to understand and manipulate by the user. If the users do not require the ability to “show instances”, you might want to consider hiding the grid / data table altogether.

### Add the Reports widget

ITSO Movie requires the ability to analyze its revenue versus theater details relative to a time frame. ITSO Movie would like to have the ability to change this time frame in their analysis. Similarly, ITSO Movie would like to carry out the same analysis of revenue versus location. A Reports widget is the most appropriate widget to fulfill these requirements. We create the location report and then the theater details report.

**Leading practice:** Use reports for analysis that are relative to a time frame that the user can define. Use dimensions for analysis that require multiple dimensions.

Perform the following steps:

1. Click Edit Page.
2. Drag and drop the Reports widget from the widget palette.
3. Click the widget menu icon and click **Edit Settings**.

   The Reports Edit window opens, as shown in Figure 7-27 on page 403. From this window, you can define which measure(s) you want to analyze, the dimension, and the time frame. The Reports widget supports four types of analysis, from which you have to choose one. The four types are outlined in Table 7-1. For ITSO Movie, both reports will be the Basic type.

**Table 7-1  Analysis types**

<table>
<thead>
<tr>
<th>Analysis type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>Displays the business measures values.</td>
</tr>
<tr>
<td>Quartile</td>
<td>Displays the value of the boundary at the 25th, 50th, or 75th percentile of a frequency distribution divided into four parts, each containing a quarter of the population.</td>
</tr>
<tr>
<td>Trend</td>
<td>Displays the analysis of the changes in a given item of information over a period of time using the Exponentially Weighted Moving Average (EWMA). The EWMA is the average of historical values that are given weights (by a weighting factor), which exponentially decrease by time.</td>
</tr>
<tr>
<td>Control</td>
<td>Displays the variation in the business measures that you are measuring to help you understand and reduce the variation. It is used mostly for quality control. The allowable variation is three times the standard deviation of the data.</td>
</tr>
</tbody>
</table>
4. Select the **ITSOMovieTicketSalesMM (All Versions)** Model.

5. Select **Location** for the Dimension.

6. Select **Measures** → **Modeled Measures** and click **Total Revenue**.

7. Click **Month to Date** and select **Daily** for the Frequency.
8. Click the **Wiring** tab. Verify that **Enable this widget to send events over wires** is selected.

9. Click **OK**.

10. In the new Reports widget menu, select **Chart → Types → Pie**.

11. Double-click the pie chart and select **Location: All Location** as the dimension on which to drill down.

12. Select **View → Toolbar → Standard**.

13. Select **View → Toolbar → Navigation**.

14. Click **Save Format**.

15. Click the widget menu icon and click **Rename**.

16. Enter Revenue X Location Report as the new name.

17. Click **Save**.

18. Click **Finish Editing**. Your report should now look like the window shown in Figure 7-28.

![Figure 7-28 Reports view after configuration and customization](image)

To create the revenue analysis by theater details report widget, perform the following steps:

1. Perform steps 1-4 from the previous report's configuration.

2. Select **Theater** for the Dimension.

3. Select **Measures → Modeled Measures** and click **Total Revenue**.

4. Perform steps 7-15 from the previous report's configuration, but select **Theater: All Theater** as the dimensions on which to drill down.

5. Enter Revenue X Theater Report as the new name.
6. Click **Save**.

7. Click **Finish Editing**. Your report should now look like the window shown in Figure 7-29.

![Figure 7-29 Total Revenue X Theater report](image)

### Add the KPI History and Prediction widget

ITSO Movie must be able to view a history of certain KPIs, including daily sales, in order to identify sales patterns. To accomplish this task, add and configure a KPI History and Prediction widget by performing the following steps:

1. Click **Edit Page**.
2. Drag and drop the **KPI History and Prediction** widget from the widget palette.
3. Click the widget menu icon and select **Edit Settings**.
4. Expand the ITSOMovieTicketSalesMM monitor model.
5. Click **Daily Sales for China**.
6. Click **OK**.
7. Click the widget menu icon and select **Rename**.
8. Enter History for Chinese Daily Sales as the new name.
9. Click **Save**.
10. Click **Finish Editing**.
Repeat the above steps for the daily sales for the rest of the countries.

**Note:** You can only have one KPI per widget.

### 7.2.3 ITSO Order Tracking

The ability to track orders is a crucial part of ITSO Movie's daily operations. ITSO Movie ships movies to its customers around the world via two shipping partners:

- ITSOShipping
- ClipsAndTacks Freight
This solution focuses mainly on the operational aspects. ITSO Movie would like to view the number of orders for each region. They would also want to receive alerts when shipments are late. We assume that you have already created a new business space with an operational page and shared it with the target users. In this section, we discuss the actual widgets and their configuration.

**Creating the KPI widgets**

ITSO Movie requires the ability to be able to view the number of orders shipped today in total and for each region.

It also requires the ability to have an accurate representation of the average time it takes to deliver an order, where the average time is calculated from the moment the order is placed up to the moment it is delivered. Furthermore, they would like to be able to see the average time for each phase of the delivery processes. ITSO Movie would like to have those figures available in real time. We decide that the KPIs widget would be the optimum choice for this set of requirements.

Perform the following steps:

1. Click **Edit Page** to edit the Operational View page.

2. From the palette, drag and drop the KPIs widget. This widget will be responsible for showing the daily shipments to the various regions to which ITSO Movie ships.

3. Click the widget menu icon and click **Edit Settings**.
4. Expand the ITSOMovieOrderTrackingMM monitor model and select the **Number of orders shipped today** set of KPIs, as shown in Figure 7-31.

![KPIs Edit](image)

Figure 7-31  Selecting orders shipped today set of KPIs

5. Click the **Wiring** tab and verify that **Enable this widget to send events over wires** is selected.

6. Click **OK**.

7. Click the widget menu icon and click **Rename**

8. Enter Today's shipments as the widget's new name.
9. Click Save. Your widget should now look like the one shown in Figure 7-32.

![Figure 7-32 Number of orders shipped KPIs widget](image)

**Leading practice:** When displaying KPIs as half gauges, the half gauges will always have six tick marks. Setting the span for your gauges as a number that is divisible by five will help you avoid awkward decimal points in your gauges.

Having half gauges with spans of less than five will result in duplicate values for tick marks. In order to avoid this situation, either specify a decimal place precision of at least one or make your span larger than four.

Repeat the previous steps to add a second KPIs widget for the averages set of KPIs.

**Creating the Alerts widget**

ITSO Movie would like to be notified when an order is still not delivered with less than two days to go before the movie release date so that it can contact its shipping partner in order to resolve the issue.

Creating the Alerts widget is a two step process:

1. Create the necessary artifacts in the Integrated Solutions Console.
2. Add the Alerts widget to your business space.

Perform the following steps:

1. Log into the Integrated Solutions Console as an administrator.
2. Expand **Applications → Monitor Services → Monitor Action Services → Template Definitions**, as shown in Figure 7-33. Select **Notifications → New**.

![Diagram of Applications menu](image)

*Figure 7-33   Notifications and Installed Situation Event Bindings links in the Integrated Solutions Console*

3. Enter LateOrderAlert as the Template name.

4. Select **Dashboard Alert** as the default action service type and User ID as the ‘To’ query type.

5. In the To field, enter the user IDs for the users who should receive this alert.

6. For the subject, enter Late order.

7. For the body field, enter Order with order id %OrderId% is late. Please check with shipping company. The body section will be displayed for the user when he clicks the alert under the comments section.

**Note**: You can access variables from the common base event being received in order to display it in the subject or body. These variables map to common base events data fields. To access these variables, either surround the variable name in percentage signs (%VARIABLE_NAME%) or write the complete XPATH expression for this variable:

```
%%cbe:CommonBaseEvents/cbe:CommonBaseEvent/cbe:extendedDataElements[@name='TrackingId']/cbe:values/text()
```

8. Click **OK**. You should now see your new notification template LateOrderAlert in the list of notification templates.

9. Click **Installed Situation Event Bindings**. Click **New**.
10. The Situation event name should match the BusinessSituationName identified in your CBE. For the Situation event name, enter ReleaseDateAlarmEvent. Click **Apply**.

11. Click **Add**.

12. Enter LateOrderBinding as the Binding name and select **LateOrderAlert** as your Template name.

13. Click **OK**. Your situation event binding should look like the one shown in Figure 7-34.

14. Click **OK**. You should now see your situation event binding, ReleaseDateAlarmEvent, in the list of installed situation event bindings.

15. Log in to Business Space as the business space administrator.

16. Click **Edit Page** for the page to which you want to add the alerts widget.

17. From the widget palette, drag and drop the **Alerts** widget.
18. By default, unread alerts are shown in red and alerts that have been read are shown in black. To change the default colors and refresh rate, click the widget menu icon, click **Edit Settings**, and change the colors / refresh rate.

19. Click **OK**.

20. Click **Finish Editing**.

To trigger the alerts, you need to create ordering instances with a movie release date that is within two days of today. Figure 7-35 shows the alerts view with the alert displayed.

![Alert widget showing details for a Late order alert](image)

**Figure 7-35** Alert widget showing details for a Late order alert

### Adding the Instances widget
ITSO Movie also needs to view the details of all orders that have more than 20 items shipped in that single order at all times until it is successfully delivered.

To accomplish this task, perform the following steps:

1. Click **Edit page**.

2. Drag and drop the Instances widget from the widget palette.

3. Click the widget menu icon and click **Edit Settings**.

4. Expand the **ITSOMovieOrderTrackingMM** monitor model and select the **OrderMovieProcess** monitoring context defined in the monitor mode and set it as the default by clicking the **Set as Default** button. A list of the associated metrics is displayed in the Available window.
5. Select the metrics that you would like to view in the Instances widget and move them to the selected list. You can modify the ordering of the metrics by using the up and down arrows next to the list, as shown in Figure 7-36.

![Figure 7-36 Configuring the Instances widget](image)

6. Click **Filter**.

7. Under Data filter, click **Add**.

8. Select **Shipment Size** for Metric, **greaterThanOrEquals** for the Operator, and enter 20 for the value, as shown in Figure 7-37.

![Figure 7-37 Adding a data filter to the Instances widget](image)

9. Click **OK**.

10. Click **Finish Editing**. Your instances widget should now display the details for any orders you have with a shipment size that is greater than 20.
Adding the Diagrams widget
ITSO Movie would like to view the number of orders that were shipped today for each country to which it ships. It would like to see this information about a map with indicators reflecting where the current amount of shipments lies in its target ranges. We use the Diagrams widget to display a map of the world that shows this information.

In order to add and configure the Diagrams widget, perform the following steps:
1. Click **Edit page**.
2. Drag and drop the Diagrams widget from the widget palette.
3. Click the widget menu icon and click **Edit Settings**.
4. Select the **ITSOMovieOrderTrackingMM** monitor model.
5. Select the **Key Performance Indicator context** radio button and select **ITSOMovieKPIContext** as the Key Performance Indicator Context.
6. Click **OK**.

Figure 7-38 shows the Diagrams widget in the view mode. Each country is labeled with the number of orders shipped to it today and colored according to where that number stands within ITSO Movie’s target regions. For example, the daily shipments to the US should be above 20 shipments per day, which would result in the US being colored green; between 10 and 20 would be yellow, and less than 10 would be red.
7.3 Service and system health monitoring

WebSphere Business Space delivers a set of widgets that offer a way to manage and monitor the individual components of your overall business process management solution, including modules and services.

**Service Monitor widget**
The Service Monitor widget is used to measure response time and throughput over a defined period of time for the services exposed and invoked by your module.

**System Health widget**
Use System Health to view a snapshot of the overall system health of your business solution. This widget provides a single place from which you can quickly assess the status of application servers, nodes, clusters, deployment environments, messaging engines and their queues, databases, system applications, and failed events.

**Module Health widget**
The Module Health widget is used to evaluate the health of your module and identify potential problems. The widget provides a central place for health information about module topology, system components, and system messaging engines, queues, data sources, and failed events.

7.3.1 The Service Monitor widget

The Service Monitor widget allows you to measure both the response time and the throughput for services exposed or invoked by an SCA module. You can choose what operations to monitor on the services exposed to requestors or consumed within the module.

The Response Time graph indicates the time elapsed between a service request and response.

**Note:** For service operations with two-way asynchronous implementations, the graph indicates only the time the operation needed to handle the request, not the time that elapsed between request and response.

The Throughput graph shows how many calls have been completed over a unit of time (seconds or minutes). In addition, the Statistic Measurements Table shows throughput for the last second or minute and for the entire monitoring session.
The data is plotted on a graph and displayed in the widget. There are three types of graphs that can be plotted for the data:

- Line graph, shown in Figure 7-39
- Spike graph, shown in Figure 7-40 on page 417
- Column graph

These can be changed by clicking the drop-down menu at the top of the widget.

*Figure 7-39   The Service Monitor widget’s line graph*
The Service Monitor is based on the client/server architecture model. The Service Monitor server gathers and aggregates response time and throughput measurements from all running Service Monitor agents, and then calculates and store the statistics. The Service Monitor widget queries the server for these measurements.

The agent measures the throughput and response time for operations and sends the measurement data to the Service Monitor server.

In a deployment environment, the Service Monitor server runs on a support cluster, while the Service Monitor agent runs in the application cluster where you deployed your module. In a stand-alone application server environment, the Service Monitor server and Service Monitor agent both run on the stand-alone application server.

In the configuration mode, the widget has a General Graph Settings tab and a Monitored Service Operations tab.
The general graph settings tab is shown in Figure 7-41. From here, you can specify:

- **Graph refresh time interval:** This is the rate at which the graphs are refreshed in seconds. You can disable automatic refresh by clearing the check box.

- **Graph time length:** The period of time you want to plot operations on the graph, measured in hours or minutes. By default, each graph plots five minutes of data.

- **Cumulate measurements by:** The unit of time (seconds or minutes) used to measure cumulative statistics, such as mean, minimum, and maximum. All response times and throughput are accumulated over the unit of time and that accumulated data is plotted on the graphs.

- **Response time Y-axis limit:** A positive integer that sets the highest response time to plot on the graph.

- **Throughput Y-axis limit:** A positive integer that sets the highest throughput value to plot on the graph.

- **Show statistics:** If you select Show statistics, the Statistic Measurements table displays operation statistics, including the cumulated statistics over the last second or minute and since monitoring began, below the graphs.

![Service Monitor Edit](image)

*Figure 7-41  General Graph Settings tab for the Service Monitor widget*
Chapter 7. Activity monitoring business spaces

The Monitored Service Operations tab is shown in Figure 7-42. From here you define which operations to monitor and how to display the monitored data.

![Monitored Service Operations tab for the Service Monitor widget](image)

To monitor an operation, perform the following steps:

1. **Click Add new operation to monitor.** All operations of all services deployed on your system will be listed.
2. Select the operation or operations from the Select operations to Add window.
3. Choose a line color for each operation plotted on the graphs.
4. To monitor response times for an operation, use the Response Time menu to indicate the statistical measurement you want to plot (maximum, minimum, or mean). Optionally, specify a threshold value for response times. To monitor throughput for an operation, select the Throughtput check box. Optionally, specify a threshold value for throughput.

### 7.3.2 The System Health widget

The System Health widget provides users with a “quick glance’ view of the overall health of their system. From within this widget, users can quickly assess the status of application servers, nodes, clusters, deployment environments, messaging engines and their queues, databases, system applications, and failed events.

The System Health widget by default is part of the Problem determination business space template, as is the Module Health widget.
The System Health widget is divided into the following tabs:

- **Topology tab**
  - Deployment environments: Lists the status of all deployment environments on the system.
  - Clusters: Lists the status of all clusters on the system.
  - Standalone servers: Lists the status of all stand-alone servers on the system.
  - Node agents: Lists the status of all node agents on the system.

**Note:** You can define filter criteria to reduce the scope of the monitored items.

- **System Applications tab**
  - System applications: Lists the status of system applications, such as Business Process Choreographer, Common Event Infrastructure (CEI), and Service Component Architecture (SCA) applications and services configured on your system (for example, the failed event manager, Business Process Choreographer containers, and the Event Service), as well as Business Space widgets and the Business Space Manager, as shown in Figure 7-43.

![Image of the System Health widget](image-url)

**Figure 7-43** System applications details displayed in the System Health widget
– System data sources: Lists the data sources that match any filter criteria you specify. If you specify no criteria, System Health displays all data sources on the system, including the Common database, the Business Process Execution database, the Common Event Infrastructure database, and the Service Integration Bus database.

– System messaging engines: Lists the messaging engines configured on the system and application buses (SCA.SYSTEM.busID.Bus, SCA.APPLICATION.busID.Bus, CEI.cellName.BUS, and BPC.cellName.BUS). This is shown in Figure 7-44.

![Figure 7-44 System messaging engine details displayed in the System Health widget](image)

Applications tab

– Applications: Lists all enterprise applications installed on the system, as shown in Figure 7-45.

![Figure 7-45 Applications tab detailing application details](image)

– Failed event count: If the Recovery subsystem is enabled, it lists the number of failed events.
Queues tab: Displays information about queues, bus names, and the current queue depth for the messaging points, as shown in Figure 7-46.

![Figure 7-46 Queue tab in System Health widget](image)

### 7.3.3 The Module Health widget

The Module Health widget is used to evaluate the health of a module and identify potential problems within it. The widget provides a central place for health information about module topology, system components, and system messaging engines, queues, data sources, and failed events.

The Module Health widget's input comes from the Module Browser widget. When a module is selected in the Module Browser widget, its details are displayed in the Module Health widget, as shown in Figure 7-47.

![Figure 7-47 Module Health widget](image)
The Module Health widget displays the overall status for the module. It also groups additional status and health information for major areas of your module.

The Module Health widget displays the same information as System Health widget, but for the selected module, for example, system components, messaging engines, data sources, and queues that are accessed by this module.

**Note:** If administrative security is enabled for Business Space, you must also enable application security for the Module Browser widget to work properly.
Common-content business spaces

This chapter provides a more detailed look at the common-content related widgets of IBM Business Space powered by WebSphere V7.

We discuss the following topics in this chapter:

- Common-content widgets, including a brief description of each one.
- How to configure, size, and wire widgets, including an example of how you might combine some common-content widgets.
- An example use case.
8.1 Common-content widgets supplied with Business Space

The common-content widgets are also called Common widgets, because they are supported by Business Space in the WebSphere Application Server “base” version. They are not directly associated with Business Process Management (BPM) like many of the other widgets described earlier in this book.

8.1.1 Document widget

The Document widget displays a Microsoft Word document.

You can view the contents of a Word document in the Document widget, in certain circumstances, when the correct components are installed on the workstation that is being used to display the business space. The following situations apply:

- You are using Internet Explorer and the browser has a plug-in for Microsoft Word. Currently, only Internet Explorer will display the contents of the document within the widget.
- If your browser does not have the plug-in, then you can still open the file using an application that opens Microsoft Word. Alternatively, you can save the file to your workstation.
- You are not using Internet Explorer, and do not have the appropriate Microsoft product installed, then the widget will not display the document content correctly.

To add a Document widget to your page, perform the following steps:

1. Click Edit Page in the open business space.
2. From the list of available widgets, select **Document**, then click the + sign next to the Document widget, as shown in Figure 8-1. This action adds the Document widget to your page.

![Figure 8-1 Adding a Document widget to your open page](image)

3. If you are the page owner or have rights to edit the page, you can edit the Document widget. Click the down arrow in the Document widget, then select **Edit Settings** from the menu, as shown in Figure 8-2.

![Figure 8-2 Edit the settings for the Document widget](image)

4. Enter the URL of the document you want to display, as shown in Figure 8-3. Click **Apply**.

![Figure 8-3 The URL for the document](image)
5. A window and prompts you to open or save the file, as shown in Figure 8-4. Click **Open**.

![File Download Window](image)

*Figure 8-4  File download window*

6. If you are using Internet Explorer and the workstation has the appropriate Microsoft product installed, the document will open in the Document widget page, as shown in Figure 8-5.

![Document Widget](image)

*Figure 8-5  Document widget displaying a Microsoft Word document*

7. Click **Finish Editing** to save your changes.
8.1.2 Presentation widget

The Presentation widget can be used to view the contents of a Microsoft PowerPoint presentation in your business space.

**Note:** Internet Explorer is currently the only browser that supports this widget.

To correctly display a PowerPoint file in the Presentation widget, your browser must have a plug-in for PowerPoint or the appropriate Microsoft product should be installed on the workstation that is using the widget.

To add a Presentation widget to your page, perform the following steps:

1. Click **Edit Page** in the open business space.

2. From the list of available widgets, select **Presentation**, then click the + sign icon next to the Presentation widget, as shown in Figure 8-6. This action adds the Presentation widget to your page. Alternatively, you can drag the Presentation widget onto the page area.

![Figure 8-6 Select Presentation from the list of available widgets](image)

3. If you are the page owner or have rights to edit the page, you can edit the Presentation widget. Click the down arrow in the Presentation widget, then select **Edit Settings** from the menu, as shown in Figure 8-7.

![Figure 8-7 Edit the settings of the Presentation widget](image)
4. Enter the URL of the presentation you want to display, as shown in Figure 8-8. Click **Apply**.

![Presentation Edit](image)

*Figure 8-8   The URL for the presentation file*

5. A window and prompts you to open or save the file, as shown in Figure 8-9. Click **Open**.

![File Download](image)

*Figure 8-9   File Download window*
6. The presentation should appear in the Presentation widget, as shown in Figure 8-10.

![Presentation widget showing a PowerPoint slide]

Figure 8-10 Presentation widget showing a PowerPoint slide

7. Click **Finish Editing** to save your changes.

### 8.1.3 Spreadsheet widget

The Spreadsheet widget can be used to open a Microsoft Excel spreadsheet and view its contents.

**Note:** Internet Explorer is currently the only browser that supports the Spreadsheet widget.

To correctly display an Excel file in the Presentation widget, your browser must have a plug-in for Excel or the appropriate Microsoft product should be installed on the workstation that is displaying the widget.

To add a Spreadsheet widget to your page, perform the following steps:

1. Click **Edit Page** in the open business space.
2. From the list of available widgets, navigate to **Spreadsheet**, then click the + icon next to the Spreadsheet widget as shown in Figure 8-11. This action adds the Spreadsheet widget to your page. Alternatively, you can drag the Spreadsheet widget from the widget list onto the page area.

![Figure 8-11 Select Spreadsheet from the list of widgets](image)

3. The File Download window opens, as shown in Figure 8-12. If you do not want to show the sample spreadsheet that comes with Business Space, click **Cancel**.

![Figure 8-12 Window to open the sample spreadsheet](image)
4. If you are the page owner or have rights to edit the page, you can edit the Spreadsheet widget. Click the down arrow in the Spreadsheet widget, then select **Edit Settings** from the menu, as shown in Figure 8-13.

![Edit settings for the Spreadsheet widget](image)

**Figure 8-13** Edit settings for the Spreadsheet widget

5. Enter the URL of the spreadsheet you want to display, as shown in Figure 8-14. Click **Apply**.

![URL for spreadsheet](image)

**Figure 8-14** URL for spreadsheet

6. A window and prompts you to open or save the file, as shown in Figure 8-15. Click **Open** if you want to have the data displayed in the Spreadsheet widget.

![File Download window for spreadsheet](image)

**Figure 8-15** File Download window for spreadsheet
7. The spreadsheet opens in the Spreadsheet widget, as shown in Figure 8-16.

![Spreadsheet widget showing an Excel spreadsheet](image)

Figure 8-16  Spreadsheet widget showing an Excel spreadsheet

8. Click **Finish Editing** to save your changes.

### 8.1.4 Google Gadget widget

The Google Gadget displays a widget from the Google Web site.

**Note:** The use of Google Gadget widgets are subject to the Google terms and conditions, which can be found at the following address:

http://www.google.com/accounts/TOS

To add a Google Gadget widget to your page, perform the following steps:

1. Click **Edit Page** in the open business space.
2. From the list of available widgets, navigate to **Google Gadgets**, then click the + icon next the Google Gadgets widget, as shown in Figure 8-17.

![Figure 8-17 Adding a Google Gadget to your open space](image)

3. The Google Gadgets window opens. It describes the terms and conditions for using these widgets, as shown in Figure 8-18.

![Figure 8-18 Google Gadgets window](image)

The action of selecting the widget states that you have read and agreed to the terms and conditions.

4. If you are the page owner or have rights to edit the page, you can edit the Google Gadgets widget. Click the down arrow in the Google Gadgets widget, then select **Edit Settings** from the menu, as shown in Figure 8-19.

![Figure 8-19 Edit Google Gadget settings](image)
5. A Google Gadgets Edit window opens, as shown in Figure 8-20. At this point, you can enter a filter for the Google Gadgets you want to use. If, for example, you intend to use Google Map, type Map in the entry field and click **Search gadgets**. This action displays all the Google Gadgets that are related to maps. Click the **Select** button under the appropriate gadget.

![Google Gadgets Edit](image)

You can select a Google Gadget to display in this widget. You understand that Google Gadgets provided by third party developers, and not IBM, IBM is not responsible for, and makes no representations, warranties or guarantees, regarding the functionality, performance, quality or content of the Google Gadgets. Your use of Google Gadgets is at your own risk.

![Map](image)

*Figure 8-20 Searching for Google Gadgets using the Map filter*

6. You are now presented with only the Google widget you selected. Click **Save** to keep the widget settings. The widget will now be displayed.

7. Click **Finish Editing** to save your changes.

### 8.1.5 Web Site widget

The Web Site widget displays a specified Web site.

To add a Web Site widget to your page, perform the following steps:

1. Click **Edit Page** in the open business space.

2. From the list of available widgets, navigate to **Web Site**, then click the + icon next to Web Site, as shown in Figure 8-21, or drag the Web Site widget from the widget list and drop it onto the page area.

![Web Site](image)

*Figure 8-21 Select the Web Site widget from the list of available widgets*
3. The default IBM Web site will be added to the page, as shown in Figure 8-22.

![Web Site widget](image)

Figure 8-22   Web Site widget

4. If you are the page owner or have rights to edit the page, you can edit the Web Site widget. Click the down arrow in the Web Site widget, then select **Edit Settings** from the menu, as shown in Figure 8-23.

![Edit the settings for the Web Site widget](image)

Figure 8-23   Edit the settings for the Web Site widget

5. Enter the URL address for the Web site you want to display and then click **Apply**. An example of this window is shown in Figure 8-24.

![The URL address for the Web site](image)

Figure 8-24   The URL address for the Web site

6. Click **Finish Editing** to save your changes.
8.1.6 Web Feed widget

The Web Feed widget displays a Web or news feed from an RSS source.

RSS is an umbrella term for a feed format that spans several different syndication versions and formats. A quick search of the Internet returns various descriptions for the RSS acronym. For example, one is “Really Simple Syndication”. Another explanation gives “Rich Site Summary”. Both of these explanations help to intuitively describe what an RSS feed is.

In the Web Feed widget, you can read the headlines from a Web or news feed. If there is a headline that interests you, you can click the hyperlink to open a browser that contains the full article.

To add a Web site widget to your page, perform the following steps:

1. Click **Edit Page** in the open business space.
2. From the list of available widgets, navigate to **Web Feed**, then click the + icon next to the Web Feed widget, as shown in Figure 8-25.

Figure 8-25  Select the Web Feed widget from the list of available widgets
3. A default Web feed from IBM will be added to your page, as shown in Figure 8-26.

![Web Feed widget](image)

*Figure 8-26  Web Feed widget*
4. If you are the page owner or have rights to edit the page, you can edit the Web Feed widget settings. Click the down arrow in the Web Feed widget and select Edit Settings from the menu. The Web Feed Edit window opens, as shown in Figure 8-27.

5. The Advanced tab in the Web Feed Edit window lets you set the refresh rate for the Web Feed. Click Save if you make any changes in the Web Feed Edit window.

6. Click Finish Editing to save your changes.

8.2 Combining common-content widgets using wiring

In this section, we demonstrate how to configure widgets to communicate with other widgets by wiring them together. When widgets are wired together, changes that occur in one widget can alter the contents of the target widget.
8.2.1 Configuring widgets

Individual widgets can be configured using the widget menu icon shown in Figure 8-28.

![Widget menu icon](image1)

Figure 8-28   Widget menu icon

Clicking the widget menu icon displays the list of configurable settings for the widget, as shown in Figure 8-29.

![Menu icon drop-down menu](image2)

Figure 8-29   Menu icon drop-down menu
If you click **Edit Settings** in the menu icon drop-down menu, you can customize the widget settings. For example, Figure 8-30 shows the Web Feed widget options. For this widget, you can edit the Feed, Style, and Advanced options.

![Web Feed Edit configurable options](image)

### 8.2.2 Wiring widgets

Widgets communicate with each other using wires. A wire has a source widget and a target widget. When widgets have been wired together, the target widget can react to an event that occurs in the source widget.
To open the wiring diagram for a particular widget, click **Edit Wiring** in the menu icon drop-down menu, as shown in Figure 8-31.

![Edit wiring menu option](image)

**Figure 8-31**  *Edit wiring menu option*

Figure 8-32 shows the widget wiring diagram for Google Gadgets. When you hover the cursor over the left-hand arrow icon, it displays the hover help *Add incoming wire*.

![Widget wiring diagram showing the Add incoming wire hover help](image)

**Figure 8-32**  *Widget wiring diagram showing the Add incoming wire hover help*
Likewise, if you move the cursor over the right-hand arrow of the gadget in the widget wiring diagram, it displays the hover help *Add outgoing wire*, as shown in Figure 8-33.

![Figure 8-33 Widget wiring diagram showing the Add outgoing wire hover help](image1)

Most widgets are not configured to subscribe or emit events by default. If, for example, you click the *Add incoming wire* of the Google Gadget, it will display the text *This widget does not currently subscribe to any events*, as shown in Figure 8-34.

![Figure 8-34 The incoming wire does not currently subscribe to any events](image2)
Some widgets are pre-configured to broadcast events. For example, if you open the wiring diagram for the Web Feed widget and click **Add outgoing widget**, you will see both the Web and Spreadsheet as potential targets. This is because both these widgets are included in the same space as the Web Feed. This is shown in Figure 8-35.

![Figure 8-35  Web Feed outgoing wire options](image)

If you want to create a wired connection between one of the hyperlinks of the Web Feed and the Web Site widget, perform the following steps:

1. Click **Web Site** in the Add outgoing wire of the Web Feed. A connection wire is drawn between the Web Feed gadget and the Web gadget, as shown in Figure 8-36.

![Figure 8-36  Web Feed gadget wired to a Web gadget](image)

The configurable menu option Feed address appears on the source (Web Feed) side of the wired connection, while the menu option Web site URL appears on the target side (Web site) of the wired connection.

2. In the source wiring drop-down of the Web Feed, click **Item Selected**, as shown in Figure 8-37.

![Figure 8-37  Choose Item Selected from the drop-down menu](image)
3. Now click **URL** from the target (Web Site) drop-down menu, as shown in Figure 8-38.

![Figure 8-38 Choose URL from the Web site drop-down menu](image)

4. Click **Save** to keep your wiring changes.

5. If you want the output from the Web Feed to be displayed in the Web Site gadget of your open space, click **Edit Settings** of the Web Feed, then check the **Make article links available to other widgets** and **Open links directly onto site** check boxes, as shown in Figure 8-39.

![Figure 8-39 Check the Web Feed options](image)

6. Click **Save**.
7. Now when you click the first hyperlink in the Web Feed (shown in Figure 8-40), the result will display in the Web Site gadget, as shown in Figure 8-41.

![Figure 8-40 Click first hyperlink in News Feed](image1)

![Figure 8-41 The first hyperlink from the Web Feed is now displayed on the Web site](image2)

### 8.2.3 Sizing widgets

Widgets have a default size that is the width of the page (or column if you have already selected a layout with columns).

**Note:** If you have only one column (which occupies the entire width of the page), you cannot reduce the width of the widgets in that column because they expand to the width of the page. You must have at least two columns on the page.
If you are the page owner or have rights to edit the page, you can resize widgets in Edit mode. The widget size you select will be the default size of the widget for the page.

To change the column definitions in Edit mode, click the down arrow page icon, then select Page Layout and then the column layout you want, as shown in Figure 8-42.

![Figure 8-42 Setting the column layout in Edit mode](image)

After selecting the column layout, click Finish Editing.

Page owners, editors, and viewers can resize widgets in View mode. The widget size displayed is a personalized setting for the person who resized it.

### 8.3 ITSO Movie case study: Combining human tasks and common-content widgets

Business users can customize the content by creating mashups. Mashups are combinations of Web applications (widgets) that display content from multiple sources on the pages of a business space. Business users can create mashup pages to provide multiple views of their business.

In addition to viewing content, business users can create mashups that interact with their business processes. For example, users can be assigned to complete certain human tasks based on the outcome of a business rule.

In this section, you learn how you can create a business space that displays a Web site when a human task is completed.

#### 8.3.1 Assignment and challenge for ITSO Movie

Members of the ITSOMovieBusinessAdministrator group have been assigned the task of creating a Web site for the upcoming movie previews.
When one of the members of the group completes the To Do task that has been assigned, the Web Site widget changes from the default page to a different URL that has been created for the movie preview.

In this rather contrived example, you will connect human-centric widgets to content-centric widgets running in the same business space.

8.3.2 The solution

**Note:** This solution assumes that the unit test environment is already running in WebSphere Integration Developer. If WebSphere Integration Developer is not running, right-click **WebSphere Process Server v7.0** in the Servers view and then select **Start** from the menu.

To solve the challenge put before the ITSOMovie Business Administrator Group, you need to perform the following steps:

1. If you have not already done so, run the script to create all the users and groups and place them into a file-based repository on the WebSphere Application Server.
   a. You can run the script in your profile by running the following command:

   ```
   wsadmin.bat -user admin -password admin -f
   <location_on_drive>\addUsersAndGroups.jacl
   ```

   Where `<location_on_drive>` is where the JACL script has been stored after downloading the files. Further information about the users and groups defined in this book can be found in 3.4, “ITSO Movie: Roles and responsibilities” on page 73.

   Alternatively, you can run the script from the WebSphere Integration Developer WebSphere test environment (WTE) by navigating to the Servers tab, right-clicking the server name in the Servers tab, and selecting **Administration → Run Administrative Script** from the menu.
b. In the Edit Configuration window, enter the 
<location_on_drive>\addUsersAndGroups.jacl path in the Administrative 
Script field, and specify a valid profile in the Profile name field. The window 
looks similar to the one shown in Figure 8-43.

![Edit Configuration window](image)

Figure 8-43  Running the script from the unit test environment

c. Click Run.
d. You should now have the users and groups defined, as shown in Figure 8-44.

<table>
<thead>
<tr>
<th>User uid</th>
<th>User cn</th>
<th>User sn</th>
<th>Group membership (group cn)</th>
</tr>
</thead>
<tbody>
<tr>
<td>bcballen</td>
<td>Bob</td>
<td>Allen</td>
<td>ITSOMovieBusinessAnalysts</td>
</tr>
<tr>
<td>brianali</td>
<td>Brian</td>
<td>Ali</td>
<td>ITSOMovieBusinessAdministrators</td>
</tr>
<tr>
<td>belindaunderhill</td>
<td>Belinda</td>
<td>Underhill</td>
<td>ITSOMovieBusinessUsers</td>
</tr>
<tr>
<td>simondavies</td>
<td>Simon</td>
<td>Davis</td>
<td>ITSOMovieSolutionDevelopers</td>
</tr>
</tbody>
</table>

Figure 8-44 Defined users and groups

Note: When logging on to the Business Space, the lowercase user ID is also the password.

e. The members of the ITSOMovieBusinessAdministrators group are responsible for getting the Web sites ready for all upcoming movie previews.

2. This case study uses the ITSOMovie project that was created in Chapter 4, “Human-centric business spaces” on page 77. If you do not have ITSOMovie and ITSOMovies_lib in the list of projects in your workspace, then import the project interchange file from the Human-centric subfolder of the additional material for this book (refer to Appendix B, “Additional material” on page 747 for more information).

3. Add the ITSOMovieApp to the list of installed projects on the server.
   a. Right-click WebSphere Process Server V7.0 in the servers view, then select Add and Remove Projects from the menu.
   b. In the Add and Remove Projects menu, click ITSOMovieApp, click Add, and then click Finish.

4. Create a business space that will include the human-centric tasks. You will use one of the templates for human interaction provided with Business Space.
   a. Launch Business Space and log in as the admin user.
   b. After you are logged in to an open business space, select Actions  Create Space.
c. In the Create Space window, provide the following options, as shown in Figure 8-45:

- Space Name: Movie Case Study.
- Click **New Space using a template**, then select **Managing My Tasks** from the drop-down menu.
- Space Style: Insurance.

![Create a space using a template](image)

*Figure 8-45  Create a space using a template*

d. Click **Save**.
5. Customize the business space you have just created.
   a. Click **Edit Page** in the Movie Case Study business space shown in Figure 8-46.

   ![Figure 8-46 Movie Case Study page](image)

   b. Delete the KPIs, Alerts, and Human Workflow Diagram widgets.
c. Add a Web Site widget and a Script Adapter widget below the current human task widgets in the page editor. The lower part of your page should now look similar to the one shown in Figure 8-47.

![Figure 8-47  Lower portion of the page in the editor](image)

6. Connect the widgets together.

You are going to connect the Task Information widget to the Web Site widget so that when a task is complete, a different Web site from the default will be displayed in the Web Site widget. However, because the format for the event coming from the Task Information widget is different from the format expected by the Web Site widget, you cannot simply wire these two widgets together.

Instead, you will use the Script Adapter widget to transform the format of the payload coming from the Task Information widget into a Web URL expected by the Web Site widget.

a. Ensure that the page is still in edit mode. Click the Script Adapter widget menu icon, and then click **Edit Settings** from the drop-down menu.
b. In the Script Adapter Edit, type `return “http://www.ibm.com/redbooks”` in the JavaScript area and check **Show Script Text**, as shown in Figure 8-48.

![Figure 8-48 Changing the values in the Script Adapter Edit window](image)

c. Click **OK**. You are providing the URL that will be sent to the Web Site widget instead of the Information Task payload.

d. Click the Script Adapter widget menu icon, and then click **Edit Wiring** from the drop-down menu.

e. In the Widget Wiring diagram, click the incoming connection arrow, and then select **Task Information** from the available options, as shown in Figure 8-49.

![Figure 8-49 Script Adapter incoming wire](image)

f. Click the widget menu icon on the outgoing wire of the Task Information widget and select **Task Completed** from the drop-down menu, as shown in Figure 8-50.

![Figure 8-50 Task Information outgoing connection](image)
g. Select the outgoing connection arrow of the Script Adapter, and then click **Web Site** from the drop-down menu.

h. Click the widget menu icon for the incoming wire of the Web Site widget and select **URL** from the drop-down menu.

When complete, the widget wiring should look similar to Figure 8-51.

![Completed wiring diagram](image)

---

i. Click **Save**. The wiring should have the following structure:
   - Task Information outgoing wire Task Completed.
   - Script Adapter incoming wire payloadReceived.
   - Script Adapter outgoing wire payloadHandled.
   - Web Site incoming wire URL.

j. Click **Finish Editing** on the page for the open space.

7. You are now ready to test the business space you have created.
   a. Click the **Create Tasks** tab, as shown in Figure 8-52.

![Create tasks tab of the Movie Case Study](image)
b. After a few moments you will be presented with the Create Tasks page. Check the **To-do** task in the list of tasks you can create, as shown in Figure 8-53.

![Figure 8-53  Check To-do item in the list of tasks](image)

Figure 8-53  Check To-do item in the list of tasks

c. Click the **Actions** button in the Create Tasks widget, then select **Create** from the action menu, as shown in Figure 8-54.

![Figure 8-54  Action drop-down to create a To-do task](image)

Figure 8-54  Action drop-down to create a To-do task
d. In the Task Information window, check **Me** in the Assignee Area, type some identifying text in the request title area, and then click **Submit**, as shown in Figure 8-55.

![Figure 8-55 Task Information widget for creating a new To-do task](image)

**Figure 8-55 Task Information widget for creating a new To-do task**

e. The Task Information window is now empty.

f. Click the **My Work** tab to go to My Work page in the business space. The task you recently created will be displayed in the My Tasks widget.

g. Check the **To-do** check box for the task in My Tasks, then select **Actions** → **Edit** from the Actions menu, as shown in Figure 8-56.

![Figure 8-56 Performing the Edit action for the To-do task](image)

**Figure 8-56 Performing the Edit action for the To-do task**
h. The task appears in the Task Information widget, as shown in Figure 8-57.

![Task Information widget showing the To-do task in edit mode](image)

Figure 8-57  Task Information widget showing the To-do task in edit mode

i. Note that the Web Site widget has been set to the default site of [http://www.ibm.com](http://www.ibm.com), as shown in Figure 8-58.

![Default Web site in the Web Site widget](image)

Figure 8-58  Default Web site in the Web Site widget
j. Back in the Task Information widget, click **Submit** to complete the to-do task, as shown in Figure 8-59.

![Task Information](image)

*Figure 8-59  Complete the To-do task*

k. The task is removed from the Task Information and My Tasks widgets. Note that the Web Site has changed to the IBM Redbooks site, as shown in Figure 8-60.

![Web Site](image)

*Figure 8-60  The Movie preview Web site*
I. The Script Adapter widget also contains data from the completed to-do task, as shown in Figure 8-61.

![Script Adapter showing received and sent events](image)

Figure 8-61  Script Adapter showing received and sent events

Now that you know that the wiring works, you can share the space with the members of the ITSOMovieBusinessAdministrators group and grant them edit access. After you have shared the space, the admin user can create a to-do task to be performed by a member of the ITSOMovieBusinessAdministrators group.

Congratulations, ITSOMovieBusinessAdministrator. You have completed the to-do task assigned to you to create the Web Site for the upcoming movie preview. In addition, you have used a business space mashup to coordinate your work assignments and display the output of your Web site.
Business design and review spaces

In this chapter, we discuss the use of IBM Business Space powered by WebSphere V7 to provide a way for organizations to create, distribute, and collaborate on information throughout the whole corporation.

We show how to use Business Space and WebSphere Business Compass to gain the following benefits.

- Create and share a common business vocabulary, ensuring consistent and efficient corporate communication.
- Manage a single view of the organization using a centrally distributed organization chart.
- Create, manage, and share business processes and collaborations.
- Define, agree upon, and disseminate the corporate strategy.
- Define and document business services that form the basis of an service-oriented architecture (SOA).
- Review and comment on business processes published by WebSphere Business Modeler.
9.1 Creating a corporate view of ITSO Movie

As discussed in Chapter 3, “Business scenario example” on page 57, ITSO Movie is a relatively young organization that wants to create a dynamic corporation with a common view of the organization for all employees and provide a common visibility of the structure and processes. To accomplish this task, ITSO Movie uses Business Space with WebSphere Business Compass to create, share, and review documents that describe the corporation.

9.2 WebSphere Business Compass: Overview

This section discusses WebSphere Business Compass and how we use it within ITSO Movie. We give an overview of the product and provide a number of examples of the functions provided.

9.2.1 What is WebSphere Business Compass

WebSphere Business Compass is a tool that allows you to create, publish and share business documents, which allows an organization to collaboratively document its business and create new strategies and processes interactively.

WebSphere Business Compass provides two main types of spaces.

- Business Design spaces
- WebSphere Business Modeler Review spaces

Each type of space is used for a different purpose.

**The Business Design spaces**

The Business Design spaces provide a collaborative Web-based environment for the creation, management, and review of business documents about strategy, processes, vocabulary, and organization.

The Business Design spaces allows the use of the following document types:

- Strategy maps
  These documents are used to define the business strategy for an organization, using such concepts as goals, actions and Strength, Weakness, Opportunity, Threat (SWOT) analyses.
- **Capability maps**
  These documents define the business structure and list what capabilities a business has. They are often used in conjunction with the strategy maps to ensure that the business has the capabilities to execute its strategy.

- **Process maps**
  These documents represent the business processes used by the business. These can be used to document existing processes (‘As Is’) or to create new, optimized processes (‘To Be’).
  
  WebSphere Business Compass uses the Business Process Modeling Notation (BPMN) standard for representing processes to ensure a consistent process documentation standard and to integrate with other BPMN tools, such as WebSphere Business Modeler.

- **Collaborations**
  These documents represent how business processes interoperate, or collaborate, with other processes. These processes might be internal to the organization or external, for example, partner processes.
  
  Even though your organization might not execute your partners’ processes, it is important to document how all of the processes interact together to ensure a common understanding. If you are familiar with Unified Modeling Language (UML), this might seem similar to a sequence diagram, showing the interactions between multiple lifelines.

- **Vocabulary**
  This document allows the creation of a set of standard roles, terms, business items, and messages that ensure consistency across the organization.

- **Organization charts**
  These documents show the structure of the organization in a single place, allowing the definition of responsibility areas, reporting lines, and departmental demarcation.

- **Service documents**
  These documents allow the management of the business service contracts within the organization. One of the challenges of implementing a successful SOA is to document and advertise the business services created to encourage and allow re-use throughout the company.

**The WebSphere Business Modeler Review space**

The WebSphere Business Modeler Review space allows an organization to publish, review, and comment on business models produced in WebSphere Business Modeler.
9.2.2 Why ITSO Movie uses WebSphere Business Compass

ITSO Movie wants to gain the following benefits from using WebSphere Business Compass:

- A “single version of the truth” where all employees can access a common view of the organization and its processes.
- A repository of information that has security controls and versions/history built in, reducing the need for a separate document management system.
- A collaborative environment where multiple employees can work on the same documents.
- A reviewing environment where employees can publish processes and invite comments.

9.2.3 What is the high-level plan to create the corporate vision

**Important:** The level of detail defined in this chapter for such documents as business items and processes, as well as the number of documents, for example, for roles, does not necessarily correlate directly with the ITSO Movie examples in other chapters. This is to reduce the complexity of our WebSphere Business Compass examples and allow us to concentrate on showing the functionality of the product, rather than exactly reproducing the full business scenario.

Feel free to enhance our examples and compare the WebSphere Business Compass documents to the content in the other chapters, although one of the key aspects of communicating concepts across the organization is to know to at what level of detail those concepts should be described.

ITSO Movie has a plan to document its business in the collaborative environment provided by Business Space and WebSphere Business Compass:

1. Create a new WebSphere Business Compass environment that will be a central point for the organization to collaborate on, store, and share information.
2. Create the corporate vocabulary to establish common terms, roles, and business items.
3. Create an organization chart so that everyone has an overview of the structure of ITSO Movie.
4. Create a strategy map for growth so that everyone knows what the strategy is and how it will be executed and measured.
5. Create a capability map so that ITSO Movie can document and use its capabilities in the execution of its strategy. ITSO Movie can also identify non-core capabilities it might want to outsource.

6. Define and create the business processes that show how the business runs and how new processes in the business are proposed to run.

7. Define the services offered and consumed by the corporation so they can be published, reused internally, and consumed or implemented by partners.

8. Define the collaboration between processes and services so that it is clear how different parts of ITSO Movie interact with each other and also with ITSO Movie’s partners.

9. Ensure that all of the parts link together, showing how services provide capabilities, how processes implement strategy actions, which roles are responsible for which parts of the business, and so on.

10. Publish and review the documents to ensure a common flow of information throughout the organization and encourage feedback from their most valuable resource: their employees.

**Note:** This order is not necessarily a leading practice, but is the one we have followed to give a structure to this chapter. In practice, development of these documents is likely to be more iterative and to utilize a lot more of the document interdependencies that can be stored in WebSphere Business Compass.

### 9.3 Creating the ITSO Movie Business Design space

Before we can start to create any documents using WebSphere Business Compass, we create a new Business Design space in which we can work.

**Note:** You can have multiple Business Design spaces. You might find it useful to have a “Sandbox” space to experiment with the capabilities of WebSphere Business Compass and Business Space, while keeping a separate Business Design space for your “real” organization data. You might also want a separate space for following our examples, another one for training, and so on. Business Space allows you to share all of these spaces using a common repository.
Perform the following steps:

1. Log in to WebSphere Business Compass. We log in as the admin user in our stand-alone server environment. You may use any user that has administration privileges. As WebSphere Business Compass is used via Business Space, the login method to both components is the same. If you have WebSphere Business Compass installed on a separate server from other Business Space products, such as WebSphere Business Services Fabric or WebSphere Business Monitor, ensure that the server and port name are correct for the environment you want to use.

Note: Remember that Adobe Flash is required for WebSphere Business Compass. You need to have that plug-in installed in your browser before you can use it.

2. Click Manage Spaces to open the Space Manager.

3. Click Create Space to create a new space.

4. In the Create Space window, enter ITSOMovie into the Space name field and ITSO Movie Design Space into the Space description field.

5. Click the Create a new space using a template radio button and select Business Design Space from the drop-down menu.

6. If you want, choose a Space style and Space icon from the ones shown.

7. Click Save to create the new space.
8. The new space will not open immediately; it appears in the Space Manager window. Click the **ITSOMovie** space in the list to open it.

WebSphere Business Compass opens with an Overview page (Figure 9-1), which offers a tour of the product and some learning resources. The Design page is also shown as another tab.

![Figure 9-1 The new ITSO Movie Business Design Space](image)

The Overview page also offers a link to recent documents and a list of team members for this space. At this point, these lists will be empty.

**Note:** For most of this example, we use a single admin user, as it makes it easier to follow our steps without having to set up multiple users in your own environment. In a production environment, you can use the Team widget to add team members to the Business Design space.

You can navigate to the Design page and start from there, or you can click the **Start** button to start creating business design documents. We navigate to the Design page to explore the available functions.
9. Click the **Design** tab to open the Design page shown in Figure 9-2.

![Figure 9-2](image)

The **Documents** tab offers a number of options, which are discussed in the following sections.

**Create Options**

This option offers the following document options (we discuss these options in detail in the sections referenced below):

- Process Map: See “Creating process maps” on page 518.
- Strategy Map: See “Creating a strategy map” on page 497.
- Capability Map: See “Creating a capability map” on page 507.
- Vocabulary Document: See “Creating a vocabulary” on page 471.
- Organization Chart: See “Creating an organization chart” on page 487.
- Collaboration Diagram: See “Creating collaboration diagrams” on page 537.
- Service Document: See “Documenting services” on page 510
- Form Document: We do not discuss creating forms in this book.
- Folder: This option creates a folder in which to store other documents.

**Actions**

This option allows you to perform a number of organizational tasks in the space, such as cut, copy, and paste and rename. It also provides facilities to create document shortcuts from a space to documents held in the repository.

**Share**

This option is a key part of WebSphere Business Compass and allows you to share documents with other users and allows you to request access to other users’ documents. It also provides a search capability.
Upload
This option allows you to upload documents that have been exported from WebSphere Business Compass or other compatible products. The upload types supported are:

- WebSphere Business Compass (.bca)
- BPM BlueWorks (.bda)
- WebSphere Integration Developer project interchange (.zip) (We discuss this option further in “Importing and exporting options” on page 571.)
- Business Leader document (.icd)

View
This option allows you to browse the document network.

Now that we have a Business Design space, we need to create some documents in it. We start by defining a vocabulary.

9.4 Creating a vocabulary

In this section, we introduce the concept of a vocabulary and show how WebSphere Business Compass allows us to manage the ITSO Movie business vocabulary.

9.4.1 What is a vocabulary

In any organization, especially one which operates in multiple countries, there can be issues with terminology, where one word can have a number of meanings.

An example with which readers of this book might be familiar is the definition of the term “server”, which can cause confusion in the IT domain. WebSphere has a definition for “server” (more correctly, an application server) that is not the same as some other IT definitions, such as the one that means a physical computer. This situation also does not take into account other definitions of the term server in English, for example, the person who serves you in a restaurant, the person who initiates a tennis rally, or a spatula for dishing out food, although the meaning of these is usually evident due to the context.
To ensure a common understanding, it is useful for an organization to create a common set of terms with clearly defined meanings. You might be familiar with this approach in legal contract writing, where terms such as “you”, “us”, and “the product” are usually defined at the start of the contract.

ITSO Movie uses WebSphere Business Compass to define their corporate vocabulary, so that it can be centrally stored, easily shared, and maintained by all employees.

9.4.2 What vocabulary do we need

The vocabulary used in an organization depends on the domains in which it operates. For example, an IT company that supplies health care software in the UK operates in the IT, health care, and UK-specific government/health care domains. Each of these domains require their own definitions.

For a company that operates in more than one domain, it is important to be clear about terminology where terms have different meanings in different domains. In our example, the word ‘ticket’ might refer to a permit to see a movie in a movie theater or a reference to an IT support request. Both are valid within their respective domains.

For the purposes of this book, ITSO Movie operates in the following domains:

- Movies and related entertainment
- Logistics and shipping
- IT encompassing BPM and SOA
- The ITSO Movie corporate domain

Obviously, these domains are far-reaching and each have a rich set of vocabulary; we show only a limited subset in this book for the sake of practicality.

9.4.3 Creating the ITSO Movie Vocabulary in Business Design space

Within WebSphere Business Compass, the vocabulary is created in the Business Design space.
Chapter 9. Business design and review spaces

Creating a new vocabulary

WebSphere Business Compass supports multiple vocabularies. You might want to use multiple vocabularies for a number of reasons, maybe by domain or by department. Sometimes an individual project will have its own vocabulary.

We create an ITSOMovie vocabulary document to hold our example ITSO Movie details by performing the following steps:

1. In the ITSO Movie Business Design Space, in the Documents tab of the Design page, click the Vocabulary icon (Figure 9-3).

![Figure 9-3 Creating a new vocabulary](image)

2. Enter ITSOMovie Corporate in the Name field and Corporate vocabulary into the Description field.

Note: You do not have to complete all of this section at once or even at all. The vocabulary created is for use in the following sections in this chapter. Often, you can create the vocabulary needed in those sections when you need them, as WebSphere Business Compass and Business Space provide “New” buttons in the widgets that allow you to search for existing vocabulary.

It is also important to note the Save, Finish Editing, and Save a Draft links. If you leave Business Space, make sure your work is saved and either click Save a Draft or Finish Editing to create a version of your work.

WebSphere Business Compass saves your work every ten seconds or so to avoid losing your work in the event of a network or browser failure. You can see this happening when the save link (in the top left of the window) grays out.
3. Click **OK** to create the vocabulary.

4. A new tab called ITSOMovie Corporate is created, as shown in Figure 9-4.

5. In the Documents tab, a new document has been created in the ITSOMovie repository, as shown in Figure 9-5. Note how the document is locked by the admin user. We discuss publishing and sharing documents in “Sharing documents” on page 556.

Now that we have created a vocabulary, we add some terms.
Adding terms to the vocabulary

A term is a word or phrase that describes a concept within an organization. A term has a description to clarify its meaning and can also have links to other words (synonyms) that have the same meaning.

In ITSO Movie, for example, “Film” is a synonym for “Movie”, and “Movie Theater” is a synonym for “Cinema”. As ITSO Movie is based in the USA, the corporate terms are “Movie” and “Movie Theater”, but as a multinational, ITSO Movie uses WebSphere Business Compass and Business Space to store additional meanings.

To create a new term, perform the following steps:

1. In the ITSOMovie Corporate vocabulary tab, select Term from the type drop-down menu.
2. Click Type a name and enter Movie Theater.
3. Click Type a description and enter This is the actual movie theater where the movies are shown to the public, as shown in Figure 9-6.
4. Click Add.
5. The new term appears, as shown in Figure 9-7 (we have resized the page and the widgets to allow our screen capture to fit in this book).

![Figure 9-7: The new Movie Theater term created in the vocabulary]

Note how the description appears in a “richer” text box, which allows us to add bold, italic, or underlined text and bulleted lists if we want.

Also note the Synonyms list pane, which shows alternate terms for this term.

The term is listed in the vocabulary list on the left, together with its type. The Actions bar allows the usual copy, cut, paste, delete, undo, and redo operations to be performed on list items. We cover the use of the History and Export bars later in 9.13, “Versions and history” on page 568 and 9.14, “Importing and exporting options” on page 571.
Creating synonyms

Synonyms are different words that mean the same thing, for example, “buy” and “purchase”.

In a corporation, there might be multiple synonyms that might not necessarily be a natural synonym outside the organization. For example, “IBM Raleigh” and “IBM RTP (Research Triangle Park)” can both refer to the IBM facility that is located not far from Durham in North Carolina, USA.

In the case of ITSO Movie, “Movie” and “Film” are synonyms; in ITSO Movie’s case, both terms refer to the artistic concept of a movie and also the physical movie media.

Sometimes, terms that might be assumed to be synonyms, for example “Shipment” and “Delivery” as in “Your shipment/delivery arrived from the internet store” might have precise, different meanings in your corporate context. In our example, ITSONmovie defines “Shipment” as something which has been despatched and in transit and a “Delivery” as the completion of a shipment. This highlights the importance of defining and communicating a corporate vocabulary.

For our example, we create the terms Movie and Film as synonyms by performing the following steps:

1. Create a new term in the ITSONmovie vocabulary. Enter Movie as the name of the term and The actual physical movie, contained in a canister as the description of the term.

2. Create another term in the ITSONmovie vocabulary. Enter Film as the term’s name and Alternate term for movie, for example in the UK as its description.
3. Click the **Movie** term in the vocabulary list. Click **Add synonym** in the synonyms section (Figure 9-8).

![Figure 9-8 Adding a synonym for Movie](image-url)
4. Enter film into the Search field and click the search icon in the Search Vocabularies for Terms window (Figure 9-9).

![Figure 9-9](image)

*Figure 9-9 Searching for the term film with the search icon highlighted*

5. Highlight the **Film** search result (avoid the hyperlink on the actual word Film) and click **OK**.

6. Film is now defined as a synonym for Movie in the vocabulary (Figure 9-10).

![Figure 9-10](image)

*Figure 9-10 The term Film defined as a synonym for Movie*

You can add multiple synonyms for a term, or you can use the red X next to synonym to delete it as a synonym for a term. The X only deletes the synonym relationship; it does not delete the synonym term itself.
Adding business items to the vocabulary

A business item is a piece of data or information that is used within an organization. It has a name and description and a set of attributes that describe what data the business item holds. Examples of business items are:

- Order
- Customer
- Invoice
- Bill of Materials

Business items differ from terms in that terms are a simple description of an entity, while a business item shows the structure and data attributes of that entity as well. As an example, the term Order might only be a single word. A business item of Order would have attributes of customer, items, amounts, shipping addresses, and so on.

Business items can have relationships with other business items. For example, an order business item can have a child business item of an order line or a customer. If you know WebSphere Process Server, business items are similar to business objects. If you know WebSphere Business Modeler, then business items will be familiar to you.

For our example, we create two business items:

- MovieTheater
- Address

As movie theaters have addresses, we will make Address a child of MovieTheater.

**Important:** Synonyms do not automatically work both ways. In our example, Film is a synonym for Movie, but Movie is not a synonym for Film, unless we explicitly make it so. You can check this relationship by looking at the synonyms in the Film term.

This action can be used as a way of expressing a corporate preference for a term: A main term might have no synonyms, but an alternate term might show the corporate preferred term. (Note that this is not what we have done in our example.)
To create our example business items, perform the following steps:

1. In the ITSOMovie Corporate vocabulary, create a new Business Item by selecting **Business Item** in the type drop-down menu and entering MovieTheater into the Name field and Movie Theater into the Description field. Click **Add**.

   The new Movie theater business item appears in the vocabulary list. Note the different icon (a briefcase) denoting a business item type. The icon is different than one for a term: each vocabulary type has its own icon.

2. Select the new business item.

3. In the Business item pane, change the Business Item Type to **Complex** in the drop-down menu. A new menu appears that allows us to add attributes to our Movie Theater Business Item.

**Note:** Note that the Address business item can be used in multiple business items, for example, as a shipping address in an order business item or as a billing address in an invoice business item. This re-use is a key principle of business items and should be used in preference to entering MovieTheaterAddressLine1 and MovieTheaterAddressLine2 as separate non-reusable attributes.
4. Use the **Add a new attribute** link to add the five new attributes shown in Figure 9-11. For the Number of Screens attribute, click the **Attribute Type** drop-down menu to change the type from Text to **Number**.

![Figure 9-11 Creating the MovieTheater business item attributes](image)

The Address attribute is currently of type Text. We now need to make the Address attribute reference an Address business item. We cannot create the new business item from the Attribute Type selection, so we need to create it in the vocabulary first.

Perform the following steps:

1. Create a new business item with a name of Address and a description of Corporate address format. Do not forget to ensure that the Type drop-down menu is set to **Business Item** to ensure that you create the correct type.

2. Change the Business Item Type to **Complex** and add the attributes from Table 9-1 on page 483 to the Address business item so that it looks like Figure 9-12 on page 483.
Table 9-1  The Address business item attributes

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Attribute type</th>
</tr>
</thead>
<tbody>
<tr>
<td>addressLine</td>
<td>Text</td>
</tr>
<tr>
<td>city</td>
<td>Text</td>
</tr>
<tr>
<td>postcode</td>
<td>Text</td>
</tr>
<tr>
<td>country</td>
<td>Text</td>
</tr>
<tr>
<td>region</td>
<td>Text</td>
</tr>
</tbody>
</table>

Figure 9-12  The Address business item attributes
Now that we have created our new Address business item, we need to link it to our MovieTheater item by performing the following steps:

1. Click the **MovieTheater** business item (be careful not to confuse it with the Movie Theater term) and select **Reference a Business Item** from the Attribute Type drop-down menu of the Address Attribute (Figure 9-13).

![Figure 9-13 Adding a child Business Item to the MovieTheater Business Item](image)
2. To find our Address business item that we created, enter Address in the search box and click the search icon. When the Address business item is found, select it and click OK (Figure 9-14).

![Search Vocabularies for Business Items](image)

*Figure 9-14  Selecting the Address business item as a child of MovieTheater*

3. The Address business item is now the attribute type of the Address attribute, as shown in Figure 9-15, and Address is a child of the MovieTheater business item.

![Business Item Type](image)

*Figure 9-15  The Address attribute type*
Adding roles to the vocabulary
Next, we need to add roles to the vocabulary. Roles are a definition of what a person does, rather than the personal details of a user, for example, Regional Manager is a role, but Bob Smith is a user.

Roles can be likened to user groups, although they are not exactly the same thing. One user can perform many roles and a role might be performed by many users.

The ITSO Movie roles used in this book are listed in Chapter 3, “Business scenario example” on page 57.

We will be using the following roles in this chapter:
- Movie Rater: The person who actually rates a movie.
- Region Head: The head of a geographical region, for example, North America, EMEA, or Asia.
- Country Head: The head of an individual country.
- Head of Distribution: The head of the distribution division of ITSO Movie.
- CEO: The head of the entire ITSO Movie organization.

To add a role, perform the following steps:
1. In the vocabulary page, click the Type drop-down menu and select Role.
2. Click Type a name and enter CEO. Click Type a description and enter Chief Executive Officer in the Description field.
3. Click Add to add the CEO role.
4. Using the same method, add the roles shown in Table 9-2.

Table 9-2 Vocabulary roles for ITSO Movie

<table>
<thead>
<tr>
<th>Role name</th>
<th>Role description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Head of Distribution</td>
<td>Head of the distribution division</td>
</tr>
<tr>
<td>County Head</td>
<td>Head of an individual country</td>
</tr>
<tr>
<td>Region Head</td>
<td>Head of a geographical region</td>
</tr>
<tr>
<td>Movie Rater</td>
<td>Person who rates a movie</td>
</tr>
</tbody>
</table>

We now have all of the roles that we need for this chapter defined in our vocabulary.
9.5 Creating an organization chart

In this section, we introduce the WebSphere Business Compass organization charts and show how they are used in ITSO Movie.

9.5.1 Why you need an organization chart

An organization chart (commonly abbreviated as “org-chart”) is one of the most important views of any corporation. It shows how the organization is structured and where everybody fits into that structure.

Organization charts show reporting lines and can be structured by division, by geography, by brand, or by any other method by which the organization wants to operate.

Some organization charts show “dotted-line” reporting lines, where there might be a need to show a reporting link for legal purposes. Some have “matrix” reporting, for example, where a department might report into their country head as well as their world-wide division head. We do not use these structures in our ITSO Movie examples.

Corporations also use org-charts to show team memberships and where individual employees fit within the organization. As WebSphere Business Compass uses roles, for example, Movie Rater, rather than individual employee names, for example, Bob Smith, we do not add names to our ITSO Movie org-charts.

9.5.2 Building the ITSO Movie organization chart

WebSphere Business Compass has a document type of Organization Chart, which is created, managed, and edited using Business Space.

As usual, our example will not show the entire structure and detail of ITSO Movie; we will use a subset to show the functions available in the Business Space editor.

Creating a new org-chart

To create a new org-chart, perform the following steps:

1. In the Create section of the Documents tab of the Design page of the Business Design space, click Organization Chart.

2. Enter ITSOMovie Overview into the Name field and ITSOMovie high-level overview chart into the Description field.

3. Click OK.
The new org-chart is created in the document list and the Organization Chart editor opens in a new tab, as shown in Figure 9-16 on page 489. The new org-chart has been created with a parent and two child boxes to get you started.

**Tip:** You can see in our screen capture that we still have the ITSOMovie Corporate tab available, which shows our vocabulary that we created, as well as our ITSOMovie Overview org-chart tab.

The icons on the left of these tabs are the key to recognizing the type of document shown in the tab; these icons correspond to the icons in the Create section of the Documents tab, which means you do not have to have documents named “ITSOMovie Corporate Vocabulary” or “ITSOMovie Overview Org-Chart”.
The main features of a WebSphere Business Compass organization chart are described in this section.
Style section
This section allows the customization of the look of individual organizational unit (OU) boxes, including text colors and effects (bold, italic, and underline) and the ability to change the background color of the OUs. This is useful to add other dimensions to a chart, for example, we could color all of the corporate-level OUs in one color and have another color for country-specific ones.

Actions section
This section provides the usual editing facilities, such as cut, copy, paste, undo, and redo.

Tip: If you are used to using Ctrl-z for undo, this shortcut does not work in Business Space. This does not mean that the undo function is not available; it just means that you must use the undo icon.

View section
This section contains the following icons:

- The Details icon shows or hides the Details window, shown in Figure 9-16 on page 489, which is on the right side of the window.
- The Outline icon provides a textual, tree-style view of the org-chart, which is similar to a file explorer view of a file directory.
- The Roles icon displays a roles widget that allows the creation of new roles and the association of roles with OUs.
- The History icon provides the usual WebSphere Business Compass history view of the document that we discuss in “Versions and history” on page 568.

Export
This allows exportation of the org-chart as a business design file. We discuss this option in 9.14, “Importing and exporting options” on page 571.

Mini View
This is shown at the bottom left of Figure 9-16 on page 489 and allows easy navigation around the chart when the main editor is zoomed in. Use the zooming and panning controls shown at the top right of the window to navigate around the diagram.
Renaming and adding more organizational unit boxes and links

We need to add more organizational units to show the structure of ITSO Movie and we need to link them together correctly. We can accomplish this task by performing the following steps:

1. To give yourself more room (if desired), click the Details icon in the View section to remove the Details window.

2. Click the **ITSOMovie Overview** OU to select it, then press F2 (rename). Enter ITSO.Movie as the new name for the OU. Instead of using F2 to rename the OU, you may also click the name.

3. Rename the left OU to Worldwide Distribution and the right OU to Production. The chart should now look like Figure 9-17. Notice how Business Space automatically resizes the OU boxes and lines the chart up for you.

Now we need to add more OU boxes.

4. Click the + sign under the Production OU. This action creates a new child OU with the name ready for editing. Enter Promotion as the name.

5. Click the + sign under the Production OU again. Another child is created. Name this child Audience Analysis.

Tip: To keep you from clicking the plus signs to add new boxes, you can just press Enter to create a peer OU when an existing one is highlighted.

6. Select the Audience Analysis box by clicking it, if it is not already selected (selected boxes are shown by an emphasized border in blue).
7. Press Enter. A new OU is created to the right of the Audience Analysis OU as a child of the Production OU. Name this OU Creative. The chart now looks like Figure 9-18.

![Org-chart showing the Production OUs](image)

**Figure 9-18** Org-chart showing the Production OUs

8. Under the Worldwide Distribution OU, add six new OUs that represent the countries in which ITSO Movie operates. The countries are UK, Canada, USA, China, Egypt and Germany. Your chart should look like Figure 9-19 (we have cropped our screen capture to fit on the page, so bear in mind that the production OUs are still there).

![Adding the country OUs to the ITSO Movie org-chart](image)

**Figure 9-19** Adding the country OUs to the ITSO Movie org-chart
In theory, our chart diagram of OUs is now complete. However, we now must perform a change control. ITSO Movie has decided to organize its worldwide operations into three regions:

- North America
- Europe, Middle East, and Africa (EMEA)
- Asia

Luckily, we can easily modify our diagram to include this extra level of organization by performing the following steps:

1. Add a new child OU to Worldwide Distribution and name it North America.
2. Drag the USA OU onto the North America OU until the North America OU is highlighted, and then release the mouse button. The USA OU becomes a child of the North America OU, as shown in Figure on page 494.

3. Add two new region OUs, EMEA and Asia, as children of the Worldwide Distribution OU.
4. Add the UK, Germany, and Egypt to the EMEA region.
5. Add China to the Asia region.
6. Add Canada to the North America region.

Figure 9-20 The USA OU as a child of the North America region
The Worldwide distribution section of the diagram now looks like Figure 9-21. Do not worry if the order of the countries or regions is different than what is shown. If you want to move them, you can drag them left or right.

**Note:** You can also drag complete subtrees to another target. While dragging, note the red X if you are not over a valid drop target.

**Figure 9-21**  ITSO Movie country OUs added as children of the new region OUs

---

**Adding roles to the organization chart**

Now we have all of our OU boxes in our diagram, we can add roles to the OUs to indicate which roles are responsible for which OUs.

Due to the flexibility of Business Space, there is more than one way to add a role to an OU.

**Adding a role using the OU Role icon**

To add a role using the OU Role icon, perform the following steps:

1. Click the Role icon of the ITSOMovie OU.

2. If you have not already created or imported the CEO role, click **New Role** to add a new role of CEO to the ITSOMovie Corporate Vocabulary, with a description of Chief Executive Officer. Click **Save** to save the new role.

3. Search for the CEO role in the search box, and click the search icon. Select the **CEO** role in the search results and click **OK**.
The CEO role is added to the ITSOMovie OU, as shown in Figure 9-22.

![Figure 9-22   Adding the CEO role to the ITSOMovie OU](image)

**Note:** If the CEO role cannot be found but you believe that you added it earlier, ensure that the vocabulary document has been saved. To do this, click the ITSOMovie Corporate tab and click **Save a Draft** to store the vocabulary as a draft.

The CEO role is added to the ITSOMovie OU, as shown in Figure 9-22.

**Adding roles by using the Roles widget**

In addition to using the roles icon, you can add roles by dragging them from the Roles widget by performing the following steps:

1. Click the Roles icon in the View section. The Roles widget appears at the left of the window.

2. If you do not have the Head of Distribution role defined, create it by clicking the **New Role** button.
3. Search for head using the search icon (you can also search using * if you want). A list of matching roles is shown in Figure 9-23.

![Figure 9-23 List of roles shown in the Roles widget](image)

4. Drag the Head of Distribution role onto the Worldwide Distribution OU until it is highlighted, and then release the mouse button.

You can also add roles by selecting the role, selecting the OU to which you want to assign the role, and clicking the **Associate Role** button.
5. To finish our diagram, associate the role of Country Head to all of the country OUs and the role of Region Head to all of the Region OUs. The Worldwide distribution part of our org-chart now looks like Figure 9-24.

Note: You can assign roles to multiple OUs in one step. Select all the OUs you want to assign the role to and select the role. Click Assign Role and the role is assigned to all selected OUs.

![Worldwide distribution section of the ITSOMovie Organization Chart](image)

6. When you have finished creating the Organization chart, be sure to click Finish Editing to save a version of your ITSO Movie org-chart.

### 9.6 Creating a strategy map

In this section, we show how to use Business Space and WebSphere Business Compass to create a strategy map.
9.6.1 What a strategy map is and why you need one

A strategy map consists of the components shown in the following sections, which are linked together in a diagram to show the strategy, the factors affecting it, the actions to take, and the targets for achieving success:

**Strategy**
This component outlines the vision for the strategy, for example, 20% growth in 5 years.

**Goals**
These are the goals that the corporation wants to achieve by executing the strategy. Goals typically adhere to the acronym SMART: Specific, Measurable, Achievable, Realistic, and Timely.

**Measures**
This component shows how the progress towards the goals will be measured and how we know if the corporation has achieved the goals.

**Actions**
This component shows what the corporation will do to achieve its goals and execute the strategy.

**Business factors**
These are:
- **Strengths**
- **Weaknesses**
- **Opportunities**
- **Threats**

They are collectively known as SWOT.

These factors might enable or hinder the strategy or the achievement of goals. Strengths and Opportunities can be used to help enable actions. Weaknesses and Threats might hinder achievement of goals and require actions to overcome them.

9.6.2 Creating the ITSO Movie strategy map

The ITSO Movie strategy map that we create in this chapter is a simple one based on ITSO Movie’s strategy for growth.
Create a new strategy map

To create a new strategy map, perform the following actions:

1. In the Create section of the Documents tab of the Design page of the Business Design space, click **Strategy Map**.

2. Enter ITSOMovie Growth into the Name field and ITSOMovie growth strategy to become the largest distributor of movies worldwide into the Description field. Click **OK** to create the map.

3. A “Starter” Strategy map is created in the editor, as shown in Figure 9-25. This shows examples of all of the components listed in 9.6.1, “What a strategy map is and why you need one” on page 498.

![Figure 9-25](image_url)  The “starter” strategy map

Defining our strategy using the strategy map

We remove the Business Factors Generic box and start by modifying the tree to the left of the Strategy by performing the following steps:

1. Click **Business Factors** and press **Delete** in the Actions section. The Business Factors box and all its child boxes disappear.

2. Click the Goal box and press F2 to rename it. You can also click again to rename the Goal. Rename the goal to Increase Audience by 10% for movies.

We now have a goal. But how do we measure if we are achieving that goal? We can measure that goal by performing the following steps:

1. Rename the **Measure** box to Audience by movie.

2. We will also add another measure, so select the **Audience by movie** box and press Enter. Another Measure box appears at the same level. Rename this box to Audience by Country.

*Note: This is not a lesson in creating a good strategy map for a particular business need or for creating a successful corporate strategy.*
Your strategy map should now look similar to Figure 9-26.

![Figure 9-26  Strategy map with renamed goal and measure, plus a new measure](image)

Next, we do some SWOT analysis and identify some Strengths, Weaknesses, Opportunities, and Threats. We do not need the Action box at the moment, so let us change its type by performing the following steps:

1. Click the green arrow of the **Action** box. A context list appears, as shown in Figure 9-27. Click **Strength**. You can always change the type of a box by clicking the type icon.

![Figure 9-27  The strategy map type context menu](image)

2. Rename the new strength box to In-house Marketing. It is a strength of ITSO Movie that it has its own promotion department (as shown in the Organization Chart).

We need to add more boxes as children of the goal. We can use the select-and-press-Enter method we used before, or we can perform the following steps:

1. Hover the pointer over the left-hand edge of the goal. A + sign appears. Click the + sign. A Generic box appears as a child of the goal. (Do not worry about which side the box appears on, as long as it is shown as a child of the goal.)
2. Change the type of the generic box to Weakness and rename it to No control over ticket prices, as ITSO Movie does not set the prices in the movie theaters; all it can do is increase the number of people through the door.

3. Add another box of type Opportunity with a description of Local movies for local people. As ITSO Movie has access to the distribution network and the studios, it has the opportunity to fulfil niche tastes, such as local language movies or cultural-based movies, which gives it an advantage over theaters that rely purely on mainstream blockbusters.

4. Add a Threat of Home entertainment. The advent of DVD and new High Definition formats might mean less people visiting movie theaters.

5. As we have a threat, we should have an action to counter it. As a child of our Home entertainment threat, add an Action with a description of Increase 3D and ITSObigScreen movies. By doing this action, ITSO Movie can provide a superior entertainment experience with giant screen formats and a full 3D experience.

At this point, the strategy map should look something like Figure 9-28.

![Figure 9-28](image)

Figure 9-28  The Increase Audience by 10% for movies goal with its children in the Strategy map

We can now add another goal to our strategy map. We have a choice of where to put it, so we place it at the left.
Goals can have sub-goals as part of the main goal. This is useful when corporations use Business Space to collaborate. Senior management can define a goal and sub-goals. Department or country heads can then own and implement individual sub-goals to meet the corporate strategy.

Perform the following steps:

1. As a left-hand child of the strategy, add a new Goal with the description Increase number of theaters using ITSOMovie.

2. As a child of this new goal, add another Goal of Reduce time of delivery to theaters. A sub-goal is still of type Goal; the relationship on the map defines the hierarchy. In our example, reducing the time of delivery is an incentive for more theaters to use ITSO Movie.

3. Add a child for the goal Reduce time of delivery to theaters of type Action with the description Bonus for beating delivery time for 30% of shipments. To reduce the time of delivery, we incentivize our shipping partners with bonuses.

4. Add a child for the goal Reduce time of delivery to theaters of type Strength with the description Fully integrated supply chain. Our SOA and automated business processes let us ship faster than competitors with manual processes.

5. Add a child for the goal Reduce time of delivery to theaters of type Measure with the description Percentage of deliveries early and late. We measure how we are performing against our goals by looking at our on-time percentages.
Your map should now look something like Figure 9-29.

![Figure 9-29 ITSO Movie Strategy map showing the new sub-goals (top)](image)

At this point, we realize that another ITSO Movie growth goal is to increase the number of studios using ITSO Movie as a distributor.

6. Add a new Goal to the strategy of Increase number of studios using ITSO Movie, which should be linked to the ITSOMovie Growth strategy.

How can we achieve this goal? Well, movie studios will want to partner with a distributor with a growing audience share and an increasing number of theaters. So we make these new sub-goals of the goal Increase number of studios using ITSOMovie.
We can either drag the goals around the diagram, to form the goal/sub-goal relationships, as we did for the organization chart, or we can use the outline view.

**Using the outline view**

To use the outline view, perform the following steps:

1. In the View box, click the **Outline** icon.

   The Outline widget is displayed and should look something like Figure 9-30.

![Outline view of the strategy map](image)

   **Figure 9-30**  Outlined view of the strategy map

Note that the goal Increase number of studios using ITSOMovie Goal is at the same level as the Increase Audience by 10% for movies and Increase number of theaters using ITSOMovie goals.

Note also that the sub-goal of Reduce Time of delivery to theaters is indented underneath Increase number of theaters using ITSOMovie.

We want to use the indentation mechanism of the outline view to create our goal/sub-goal relationship.
2. Click **Increase Audience by 10% for movies** and press Tab. The Increase Audience by 10% for movies indents under Increase number of Studios using ITSOMovie.

3. Click **Increase number of theaters using ITSOMovie** and press Tab. The Increase number of theaters using ITSOMovie indents under Increase number of Studios using ITSOMovie.

   (If you want to decrease the indentation, press Shift-Tab instead. These key combinations also work from the diagram as well as the outline view, but the results are often not so obvious)
When we modify the map using the outline view, the diagram view updates in sync. We can now see that our diagram view looks like Figure 9-31. (We have moved the boxes around to fit on our page.)

![Figure 9-31 The complete Strategy Map Diagram](image)

Each of the boxes in the strategy map also has a details section, such as the OUs in the organization chart. We look at those boxes in more detail in 9.11, "Linking maps together" on page 548.

4. Finally, do not forget to click either Finish Editing or Save a Draft to ensure that your work is saved.
9.7 Creating a capability map

In this section, we introduce capability maps and show how to create and edit them using WebSphere Business Compass. We also show the example of the ITSO Movie capabilities being mapped using the tool.

9.7.1 What a capability map is and why you need one

Capability maps define what an organization does. A capability might be something directly related to the business, for example, a bookshop selling books to a customer. A capability might be related to that core business, for example, obtaining new titles in advance of competitors. A capability might be something that needs to be done, but it not so directly related to the core business, for example, supplying pensions to employees.

Mapping capabilities allows the corporation to identify capabilities in a hierarchical manner, allows it to identify core business capabilities versus non-core business capabilities, and identify possible outsourcing opportunities in addition to allowing it to prioritize its capabilities.

In addition, Business Space and WebSphere Business Compass allow the organization to link business processes to capabilities and assign owners.

A capability map can be a very powerful tool, especially in conjunction with the collaboration and cross-referencing capabilities of WebSphere Business Compass.

This section does not intend to show you how to create an optimum map for your own business, but will show you how to use the WebSphere Business Compass features through our ITSO Movie examples.

9.7.2 Creating the ITSO Movie capability map

To create the ITSO Movie capability map, we need to create a new document in WebSphere Business Compass.

Creating a new capability map document

Perform the following steps:

1. In the Create section of the Documents tab of the Design page of the Business Design space, click Capability Map.

2. Enter ITSOMovie Capabilities into the Name field. Enter a description if you want and click OK.
A “starter” capability map is created, as shown in Figure 9-32.

![Capability Map](image)

Figure 9-32 The “starter” capability map

**Defining the capabilities in the map**

Perform the following steps:

1. Select **Capability 1** and press F2 to rename it. Enter Distributing movies as the new name.

2. Rename Capability 2 to Rating movies.

3. Rename Capability 3 to Monitoring ticket sales and revenue.

4. Click the + sign to the right of Monitoring ticket sales and revenue. This will add another capability. Rename this to Creating collateral. Your window should look like Figure 9-33.

![Capability Map](image)

Figure 9-33 The new ITSO Movie capabilities

**Creating the child capabilities**

Now we have our high-level capabilities defined, we can drill down and create child capabilities that combine to provide the high-level capabilities.

We will drill down into our Rating movies capability and discover that it is made up of the capabilities of movie ratings for each of the countries in which ITSO Movie operates.

Perform the following steps:

1. Hover over the **Rating movies** capability and click the yellow drill-down icon that appears. Alternatively, you can double click **Rating movies**.

2. A new level replaces the existing level shown in the window and a prompt appears. Click **Click here to create the first capability for this level**.
3. A new capability box appears. Rename this box as China age rating.

4. Add five new capability boxes, named USA age rating, UK age rating, Egypt age rating, Canada age rating, and Germany age rating.

5. As an example of how the ratings can be categorized by color, select the Canada age rating capability and click the Background Color icon in the Style section. Select a new color (we selected green in our example) to indicate, for example, that this is an automated process and different from the rest. Your window should look something like Figure 9-34.

![Figure 9-34 Next level down capability map for rating movies](image)

Tip: When navigating the capabilities, you can always see at what level you are working by checking the bread crumb trail on the window.

6. Click ITSMovie Capabilities in the bread crumb trail. The top level diagram is shown.

Note that the Rating movies capability box now has a drill-down icon (it looks like an = sign) in the bottom-right corner. This shows that it has child capabilities.

ITSO Movie now decides that rating movies is actually part of the capability of distributing them, you should perform the following steps:

1. Drag the Rating movies capability on to the Distributing movies capability. The Distributing movies capability now has a drill-down icon indicating that it has child capabilities.

2. Double-click Distributing movies. The next level is displayed, showing that the Rating movies capability is now one level lower.
3. Click the **Outline** icon in the View box. The outline view is displayed and shows an overview of the capability hierarchy (Figure 9-35).

![Outline view of the ITSO Movie Capability Map](image)

4. Finally, do not forget to save and either click **Save a Draft** or **Finish Editing** to save your work.

## 9.8 Documenting services

In this section, we show how WebSphere Business Compass can be used to document services at the business level.

### 9.8.1 Why document services in WebSphere Business Compass

Within a SOA, it is important that the defined services either fulfil or help to fulfil a business function. If service identification is owned wholly by the IT department with no business involvement, a large part of the SOA value is lost.

Business services relate to capabilities and are a key part of business processes. Having the services visible in a business-facing tool like WebSphere Business Compass and defining them using Business Space allows the services to be linked to the rest of the organization’s documents and show how they fit into the overall picture.
In addition, WebSphere Business Compass allows services to be defined at a high level with just enough detail to indicate how and where they are used and which other documents relate to them. Details can be added later or can be stored in WebSphere Service Registry and Repository.

9.8.2 Creating the ITSO Movie “Order Movie” scenario services in WebSphere Business Compass

We will create two simple service documents in this section:

- OrderMovie
- UpdateShippingStatus

**OrderMovie service**

OrderMovie will be used for a movie theater to order a movie from ITSO Movie. The same service interface is used for ITSO Movie to ship a movie using either ITSOShipping or ClipsAndTacksFreight.

**UpdateShippingStatus service**

UpdateShippingStatus is used to allow shipping partners to update ITSO Movie with the status of a shipped order.

We keep the service definitions simple for this example, although WebSphere Business Compass and Business Space allow you to create detailed definitions of services.

**Note:** Using WebSphere Business Compass allows a more abstract definition than if services are defined in WebSphere Integration Developer. In our example, we define the services, the operations with inputs, outputs, and error messages, but we do not define the message structures or attributes.

This is not only to keep our example simple, but also to show that WebSphere Business Compass allows Business Space users to work with processes and services at a level that suits them, while a WebSphere Integration Developer user needs to concentrate on the details of the implementation.

There is, of course, nothing to stop more detailed definitions being created in WebSphere Business Compass.
Creating the OrderMovie service document

Creating a service document is straightforward using Business Space. Simply perform the following steps:

1. In the Create section of the Documents tab of the Design page of the Business Design space, click **Service Document**.

2. Enter OrderMovie in the Name field and Movie Ordering Service as a description. Click **OK**. A new service definition is created, as shown in Figure 9-36.

![Figure 9-36 The new service definition created for the OrderMovie service](image)

In our example, we keep it simple and only create one operation, orderMovie.
3. In the Operation Details section, change the name of New Operation to orderMovie and change the description to Order the movie. Note how Business Space automatically updates the name in the Operations section, as shown in Figure 9-37.

![Figure 9-37 Renaming the orderMovie operation](image)

4. Operations need inputs, outputs (if they are two-way), and errors (if they are two-way). In the Operation Details section, click **Specify an input**.
   
The Search Vocabularies for Messages window appears. We use the movieOrder message as the input.
5. If the movieOrder message is not already defined in the vocabulary, click New Entry. In the New Vocabulary Entry window, in the ITSOMovie Corporate Vocabulary, enter the new name movieOrder and select Message in the drop-down menu. Enter a description if you want and click Save (Figure 9-38).

![New Vocabulary Entry](image)

**Figure 9-38  Creating the new movieOrder message**

6. Enter movieOrder in the search box and click the magnifying-glass search icon. Select movieOrder in the search results box and click OK.

7. In the Operation Details section, click Specify an output.
8. We use the movieOrderConfirmation message as an output. In the same way as for the movieOrder message, select the `movieOrderConfirmation` message as the output. The Operation Details section now looks like Figure 9-39.

![Figure 9-39](image)

Figures 9-39 The orderMovie operation showing the input and output

Services normally define what business errors they will send. Note that business errors are not the same as technical or infrastructure errors. In our example, the following are possible business errors:

- The movie does not exist.
- The movie theater identifier is not a valid customer of ITSO Movie.
- There is insufficient credit available to the movie theater to order a movie.
- The movie is not allowed to be shipped to the country where the movie theater is located.

Any technical errors are not usually defined at this level, as they are defined in the IT domain. Technical errors could be errors such as the following:

- The database is unavailable.
- No threads are available in the thread pool.
- There is a null pointer exception.

We create an business error message of movieUnavailable.

9. In the Operation Details section, click **Add an error**.
10. We use the movieUnavailable error. (Note that if you need to create this vocabulary entry, it is of type Error, not type Message, as shown in Figure 9-40.)

![Figure 9-40 Creating the movieUnavailable error]
11. The finished OrderMovie service definition now looks like the one shown in Figure 9-41.

![Figure 9-41 The finished OrderMovie service definition](image)

Finally, we need to create the UpdateShippingStatus service. The flexibility of Business Space and WebSphere Business Compass means that we do not have to create any of the details of the service at the moment; we just create a service with a name so that we can use it when we define business processes and define the details of the inputs and outputs later.

12. Create a new Service Definition document named UpdateShippingStatus.
13. Rename the default operation to updateStatus. The service definition should look like Figure 9-42.

Figure 9-42  The UpdateShippingStatus service definition

14. Make sure you click Save, Finish Editing, or Save a Draft to save your work.

9.9  Creating process maps

In this section, we describe how to model and document some example ITSO Movie business processes using WebSphere Business Compass.

9.9.1  What processes do we need for ITSO Movie

ITSO Movie has a number of processes, but we only model the Order Movie process in this example.

The Order Movie process we model is simple, but we use it to show how an ITSO Movie process collaborates with partners such as the movie theaters and the shipping partners; this collaboration will be described in 9.10, “Creating collaboration diagrams” on page 537.

The ITSO Movie processes are as follows:

- Order Movie
- Release Movie
- Rate Movie (for age)
Although the Rate Movie process is one process, it actually has a number of variants, one per country. For implementing the variation logic, we use WebSphere Business Services Fabric in this book to show how ITSO Movie selects the correct variation based on a policy of country.

ITSO Movie uses WebSphere Business Services Fabric to choose the process variants, so we need to define the following variants for Rate Movie:

- Rate Movie USA: Uses a single person rating of multiple movie factors.
- Rate Movie Canada: Uses business rules.
- Rate Movie Egypt: Uses ‘Take highest age response’ voting.
- Rate Movie Germany: Uses escalation.
- Rate Movie UK: Uses collaborative scopes for human tasks.
- Rate Movie China: Uses majority voting.

For a more detailed discussion of the processes and country variants, see Chapter 3, “Business scenario example” on page 57.

### 9.9.2 Creating the ITSO Movie Process Maps in WebSphere Business Compass

We now show how to model the processes using the WebSphere Business Compass process maps.

**The OrderMovie process**

Our version of the order movie process used in this book is very simple. It consists of the following steps:

1. Receive the order for the movie from the movie theater.
2. Order the movie from the shipping partner.
3. Send the order acknowledgement back to the movie theater.
4. Wait for a “shipped” status from the shipping partner.
5. Wait for an “arrived in destination country” status from the shipping partner.
6. Wait for a “delivered to theater” status from the shipping partner.

**Creating a new process**

To create a new process, perform the following steps:

1. In the Create section of the Documents tab of the Design page of the Business Design space, click **Process Map**.
2. Enter OrderMovie as the Name of the process. Enter a Description if you want and click **OK** to create the process.
A blank process is created, as shown in Figure 9-43. By default, the process is shown in the free-form layout. We discuss the other layout options later.

Figure 9-43   The blank process diagram for the OrderMovie process

**Adding tasks to our process**

We decided on the steps for our process in “The OrderMovie process” on page 519. We could create separate tasks for our process by manually adding tasks using the task icon in the palette section, but instead we use the QuickAdd feature to add our tasks quickly. We accomplish this task by performing the following steps:

1. Select the **Task** task, then click the QuickAdd icon. The QuickAdd window opens, as shown in Figure 9-44.

Figure 9-44   The QuickAdd window
2. Enter the following task names into the edit field, separating them from each other by pressing Enter after entering each one (you can even copy and paste them from this book if you want):
   - Receive movie order.
   - Send order to shipping partner.
   - Return order confirmation.
   - Wait for Shipped status.
   - Wait for Arrived In Country status.
   - Wait for Delivered to Theater status.

   The tasks should be automatically created, as shown in Figure 9-45.

![Figure 9-45 The new tasks added with the QuickAdd button](image)

3. We do not need the Task icon any more, so we can delete it by clicking it and pressing **Delete** to delete it. (You might have to open the Actions section first.)

4. Drag the arrow from the Start Event on the canvas to the Receive movie order task to create a link. Then click the **Layout Horizontally** icon in the Actions box to arrange the canvas so that it all lines up, as shown in Figure 9-46.

![Figure 9-46 The OrderMovie process with all of the tasks lined up](image)

If all we want to do is document the steps for a process, then we are done. In practice, the OrderMovie process is a very straightforward process that is implemented in ITSO Movie as a fully automated BPEL process running in WebSphere Process Server.
More details about the implementation can be found in Chapter 5, “Integration-centric business spaces” on page 227.1

We also use the OrderMovie process to show how processes collaborate in 9.10, “Creating collaboration diagrams” on page 537.

To demonstrate more capabilities of designing processes in Business Space, let us create the ReleaseMovie process.

**Creating the ReleaseMovie process**

Create a new process named ReleaseMovie. The steps of ReleaseMovie are as follows:

- Receive movie release request.
- Rate movie.
- Obtain final approval for movie.
- Store movie details.

You should have a diagram that looks like Figure 9-47.

![Figure 9-47 The initial release movie process showing the tasks](image)

This is a simple diagram for the process, but we can add more detail to it. We add the following information:

- Store movie details is an automated service task, which will be performed without human intervention.
- Obtain final approval for movie is a User Task that will be performed by a user.
- Rate movie calls a sub-process that rates the movie.

To do this task, we need to use the detailed palette; by default, only the simple palette is displayed.
Adding more detail to the ReleaseMovie process using the detailed palette

Perform the following steps:

1. Click the Palette drop-down menu and click **Palette (Detailed)**, as shown in Figure 9-48.

![Palette (Detailed)](image1)

*Figure 9-48 Changing the palette from simple to detailed*

The Palette box changes to the detailed palette, as shown in Figure 9-49. Note the drop-down arrows that indicate more options.

![Detailed Palette](image2)

*Figure 9-49 The detailed palette box*

2. Click the down-arrow for the Task box to show the additional options. Click and drag the Service Task icon onto the Store movie details task on the canvas. The task now has the Service Task icon shown on it, as shown in Figure 9-50.

![Store movie details to Service Task](image3)

*Figure 9-50 Changing the Store movie details to a Service Task*

3. Using the same technique, change the Obtain final approval for movie task to type User Task.

4. Change the Rate Movie task to a Subprocess.
Your diagram should now look like Figure 9-51. Note the different task types; the Subprocess is shown with a plus sign at the bottom of the task.

![Image](image1.png)

**Figure 9-51**  ReleaseMovie process with task types

We can add more detail to the tasks by using the Detail tab at the top-right corner of the tasks. For example, we can assign responsibility for the tasks by organization unit. We show which tasks belong to which OUs by using the swimlane layout.

**Using swimlanes and organization units**

Perform the following steps:

1. Select the drop-down menu from the layout icon, as shown in Figure 9-52, and select **Swimlane by Organization Unit**.

![Image](image2.png)

**Figure 9-52**  Changing the layout to swimlanes

The diagram now looks like Figure 9-53. A swimlane has been created that is named Unassigned, and it has all of the tasks in it. This indicates that none of the tasks are currently assigned to an organization unit.

![Image](image3.png)

**Figure 9-53**  The ReleaseMovie process in a swimlane

Swimlanes allow you to show who is doing what; at the moment, all of the tasks are unassigned, so let us assign tasks to some organization units.
In 9.5, “Creating an organization chart” on page 487, we created the organization units for ITSO Movie. Part of the org-chart that we use in this section looks like Figure 9-54 (you can view the chart in the ITSOMovie Overview document in Business Space in a separate tab to the process, so you can refer to it when you need to).

In our example, the movie is received from Production (not shown, but under the ITSO Movie organizational unit), and is rated by Worldwide Distribution. The final approval is performed by ITSO Movie corporate, as the CEO always has the final say, and the service to store movie details is provided by Worldwide Distribution.

2. In the Receive movie release request task of the OrderMovie process, click the Details icon at the top-right corner.
3. The Details window appears. Click **Add** in the performers section. In the Add a Performer window, click **Show** and select **Organizational Units** in the drop-down menu (Figure 9-55).

![Figure 9-55  Changing the performer search to organizational units](image)

4. Search for Worldwide and select the Worldwide Distribution result. Click **OK** to accept the result.

5. The Worldwide Distribution Organizational Unit is now added to the Performers section of the Details window, as shown in Figure 9-56.

![Figure 9-56  Adding Worldwide Distribution to the performers task](image)
Notice that the Receive movie release request task has now been automatically moved into a new Worldwide Distribution swimlane, as shown in Figure 9-57 (we have resized the swimlane in our screen capture so that you can see the full description).

![Figure 9-57  The new Worldwide Distribution Swimlane added to the diagram](image)

6. Using the same technique, add the Obtain final approval for movie task to the ITSOMovie swimlane. Note that when searching for performers, you might need to change the Show selection criteria to Organization Units, as we did in Figure 9-55 on page 526.

7. Now we have three swimlanes, as shown in Figure 9-58.

![Figure 9-58  Adding the ITSOMovie swimlane](image)

8. We can use the same technique to move the Store movie details task into the Worldwide Distribution swimlane, but it is much easier to drag Store movie details straight into the Worldwide distribution swimlane.
Even though we used drag and drop to change the organizational unit and the swimlane, Business Space is smart enough to change the detailed properties of the Store movie details task so that it has the Worldwide distribution performer automatically added to it.

Our process now looks like the diagram shown in Figure 9-59.

**Figure 9-59  Final swimlane view of the Release movie process**

**Defining a subprocess**
Earlier, we converted the Rate movie task into a subprocess. Now we add additional detail to that subprocess by performing the following steps:

1. Click the Layout icon and select **Free-Form Layout**.
2. Click the down-arrow in the Actions box and click **Layout Vertically**.
The process now looks like Figure 9-60. If you are familiar with the WebSphere Integration Developer BPEL editor, this layout might look familiar to you.

Figure 9-60  The Release Movie process in free-form vertical layout
3. Click the + sign on the Rate movie task. The Subprocess expands, as shown in Figure 9-61.

![Diagram of subprocess](image)

Figure 9-61 Expanding the RateMovie subprocess

Now we can edit the subprocess. In our real example, we use WebSphere Business Services Fabric to select the correct subprocess, as described in Chapter 6, “Dynamic business spaces” on page 311. In our diagram, we use a decision gateway to show the logic used.

This is another example where the business facing logic does not need to match the implementation technology and logic. It is important that the flow and logic are clear to the audience for the diagram.
4. Drag an Exclusive Gateway box from the Palette onto the + on the connector between the Subprocess Start Event and the Task task. The subprocess now looks like Figure 9-62.

![Figure 9-62 Adding an Exclusive Gateway to the subprocess](image)

5. Click the Task task, press F2, and rename the task as Majority Vote.

6. Click the Branch 1 connector, press F2, and rename the connector as China.

    The subprocess now looks like Figure 9-63, indicating that China uses the Majority vote process.

![Figure 9-63 Renaming the branch and task](image)

7. Drag another task from the Palette underneath the Majority Vote task. Press F2 and rename this task as Highest Age Vote.

8. Click the arrow at the bottom right of the Exclusive Gateway and drag it to the Highest Age Vote task.

9. Rename the Branch 2 link as Egypt.

10. Rename the Exclusive Gateway as Choose Country.
The RateMovie subprocess now looks like the diagram shown in Figure 9-64.

![Diagram of RateMovie subprocess with two country choices](image)

Figure 9-64  Subprocess with two country choices

We could model all of the county choices here, but for the sake of brevity, we only use China and Egypt; the process is the same for all of the other countries.

**Note:** In our diagram, we do not necessarily need to show the actual logic for how the country is chosen. In our case, as we have a field of Country in our business item, our choice is obvious. Try not to clutter your diagrams with information that can be found in other linked documents and concentrate on the business flow that the process is describing.

**Defining global subprocesses**
A subprocess is effectively just a modelling artifact that allows us to expand and collapse a local subprocess for visual convenience. WebSphere Business Compass also allows us to define global subprocesses that can be re-used across multiple parent processes.

**Adding global subprocesses to the Rate movie subprocess**
For this example, we create a global subprocess for the China Majority Vote process by performing the following steps:

1. Ensure that the palette is in Detailed mode by clicking the Palette drop-down menu and clicking **Detailed**.
2. Drag the Global Subprocess icon (part of the Task item in the palette) onto the Rate movie subprocess, so that the subprocess looks like the diagram shown in Figure 9-65.

![Figure 9-65 Adding the new global subprocess into the Rate movie subprocess](image)

3. Delete the existing Majority Vote task and rename the Global Subprocess task as Majority Vote. Re-wire the new Majority Vote global subprocess to the China decision branch and the End Event. The Rate movie subprocess should now look like Figure 9-66.

![Figure 9-66 The new Majority Vote global subprocess](image)

We now need to define the global subprocess. As it is global, we can define it as a separate process using the Documents tab, or we can define it through the New Process option in the Global Subprocess details view. Both of these options achieve the same thing and create a completely separate subprocess.

We define the Global Subprocess through the New Process option in the Global Subprocess details view.
4. As this is a global subprocess and there is no subprocess currently defined, we cannot use the + icon to view the subprocess. Instead, click the Details icon at the top-right of the Majority Vote Global subprocess task.

5. The Details window appears. Click **Choose** in the Called Process section. The Choose a Process to Call window opens, as shown in Figure 9-67. Note that it displays both processes that we have created.

![Choose a Process to Call window](image)

*Figure 9-67  The Choose a Process to Call window*

---

**Note:** The Rate movie subprocess is not shown, as it is only a local subprocess of ReleaseMovie, and is not a reusable global subprocess.

6. We need to create a new process, so click **New Process Map**. A new blank process appears. Enter MajorityVoteAgeRating.
7. Select the **MajorityVoteAgeRating** process and click **OK**.

The Details window now shows that the Majority Vote has a Called Process named MajorityVoteAgeRating. This process has been created as a completely new process; you can verify this fact by looking in the Documents tab.

As the process has now been linked as a global subprocess of the Majority Vote task, we can now link to it from the Rate movie subprocess.

8. Click the + symbol for the Majority Vote task. The process editor opens the MajorityVoteAgeRating process, as shown in Figure 9-68.

![Figure 9-68 The new blank MajorityVoteAgeRating process](image)

**Note:** The MajorityVoteAgeRating process is a process in its own right; it is not a subprocess document. The subprocess relationship is maintained by the calling global subprocess task, in our case, the Majority Vote task.

Also note that we have called the MajorityVoteAgeRating process, not ChinaAgeRating or MajorityVoteForChina. This is best practice, as it means we can re-use this process for any country, current or future, that uses a majority voting system to rate movies.

We edit the process as we did with the other processes.

**Note:** The process opens in view mode by default; you need to click **Edit** to edit the process.

9. Add the following tasks to the MajorityVoteAgeRating process.

   a. Identify the rating group.
   b. Send rating requests to group members.
   c. Rate the movie. Make this task a User Task. If you want, you can add the MovieRater role as a Performer using the task details window.
   d. Collect rating responses.
e. Return a majority vote.

10. Remove the initial blank task, unless you have renamed it, and wire the start event to the Identify rating group task.

Your new process should look something like the diagram shown in Figure 9-69 (we used the Layout Vertically icon to lay the process out so that it would fit on our page).
For our scenario, we have five other processes for each of the five other countries that rate movies. These are chosen so that we can show five different uses of Business Space to rate a movie. In practice, multiple countries would probably use the same rating method, so we would re-use some of the rating processes and would have them called by more than one global subprocess in the Release Movie process.

The complete processes are provided with the additional materials available with this book. In addition, the process diagrams are included in Chapter 3, “Business scenario example” on page 57.

9.10 Creating collaboration diagrams

In this section, we describe the use of collaboration diagrams to show the interaction between the ITSO Movie processes and the ITSO Movie partners.

9.10.1 What is a collaboration diagram

A collaboration diagram is a way of showing how multiple processes or businesses collaborate and interact together.

In our scenario, a movie theater calls our Order Movie process, which then calls either ITSOShipping or ClipsAndTacksFreight to ship the movie. The shipping partner returns a tracking reference back to the Order Movie process, which then sends it back to the movie theater. The shipping partner then sends status updates back to the Order Movie process for the statuses of Shipped, Arrived in Country, and Delivered to movie theater.

Note: This process describes the voting process in a series of steps. These steps do not necessarily coincide with the steps that an executable process would contain, for example, WebSphere Process Server has functionality to perform majority voting in a single human task activity (see Chapter 4, “Human-centric business spaces” on page 77).

It is important to be aware of the differences between descriptive processes which are meaningful to a business user, and a process that is optimized for execution and might not be so clear to someone less familiar with the execution platform.
9.10.2 Adding the ITSO Movie Order Movie process and partners to collaboration diagrams

To document the relationships, we need to create a new WebSphere Business Compass document.

Creating a new collaboration diagram

In the Create section of the Documents tab of the Design page of the Business Design space, click **New Collaboration Diagram**. Name the diagram MovieOrdering. If you want, give it a Description.

A blank collaboration diagram opens in the editor, as shown in Figure 9-70.

![Figure 9-70 The blank MovieOrdering collaboration diagram](image)

The collaboration diagram currently shows two pools. A pool is a container for everything that is done by a participant. A participant is one of the entities that takes part in the collaboration; all of the participants collaborate together to achieve the desired outcome.

We have four participants in our example:

- ITSO Movie: Running the Order Movie process.
- Movie theater. In our example, all movie theaters collaborate in the same way, so we only need to show one.
- ITSOShipping: One of our shipping partners.
- ClipsAndTacksFreight: Our other shipping partner.

We need to create one pool for each of our participants.
Adding participants to the collaboration diagram

Perform the following steps:

1. Drag the Pool icon from the palette onto the workspace to create a new pool.
2. Drag another Pool icon onto the workspace, so that we have four pools in total.
3. Click **Participant** in the top pool and rename it as Movie theater.
4. From top to bottom, rename the next three pools as ITSO Movie, ITSOShipping and ClipsAndTacksFreight.

The collaboration diagram should now look like Figure 9-71.

Figure 9-71  The four participant pools in the MovieOrdering collaboration diagram

The first thing we do is to add our OrderMovie process to the ITSO Movie pool, as this process is what drives the collaboration.
Adding the OrderMovie process to the collaboration diagram
Perform the following steps;

1. In the ITSO Movie pool, click Add a process to this pool.
2. The Add Process to Pool window opens. Select OrderMovie, and then click OK.

   The OrderMovie process tasks are shown. We need to select the elements that we want to show in our collaboration diagram. We only need to show the ones that are important to the collaboration.

3. Click the green boxes above the following tasks to tick them:
   – Receive movie order.
   – Send order to shipping partner.
   – Return order confirmation.
   – Wait for shipped status.
The window should look like Figure 9-72. Click **Done** to return to the main collaboration window, which should now look like Figure 9-73.

![Collaboration Diagram](image)

**Figure 9-72** Selecting the process elements to include in the collaboration diagram

**Figure 9-73** The collaboration diagram with the selected process elements

We did not select the **Wait for Arrived in Country** status and **Wait for Delivered to Theater** status to show that we can select a subset of elements and to help our example fit on the page and keep it simple.

We do not have processes defined for any of the other three pools. A decision needs to be made here. We do not know what the processes look like in those pools, as they are owned by other participants and are out of our control.
One approach when drawing a collaboration is to create a process for each of the other participants to give us some visibility in the diagram; this might appear to be a more straightforward layout, but can give a false sense of confidence in the visibility of the external processes, that is, people looking at the diagram might take it to be fact rather than supposition.

Another approach is to treat each pool as a black box. This means that we assume (accurately) that we cannot see what the process inside the other pools looks like. All we can see are the inputs and outputs. In real life, this is actually the case; we do not know what another partner’s process really looks like, although we can guess. We do, however, know what the service contracts are and in which order the messages flow. As we are confident in this level of information, this is the only information that we add to our example collaboration diagram.

**Showing the collaborations between the participants**

Now that we have all of our participants and our process, we can document the interactions between them. Remember that we are treating the pools without a process as black boxes.

We document the interactions in the order in which they happen. This is not compulsory, but is a good approach to ensure that everything is covered.

First, the participant Movie theater orders a movie. There is no process in the Movie theater pool, so we draw an interaction between the Movie Theater pool itself and the Receive movie order task in the OrderMovie pool.
Perform the following steps:

1. Click the arrow at the bottom-right of the Movie theater pool and drag it to the Receive movie order task in the OrderMovie pool. The Movie theater pool is now linked to the Receive movie order task, as shown in Figure 9-74.

![Diagram](image)

Figure 9-74  Showing the interaction between the Movie theater pool and the Receive movie order task

The Add/Remove Process Elements text that obscures the line is only visible in edit mode; it disappears after we click Finish editing.

**Note:** We have linked the Movie theater pool to a process task within OrderMovie. We could have linked it to the pool itself, which is still accurate, but it is clearer to show the actual task to which it links.

The next thing that happens is that ITSO Movie sends the order to the shipping partner. For clarity, even though we have two partners shown, we only link the call to the ITSOShipping pool.
2. Click the arrow on the bottom-right corner of the Send order to shipping partner task and drag it to the ITSOShipping pool (Figure 9-75).

Next, ITSOShipping sends a confirmation back to ITSO Movie, that is, to the Return order confirmation task.

**Note:** If we look at the process now, we might have a separate Receive order confirmation task in the process. Business Space and WebSphere Business Compass let us add an extra activity easily at this point, but we will not in our example in order to keep the structure simple.

3. Link the ITSOShipping pool to the Return order confirmation task. 
   Next ITSO Movie sends an acknowledgement back to the movie theater.

4. Link the Return order confirmation task to the Movie theater pool.
   Finally ITSO Movie waits for the Shipped status message sent from ITSOShipping.

5. Link the ITSOShipping pool to the Wait for Shipped status task.
The collaboration now looks like the diagram shown in Figure 9-76.

Now that we show our interactions, we could stop here, as the diagram is clear at this point. However, WebSphere Business Compass also allows us to document what messages and data are exchanged over the links. We start by documenting the message sent from the Movie theater pool to the Receive movie order task. This message is of type movieOrder.

6. Click the + sign on the connection between the Movie theater pool and the Receive movie order task. An envelope icon appears, which indicates a message.
7. Click the box underneath the envelope icon (this box is quite faint and might be hard to see; it might be easier for you to click the envelope icon and press F2 instead). In the box, enter Movie Order. The link now looks like the diagram shown in Figure 9-77 (we have moved the OrderMovie pool to show the message details more clearly; if you want to move yours, simply drag the pool).

![Figure 9-77 Adding the Movie Order message](image)

8. Click the Movie Order envelope icon to select it, and the Details pane is displayed at the right side of the window. This pane allows you to choose a message type from the Vocabulary that we defined earlier. Select **Message → Choose**.

9. Search for Order by using the search box. Select **movieOrder** in the results and click **OK**.

The message in the collaboration diagram is now correctly associated with the movieOrder message defined in the ITSOMovie Corporate vocabulary.

10. Add the messages to the collaboration links, as shown in Table 9-3.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send order to shipping partner task.</td>
<td>ITSOShipping pool.</td>
<td>Movie Order.</td>
</tr>
<tr>
<td>ITSOShipping pool.</td>
<td>Return order confirmation task.</td>
<td>Movie Order Confirmation.</td>
</tr>
</tbody>
</table>
The collaboration diagram now looks like Figure 9-78.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return order confirmation task</td>
<td>Movie theater pool.</td>
<td>Movie Order Confirmation.</td>
</tr>
<tr>
<td>ITSO Shipping pool.</td>
<td>Wait for shipped status task</td>
<td>Shipping Status. (You will need to create this message in the vocabulary.)</td>
</tr>
</tbody>
</table>
9.11 Linking maps together

One of the most powerful features of WebSphere Business Compass is the fact that the diagrams are not simply drawings. The documents and document elements have detailed attributes and links that allow cross-referencing and drill-down capabilities.

Adding a linked capability to an organization unit
ITSO Movie has decided that all of their organization units should document their capabilities. To ensure consistency and to distribute the information effectively, ITSO Movie uses Business Space to add this information to their WebSphere Business Compass organization chart.

We will use the example of adding the Rating movies capability to the Worldwide distribution organization unit (OU).

The organization chart section we need looks like Figure 9-79.

Figure 9-79 The section of the organization chart showing the Worldwide distribution OU
The Rating movies capability is a child of the Distributing movies capability, as shown in Figure 9-80.

Perform the following steps:

1. Open the ITSOMovie Overview org-chart for editing.

   **Tip:** If nothing seems to work when you click the canvas to change something in WebSphere Business Compass, ensure that you are in edit mode, which you can do by clicking **Edit** at the top-left corner of the editor.
2. Click the **details** icon at the top-right of the Worldwide distribution OU. The Details window is shown (Figure 9-81). Ensure that the Links view is checked by clicking the **Show** menu; check **Links** if it is not already check.

![Figure 9-81  The details window showing the Links view checked in the Show menu](image)


   We do not want to link to the entire ITSOMovie Capabilities document, just the individual Rating movie capability.

4. Select **ITSOMovie Capabilities** (do not check the box next to it) and click **Show elements**.
5. The contents of the ITSOMovie Capabilities are shown. Check the **Rating Movies** check box and click **OK** (Figure 9-82).

![Figure 9-82 Adding the link to the Rating movies capability](image)

The Rating movies capability is now linked to the Worldwide distribution OU through the Details window. If you click the **Rating movies** link, Business Space takes you directly to that capability.

Now we can add a process to the Rating movies capability.

**Adding a supporting process to a capability**

If we look at the Rating movies capability, we have not explicitly defined a separate Rate movies process. We defined it as a local subprocess of the ReleaseMovie process and cannot link directly to it. This is an example of why we must be careful about how we define the granularity of our processes.
We could change the Rate movie subprocess into a global subprocess (as we would probably do in real life). Alternatively, we can drill down into the China age rating capability and add the MajorityVoteAgeRating as a supporting process by performing the following steps:

1. Open the ITSOMovie Capabilities document in edit mode.
2. Drill down by clicking the = icon or use the Outline menu to navigate to Distributing movies → Rating movies → China age rating.
3. If the Details window is not displayed, click the Show Document Details icon.
4. Select the China age rating capability.
5. In the Details window, select Supporting Processes → Add.
6. The Links to Supporting Processes window opens. Check the MajorityVoteAgeRating check box and click OK (Figure 9-83).

Figure 9-83 Selecting the MajorityVoteAgeRating process
The MajorityVoteAgeRating process is now linked as a supporting process to the China age rating capability.

Adding ownership to a strategy goal
ITSO Movie has decided that all strategy goals must have owners so that they can be rewarded if the goals are achieved.

In this example, we add an owner named Head of Distribution to the goal of Increase audience by 10% for movies. The Strategy map is shown in Figure 9-84, with the goal highlighted.

![Figure 9-84 The ITSOMovie Growth strategy map](image)

Perform the following steps:
1. Open the ITSOMovie growth strategy map in edit mode.
2. Select the **Increase Audience by 10% for movies** goal.
3. If the Details window is not shown, click the **Show Document Details** icon.
4. Ensure that the Owners view is available by checking it in the Show menu (Figure 9-85).

5. Select Owners → Add.

6. Search for dist. Select the Head of Distribution and click OK.

The Head of Distribution is now the owner of the Increase Audience by 10% for movies goal.

Tip: You can also assign organizational units as owners as well as roles. In the Add an Owner search window, click Show and select Organizational Units.

Using vocabulary in descriptions
At the beginning of this chapter, we defined the Movie Theater, Film, and Movie terms. The idea behind defining terms was to ensure consistent vocabulary use throughout ITSO Movie.

In our examples, we have not been very vigilant about enforcing this discipline, so let us remedy that in one description.
We add the description “Increase number of ticket sales by 10% for each Movie Theater” to the Strategy Map goal Increase Audience by 10% for movies.

We use the vocabulary term “Movie Theater” instead of just typing the word. In this way, the term will be hyperlinked to its definition.

Perform the following steps:

1. Select the **Increase Audience by 10% for movies** goal in the ITSOMovie growth strategy map.
2. In the Details window, enter Increase number of ticket sales by 10% for each (but do not press Enter yet).
3. Click **Search vocabulary**.
4. In the Search for Vocabulary Entries window, search for Theater.
5. Select the **Movie Theater** term (with a document icon) and click **OK**.

**Note:** You will also see the MovieTheater business item, which has a briefcase icon. You can filter the types of vocabulary items that are returned by clicking the **Show** button and checking the ones you want.

The Details window now looks like Figure 9-86.

*Figure 9-86   The Details window with the Movie Theater term hyperlink*
The term Movie Theater has now been entered as a hyperlink to the term definition.

In practice, a lot of discipline would be needed to enter all the descriptions of items with hyperlinks back to their related terms. It might be more useful to only link back to certain business-significant terms, or ones that are less well known or ambiguous.

### 9.12 Sharing documents

In this section, we discuss the document sharing facilities provided by WebSphere Business Compass.

#### 9.12.1 How ITSO Movie shares documents and who shares them

ITSO Movie has an open corporate philosophy, encouraging the sharing and publishing of documents around the company.

In this section, we show how to publish documents and share them with other users.

#### 9.12.2 Using WebSphere Business Compass sharing capabilities

This section discusses the following topics:

- Adding more users to Business Space
- Reviewing the created documents
- Searching the repository
- Logging in as a different user
- Creating a new space for a different user
- Retrieving documents from the repository

**Adding more users to Business Space**

Business Space and WebSphere Business Compass use the WebSphere Application Server users and groups.

For our discussion, you can create or re-use your own users or you can use our users and groups that we have created for our examples.
If you want, you can load our users and groups into your WebSphere Business Compass run time using the addUsersAndGroups.jacl script, which can be found in the additional materials for this book (see Appendix B, “Additional material” on page 747 for more details.).

**Reviewing the created documents**

In our ITSOMovie space, let us review what we have created so far. If you have not been following the chapter, you can import the documents by downloading them from the additional material available with this book.

Review Figure 9-87. This figure shows the list of documents created by the admin user. If you do not see the list, check that you have the ITSOMovie space highlighted on the left and not the Repository icon. Also, if you have entries in the Locked By column, this indicates that the documents are still being edited; you should finish editing them (click **Finish Editing**) so that they are no longer locked.

**Note:** There might be more documents in the list than you have, as this list includes the full list of process maps for all of our scenarios, which we did not create during this chapter (you can download these processes from the additional material available with this book, or you can see their structures in Chapter 3, “Business scenario example” on page 57).

<table>
<thead>
<tr>
<th>Document Name</th>
<th>Locked By</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSOMovie Corporate</td>
<td></td>
<td>Corporate vocabulary</td>
</tr>
<tr>
<td>ITSOMovie Overview</td>
<td></td>
<td>ITSOMovie high-level overview chart</td>
</tr>
<tr>
<td>ITSOMovie Growth</td>
<td></td>
<td>ITSOMovie growth strategy to become the largest distributor of movies</td>
</tr>
<tr>
<td>ITSOMovie Capabilities</td>
<td></td>
<td>Movie Ordering Service</td>
</tr>
<tr>
<td>OrderMovie</td>
<td></td>
<td>Updates the status of an order with its shippings status</td>
</tr>
<tr>
<td>UpdateShipmentStatus</td>
<td></td>
<td>The order movie process that takes an order and ships the movie</td>
</tr>
<tr>
<td>ReleaseMovie</td>
<td></td>
<td>Releases the movie to make it available to be shipped</td>
</tr>
<tr>
<td>MajorityVoteAgeRating</td>
<td></td>
<td>Diagram to show how the OrderMovie process interacts with the shippings</td>
</tr>
<tr>
<td>MovieOrdering</td>
<td></td>
<td>This process approves the age rating using a business rule</td>
</tr>
<tr>
<td>HighestAgeRating</td>
<td></td>
<td>Rate using a collaborative process</td>
</tr>
<tr>
<td>RateByBusinessRule</td>
<td></td>
<td>A single person rates multiple factors of a movie (USA)</td>
</tr>
<tr>
<td>RateCollaboratively</td>
<td></td>
<td>A movie rating rates the movie, which is then approved by their manager</td>
</tr>
<tr>
<td>SinglePersonRateMultipleFactors</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RateWithManagerApproval</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Figure 9-87  The list of documents in the ITSOMovie design space*
All of these documents are shown in the local business design space (ITSOMovie). To share these with other users using other spaces, we need to publish the documents to the central repository.

**Searching the repository**
The repository is used to share documents between spaces. If we now search the repository rather than the ITSOMovie space, we can see more documents. We can accomplish this task by performing the following steps:

1. To search the repository, select the Repository icon (or click the Search icon in the Share section). The window shown in Figure 9-88 opens (we have opened the Search menu to show the options).

   ![Figure 9-88 Setting the scope to search the repository](image)

   Note the search scope, highlighted in Figure 9-88. It indicates that the current search scope will include public documents in the repository.

   **Note:** If your scope shows “Search results will include documents that you own”, click the down-arrow to the right of the search button and click **Public Documents** to change the search scope to “Search results will include public documents in the repository”.

2. Click the **Search** button. You should see that the search results return 0 matches, as there are no public documents in the repository. If you do see any results, this will be because documents have been published to your repository, which is not a problem.

   **Note:** With our configuration, we had some issues when using the search functionality on the repository; your configuration might vary.

3. Now use the Search Menu to change the scope to **My Documents** and then click **Search**.
Our results look like Figure 9-89. Your results might vary. Our results include the example JKAir documents that are supplied with WebSphere Business Compass. Whether you see these documents will depend on whether they are installed in your repository and whether your current login has access to them.

As you can see in our screen capture, the JKAir example documents in our environment are owned by the same admin user that we used to create our example documents.

![Figure 9-89 The results of searching for documents owned by the current logged in user](image)

You can also search the repository for document names or partial names, for example, searching for ITSO will return ITSOMovie Capabilities, ITSOMovie Corporate, and so on.

The reason that more results are returned is that they are stored in a separate Business Design space. It is important to note the distinction when managing documents.

To share our documents with other spaces and other users, we need to publish them to the repository.
Publishing documents to the repository

Perform the following steps:

1. Click the ITSOMovie business design space icon (top left of the page) to show
the list of documents in the space (Figure 9-87 on page 557).

2. Select the OrderMovie process and click Make document public in the
Share section.

3. A query Make document public window opens and prompts about whether
you want to make the document public. Click Yes.

4. A confirmation box appears confirming that the document has been made
public. Click OK to dismiss the box.

Now that the document is published, we can see it in the repository.

5. Click Repository. Ensure that the search scope is “Search results will include
public documents in the repository”.

6. Enter movie and click Search. Just the published document will be displayed
(Figure 9-90).

![Figure 9-90  Search results showing the public document](image)

Now that the document is published, we log in as another user to look at it.

Logging in as a different user

Throughout this chapter, our examples have been authored using the
WebSphere Business Compass admin user. This has been for simplicity’s sake,
especially if you are using a stand-alone workstation instance.

Now we use another user to show the collaborative capabilities of Business
Space and WebSphere Business Compass. In our example, we use the user ID
boballlen, who is one of the users created by the script provided with this book.
You can use any user as long as they are different than the user that you used for
the first part of this chapter.
Perform the following steps:

1. Login as boballen (Figure 9-91) or an alternative user on your installation. If you use our example users, the password from our script is boballen.

![Figure 9-91  Logging in to Business Space as a different user](image)

2. boballen does not have any Business Design Spaces defined, so Business Space opens the WebSphere Business Compass welcome window. Click Document Viewer.

3. Set the scope to **Search results will include documents that you own**. Click **Search**. No results are returned, as boballen does not own any documents.
4. Set the scope to **Search results will include public documents in the repository**. Click **Search**. The OrderMovie process is shown (Figure 9-92), as we published it to the repository earlier.

![Figure 9-92 Searching the repository as boballen](image)

**Note:** When working through multi-user examples, it is important always to remember who you are logged in as at any time. To help you, Business Space shows the current logged in user at the top right of the window.

5. Click **OrderMovie**.

The OrderMovie process is shown in Figure 9-93 on page 563. Note that the document is shown in read-only mode. In fact, the read-only restriction is so severe that we cannot even change the vertical to horizontal layout of the process.
If we refer back to Figure 9-92 on page 562, we can see the publish date for the document and also the owner. If we want to edit the document, we need to create a space in which to edit it.

**Creating a new space for a different user**

Typically, a Business Design space will be shared by multiple users, but in our example, we create a new space for boballen to use by performing the following steps:

1. Select Manage Spaces → Create Space.
2. Create a new space with a Space name of ITSOMovie Reviewer. Enter a Space description if you want. Select the Create a new space using a template radio button and select the Business Design Space as a template. If you want, select a space style and a space icon (Figure 9-94).

3. Click Save to save the new space.
4. Click Done to close the Manage Spaces page.
5. Select Go to Spaces → ITSOMovie Reviewer. Our new space appears. Note how boballen is the space owner, as shown in the Team section.

Now that we have a new space, we need to bring import content into it.

Retrieving documents from the repository
While we are logged in as boballen in our new ITSOMovie Reviewer space, we can search the repository in the Design page to find the OrderMovie process. We can see the document we want, but it is still owned by user admin in the repository.

We need to gain access to the document so that we can edit it. We can accomplish this task by performing the following steps:

1. In the repository search results, select OrderMovie (avoid the hyperlink).
2. Click **Add shortcut** in the Share section. A confirmation window appears and shows that the documents have been added to the space (Figure 9-95).

![Figure 9-95 Documents Added to Space confirmation window](image)

3. If we now click the ITSOMovie Reviewer space icon in the Documents tab, we can see that OrderMovie is now in our space. Click **OrderMovie** to edit it.

4. The editor opens, showing the OrderMovie process (Figure 9-96), but the process is still owned by admin. User boballen does not have the rights to edit it yet, and there is no edit option. Click **Request edit access**.

![Figure 9-96 Requesting edit access to the OrderMovie process](image)

5. The Request Edit Access to Document window appears. Enter ‘Need to add comments to the process” for the reason and click **OK**.
Note how the Request edit access link has now changed to a status message of “A request to edit this document has been sent to the document owner”.

**Tip**: You can also request edit access directly from the Documents list in the Documents tab using the Request edit access icon.

Now we need to get user admin to grant edit access to user boballen.

6. Log in to Business Space as admin.

7. Select *Go to Spaces → Business Design Home* and click the **Document Access Control** page tab.

The Document Access Control page is shown in Figure 9-97.

![The Document Access Control window](image)

**Figure 9-97** The Document Access Control window

The Document Access Control window shows boballen’s document access request for edit access to the OrderMovie process. On the right side, if you select the **OrderMovie** process (you might have to scroll to get to it), you can see the document owners (admin) and the spaces with edit access.

**Note**: The edit access request is actually for the ITSOMovie Reviewer Business Design space, not the user boballen. You can see the name of the space at the top of Bob’s request; you can also click **Show Space Details** to see the description of the space, so you can decide whether or not to grant access.
8. Click **Accept** next to the request from Bob in the Document Access Requests widget.

The Document Access Control page updates to show the new status of the OrderMovie process (Figure 9-98). You might have to refresh the window to see this.

![Figure 9-98 The OrderMovie process with edit access given to the ITSOMovie Reviewer space](image)

We can see that the ITSOMovie Reviewer space now has edit access to the OrderMovie process. Note that Space Access can also be revoked from this window.

Let us now check that boballen and the users of ITSOMovie Reviewer have access to the OrderMovie process.

9. Log in as boballen and open the **OrderMovie** process for editing. You can now see that the edit link is enabled, as we requested.

We can now make some changes as boballen.
9.13 Versions and history

In this section, we show how WebSphere Business Compass stores the history and versions of the documents that we have created.

9.13.1 Viewing the versions and history of our WebSphere Business Compass documents

WebSphere Business Compass and Business Space provide a mechanism to store multiple versions of documents and to view their history. This is a self-contained feature and does not require another document management or version control product, such as IBM FileNet® or IBM Rational ClearCase®.

In 9.12, “Sharing documents” on page 556, we took the OrderMovie process created by user admin in the Business Design space ITSOMovie and published it to the Repository. We gave edit access to another Business Design space ITSOMovie Reviewer and logged in as user boballen to edit the process.

We will now log in as boballen to make some changes and view the history of the process.

Making changes as another user
Perform the following steps:

1. Log in as user ID boballen, navigate to the ITSOMovie Reviewer Business Space, and open the OrderMovie process for editing (remember to click the Edit link).
2. We simply add a note to the process. Drag the **Note** icon from the palette onto the workspace (the note icon is in the detailed palette view). Enter “How long should we wait before a timeout?”. Link the note to the **Wait for Shipped status** task, as shown in Figure 9-99.

![Figure 9-99   Adding a note to the process](image)

3. Click **Finish Editing**. When the Finish Editing Session box appears, enter Added timeout query and click **OK**.

**Viewing the history of the document**

Click the **History** icon in the View box (you might need to click the down-arrow to show it).
The history of this document is shown in Figure 9-100. If you have more versions of the document, they are shown as well.

Note that the history is shown as a timeline moving from right to left. Each of the white dots is a version. If you hover over a version, you can see the date of the version, who saved it, and any comments they made.

You might want to add more changes to the process so that you can explore it further.

**Viewing previous versions of the document**

A powerful feature of WebSphere Business Compass is that, in addition to tracking the history of documents, it actually keeps all the details of the previous versions as well, so that you can view them and even revert to previous versions.

Click the version points in the history timeline and watch as WebSphere Business Compass shows you the different versions of the OrderMovie process. Note how the orange line connects the version marker to the edit part to show you which version you are currently viewing.
You cannot directly edit previous versions, but you can go back to one by clicking the **Revert to this Version** link, as shown in Figure 9-101.

![Figure 9-101](image)

**Figure 9-101  Reviewing a previous version of the process**

**Note:** Even if you revert to a previous version, all of the versions are still held in the document history and the reverted version becomes the current one. For example, if you have 10 versions and you revert to version 6, version 6 becomes version 11 and WebSphere Business Compass still keeps versions 1 to 10 as well.

### 9.14 Importing and exporting options

This section discusses the import and export options provided by WebSphere Business Compass.

#### 9.14.1 What can be imported and exported with WebSphere Business Compass

WebSphere Business Compass offers a number of importing and exporting options.

**Importing options**

WebSphere Business Compass imports files using the Upload File icon in the Upload section of the Documents view.
Supported upload file types are:
- WebSphere Business Compass archive files (.bca)
- BPM BlueWorks archive files (.bda)
- WebSphere Integration Developer project interchange (PI) files (.zip)
- Business Leader document files (.icd)

**Exporting options**
WebSphere Business Compass allows the following export options for the document types listed in Table 9-4.

### Table 9-4 Export options

<table>
<thead>
<tr>
<th>Document</th>
<th>Export to Business Design</th>
<th>Export to Microsoft PowerPoint</th>
<th>Export to BPMN XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vocabulary</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Organization Chart</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Strategy Map</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Capability Maps</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Service Document</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Process Map</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Collaboration Diagram</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

**9.15 Reviewing and approving using WebSphere Business Compass and publishing server**

WebSphere Business Compass provides the publishing server capability to allow an organization to publish and comment on WebSphere Business Modeler models.

This way, the models can be reviewed and commented on by anyone with access to the publishing server, even those who do not have WebSphere Business Modeler installed on their workstation.

This chapter assumes familiarity with WebSphere Business Modeler and requires the WebSphere Business Modeler product to follow our examples. If you
want, you can download the process model from the additional material provided with this book.

9.15.1 Creating a process to review

We create a process in WebSphere Business Modeler that will be reviewed using WebSphere Publishing Server. Perform the following steps:

1. In WebSphere Business Modeler, create a new Business process named ITSOMovieTestScreening with a Process catalog of ITSOMovieCatalog1 and a project name of ITSOMovieProject1, as shown in Figure 9-102. If using the wizard, enter Movie Review for a business item name.

**Note:** Our example starts from the Getting Started page in WebSphere Business Modeler.

![Start Process Modeling](image)

*Figure 9-102  Creating the new WebSphere Business Modeler process*
2. When the ITSOMovieTestScreening process editor appears, create a process. For the purposes of this example, it does not matter what the process actually is; we are simply going to review and comment on it using Publishing Server. Our example looks like Figure 9-103.

![Figure 9-103 Our example ITSOMovieTestScreening process](image)

Now we have our example process defined in WebSphere Business Modeler, we need to publish it to a publishing server within WebSphere Business Compass.

First, we create a reviewing space by performing the following steps:

1. Log in to Business Space as admin.
2. Within WebSphere Business Compass, create a new space named ITSOMovieProcessReview, based on the Reviewing template.
3. You need to give access to a user other than the one who created the space, so that this user can add comments. When the ITSOMovieProcessReview space appears in the Space Manager widget, select Actions → Share.
4. Add user boballen as an editor by searching for user boballen, selecting the check box next to the boballen search results, and clicking **Add to Edit** (Figure 9-104). When boballen is added, click **Save**.

![Figure 9-104 Adding user boballen as an editor to the ITSOMovieProcessReview space](image)

5. Open the ITSOMovieProcessReview space. The space opens at the Welcome page.

At the moment, the space has no artifacts loaded. We need to publish our process from WebSphere Business Modeler so that it can be reviewed.
9.15.2 Publishing the process from WebSphere Business Modeler

Before we can publish any models, we need to connect WebSphere Business Modeler to WebSphere Publishing Server.

Connecting WebSphere Business Modeler to the publishing server

Before we can publish anything, we need to connect to the publishing server. We can perform this task by using the Preferences menu within WebSphere Business Modeler, or we can do it as we publish our process. We use the second method.

**Note:** If you are using SSL to connect to WebSphere Business Compass, ensure that you have imported the WebSphere Business Compass certificate into WebSphere Business Modeler. See “Using SSL to connect securely” on page 580.
Perform the following steps:

1. In WebSphere Business Modeler, in the ITSOMovieProject1 project, in the ITSOMovieCatalog1 catalog, right-click the ITSOMovieTestScreening process and click Publish. The Publishing Server Selection window opens, as shown in Figure 9-105.

![Publishing Server Selection window](image)

*Figure 9-105  The Publishing Server Selection window*
2. We need to add a new server. Click **Add**. The New Server window opens, as shown in Figure 9-106.

![Add a publishing server](image)

**Figure 9-106  Connecting to the publishing server**

3. Enter the details to connect to the publishing server. We used the following values:

   - **Name**
     Enter a name. It is used as a reference if you are using multiple publishing servers. We enter `ITSOMoviePublishingServer`.

   - **Server address**
     This is the IP address of the server. We use localhost, because our publishing server is running on our local machine.

   - **Port number**
     This is the port number that your server is listening on; it is usually the same one that you use to log in to Business Space via your browser. By default, it is 9080, or 9443 if you want to use SSL. In our example, it is 9446, as we have more than one server running on our machine.
– User ID and Password

These are the credentials of the user that you want to use to publish to your publishing server. This user must have publishing rights to the Business Space to which you want to publish. We use boballen as our user to connect to the publishing server.

– https

Checking this box tells WebSphere Business Modeler to use a secure connection to WebSphere Business Compass publishing server. This means that you need to specify a secure port (the default is 9443).

4. Click **Finish** to close the window.
If you have problems with the Publishing Server Connection window:

We had some initial problems connecting to our publisher server. If you have problems as well, you might want to try our troubleshooting tips:

- Is the user name and password correct?
- Does your user name contain a colon? This can cause issues.
- Do you have the correct port for your publishing server?
- If you are using SSL, have you imported the publishing server certificate to WebSphere Business Modeler? This can cause the “There is a problem with the server” error. See “Using SSL to connect securely” on page 580.

If you can click Finish and there are no errors, it is likely that your user ID, password, host name, and port number are correct. The rest of these tips are related to being unable to see your Business Space when you click Browse:

- We found that being logged in as the admin user did not let us see our ITSOMovieReviewSpace space (we saw a blank box when we clicked Browse). Changing to another user (boballen) corrected this problem.
- Have you created a Business Space? Did it use the Reviewer template? If it does not have the correct pages from the Reviewer template, it will not show up in the Browse window.
- Does your user have publishing rights to the space? Editing rights are not the same as publishing rights. Make sure to click Submit in Business Space when setting Publisher Access Check that the users do not just have viewing rights.

We restarted both our publishing server and WebSphere Business Modeler after we created our new spaces and imported our certificates.

After our installation, using a stand-alone WebSphere Business Compass server with a file-base user repository, we had problems browsing the Business Spaces when logged in as the admin user. No spaces were displayed when we clicked the Browse button. When we switched to the user boballen, we could see our ITSOMovieReviewSpace in the list.

Using SSL to connect securely

If you are not using SSL (that is, you are not checking the https box), then you can skip this section and go to “Selecting the space to publish and publishing the process” on page 584.
Connecting to a secure publishing server can be complex. We need to extract the security certificate from Business Space and import it into WebSphere Business Modeler by performing the following steps:

1. Open the Integrated Solutions Console of the Business Space instance.
2. Select **Security → SSL certificate and key management**. The window shown in Figure 9-107 opens.

![Figure 9-107 The ISC security SSL window](image)

---

**Chapter 9. Business design and review spaces** 581
3. Select **Key stores and certificates** → **NodeDefaultKeyStore** → **Personal certificates**. The window shown in Figure 9-108 opens.

![Figure 9-108](image)

**Figure 9-108** The Personal certificates window

4. Check the check box next to the certificate and click **Extract**. The Extract certificate window opens (Figure 9-109).

![Figure 9-109](image)

**Figure 9-109** The Extract certificate window

5. Enter a path and file name for the certificate. We used `c:\temp\ITSOTempCertificate`. Ensure that the Data Type is set to Base64-encoded ASCII data and click **OK**.

The certificate has now been extracted from the publishing server. Next, we need to import it into WebSphere Business Modeler. If it is a remote server, it gets extracted to the remote server’s file system. You need to copy it to the Modeler machine first.
Chapter 9. Business design and review spaces

Back up the keystore in WebSphere Business Modeler. The keystore is in the `<MODELER_INSTALL_ROOT>/jdk/jre/lib/security/cacerts` file. Copy this file to a safe location.

6. Open a command prompt and enter the commands shown in Example 9-1. Note that the quotes are needed if your file path contains spaces. Change `<CERTIFICATE_LOCATION>` to the location to where you extracted your certificate. In our example, this is `c:\temp`

   **Example 9-1 Installing the certificate**

   ```
   cd "<MODELER_INSTALL_ROOT>/jdk/jre/bin"

   keytool -import -alias ITSOMovieAlias -file <CERTIFICATE_LOCATION>
   -keystore "<MODELER_INSTALL_ROOT>/jdk/jre/lib/security/cacerts"
   ```

7. You need to enter the password for the WebSphere Business Modeler keystore when prompted. The default password is changeit. You might need to re-enter this password if this is your first time to access the keystore.
When asked Trust this certificate? [no]:, enter yes, as shown in Example 9-2. You should see that the message certificate was added to keystore.

Example 9-2  The DOS session to import the certificate

C:\Program Files\IBM\WBModeler7\jdk\jre\bin>keytool -import -alias ITSMovieAlias -file c:\temp\ITSOTempCertificate -keystore "c:\Program Files\IBM\WBModeler7\jdk\jre\lib\security\cacerts"
Enter keystore password:
Re-enter new password:
Owner: CN=9.44.168.247, OU=LENOVOB3BC8D62Node01Cell, OU=LENOVOB3BC8D62Node01, O=IBM, C=US
Issuer: CN=9.44.168.247, OU=Root Certificate, OU=LENOVOB3BC8D62Node01Cell, OU=LENOVOB3BC8D62Node01, O=IBM, C=US
Serial number: 5ad28839981d
Valid from: 16/02/10 12:10 until: 16/02/11 12:10
Certificate fingerprints:
Trust this certificate? [no]: yes
Certificate was added to keystore

8. At this point, restart WebSphere Business Modeler to use the new certificate.

Selecting the space to publish and publishing the process
Now that we have established a connection to our publishing server, we must select a space to use for publication.
In the Publishing Server Selection window, we can now see our new Publishing Server, as shown in Figure 9-110.

![Publishing Server Selection window](image)

**Figure 9-110  The new ITSOMoviePublishingServer connection**

Perform the following steps:

1. Select **ITSOMoviePublishingServer** and click **Browse**.

   **Note:** If this step does not work, or you have problems, check out our troubleshooting tips in “Connecting WebSphere Business Modeler to the publishing server” on page 576.

2. The Space selection window opens, showing our ITSOMovieProcessReview space. Select this space and click **Finish**.

3. When the ITSOMovieProcessReview space appears in the Space field, click **Finish**.
The Publishing Results Confirmation window is shown in Figure 9-111. The process is now published.

![Publishing Results Confirmation](image)

*Figure 9-111  The Publishing Results confirmation*

**Reviewing and commenting on the process**

Perform the following steps:

1. Log in to Business Space as boballen and go to the ITSOMovieProcessReview space. Click the Draft Artifacts page.

2. Navigate to Draft Projects → ITSOMovieProject1 → ITSOMovieCatalog1 → ITSOMovieTestScreening.
We can see that our process has been published, as shown in Figure 9-112.

9.15.3 Commenting on a published process

Now that we have our process published, it is in a draft state, which means that it is available for comments. Users can comment on it until it is released.

User boballen wants to add some comments to the process that he has published.

Adding comments to the process
Perform the following steps:
1. Ensure you are logged in as user boballen.
2. In the Draft Artefacts page, expand the Draft Projects tree and select the ITSOMovieTestScreening process.
3. In the Comments widget, click New to comment on the process.
4. When the Add Comment window appears, enter Should the Movie Theater booking and obtaining the media be in parallel? into the Subject field. Select **Question** as the type, leave the Priorities as Medium and the Status as Open, as shown in Figure 9-113.

![Add Comment Window](image)

**Figure 9-113 Adding user boballen’s question comment on the process**

5. Click **Submit** to submit the comment. The comment is now listed in the comments widget, as shown in Figure 9-114.

![Comments Widget](image)

**Figure 9-114 boballen’s comment in the comments list**
Allowing another user to comment on the process
User boballen now wants to allow user belindaunderhill to review and comment on his process. At the moment, Belinda is not authorized to do this, so Bob needs to authorize her by performing the following steps:

1. Logged on as user boballen and go to the Review Access Control page.
2. In the Users/Groups section, expand Users and select belindaunderhill.
3. In the projects section, expand Draft Projects and check the Review box next to ITSOMovieProject1. This allows Belinda to review all of the artifacts in ITSOMovieProject1, as shown in Figure 9-115.

4. Click Submit to submit the authorization. A confirmation window opens and confirms the access rights. Click OK to dismiss window.

If you now try and log in as Belinda (user ID belindaunderhill), you will find that you cannot post comments yet. You might have access to the project and process, but you need access to the ITSOMovieProcessReview space, so it must be published as well.
5. Log in as admin and, using the Manage Spaces function, share the ITSOMovieProcessReview space and add edit permissions for belindaunderhill.

Commenting on another user’s process
Perform the followings steps:

1. Log in as user belindaunderhill. This user is now authorized to make comments, so go to the ITSOMovieprocessReview space and open the Draft Artifacts page.

2. Select the ITSOMovieTestScreening process. You can see that Bob’s comment is displayed in the comments widget. Click the subject of the comment hyperlink.

3. We cannot edit Bob’s comment as belindaunderhill, but we can reply to it. In the View Comment widget, click Reply.

4. In the Add Comment window, enter “I think this process is OK - we can always use an empty theater.” and click Submit (Figure 9-116).

![Figure 9-116  Replying to boballen's comment]
Releasing a process
Now that Bob has received Belinda's comments on his process, he decides to release it. Perform the following steps:

1. Log in as boballen and go to the Review Manager page in the ITSOMovieProcessReview space.

2. In the ReviewManager widget, in the Release Project section, select ITSOMovieProject1 and click Release (Figure 9-117).

![Figure 9-117](image)

Figure 9-117 Releasing the ITSOMovieProject1 project

3. Click OK, and then click OK again to dismiss the status window.

4. Click Refresh in the Request Status Widget until the Release request is successful (Figure 9-118).

![Figure 9-118](image)

Figure 9-118 The Status widget showing a successful release

The process is now released. You can now inspect the released process in the Inspect Artifacts page in the same way as we did using the Draft Artifacts page.
Note: Depending on your configuration, you might find that after the process is released, user boballen is no longer authorized to it. This is because the authorization works on release state as well as artefact. boballen might be authorized to see the draft version of the process, but not the released version.

If you experience this situation, use the Review Access Control page to authorize Bob. Select user boballen in the Users/Groups tree view, then expand Released Projects in the Projects tree view and check the ITSOMovieProject1 project to authorize.
Part 3

Developing clients and custom widgets
Web 2.0 introduction

This chapter provides a brief introduction to Web 2.0 and related concepts. It does not discuss the technologies and ideas presented in depth. Instead, we provide a quick introduction into the following topics:

- Web 2.0 overview and technologies
- Representational State Transfer
- Dojo Toolkit
- Asynchronous JavaScript and XML
- JSON

If you are familiar with Web 2.0, you can skip this chapter.
10.1 Web 2.0 overview

The term Web 2.0 applies to a set of developments and trends that are advancing the transition from a traditional read-only World Wide Web to a collaborative and participatory Web. This evolution is built on the appreciation that the Web, as a two-way medium, rather than a read-only one-way path for human beings, adds increased value for individuals and communities.

Information scattered around the Web is remixed by users to customize global available information for individual demands and needs. To empower people, Web 2.0 introduce collaborative software for social networks. The Web is seen as a multimedia platform based on a lightweight programming model for richer user experience. Interactive editing of content, such as adding metadata over time (tagging) in real time ties formerly disparate information sources together.

Web 2.0 is a concept built on human-centric collaboration on the Web.

IBM provides end-to-end Web 2.0 solutions for business. Social computing tools, such as Lotus Connections or Lotus Quikr, deliver Web 2.0 benefits. IBM Mashup Center, which Business Space is based on, offers a lightweight mashup environment for easy assembly of business information.

For more information about Web 2.0 solutions from IBM, go to the following address:

http://www-01.ibm.com/software/info/web20

10.2 Web 2.0 technologies

Web 2.0 is based on a collection of architectural styles and technologies. This section gives a quick overview of these technologies as they are used in the context of Web 2.0; you should become familiar with them when implementing custom widgets for Business Space.

10.2.1 Representational State Transfer

Representational State Transfer (REST) describes an architectural style where service consumers and providers interact with each other in a RESTful way. The largest implementation of REST is the Web, so REST is most often and almost only used in context of the Web.
Chapter 10. Web 2.0 introduction

REST is based on some basic key principals, which we describe in this section in the context of the Web. Chapter 11, “Developing a service for a custom widget” on page 601 also explains how REST is used in the context of a scenario.

**Resources**
Every entity, or resource, within a RESTful system can be identified by a unique key. On the Web, URIs are used to identify resources. Beside having a unique identifier, resources have different representations. A service consumer can, for example, request a JavaScript Object Notation (JSON) or XML representation of a movie.

**Interconnected resources**
Because resources are identifiable by URIs, relationships between different resources can be established using links that point from one resource to another. From a service consumer point of view, the usage of interconnected resources provides the possibility to advance from one state to another in an application, which describes the state transfer aspect of REST.

**Consistent interface**
All resources are accessed with the same interface using a set of standard methods. The HTTP standard includes the methods, also known as verbs, GET, PUT, DELETE, and POST to interact with resources.

**Stateless communication**
As the name implies, REST is a stateless architectural style. That is why every request between a client and a server must contain all the context information to process the request successfully. A request cannot rely on stored context information on the provider side from a previous request. All states are kept either in the resource itself or on the service consumer side.

### 10.2.2 Dojo Toolkit

The Dojo Toolkit is an open source JavaScript framework. Its aim is to ease the cross-platform development of JavaScript and AJAX-based Web applications.

The Dojo Toolkit provides a basic set of JavaScript libraries (packaged in Dojo Base and Core). Dojo also includes widgets called Dijits (Dojo widgets) for common interface controls, such as buttons or text fields, and an extension library (DojoX) for features that do not (yet) fit into the other Dojo components.
Base
Base is the foundation for the Dojo Toolkit. As well as a packaging system for Dojo classes, it contains several convenience utilities for JavaScript. It provides a bootstrapping mechanism that, for example, detects the browser and hides incompatibility issues. Everything else in Dojo is built upon this package.

For Business Space, the base package is loaded by the Business Space framework and does not need to be included in each custom widget.

Core
Core gives Base additional functions, such as animation effects, drag-and-drop capability, and internationalization support.

Dijit
Dijit is a widget layer based on Core. It provides a large set of widgets that can be easily included in a Web page.

In this book, some of the Dijits are used in the custom widget developed in Chapter 11, “Developing a service for a custom widget” on page 601.

For more information about the Dojo Toolkit, go to the following address:
http://www.dojotoolkit.org

10.2.3 Asynchronous JavaScript and XML

With Asynchronous JavaScript and XML (AJAX), clients communicate with a server in an asynchronous way. Web applications, instead of loading a page completely in one synchronous step while the user is waiting, can now fetch data partitioned in smaller packets without blocking the user. Loading is typically done in the background without impacting the user.

JavaScript provides the XMLHttpRequest object to communicate with a server. Although the name could lead you to draw the conclusion that XML is inherent for each request to a server, XML is not required. Instead, JSON (10.2.4, “JSON” on page 599) is often used as data interchange format.

Dojo makes use of the XMLHttpRequest object and provides a set of functions in the Dojo Base package. Some of these functions are:

- dojo.xhrGet
- dojo.xhrPost
- dojo.xhrPut
- dojo.xhrDelete
These functions correspond to the HTTP methods GET, POST, PUT, and DELETE. This shows how AJAX fits perfectly in the RESTful architecture of the Web.

10.2.4 JSON

JSON is a string-based representation of JavaScript objects. It is a lightweight format that is used to interchange data based name/value pairs. It is easy to read by humans but can be parsed by machines, which can generate JSON texts in a simple way. Example 10-1 shows a JSON representation of a movie used in this book.

Example 10-1  JSON representation of a movie

```json
{
    "movie" : {
        "id" : "1",
        "title" : "ITS02 - The Sequel",
        "director" : [
            { "firstName" : "Mike", "lastName" : "Director" }
        ],
        "actor" : [
            { "firstName" : "Maria", "lastName" : "Actor" },
            { "firstName" : "Michael", "lastName" : "Actor" }
        ]
    }
}
```

For more information about JSON, go to the following address:

http://www.json.org
Developing a service for a custom widget

This chapter explains how to create a service for custom widgets. We discuss the following topics:

- Overview of a service
- Designing a service
  - Leading practices
  - Designing a service scenario
  - Designing an RPC-style service
  - Designing a JAX-WS service
  - Designing a RESTful service
- Implementing a service
- Deploying a service
- Testing a service
11.1 Overview of a service

A Web service is an application programming interface (API) that can be accessed over a network, such as the Internet by a client, and executed on a remote server. In general, this term refers to clients and servers that communicate over the HyperText Transfer Protocol (HTTP) protocol used on the Web.

The W3C defines a “Web service” as:

“A software system designed to support interoperable machine-to-machine interaction over a network. It has an interface described in a machine-processable format (specifically Web Services Description Language WSDL). Other systems interact with the Web service in a manner prescribed by its description using SOAP messages, typically conveyed using HTTP with an XML serialization in conjunction with other Web-related standards.”

The W3C also states:

“We can identify two major classes of Web services, REST-compliant Web services, in which the primary purpose of the service is to manipulate XML representations of Web resources using a uniform set of “stateless” operations; and arbitrary Web services, in which the service may expose an arbitrary set of operations.”

For the sake of this discussion, we break the second group of “arbitrary Web services” into two groups:

- Web services that use a SOAP API (JAX-WS)
- Web services that do not use a SOAP API (JAX-WS)

11.1.1 RPC-oriented or RPC style service

An RPC-oriented Web service exposes its API as a set of Remote Procedural Calls (RPCs). A Remote Procedural Call (RPC) is a form of communication where the client invokes (calls) a remote procedure on the server.

RPCs are generally characterized as actions. The URI is usually verb-like, for example, the following actions can be accessed via an HTTP GET:

/itsomovie/getMovieList
/itsomovie/updateMovie?movieId=M1&title=New%20Title

1 http://www.w3.org/TR/ws-arch/#whatis
2 http://www.w3.org/TR/ws-arch/#relwwwwwrest
RPC-Oriented services typically implement only the HTTP GET, and POST operations. GET is used when the parameters of the operation can be encoded safely and efficiently as part of the URL; POST is used in other cases.

11.1.2 Java API for XML Web Services service

The Java API for XML Web Services (JAX-WS) is a Java programming language API for creating Web services. JAX-WS uses annotations, introduced in Java 5, to simplify the development and deployment of Web service clients and endpoints.

A JAX-WS style service is a Web service that implements a SOAP based API. Interfaces are defined by a Web Services Definition Language (WSDL). Interactions between clients and servers are often a XML message wrapped in a SOAP envelope and transmitted to the server over HTTP. A SOAP request using HTTP is either a POST or a GET.

11.1.3 Resource-oriented or RESTful service

A Resource-Oriented Web service or RESTful Web API is a Web service implemented using HTTP that adheres to the principles of REST. This Web API represents a collection of interconnected resources, which defines a consistent interface, and is stateless. In addition, it has the following three aspects:

- A base URI for the Web service, such as http://example.com/itsomovie/rest/.
- The Web service supports a consistent data format. Usually this is JSON or XML, but could be any valid content type.
- Every resource within the services is exposed by a unique identifier.
Table 11-1 shows how the HTTP methods are typically used to implement a RESTful Web service.

Table 11-1   RESTful Web API mapping to HTTP methods

<table>
<thead>
<tr>
<th>Resource type</th>
<th>POST</th>
<th>GET</th>
<th>PUT</th>
<th>DELETE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection URI, such as /itsomovie/rest/movies.</td>
<td>Creates a new element in the collection, with a generated ID.</td>
<td>Lists the members of the collection, complete with their member URIs for further navigation. For example, lists all the movies in the database.</td>
<td>Replaces the existing collection with a new collection.</td>
<td>Deletes the collection.</td>
</tr>
<tr>
<td>Element URI, such as /itsomovie/rest/movie/m01.</td>
<td>Creates a new element in the collection using a provided ID as a key.</td>
<td>Retrieve a representation of the addressed member of the collection.</td>
<td>Updates the addressed member of the collection.</td>
<td>Deletes the addressed member of the collection.</td>
</tr>
</tbody>
</table>

11.2 Designing a service

This section discusses the following items:

- Leading practices
- Designing a service scenario
- Designing an RPC-style service
- Designing a JAX-WS service
- Designing a RESTful service

11.2.1 Leading practices

Consider the items discussed in the following sections as leading practices in designing a service.
**Interface granularity**
A service should provide a set of interfaces. A service with only a single interface indicates inappropriate interface granularity.

**Leading practice:** A service should provide a set of interfaces.

An interface should generally contain more than one operation. Operations defined as part of an interface should be semantically related.

A large number of interfaces, each containing a single operation or small number of operations, indicates inappropriate interface granularity. Conversely, a very small number of interfaces (or a single interface) containing a large number of operations likewise indicates inappropriate interface granularity.

**Leading practice:** An interface should generally contain more than one operation. Operations defined as part of an interface should be semantically related by data on which they operate.

**Addressability**
A Web service is addressable if it exposes every resource in your system with a unique identifier. In Web terms, this is a URI or Universal Resource Identifier. RPC-oriented services typical expose very few URIs (often just one). A RESTful service exposes many URIs.

For a RESTful service, addressability is addressed through the use of URIs. URIs are standardized and well-known. A URI defines how to communicate with a resource. It defines its host, port, and others; in essence, where it is on the Web. It also defines the resource’s path, which is its identity on the server it resides.

Using a URI to identify each of your resources makes each of your resources linkable. URIs can be embedded in the data that the service responds with, allowing resources to be composed and linked into larger collections and related resources easily.

**Leading practice:** When designing a RESTful service, every resource should be assigned a URI.
Header versus payload
The HTTP request is represented as a message. This message contains data (or the payload) that will be used by the Web service to perform the business logic of the operation. This request can also contain data that is more pertinent to system-level processing associated with that request, rather than business logic performed by the operation. This data would be considered header data.

Leading practice: Define and use custom headers to carry system-relevant information that is specific to your service. Avoid putting system-relevant information into the payload of your message.

Stateful versus stateless
Interactions between clients and services can be stateful or stateless in nature. A stateful, or conversational, interaction between services occurs when the service retains knowledge of data that has been exchanged between the client and during preceding interaction.

In a stateless interaction, each operation represents a separate interaction, with the request message containing all of the necessary information to complete it; no information needs to be stored by the service to process subsequent interactions.

Stateless services are more scalable. In a stateless system, you can increase the number of concurrent requests you can handle by increasing the number of servers. In a stateful service, you can do the same thing, but then you have to worry about coordinating states between different servers (session affinity). You also have to be concerned about persisting a state in the case of an outage.

Stateless services are also reliable in the event that the client disconnects during an interaction. The client can easily resend the request, because each request is independent.

Leading practice: Design your service interfaces for stateless interactions.

Interconnected resources
In a RESTful service, within the resource data, there is often a URI linking the resource to other related resources. The hypermedia links connect the resources to each other, much like the Web sites are connected via hyperlinks.

In a well designed service, the client can follow a path through the application by following the links in the returned resources. In a service that is not well connected, the client must use predefined rules to construct the URI of every resource it requests. In essence, a well connected service is self documenting.
Uniform interface
All interactions between client and service are mediated through a few basic HTTP methods. A resource exposes a subset of these operations. The methods are GET, PUT, DELETE, and POST.
- GET is a request for information about a resource.
- PUT is usually modeled as an insert or update for a resource.
- DELETE is used to remove a resource.
- POST operations are everything else.

Using a uniform interface allows your service to more easily interoperate with other services that expose the same interface. Users of a service that uses the same uniform interface will more easily understand the workings of your interface.

In a way, the uniform interface provides another mechanism to self document your service. Once a user understands how a GET request operates, and what resources are available in your service, it easy to see how to create a GET request for a required resource.

Leading practice: Constrain your service to a uniform interface.

Idempotence and safety
Idempotence means that no matter how many times you apply the operation, the result is always the same (assuming the same payload). Safe means that invoking an operation does not change the state of the server at all.
- GET is safe and idempotent.
- PUT is idempotent.
- DELETE is idempotent
- POST is non-safe and non-idempotent.

Leading practice: Implement idempotent and safe operations where applicable.

Versioning
Using a versioning scheme in your service gives you the capability of changing your service, perhaps radically, without breaking the interoperability of existing clients.
Versioning can be done in several ways. For example, providing the version number as a component of the request, via a path segment `myservice/v1/rest`, or as a version number, can be incorporated into the host name of your service `v1.myservice.example.com`

**Leading practice:** Incorporate versioning into your service design.

**Cachability**
Web browsers use caches to store previous responses from HTTP requests. Caching reduces the number of requests that a browser needs to make to the Web servers, as information previously stored in the cache can be re-used. This improve responsiveness for the Web browser.

Caching can be implemented at both the server and client level.

**Leading practice:** Use caching mechanisms to improve responsiveness of your service.

### 11.2.2 Designing a service scenario

In this section, we present a scenario and discuss the design of an RPC, a JAX-WS, and a RESTful service to implement that scenario.

**Overview of scenario**
The ITSO Movie Company has a database that contains information about all the movies that the ITSO Movie Company has produced. Within this database, information about the movies is stored in a table, such as the title of the movie, when it was released, and what the budget was. In addition, the directors and actors for a movie are stored in another table.

The ITSO Movie Company would like to provide a RESTful style service to allow the company's personnel to access the database from a Web browser. They need the ability to query the information for movies and cast, as well as the ability to add and delete movies and cast. Finally, the service needs the ability to tell if a movie is available to the public.

These are the steps we use to design our service:

1. Define the data set.
2. Define the resources.
3. Define the interface.
4. Define the data format.
The first two steps are the same for all three service types. We define them here in this section.

Define the data set
The first step in creating a service is to define the data set involved in the service. The ITSO Movie Company data is stored in a database of two tables.

The movie table provides information about the movies. Each row in the table represents a movie. See Table 11-2.

Table 11-2  Movie table

<table>
<thead>
<tr>
<th>Column name</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>string</td>
<td>The unique identifier for a movie.</td>
</tr>
<tr>
<td>title</td>
<td>string</td>
<td>The title of the movie.</td>
</tr>
<tr>
<td>shortDescription</td>
<td>string</td>
<td>A short description of the movie.</td>
</tr>
<tr>
<td>longDescription</td>
<td>string</td>
<td>A longer description.</td>
</tr>
<tr>
<td>releaseDate</td>
<td>date</td>
<td>The date the movie was released.</td>
</tr>
<tr>
<td>budget</td>
<td>long</td>
<td>Budget for the making of the movie</td>
</tr>
<tr>
<td>available</td>
<td>boolean</td>
<td>Whether the movie is available.</td>
</tr>
<tr>
<td>genre</td>
<td>string</td>
<td>Genre of the movie, such as comedy, drama, and so on.</td>
</tr>
<tr>
<td>tagline</td>
<td>string</td>
<td>Marketing tagline for the movie.</td>
</tr>
<tr>
<td>plot</td>
<td>string</td>
<td>The synopsis of the movie plot.</td>
</tr>
<tr>
<td>awards</td>
<td>string</td>
<td>Awards that the movie has won.</td>
</tr>
</tbody>
</table>
The names table stores information about the directors and actors for a movie. Each row in the table represents a person who was either an actor or director of the movie. See Table 11-3.

### Table 11-3  Names table

<table>
<thead>
<tr>
<th>Column name</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>string</td>
<td>The unique identifier for a person</td>
</tr>
<tr>
<td>movieId</td>
<td>string</td>
<td>The ID for the movie with which this person is associated</td>
</tr>
<tr>
<td>firstName</td>
<td>string</td>
<td>First name of the person</td>
</tr>
<tr>
<td>lastName</td>
<td>string</td>
<td>Last name of the person</td>
</tr>
<tr>
<td>isActor</td>
<td>boolean</td>
<td>Indicates whether this person was an actor or director</td>
</tr>
</tbody>
</table>

**Define the resources**

The main resource of the ITSO Movie Service is the movies collection. The movie collection’s main purpose is to provide a retrieve operation that allows a user to retrieve a list of movies.

The movies collection represents a collection of movie elements. The movie resource provides the ability for a user to retrieve a movie, to add a movie, to delete a movie, and to update a movie.

For performance reasons, when we retrieve a movies collection, or an individual movie, we might not want to retrieve all the available data. In this case, we can represent more information about a movie in the MovieDetails resource. A MovieDetails resource provides more detailed information than in the parent movie resource. The MovieDetails provides the same operations as the movie resource, that is, retrieve, add, update, and delete.
Finally, for a particular movie, there is the cast. Currently, the ITSO Movie Company tracks the directors, and actors for each movie. This data is represented as part of the MovieDetails resource. The directors and actors are both represented by a person resource. The person resource provides the ability to retrieve, add, update, and delete. See Table 11-4.

Table 11-4  ITSOMovie Resources

<table>
<thead>
<tr>
<th>Resource name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>movies</td>
<td>A collection of movies</td>
</tr>
<tr>
<td>movie</td>
<td>Information about a movie</td>
</tr>
<tr>
<td>movieDetails</td>
<td>More detailed information about a movie</td>
</tr>
<tr>
<td>actors</td>
<td>A collection of persons representing the actors in a movie</td>
</tr>
<tr>
<td>directors</td>
<td>A collection of persons representing the director of a movie</td>
</tr>
<tr>
<td>person</td>
<td>Information about a person involved in a movie</td>
</tr>
</tbody>
</table>

The last two steps are discussed in more detail for each type of service. In general, the steps are:

- Define the interfaces
  Given the resources defined for the service, we need to define the set of interfaces for the service that implements those resources, and how these interfaces map to the HTTP protocol methods.

- Define the data format
  Choose a data format for the data coming from clients, and data being delivered by the server. The HTTP protocol allows for a client and server to define the data formats accepted by each component.

11.2.3 Designing an RPC-style service

The additional steps for an RPC-style service are described in this section.

Define the interfaces
We create a service called the ITSOMovieService. This service will be implemented for the RPC style as a servlet. The servlet’s Context Root will be ITSOMovieServiceRPC.
An example of a URI for this service is:

http://.../ITSOMovieServiceRPC/v7.0/getMovies

The relative URI v7.0/ represents the version of the API, allowing the service to be expanded in the future, without breaking existing clients. The relative URI getMovies represents an operation.

Table 11-5 details the list of operations for the RPC-style service.

<table>
<thead>
<tr>
<th>Operation</th>
<th>HTTP method</th>
<th>Relative URI</th>
<th>Query params</th>
<th>POST data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve list of movies.</td>
<td>GET</td>
<td>getMovies/</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Retrieve a movie.</td>
<td>GET</td>
<td>getMovie</td>
<td>ID</td>
<td>None</td>
</tr>
<tr>
<td>Remove a movie.</td>
<td>GET</td>
<td>removeMovie</td>
<td>ID</td>
<td>None</td>
</tr>
<tr>
<td>Update a movie.</td>
<td>GET</td>
<td>setMovieAvailability</td>
<td>ID available</td>
<td>Available</td>
</tr>
<tr>
<td>Add a movie.</td>
<td>POST</td>
<td>addMovie</td>
<td>None</td>
<td>ID title shortDescription longDescription releaseDate budget available movieDetails</td>
</tr>
<tr>
<td>Retrieve movieDetails.</td>
<td>GET</td>
<td>getMovieDetails/</td>
<td>ID</td>
<td>None</td>
</tr>
</tbody>
</table>
Define the data format

For an RPC-style interface, it would be appropriate to receive data from the client as either query parameters on the URL, or as name value pairs in the content area of the HTTP request. The service could deliver outbound data in XML format. See Example 11-1.

Example 11-1  Sample XML movie object

```xml
<movie id="MOVIE004" title="ITSO Action"
   shortDescription="An action adventure"
   longDescription="Join the ITSO Space Rangers as they explore a distant and mysterious planet."
   releaseDate="03-01-2010" budget="50000" available="true">
   <details genre="action">
      <actors>
         <actor firstName="Biff" lastName="Rockwright"/>
         <actor firstName="Lisa" lastName="Lamour"/>
      </actors>
      <directors>
         <director firstName="Jon" lastName="Smith"/>
      </directors>
   </details>
</movie>
```

11.2.4 Designing a JAX-WS service

The additional steps for a JAX-WS service are described here.

Define the interfaces

For a JAX-WS service, the service is implemented with a JavaBean Web Service. The servlet's Context Root will be ITSOMovieServiceWS. An example of a URI for this service is:

http://.../ITSOMovieServiceWS/v7.0

The relative URI v7.0/ represents the version of the API, allowing the service to be expanded in the future, without breaking existing clients.

The JAX-WS service interfaces and operations are defined in a WSDL file.
Table 11-6 details the list of operations for the JAX-WS service.

<table>
<thead>
<tr>
<th>Operation</th>
<th>HTTP method</th>
<th>Relative URI</th>
<th>Query params</th>
<th>POST data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve list of movies</td>
<td>POST</td>
<td>None</td>
<td>None</td>
<td>SOAP Message</td>
</tr>
<tr>
<td>Retrieve a movie</td>
<td>POST</td>
<td>None</td>
<td>None</td>
<td>SOAP Message</td>
</tr>
<tr>
<td>Remove a movie</td>
<td>POST</td>
<td>None</td>
<td>None</td>
<td>SOAP Message</td>
</tr>
<tr>
<td>Update a movie</td>
<td>POST</td>
<td>None</td>
<td>None</td>
<td>SOAP Message</td>
</tr>
<tr>
<td>Add a movie</td>
<td>POST</td>
<td>None</td>
<td>None</td>
<td>SOAP Message</td>
</tr>
<tr>
<td>Retrieve movieDetails</td>
<td>POST</td>
<td>None</td>
<td>None</td>
<td>SOAP Message</td>
</tr>
</tbody>
</table>
Figure 11-1 gives an example of how a WSDL might look.

Figure 11-1   Sample WSDL for JAX-WS Service
**Define the data format**

For a JAX-WS style interface, data should be passed to and from the service as SOAP messages. See Example 11-2.

**Example 11-2  Sample SOAP movie object**

```xml
<soapenv:Envelope
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/
xmlns:itsoms="http://ITSOMovieService/JAXWS">
  <soapenv:Header/>
  <soapenv:Body>
    <itsoms:movie id="MOVIE004" title="ITSO Action"
      shortDescription="An action adventure"
      longDescription="Join the ITSO Space Rangers as they explore a
distant and mysterious planet."
      releaseDate="03-01-2010" budget="50000" available="true">
      <itsoms:details genre="action">
        <itsoms.actors>
          <itsoms.person firstName="Biff" lastName="Rockwright"/>
          <itsoms.person firstName="Lisa" lastName="Lamour"/>
        </itsoms.actors>
        <itsoms.directors>
          <itsoms.person firstName="Jon" lastName="Smith"/>
        </itsoms.directors>
      </itsoms.details>
      <itsoms:movie>
    </soapenv:Body>
</soapenv:Envelope>
```

**11.2.5 Designing a RESTful service**

The additional steps for a RESTful service are described here.

**Define the interfaces**

Our RESTful Web API will be defined at the URI http://.../ITSOMovieService/rest/v7.0/. ITSOMovieService represents the context root of the ITSOMovieService. The relative URI rest/ represents this RESTful API, and the relative URI v7.0/ represents the version of the API, allowing the service to be expanded in the future, without breaking existing clients.
Our service exposes two resources at the relative URIs `movies/` and `movie/`. Technically speaking, the movie resource could have been represented as a subordinate resource of the movies resource; in this case, we chose two URIs, so we could demonstrate the functionality in the implementation code in an easier fashion.

- **The Movies interface**

  The Movies interface allows a user to retrieve a list of all movies. In the future, this could be expanded to provide some filtering and querying capabilities.

  Table 11-7 shows how the movies operations map to HTTP's uniform interface.

<table>
<thead>
<tr>
<th>Operation</th>
<th>HTTP method</th>
<th>Relative URI</th>
<th>Query params</th>
<th>POST data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve a list of movies.</td>
<td>GET</td>
<td>movies/</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

- **The Movie interface**

  The Movie interface allows a user to retrieve a movie based on the movie ID.

  The user can remove that movie from the movies database. The user can update some data about the movie. In this example, the user can change the available flag of the movie. Finally, the user can add a new movie to the movies database.

  Table 11-8 shows how the movie operations map to HTTP’s uniform interface.

<table>
<thead>
<tr>
<th>Operation</th>
<th>HTTP method</th>
<th>Relative URI</th>
<th>Query params</th>
<th>POST data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve a movie.</td>
<td>GET</td>
<td>movie/M01/</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Remove a movie.</td>
<td>DELETE</td>
<td>movie/M01/</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Update a movie.</td>
<td>PUT</td>
<td>movie/M01/</td>
<td>available</td>
<td>available</td>
</tr>
</tbody>
</table>
  | Add a movie.     | POST        | movie/       | None         | ID title
  |                 |             |              |              | shortDescription
  |                 |             |              |              | longDescription
  |                 |             |              |              | releaseDate
  |                 |             |              |              | budget
  |                 |             |              |              | available
  |                 |             |              |              | available
  |                 |             |              |              | movieDetails
The MovieDetails interface

The MovieDetails interface allows a user to retrieve more information for a movie based on the movie ID. This allows a client to retrieve a subset of information about a movie or list of movies, using the movie and movies resources, and if more information is needed to be retrieved, it can be done with a subsequent call to the MovieDetails resource.

As mentioned a user can retrieve MovieDetails based on a movie ID. When a user removes a movie, movie details should also be removed. When user adds a movie they also add MovieDetails. Currently users cannot update a MovieDetails resource.

Since an ITSOMovie movie can also have various cast members, the MovieDetails also represents a collection of cast members. Currently ITSOMovie tracks the director and actors involved in a movie. So the movie details needs to provide those resources as well.

Table 11-9 shows how the MovieDetails operations map to HTTP's uniform interface.

<table>
<thead>
<tr>
<th>Operation</th>
<th>HTTP method</th>
<th>Relative URI</th>
<th>Query params</th>
<th>POST data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve movieDetails</td>
<td>GET</td>
<td>movie/M01/details/</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Remove movieDetails</td>
<td>DELETE</td>
<td>movie/M01/details/</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Add movieDetails</td>
<td>POST</td>
<td>movie/details/</td>
<td>None</td>
<td>genre, tagline, plot, awards, actors, directors</td>
</tr>
</tbody>
</table>

The Person interface

The person interface allows a user to retrieve information for a person involved in an ITSOMovie. For a person, the ITSOMovie Company stores the first name and last name.

Currently, information about person resources is retrieved via the MovieDetails resource. No more operations are required.
Define the data format
Choose a data format for the data coming from clients, and data being delivered by the server. The HTTP protocol allows for a client and server to define the data formats accepted by each component.

For the ITSOMovie Company, data between the client and server will be represented in JSON format. See Example 11-3.

Example 11-3  Sample JSON movie object

```json
{
    id : "MOVIE004",
    title : "ITSO Action",
    shortDescription : "An action adventure",
    longDescription : "Join the ITSO Space Rangers as they explore a distant and mysterious planet.",
    releaseDate : "03-01-2010",
    budget : 50000,
    available : true,
}
```

11.3 Implementing a service

In this section, we discuss the steps to implement a RESTful service in WebSphere Integration Developer based on the design outlined in 11.2.5, “Designing a RESTful service” on page 616. The source code for all the samples provided here are in the Project Interchange file ITSOMovieService.zip, which comes with the additional material for this book (see Appendix B, “Additional material” on page 747 for more information).

11.3.1 Implementing a RESTful service

There are a number of steps to create a RESTful service in WebSphere Integration Developer.

Create a Dynamic Web Project and an EAR Application Project
Perform the following steps to create a dynamic Web project for your RESTful service and an EAR Application Project for deployment:

1. Select File → New → Other.
2. Select Web → Dynamic Web Project and click Next.
3. Enter ITSOMovieRESTfulService in the Project name field (Figure 11-2).

*Figure 11-2  New Dynamic Web Project window*
4. In the section EAR Membership, Click **New**. This action opens the New EAR Application Project. Enter ITSOMovieRESTfulServiceEAR in the Project name field. Leave all other defaults and click **Finish** (Figure 11-3).

![New EAR Application Project window](image)

*Figure 11-3  New EAR Application Project window*

The new project is created, and, when asked, do not switch to the J2EE perspective.

You will now be back in the New Dynamic Web Project wizard. Click **Next**.

5. Under ContextRoot, enter ITSOMovieService.
6. Leave the other values at their default value. Click Finish (Figure 11-4).

![Figure 11-4](image)

**Import sample code**

Perform the following steps to import the sample code for the ITSO Movie DB client and the REST service framework:

1. In the project navigation tree view, right-click the **Java Resources → src** folder in the ITSOMovieRESTfulService project and select **Import**.
2. Select **General → Archive File** and click **Next**.
3. Browse to the location of the Creating_a_Service_SampleCode.zip file and click Finish (Figure 11-5). Ignore the errors in the project.

![Figure 11-5 Import the sample code for the ITSO Movie DB Client](image)

**Figure 11-5 Import the sample code for the ITSO Movie DB Client**

**Import the Java libraries to support JSON**

Perform the following steps to import and set up the library files to support JSON:

1. In the project navigation tree view, right-click the ITSOMovieRESTfulService project and select New → Folder.
2. Enter lib for the folder name.
3. Right-click the lib folder and select Import.
5. Browse to the location of the JAXON .jar file and click Finish.
6. In the project navigation tree view, right-click the **ITSOMovieRESTfulService** project and select **Properties**.

7. Select **Java EE Module Dependencies**.

8. Select the **Web Libraries** tab.

9. Click **Add Jars**.

10. Expand the **ITSOMovieRESTfulService** project, and the **lib** folder, and select the JAXON .jar file (Figure 11-6).

![JAR Selection](image)

Figure 11-6   Adding Java EE Module Dependencies Part 1
11. Click **OK** (Figure 11-7).

![Figure 11-7   Adding Java EE Module Dependencies Part 2](image)

12. In the properties window, click **OK**.

**Create a Movie resource**
Perform the following steps to add a class to your project to implement the Movie resource:

1. In the project navigation tree view, right-click the **Java Resources → src** folder in the ITSOMovieRESTfulService project and select **New → Class**.
2. For the package name, enter itsomovie.resource.
3. For the class name, enter Movie.
4. Under Interfaces, Click Add... and enter Converter. Locate and select the com.ibm.jaxon.Converter interface.

5. Click OK.

6. Click Finish to complete the New Java Class wizard.

**Figure 11-8  Create the Movie class**

**Implement the Movie resource**

For the Movie resource, the class needs some fields to store the data for the movie. The class also requires a constructor that uses those fields. In addition, the JAXON Converter will require a no-arg constructor.
Perform the following steps to implement the necessary Java code for the Movie resource:

1. Open the Movie.java file. Add the fields shown in Example 11-4.

   **Example 11-4  Movie.java fields**
   ```java
   public String id;
   public String title;
   public String shortDescription;
   public String longDescription;
   public String releaseDate;
   public long budget;
   public boolean available;
   ```

2. Add the constructors shown in Example 11-5.

   **Example 11-5  Movie.java constructors**
   ```java
   public Movie() {
   }
   
   public Movie(String id, String title, String shortDescription,
                 String longDescription, String releaseDate, long budget,
                 boolean available)
   {
      this.id = id;
      this.title = title;
      this.shortDescription = shortDescription;
      this.longDescription = longDescription;
      this.releaseDate = releaseDate;
      this.budget = budget;
      this.available = available;
   }
   ```
3. In order to support the conversion between JSON and the Java Movie object, we need to implement the `toJSON` and `fromJSON` methods. Enter the appropriate code from Example 11-6 and Example 11-7 on page 629 to override the auto-generated methods.

Example 11-6  Movie.java fromJSON

```java
public Object fromJSON(JSONNode jsonNode, Type targetType, Properties options) throws ConverterException {

    if (! (jsonNode instanceof JSONObject))
        throw new java.lang.IllegalArgumentException("Expecting a JSONObject representing a " + Movie.class.getName() + ":");

    JSONObject jsonMovie = (JSONObject)jsonNode;

    String id =
        ((JSONStringValue)jsonMovie.get("id")).getValueAsString();
    String title =
        ((JSONStringValue)jsonMovie.get("title")).getValueAsString();
    String shortDescription =
        ((JSONStringValue)jsonMovie.get("shortDescription")).getValueAsString();
    String longDescription =
        ((JSONStringValue)jsonMovie.get("longDescription")).getValueAsString();
    String releaseDate =
        ((JSONStringValue)jsonMovie.get("releaseDate")).getValueAsString();
    long budget =
        ((JSONObjectNumberValue)jsonMovie.get("budget")).getValueAsNumber().longValue();
    boolean available = (jsonMovie.get("available") instanceof JSONTrueValue);

    return new Movie(id, title, shortDescription, longDescription, releaseDate, budget, available);
}
```
Example 11-7  Movie.java toJSON

```java
public JSONNode toJSON(Object javaObj, Properties options) {
    Movie movie = (Movie)javaObj;

    JSONObject jsonMovie = new JSONObject();
    jsonMovie.put("id", new JSONStringValue(movie.id == null ? "" : movie.id));
    jsonMovie.put("title", new JSONStringValue(movie.title == null ? "" : movie.title));
    jsonMovie.put("shortDescription", new JSONStringValue(movie.shortDescription == null ? "" : movie.shortDescription));
    jsonMovie.put("longDescription", new JSONStringValue(movie.longDescription == null ? "" : movie.longDescription));
    jsonMovie.put("releaseDate", new JSONStringValue(movie.releaseDate == null ? "" : movie.releaseDate));
    jsonMovie.put("budget", new JSONNumberValue(movie.budget));
    jsonMovie.put("available", movie.available ? new JSONTrueValue() : new JSONFalseValue());

    return jsonMovie;
}
```

Create a Person resource

For the Person resource, the class needs some fields to store the data for the person. The class also requires a constructor that uses those fields. In addition, the JAXON Converter requires a no-arg constructor.

Follow the procedure in “Create a Movie resource” on page 625 to create a Person class with the same package and interface.
Implement the Person resource
Perform the following steps to implement the necessary Java code for the Person resource:

1. Open the Person.java file. Add the fields and constructors shown in Example 11-8.

   Example 11-8  Person.java fields and constructors
   
   ```java
   public String personId;
   public String firstName;
   public String lastName;
   public Person() {
   }
   public Person(String personId, String firstName, String lastName) {
       this.personId = personId;
       this.firstName = firstName;
       this.lastName = lastName;
   }
   ```

2. In order to support the conversion between JSON and the Java Person object, we need to implement the `toJSON` and `fromJSON` methods. Enter the appropriate code for the methods from Example 11-9 and Example 11-10 on page 631.

   Example 11-9  Person.java fromJSON
   
   ```java
   public Object fromJSON(JSONNode jsonNode, Type targetType, Properties options)
       throws ConverterException {
       JSONObject jsonPerson = (JSONObject)jsonNode;
       JSONNode personIdNode = jsonPerson.get("personId");
       String personId = ((JSONStringValue)personIdNode).getValueAsString();
       JSONNode firstNameNode = jsonPerson.get("firstName");
       String firstName = "";
   ```
if (firstNameNode != null && firstNameNode instanceof JSONStringValue) {
    firstName = ((JSONStringValue)firstNameNode).getValueAsString();
}

JSONNode lastNameNode = jsonPerson.get("lastName");
String lastName = "";
if (lastNameNode != null && lastNameNode instanceof JSONStringValue) {
    lastName = ((JSONStringValue)lastNameNode).getValueAsString();
}

return new Person(personId, firstName, lastName);

Example 11-10  Person.java toJSON

public JSONNode toJSON(Object javaObj, Properties options) {
    Person person = (Person)javaObj;

    JSONObject jsonMovie = new JSONObject();
    jsonMovie.put("personId", new JSONStringValue(person.personId == null ? "" : person.personId));
    jsonMovie.put("firstName", new JSONStringValue(person.firstName == null ? "" : person.firstName));
    jsonMovie.put("lastName", new JSONStringValue(person.lastName == null ? "" : person.lastName));

    return jsonMovie;
}

Create a MovieDetails resource
A class for the MoviesDetails resource needs some fields to store the data for the MovieDetails. The class also requires a constructor that uses those fields. In addition, the JAXON Converter requires a no-arg constructor.

Follow the procedure described in “Create a Movie resource” on page 625 to create a MovieDetails class with the same package and interface.
Implement MovieDetails Resource

Perform the following steps to implement the necessary Java code for the MovieDetails resource:

1. Open the MovieDetails.java file. Add the fields and constructors shown in Example 11-11.

Example 11-11 MovieDetails.java fields and constructors

```java
public String movieId;

public String title;

public Person[] actors;

public Person[] directors;

public MovieDetails() {
}

public MovieDetails(String movieId, String title, Person[] actors, Person[] directors) {
    this.movieId = movieId;
    this.title = title;
    this.actors = actors;
    this.directors = directors;
}
```

2. In order to support the conversion between JSON and the Java MovieDetails object, we need to implement the toJSON and fromJSON methods. Enter the appropriate code for the methods from Example 11-12 and Example 11-13 on page 633.

Example 11-12 MovieDetails.java fromJSON

```java
public Object fromJSON(JSONNode jsonNode, Type targetType, Properties options) throws ConverterException {
    JSONObject jsonMovieDetails = (JSONObject)jsonNode;
    JSONNode movieIdNode = jsonMovieDetails.get("movieId");
    String movieId = ((JSONStringValue)movieIdNode).getValueAsString();
```
JSONNode titleNode = jsonMovieDetails.get("title");

String title = ((JSONStringValue)titleNode).getValueAsString();

JSONNode actorsNode = jsonMovieDetails.get("actors");
Person[] actors = new Person[0];
if (actorsNode != null && (actorsNode instanceof JSONArray))
    actors = (Person[])JSONToJavaConverter.fromJson(actorsNode, GenericArrayTypeImpl.make(Person.class), null);

JSONNode directorsNode = jsonMovieDetails.get("directors");
Person[] directors = new Person[0];
if (directorsNode != null && (directorsNode instanceof JSONArray))
    directors = (Person[])JSONToJavaConverter.fromJson(directorsNode, GenericArrayTypeImpl.make(Person.class), null);

return new MovieDetails(movieId, title, actors, directors);

Example 11-13  MovieDetails.java toJSON

    public JSONNode toJSON(Object javaObj, Properties options) throws ConverterException {
        MovieDetails movieDetails = (MovieDetails)javaObj;

        JSONObject jsonMovie = new JSONObject();
        jsonMovie.put("movieId", new JSONStringValue(movieDetails.movieId == null ? "" : movieDetails.movieId));
        jsonMovie.put("title", new JSONStringValue(movieDetails.title == null ? "" : movieDetails.title));
        jsonMovie.put("actors",
            JavaToJSONConverter.toJSON(movieDetails.actors == null ? new Person[0] : movieDetails.actors, null));
        jsonMovie.put("directors",
            JavaToJSONConverter.toJSON(movieDetails.directors == null ? new Person[0] : movieDetails.directors, null));

        return jsonMovie;
    }
Create a Movies REST Handler

Each resource within the service is defined by a handler. The resource handlers implement the logic necessary to process the request and respond. By implementing a standardized interface, each handler can implement its resource's operations in a standardized way.

Perform the following steps to add a class to your project to implement the REST Handler for the Movies resource:

1. In the project navigation tree view, right-click the itsomovie.service package in the ITSOMovieRESTfulService project and select **New → Class**.
2. For the class name, enter MoviesRESTHandler.
3. Under Superclass, enter itsomovie.service.RESTRequestHandler.
4. Leave all the other values at their defaults and click **Finish** (Figure 11-9).

![Figure 11-9  Create the MoviesRESTHandler class](image)

**Implement MoviesRESTHandler operations**

The Movies handler needs to implement only the GET operation for the Movies resource. The `processRetrieveRequest` will be called by the GET operation. In that method, we need to simply call the `getMovies` method in the `MovieDBClient` class.
To implement the necessary Java code for the GET operation of the MoviesRESTHandler class, open the MoviesRESTHandler.java file. Add the code shown in Example 11-14 to the processRetrieveRequest method.

**Example 11-14 MoviesRESTHandler.java processRetrieveRequest**

```java
@Override
public Object processRetrieveRequest(ITSOMovieServiceRequest itsoRequest, HttpServletRequest httpRequest) {
    try {
        return itsoRequest.movieDBClient.getMovies();
    } catch (SQLException e) {
        return e;
    }
}
```

**Create a MovieDetails REST Handler class**

To add a class to your project to implement the REST Handler for the MovieDetails resource, follow the procedure described in “Create a Movies REST Handler” on page 634 to create a MovieDetailsRESTHandler class with the same package and superclass.

**Implement MovieDetailsRESTHandler operations**

The MovieDetails handler needs to implement the GET and POST operations for the MovieDetails resource. Because it is a child resource of the Movie Resource, it should obtain the necessary information about the parent (movieId) in the constructor.

The processRetrieveRequest is called by the GET operation. In that method, we need to call the getMovieDetails method in the MovieDBClient class.

The processCreateRequest is called by the POST operation. In that method, we need to call the addMovieDetails method in the MovieDBClient class, passing a MovieDetails object.
Perform the following steps to implement the necessary Java code for the GET and POST operation of the MovieDetailsRESTHandler class:

1. Open the MovieDetailsRESTHandler.java file. Add the fields and constructor shown in Example 11-15.

   **Example 11-15 MovieDetailsRESTHandler.java fields and constructor**
   ```java
   private String movieId;

   public MovieDetailsRESTHandler(String movieId) {
       this.movieId = movieId;
   }
   ```

2. Add the code shown in Example 11-16 to the processRetrieveRequest method.

   **Example 11-16 MovieDetailsRESTHandler.java processRetrieveRequest**
   ```java
   @Override
   public Object processRetrieveRequest(ITSOMovieServiceRequest itsoRequest, HttpServletRequest httpRequest) {
       try {
           return itsoRequest.movieDBClient.getMovieDetails(movieId);
       } catch (SQLException e) {
           return e;
       }
   }
   ```

3. Add the code shown in Example 11-17 to the processCreateRequest method.

   **Example 11-17 MovieDetailsRESTHandler.java processCreateRequest**
   ```java
   @Override
   public Object processCreateRequest(ITSOMovieServiceRequest itsoRequest, HttpServletRequest httpRequest) {
       String title = itsoRequest.parameterList.get("title");

       String actorsString = itsoRequest.parameterList.get("actors");
       String directorsString = itsoRequest.parameterList.get("directors");
   ```
try {
    Parser p;
    Person[] actors = new Person[0];
    if (actorsString != null && actorsString.length() > 0) {
        p = new Parser(new
            CharArrayReader(actorsString.toCharArray()));

        actors =
            (Person[])JSONToJavaConverter.fromJSON(p.parseArray(),
                GenericArrayTypeImpl.make(Person.class), null);
    }

    Person[] directors = new Person[0];
    if (directorsString != null && directorsString.length() >
        0) {
        p = new Parser(new
            CharArrayReader(directorsString.toCharArray()));
        directors =
            (Person[])JSONToJavaConverter.fromJSON(p.parseArray(),
                GenericArrayTypeImpl.make(Person.class), null);
    }

    if (actors.length > 0 || directors.length > 0) {
        MovieDetails movieDetails = new MovieDetails(movieId,
            title, actors, directors);

        return
            itsoRequest.movieDBClient.addMovieDetails(movieDetails);
    } else {
        return 0;
    }
}

catch (SQLException e) {
    return e;
}

catch (ConverterException e) {
    return e;
}

catch (ParserException e) {
    return e;
}
Create a Movie REST Handler class

To add a class to your project to implement the REST Handler for the Movie resource, follow the procedure described in “Create a Movies REST Handler” on page 634 to create a MovieRESTHandler class with the same package and superclass.

Implement MovieRESTHandler operations

The Movie handler needs to implement the GET, PUT, DELETE, and POST operations for the Movie resource.

The processRetrieveRequest is called by the GET operation. Either the request is forwarded to the MovieDetails REST handler, or it needs to call the getMovie method in the MovieDBClient class.

The processCreateRequest is called by the POST operation. Either the request is forwarded to the MovieDetails REST handler, or it needs to call the addMovie method in the MovieDBClient class, passing a Movie object.

The processDeleteRequest is called by the DELETE operation. It needs to call the removeMovie method in the MovieDBClient class.

The processUpdateRequest is called by the POST operation. It needs to call the updateMovieAvailability method in the MovieDBClient class.

Perform the following steps to implement the necessary Java code for the GET, PUT, DELETE, and POST operation of the MovieRESTHandler class:

1. Open the MovieRESTHandler.java file. Add the code shown in Example 11-18 to the processCreateRequest method.

Example 11-18  MovieRESTHandler.java processCreateRequest

```java
@Override
    public Object processCreateRequest(ITSOMovieServiceRequest itsoRequest,
                                        HttpServletRequest httpRequest) {

        // first segment could be an id, followed by 'details' or no segments
        if (itsoRequest.segmentList.size() == 2) {
            // get movie Id
            String movieId = itsoRequest.segmentList.get(0);

            // check for child resource
            String childResource = itsoRequest.segmentList.get(1);
```
if (childResource.equalsIgnoreCase("details"))
{
    MovieDetailsRESTHandler childRequestHandler = new MovieDetailsRESTHandler(movieId);
    return childRequestHandler.processCreateRequest(itsoRequest, httpRequest);
}

//additional segments not provided or not recognized, so just do a add movie
String movieId = itsoRequest.parameterList.get("id");
if (movieId == null || movieId.length() == 0)
    return new ITSOMovieServiceException("Invalid POST movie request. Expected a movie Id.");

String title = itsoRequest.parameterList.get("title");
if (title == null || title.length() == 0)
    return new ITSOMovieServiceException("Invalid POST movie request. Expected a title.");

String shortDescription = itsoRequest.parameterList.get("shortDescription");
String longDescription = itsoRequest.parameterList.get("longDescription");
String releaseDate = itsoRequest.parameterList.get("releaseDate");
long budget = 0;
try {
    budget = Long.parseLong(itsoRequest.parameterList.get("budget"));
} catch (Exception e) {
    // ignore, value will default to 0
}
String avail = itsoRequest.parameterList.get("available");
boolean available = (avail == null ? true : avail.equalsIgnoreCase("true"));

Movie movie = new Movie(movieId, title, shortDescription, longDescription, releaseDate, budget, available);
try {
    return itsoRequest.movieDBClient.addMovie(movie);
} catch (SQLException e) {
    return e;
}

2. Open the MovieRESTHandler.java file. Add the code shown in Example 11-19 to the processDeleteRequest method.

---

Example 11-19  MovieRESTHandler.java processDeleteRequest

```java
@Override
public Object processDeleteRequest(ITSOMovieServiceRequest itsoRequest,
                                  HttpServletRequest httpRequest) {

    // first segment should be an id
    if (itsoRequest.segmentList.size() == 0)
        return new ITSOMovieServiceException("Invalid DELETE movie request. Expected a movie Id.");

    String movieId = itsoRequest.segmentList.get(0);
    try {
        return itsoRequest.movieDBClient.deleteMovie(movieId);
    } catch (SQLException e) {
        return e;
    }
}
```
3. Open the MovieRESTHandler.java file. Add the code shown in Example 11-20 to the processRetrieveRequest method.

**Example 11-20  MovieRESTHandler.java processRetrieveRequest**

```java
@override
public Object processRetrieveRequest(ITSOMovieServiceRequest itsoRequest,
HttpServletResponse httpResponse) {
    // first segment should be an id
    if (itsoRequest.segmentList.size() == 0)
        return new ITSOMovieServiceException("Invalid GET movie request.
    Expected a movie Id.");

    String movieId = itsoRequest.segmentList.get(0);

    // check if an additional segment was specified
    if (itsoRequest.segmentList.size() > 1)
    {
        String childObject = itsoRequest.segmentList.get(1);

        // note child object can't be null since it was passed in the
        // URL between slashes, so at worst
        // it is an empty string, no need to check for null
        if (childObject.equalsIgnoreCase("details"))
        {
            MovieDetailsRESTHandler childRequestHandler = new
            MovieDetailsRESTHandler(movieId);

            return childRequestHandler.processRetrieveRequest(itsoRequest,
            httpResponse);
        }
    }

    // additional segment, not specified, or not recognized
    try{
        return itsoRequest.movieDBClient.getMovie(movieId);
    } catch (SQLException e) {
        return e;
    }
}
```
4. Open the MovieRESTHandler Java class. Add the code shown in Example 11-21 to the processUpdateRequest method.

```java
Example 11-21  MovieRESTHandler.java processUpdateRequest

@Override
public Object processUpdateRequest(ITSOMovieServiceRequest itsoRequest,
                                  HttpServletRequest httpRequest) {

    // first segment should be an id
    if ( itsoRequest.segmentList.size() == 0 )
        return new ITSOMovieServiceException("Invalid PUT movie request. Expected a movie Id.");

    String movieId = itsoRequest.segmentList.get(0);

    String avail =
        itsoRequest.queryParameterList.get("available");

    if ( avail == null)
        return new ITSOMovieServiceException("Invalid PUT movie request. Expected a query parameter of available=<true/false>." );

    boolean available = avail.equalsIgnoreCase("true");

    try {
        return
            itsoRequest.movieDBClient.updateMovieAvailability(movieId,
                        available);
    } catch (SQLException e) {
        return e;
    }
}
```

Create the ITSOMovieService class

The ITSOMovieService class is the servlet that responds to requests for this service. The servlet’s job is to process and validate the REST request. Using the path information from the REST request, the servlet forwards the request to the appropriate REST Handler class. Finally, the servlet processes the return value from the REST Handler class into a JSON object and writes that value to the output stream of the HTTPResponse.
Perform the following steps to add a servlet to your project for the ITSO Movie Service:

1. In the project navigation tree view, right-click the itsomovie.service package in the ITSOMovieRESTfulService project and select New → Servlet.
2. For the class name, enter ITSOMovieService.
3. Keep the other default values and click Next (Figure 11-10).

4. In the URL Mappings section, select the mapping and click Edit....
5. Change the value to /*.
6. Click **OK** (Figure 11-11).

![Create Servlet](image)

**Figure 11-11  Create the Servlet ITSOMovieService part 2**

7. Click **Finish**.

**Implement ITSOMovieService**

On initialization, the ITSOMovieService needs to initialize the ITSO Movies DB client and register the JSON converter classes.
To implement the necessary Java code to initialize the ITSOMovieService class, open the ITSOMovieService.java file. Add the code shown in Example 11-22 to the ITSOMovieService class.

**Example 11-22  ITSOMovieService.java fields and init method**

```java
private MovieDBClient movieDBClient;

@Override
public void init(ServletConfig cfg) throws ServletException {
    super.init(cfg);

    // register jaxon converters for our resource classes
    ConverterRegistry.getInstance().registerConverter("itsomovie.resource.Movie", Movie.class);
    ConverterRegistry.getInstance().registerConverter("itsomovie.resource.MovieDetails", MovieDetails.class);
    ConverterRegistry.getInstance().registerConverter("itsomovie.resource.Person", Person.class);
    ConverterRegistry.getInstance().registerConverter("itsomovie.service.ITSMovieServiceException", ITSOMovieServiceException.class);
    ConverterRegistry.getInstance().registerConverter("itsomovie.service.ITSMovieServiceRequest", ITSOMovieServiceRequest.class);

    // initialize Movie database client
    try {
        movieDBClient = new MovieDBClient();
    } catch (SQLException e) {
        throw new ServletException("A SQLException occurred while initializing the ITSOMovies DB Client.", e);
    }
}
```

The ITSOMovieService needs to implement the HTTP GET, PUT, DELETE, and POST operations. For these operations, simply forward them to another method that handles all the operations generically.
Perform the following steps to implement the necessary Java code for the GET, PUT, DELETE, and POST operations of the ITSOMovieService class:

1. Open the ITSOMovieService.java file. Add the code shown in Example 11-23 to the doDelete method.

Example 11-23  ITSOMovieService.java doDelete

@override
protected void doDelete(HttpServletRequest req,
HttpServletResponse resp) throws ServletException, IOException {

// call handleRequest to handle the request
handleRequest(req, resp);
}

2. Using similar code, implement the doGET, doPost, and doPUT methods.

3. Add the handleRequest method to process these requests (Example 11-24).

Example 11-24  ITSOMovieService.java handleRequest

private void handleRequest(HttpServletRequest request,
HttpServletResponse response) throws ServletException, IOException {

    // create a RESTPathInfo with the retrieved path info
    ITSOMovieServiceRequest itsoRequest = new
    ITSOMovieServiceRequest(movieDBClient, request);

    Object results;
    if (itsoRequest.version.equalsIgnoreCase("v7.0") )
    {
        if (itsoRequest.resource.equalsIgnoreCase("movies"))
        {
            MoviesRESTHandler requestHandler = new
            MoviesRESTHandler();

            results = requestHandler.handleRequest(itsoRequest,
            request);
        }
        else if (
        itsoRequest.resource.equalsIgnoreCase("movie"))
        {
            MovieRESTHandler requestHandler = new
            MovieRESTHandler();
        }
    }
results = requestHandler.handleRequest(itsoRequest, request);
}
else {
    results = new ITSOMovieServiceException("Unknown
    ITSOMovieService resource name " + itsoRequest.resource + ".");
}
else {
    results = new ITSOMovieServiceException("Unsupported
    ITSOMovieService REST API version number " + itsoRequest.version + ".");
}
handleResponse(itsoRequest, results, response);
}

4. Add the handleResponse method to process the response (Example 11-25).

Example 11-25  ITSOMovieService.java handleResponse

private void handleResponse(ITSOMovieServiceRequest itsoRequest, Object result, HttpServletResponse response) throws ServletException, IOException {

    // set cache settings
    Date now = new Date();
    response.setDateHeader("Expires", now.getTime());
    response.setHeader("Cache-Control", "no-cache,
    must-revalidate");
    response.setHeader("Pragma", "no-cache");

    // create top level object
    JSONObject tloObj = new JSONObject();

    // create a request/response wrapper
    JSONObject wrapperObj = new JSONObject();
    tloObj.put("ITSOMovieService", wrapperObj);

    try {
    

// process the request parameters and transform to JSON object
wrapperObj.put("request",
JavaToJSONConverter.toJSON(itsoRequest, null));

// Process results and transform to JSON object
JSONNode jsonResponse = JavaToJSONConverter.toJSON(result, null);
wrapperObj.put("response", jsonResponse);
}

// Initialize

} catch (ConverterException e) {
    String message = "A JSONConverterException occurred while attempting to serialize the results object : " + e;
    wrapperObj.put("Response", new JSONStringValue(message));
}

/*
 * Serialize it
 */
String jsonStr = tloObj.toJSONString();

/*
 * Write the serialized JSON object to the output stream
 */
response.setContentType("application/json");
Writer writer = response.getWriter();
writer.write(jsonStr);
}

11.4 Deploying a service

In this section, we discuss the steps to deploy a RESTful service in WebSphere Integration Developer based on the service implemented in 11.3.1, “Implementing a RESTful service” on page 619.

When we create the project for the service, we create a Dynamic Web Project and an EAR Application Project. We need to deploy that EAR.

Perform the following steps to deploy the EAR file from the Integrated Test Environment of WebSphere Integration Developer:

1. In the Servers view, right-click your Integrated Test Environment server and select Add and Remove Projects.
2. In the Available projects list, select the ITSOMovieRESTfulServiceEAR project and click Add (Figure 11-12).

![Add and Remove Projects](image)

Figure 11-12  Add and Remove Projects

3. After the Publish step completes, your service will be deployed.

11.5 Testing a service

In order to test all of the RESTful service's interfaces, we need a way to initiate HTTP requests with all four HTTP methods. An HTTP GET can be done quite easily by just typing the URL of the get method, for example, getMovies, into a Web browser address bar. However, for the other methods, it is a little more tricky. In 12.3, “Creating a widget client implementation” on page 658, we develop a Dojo client that can communicate with our Web service.
For now, we use a simple JavaScript and HTML client running in a Web browser to test the service. The test client is included in the code that accompanies this book, and is located in the project interchange file ITSOMovieServiceTestConsole.zip. (See Appendix B, “Additional material” on page 747 for more details.)

**Import the test harness Web application**
Perform the following steps to import the test harness application:

1. In the project navigation tree view, right-click and select **Import**.
2. Select **Other → Project Interchange** and click **Next**.
3. Browse to the location of the ITSOMovieServiceTestConsole project interchange file.
4. Click **Select All** and click **Finish**.

**Deploy the test harness Web application**
In order to use the test harness Web application, we need to add the test console Web application to an EAR to be deployed, and then deploy it to our server.

Perform the following steps to deploy the test harness application:

1. In the project navigation tree view, select the **ITSOMovieRESTfulServiceEAR** project, and right-click and select **Properties**.
2. Select **Java EE Module Dependencies** and click **Next**.
3. In the Available Java EE modules section, find the **ITSOMovieServiceTestConsole.war** module and check its check box.
4. Click **OK**.

**Publish changes to the server**
To publish the changes to the EAR to the Integrated Test Environment of WebSphere Integration Developer, right-click, in the Servers view, your Integrated Test Environment server and select **Publish**.
Test the service
The sample test console application, when it is opened, detects the host name and port of server on which the application is running, and shows that information in the connect window. You can use these values to connect, or, if you had deployed the application in a different way, specify the appropriate values here. The connect page is shown in Figure 11-13.

Figure 11-13  ITSOMovieService Test Console’s connect page
Open the test harness application in a browser (or in WebSphere Integration Developer) and use the application to test your service. For example, in the navigation pane on the left, select Get Movies. On the page that opens, click the Submit Request button. The test client invokes a request to the service and the result (a list of movies rendered in HTML) should be displayed. See Figure 11-14.

Figure 11-14  ITSOMovieService Test Console’s Get Movies page response

You can select the [raw] hyper link to show the raw JSON object in a text box.
Developing a client for a custom widget

This chapter explains how to develop a client for a custom widget.

We discuss the following topics:

- Overview of a widget client
- Designing a widget client
- Creating a widget client implementation
- Packaging, deploying, and testing of a Dojo client
12.1 Overview of a widget client

A widget client is a component that encapsulates the logic that interacts with a Web service, such as the one created in 11.3.1, “Implementing a RESTful service” on page 619. Widget clients can be built by using various methods. In 11.5, “Testing a service” on page 650, we demonstrate a pure JavaScript client that interacts with a Web service. In this chapter, we show how to create a widget client using a Dojo class. In 13.3.3, “Implementation for ITSO Movie DB Connector widget” on page 708, we show how to easily implement a widget that encapsulates the client logic.

12.2 Designing a widget client

The design of our widget client will follow the design of the RESTful service we created in 11.2.5, “Designing a RESTful service” on page 616. In Table 12-1, we summarize the interface of the service.

Table 12-1  RESTful Service API

<table>
<thead>
<tr>
<th>Operation</th>
<th>HTTP method</th>
<th>Relative URI</th>
<th>Query params</th>
<th>POST data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve list of movies.</td>
<td>GET</td>
<td>movies/</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Retrieve a movie.</td>
<td>GET</td>
<td>movie/M01/</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Remove a movie.</td>
<td>DELETE</td>
<td>movie/M01/</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Update a movie.</td>
<td>PUT</td>
<td>movie/M01/</td>
<td>available</td>
<td>available</td>
</tr>
<tr>
<td>Add a movie.</td>
<td>POST</td>
<td>movie/</td>
<td>None</td>
<td>ID title shortDescription longDescription releaseDate budget available movieDetails</td>
</tr>
<tr>
<td>Retrieve movieDetails.</td>
<td>GET</td>
<td>movie/M01/details/</td>
<td>None</td>
<td>none</td>
</tr>
<tr>
<td>Remove movieDetails.</td>
<td>DELETE</td>
<td>movie/M01/details/</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>
When the Remove a movie operation is called, all movie details are removed as well, so the client only needs to call Remove a movie. When using the Dojo `xhrXXX` methods, we have the option of using asynchronous or synchronous requests. For synchronous requests, the call to the Dojo method blocks the browser until the response is returned from the HTTP call. For asynchronous requests, this action does not occur. The Dojo `xhrXXX` methods also allow a parameter to determine if Dojo should add a unique identifier to each request to prevent the request from being cached by the browser. This gives us the operations summarized in Table 12-2.

<table>
<thead>
<tr>
<th>Operation</th>
<th>HTTP method</th>
<th>Relative URI</th>
<th>Query params</th>
<th>POST data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add movieDetails</td>
<td>POST</td>
<td>movie/details/</td>
<td>None</td>
<td>genre tagline plot awards actors directors</td>
</tr>
</tbody>
</table>

Table 12-2  Client API

<table>
<thead>
<tr>
<th>Method</th>
<th>Service method</th>
<th>Sync or async</th>
<th>Cachable</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>getMovies</td>
<td>Retrieve list of movies.</td>
<td>Async</td>
<td>Yes</td>
<td>None</td>
</tr>
<tr>
<td>getMovie</td>
<td>Retrieve a movie.</td>
<td>Async</td>
<td>Yes</td>
<td>string movieId</td>
</tr>
<tr>
<td>removeMovie</td>
<td>Remove a movie.</td>
<td>Async</td>
<td>No</td>
<td>string movieId</td>
</tr>
<tr>
<td>setMovieAvailability</td>
<td>Update a movie.</td>
<td>Async</td>
<td>No</td>
<td>string movieId boot available</td>
</tr>
<tr>
<td>addMovie</td>
<td>Add a movie.</td>
<td>Async</td>
<td>No</td>
<td>object Movie</td>
</tr>
<tr>
<td>getMovieDetails</td>
<td>Retrieve movieDetails.</td>
<td>Async</td>
<td>Yes</td>
<td>string movieId</td>
</tr>
<tr>
<td>addMovieDetails</td>
<td>Add movieDetails.</td>
<td>Async</td>
<td>No</td>
<td>object MovieDetails</td>
</tr>
</tbody>
</table>
12.3 Creating a widget client implementation

This section describes the steps necessary to build a Dojo client in WebSphere Integration Developer V7.0. The source code for all the samples provided here are in the project interchange file ITSOMovieClient.zip, which is included in the additional materials supplied with this book (see Appendix B, “Additional material” on page 747 for more information).

12.3.1 Create a static Web project

Perform the following steps to create a static Web project for your client:

1. Select **File → New → Other**.
2. Select **Web → Static Web Project**.
3. Enter ITSOMovieClient into the Project name field.
4. Leave the rest of the default values as they are (Figure 12-1) and click **Finish**.

![Figure 12-1 Create a new static Web project](image-url)
5. Select **Yes** if you are prompted to switch to the Web perspective.

### 12.3.2 Add project facets

In order to build and work with JavaScript and Dojo code more easily, we add some project facets to our static Web project. This will give us some rudimentary error detection and content-assist.

Perform the following steps to create a static Web project for your client:

1. Right-click the **ITSOMovieClient** project in the project navigation view and click **Properties**.
2. Click **Project Facets**.
3. Check the **JavaScript Toolkit** check box.
4. Check the **Web 2.0** check box, expand it, and check the **Dojo Toolkit** check box (Figure 12-2).

![Figure 12-2 Adding Project Facets](image)

5. Click **OK**.

**12.3.3 Create a folder for client code**

Perform the following steps to create a folder for your client code:

1. Right-click the **WebContent** folder of the ITSOMovieClient project and select **New → Folder**.
2. Enter client for the folder name.
3. Click **Finish**.
12.3.4 Create a Dojo class

This client is implemented as a Dojo class. We use the New Dojo Class wizard to create the class, and basic framework.

Perform the following steps to create a Dojo class;

1. Right-click the client folder you just created and select New → Other → JavaScript → Dojo Class (Figure 12-3).

![Figure 12-3  New a Dojo class](image)

2. Click Next.
3. Enter itsomoviedbclient.js for the file name.
4. Enter itsomoviedbclient for the class name.
5. Accept the other defaults as they are (Figure 12-4) and click **Finish**.

![Image](itsomovie.dbclient.js)

**Figure 12-4**  itsomovie.dbclient.js

### 12.3.5 Implement the code for the Dojo Class

It is a good programming practice to add a dojo.provide method to the top of the Dojo class to prevent this class from being loaded multiple times.

To add a call to dojo.provide, open the itsomovie.dbclient JavaScript file. Add the line shown in Example 12-1 above the dojo.declare method.

*Example 12-1  Dojo.provide*

```javascript
    dojo.provide("client.itsomovie.dbclient");
```
This Dojo class will be accessing a URL defined by the iWidget framework, which is discussed in more detail in 13.3.3, “Implementation for ITSO Movie DB Connector widget” on page 708. For now, just add two fields to store the necessary values.

To add variables to the Dojo class, open the itsomovedbclient JavaScript file. Add the line shown in Example 12-2 in the class body after the dojo.declare method.

```
//service root for the ITSOMovieService
itsomovieServiceRoot : null,

// iContext object
iContext: null,
```

When a Dojo class is instantiated, a constructor is called. This action allows us to define a place for our class to be initialized. In this case, we need to get two parameters from the invoker, that is, the value of the iContext object and the value of the ITSOMovieServiceEndpoint, and set those values to the variables we defined in Example 12-2.

To add a constructor to the Dojo class, open the itsomovedbclient JavaScript file. Add the line shown in Example 12-3 after the variables created in Example 12-2.

```
constructor: function(parameters){
    this.itsomovieServiceRoot = parameters.itsomovieServiceRoot;
    this.iContext = parameters.iContext;
},
```

**Note:** Remember that in a Dojo class, the functions and variables in the class are actually JavaScript Object properties, so they are separated by commas.

The Dojo client needs to provide a set of methods that invoke the ITSO Movie Service. The client needs to provide a addMovie, addMovieDetails, getMovie, getMovies, getMovieDetails, removeMovie, and finally setMovieAvailability methods.
We start with the getMovies method. In this method, callers call this Dojo class by passing in two JavaScript functions as arguments. One of the functions is called on a successful response (load) and the other is called in case of error. In either case, we want to use code to clean up the result and handle typical errors. Therefore, we wrap those given functions in our own functions.

For example, in the case of an error, we return an object that has the value of the HTTP status code, the error message (if any), and we return an empty array of movies, because no result was returned. See Example 12-4.

**Example 12-4  Sample onError code**

```javascript
var onError = function(data, ioArgs) {
    var response = {
        status : ioArgs.xhr.status,
        error : data,
        movies : []
    };
    error(response);
};
```

In the case of a successful interaction, we return an object that has the value of the HTTP status code, the array of movies returned, and the raw JSON text that was returned. We return a client error (an HTTP status code 400) if we receive a success status code from the service, but no result was returned. See Example 12-5 on page 665.
Example 12-5  Sample onLoad code

```javascript
var onLoad = function(data, ioArgs) {
    var response = { movies: [] };  

    // check if a result was returned
    if (data.ITSOMovieService == undefined ||
        data.ITSOMovieService.response == undefined) {
        // return a client error, with status code 400
        response.status = 400;
        response.error = { message:
            "data.ITSOMovieService.response object not defined."};
    } else {
        response.status = ioArgs.xhr.status;
        response.movies = data.ITSOMovieService.response;
    }
    load(response);
};
```

In order to call our service, we use the dojo.xhrXXX methods, where XXX is the HTTP method to be called. In this case, we need to make a GET request to the URI .../movies. We use asynchronous request/response for performance reasons, and the request can be cached. See Example 12-6.

Example 12-6  Sample dojo.xhrGet code

```javascript
var request = {
    url: this.iContext.io.rewriteURI(this.itsomovieServiceRoot + "movies"),
    sync: false,
    handleAs: "json",
    preventCache: false,
    contentType: "charset=UTF-8",

    load: onLoad,
    error: onError
};
dojo.xhrGet(request);
```
Putting it all together, we have the code shown in Example 12-7.

**Example 12-7  getMovies method**

```
getMovies: function(/*function*/ load, /*function*/ error) {
  var onError = function(data, ioArgs) {
    var response = {
      status : ioArgs.xhr.status,
      error : data,
      movies : []
    };
    error(response);
  };

  var onLoad = function(data, ioArgs) {
    var response = { movies : [] };

    // check if a result was returned
    if (data.ITSOMovieService == undefined ||
      data.ITSOMovieService.response == undefined) {
      // return a client error, with status code 400
      response.status = 400;
      response.error = { message : "A client error occurred in the
getMovies request."};
    } else {
      response.status = ioArgs.xhr.status;
      response.movies = data.ITSOMovieService.response;
    }
    load(response);
  };

  var request = {
    url : this.iContext.io.rewriteURI(this.itsomovieServiceRoot +
      "movies"),
    sync : false,
    handleAs : "json",
    preventCache : false,
    contentType : "charset=UTF-8",
    load : onLoad,
    error : onError
  };
  dojo.xhrGet(request);
},
```
Using the code shown in Example 12-7 on page 666 as a template, we create the getMovie method. In this case, we need an additional parameter, the movieId. The URI is now ../movie/<movieId>. Also, we use GET in an asynchronous fashion and allow the result to be cached. See Example 12-8 (note that the changes from getMovies are in bold).

**Example 12-8  getMovie method**

```javascript
getMovie: function(/*string*/ movieId, /*function*/ load, /*function*/ error) {
    var onError = function(data, ioArgs) {
        var response = {
            status : ioArgs.xhr.status,
            error : data,
            movie : {};
        }
        error(response);
    }
    var onLoad = function(data, ioArgs) {
        var response = { movie : {} };  
        // check if a result was returned
        if (data.ITSOMovieService == undefined || data.ITSOMovieService.response == undefined) {
            // return a client error, with status code 400
            response.status = 400;
            response.error = { message : "An client error occurred in the getMovie request."};
        } else {
            response.status = ioArgs.xhr.status;
            response.movie = data.ITSOMovieService.response;
        }
        load(response);
    }
    var request = {
        url : this.iContext.io.rewriteURI(this.itsomovieServiceRoot + "movie/" + movieId),
        sync : false,
        handleAs : "json",
        preventCache : false,
```
Using the code shown in Example 12-8 on page 667 as a template, we create the `getMovieDetails` method. The URI is now `/movie/<movieid>/details`. We use GET in an asynchronous fashion and allow the result to be cached. See Example 12-9 (note that the changes from `getMovies` are in **bold**).

**Example 12-9 getMovieDetails method**

```javascript
getMovieDetails: function(/*string*/ movieId, /*function*/ load, /*function*/ error) {
  var onError = function(data, ioArgs) {
    var response = {
      status: ioArgs.xhr.status,
      error: data,
      movieDetails: {}
    }
    error(response);
  }
  var onLoad = function(data, ioArgs) {
    var response = { movieDetails: {} }
    // check if a result was returned
    if ( data.ITSOMovieService == undefined || data.ITSOMovieService.response == undefined ) {
      // return a client error, with status code 400
      response.status = 400;
      response.error = { message: "An client error occurred in the getMovieDetails request."};
    } else {
      response.status = ioArgs.xhr.status;
      response.movieDetails = data.ITSOMovieService.response;
    }
    load(response);
  }
  dojo.xhrGet(request);
}
```

Using the code shown in Example 12-8 on page 667 as a template, we create the `getMovieDetails` method. The URI is now `/movie/<movieid>/details`. We use GET in an asynchronous fashion and allow the result to be cached. See Example 12-9 (note that the changes from `getMovies` are in **bold**).
var request = {
    url: this.iContext.io.rewriteURI(this.itsomovieServiceRoot +
    "movie/" + movieId + "/details"),
    sync: false,
    handleAs: "json",
    preventCache: false,
    contentType: "charset=UTF-8",

    load: onLoad,
    error: onError
};
dojo.xhrGet(request);

Using the code shown for the getMovie method in Example 12-8 on page 667 as a template, create the addMovie method. A Movie object needs to be passed as a parameter. The URI is now ../movie. We use POST in an asynchronous fashion. In this case, we do not want to request to be cached. See Example 12-10 (note that the changes from getMovie are in bold).

Example 12-10  addMovie method

    addMovie: function(/*object*/ movie, /*function*/ load, /*function*/
           error) {
        var onError = function(data, ioArgs) {
            var response = {
                status: ioArgs.xhr.status,
                error: data,
                pkey: -1
            }; response(pkey: -1);
            error(response);
        };

        var onLoad = function(data, ioArgs) {
            var response = { pkey: -1 };

            // check if a result was returned
            if (data.ITSOMovieService == undefined ||
                data.ITSOMovieService.response == undefined) {

                // return a client error, with status code 400
                response.status = 400;
                response.error = { message: "An client error occurred in
                    the addMovie request."};
            } else {
                // return a server error, with status code 500
                response.status = 500;
                response.error = { message: "A server error occurred in
                    the addMovie request."};
            }
        }

        dojo.xhrPost(request, onLoad, onError);
    },
Using the code shown for the addMovie method in Example 12-8 on page 667 as a template, create the addMovieDetails method. Instead of a Movie object, we pass a movieId and a MovieDetails object. The URI is now .../movie/<movieid>/details. As before, we use POST in an asynchronous fashion. We do not want the request to be cached. See Example 12-11 (note the changes from addMovie are in bold).

**Example 12-11  addMovieDetails method**

```javascript
addMovieDetails: function(/*string*/ movieId, /*object*/ movieDetails, /*function*/ load, /*function*/ error) {
    var onError = function(data, ioArgs) {
        var response = {
            status : ioArgs.xhr.status,
            error : data,
            pkey : -1
        };
        error(response);
    };
    var onLoad = function(data, ioArgs) {
        var response = {
            status : ioArgs.xhr.status,
            error : data,
            pkey : -1
        };
        load(response);
    };
```

var response = { pkey : -1 };

// check if a result was returned
if ( data.ITSOMovieService == undefined ||
data.ITSOMovieService.response == undefined ) {
    // return a client error, with status code 400
    response.status = 400;
    response.error = { message : "An client error occurred in
the addMovieDetails request."};
}
else{
    response.status = ioArgs.xhr.status;
    response.pkey = data.ITSOMovieService.response;
}
load(response);
};

var request = {
    url : this.iContext.io.rewriteURI(this.itsomovieServiceRoot + 
"movie/" + movieId + "/details"),
    sync : false,
    handleAs : "json",
    preventCache : true,
    contentType : "charset=UTF-8",
    content: movieDetails,
    load : onLoad,
    error : onError
};
dojo.xhrPost(request);,


Using the code shown for the addMovie method in Example 12-3 on page 663 as a template, create the removeMovie method. We pass a movieId. The URI is now `../movie/<movieid>`. We make a DELETE request in an asynchronous fashion. We do not want the request to be cached. See Example 12-12 (note that the changes from addMovie are in **bold**). Note that the content variable in the request object is not needed for DELETE.

**Example 12-12  removeMovie method**

```javascript
removeMovie: function(/*string*/ movieId, /*function*/ load, /*function*/ error) {
  var onError = function(data, ioArgs) {
    var response = {
      status : ioargs.xhr.status,
      error : data,
      numOfRowsDeleted : 0
    };
    error(response);
  };

  var onLoad = function(data, ioArgs) {
    var response = { numOfRowsDeleted : 0 };

    // check if a result was returned
    if ( data.ITSOMovieService == undefined ||
        data.ITSOMovieService.response == undefined ) {

      // return a client error, with status code 400
      response.status = 400;
      response.error = { message : "An client error occurred in the removeMovie request."};
    }

    else
      {
        response.status = ioArgs.xhr.status;
        response.numOfRowsDeleted = data.ITSOMovieService.response;
      }
    load(response);
  };

  var request = {
    url : this.iContext.io.rewriteURI(this.itsomovieServiceRoot + "movie/" + movieId),
    sync : false,
    handleAs : "json",
```
preventCache : true,
contentType : "charset=UTF-8",

load : onLoad,
error : onError

};
dojo.xhrDelete(request);
Finally, we need to create a setMovieAvailability method. We use the code for removeMovie in Example 12-3 on page 663 as a template. We pass a movied as well as a Boolean value that indicates whether the movie is available. The URI is now ../movie/<movieid>?available=<true|false>. We make a PUT request in an asynchronous fashion. We do not want the request to be cached. See Example 12-3 on page 663 (note that the changes from removeMovie are in bold).

**Example 12-13 updateMovieAvailability method**

```javascript
setMovieAvailability: function(/*string*/ movieId, /*boolean*/ avail, /*function*/ load, /*function*/ error) {
  var onError = function(data, ioArgs) {
    var response = {
      status : ioArgs.xhr.status,
      error : data,
      numOfRowsUpdated : 0
    };
    error(response);
  };

  var onLoad = function(data, ioArgs) {
    var response = { numOfRowsUpdated : 0 };

    // check if a result was returned
    if ( data.ITSOMovieService == undefined ||
    data.ITSOMovieService.response == undefined ) {
      // return a client error, with status code 400
      response.status = 400;
      response.error = { message : "An client error occurred in
    the setMovieAvailability request."};
    } else {
    response.status = ioArgs.xhr.status;
    response.numOfRowsUpdated = data.ITSOMovieService.response;
    } load(response);
  };

  var availString = (avail ? "?available=true" : "?available=false");
  var request = {
    url : this.iContext.io.rewriteURI(this.itsomovieServiceRoot + "movie/" + movieId + availString),
  };
```
12.4 Packaging, deploying, and testing of a Dojo client

In 13.3.3, “Implementation for ITSO Movie DB Connector widget” on page 708, we demonstrate how to include your client into a custom widget that encapsulates the client logic for other widgets to use. The Dojo client then can easily be deployed with the widgets and tested using Business Space.
Developing a custom widget

This chapter explains how to develop a custom widget. It outlines all the necessary steps that need to be performed within WebSphere Integration Developer to create a custom widget.

We discuss the following topics

- Creating a widget definition
- Creating a widget implementation
- Packaging and registering a custom widget
- Creating a help plug-in for a custom widget
- Testing a widget
13.1 Business scenario: ITSO Movie database

ITSO Movie has a database that contains information about all movies that ITSO Movie has produced. For each movie, some details, such as title, description, budget, or directors and actors, are stored. In addition, the availability of a movie is managed through this database.

In this chapter, you learn how to create widgets that manage this database. The widgets provide functionality to perform the following actions:

- Add a new movie to the ITSO Movie database.
- Remove a movie from the ITSO Movie database.
- Make a movie unavailable or available.
- View details about a movie.

Three custom widgets are necessary for the scenario to provide the above listed capabilities:

- ITSO Movie DB Browser widget
- ITSO Movie DB Detail widget
- ITSO Movie DB Connector widget

**ITSO Movie DB Browser widget**
This widget shows a list of all ITSO Movie movies stored in the database. It has the capability to add and remove movies and to make them available or unavailable. Figure 13-1 shows the widget. At the top, you see a toolbar, while the lower pane shows a table that lists the movies.

![Figure 13-1 ITSO Movie DB Browser widget](image)
**ITSO Movie DB Detail widget**

This widget shows additional detailed information for a movie. As soon as a movie is selected in the ITSO Movie DB Browser widget, it shows information about the movie's directors and actors (Figure 13-2).

![ITSO Movie DB Detail Widget](image)

*Figure 13-2  ITSO Movie DB Detail widget*

**ITSO Movie DB Connector widget**

This widget is a bridging widget between Business Space and the service provider. Whereas the other two widgets communicate only with this widget through Business Space events, the connector widget communicates with the service provider through asynchronous AJAX requests to query the ITSO Movie database. This widget is used as a hidden widget because it is purely used as a connector widget without any user interface.

### 13.2 Creating a widget definition

Each widget is described by a widget definition file. This XML file defines the basic elements for a widget.
13.2.1 Structure of iWidget XML definition file

The iWidget XML definition file contains properties for a widget, as shown in Figure 13-3.

Example 13-1 shows the widget definition XML code for the ITSO Movie DB Detail widget used in this scenario.

Example 13-1 ITSO Movie DB Detail widget definition XML code

```xml
<?xml version="1.0" encoding="UTF-8" ?>
<iw:iwidget id="ITSOMovieDBDetailWidget"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:iw="http://www.ibm.com/xmlns/prod/iWidget"
supportedModes="view edit" mode="view"
name="ITSOMovieDBDetailWidget">

<iw:eventDescription id="getMovieDetailsDesc" description="Contains detailed information about a movie." lang="en" payloadType="JSON"></iw:eventDescription>
<iw:eventDescription id="getMovieDetailsResultDesc" description="Contains details for a movie. It is emitted to notify the emitter of a getMovieDetails event of the returned results." lang="en" payloadType="JSON"></iw:eventDescription>
```
Each widget must have a unique ID identifying it. Additionally, a name can be specified. The property iScope points to the JavaScript class implementing the widget’s logic. The iScope property must match the JavaScript class name that implements the widget. The property supported modes specify which modes are available for a widget. The two main modes for a widget are:

- View
- Edit
**View mode**

The view mode is the normal working mode that contains the presentation logic. The view mode is the mode that a user interacts with by default.

**Edit mode**

The edit mode is the configuration mode of a widget. In this mode, a user can modify configuration properties of a widget to customize its behavior in view mode.

Beside the basic properties, more complex elements can be specified, as shown in Figure 13-4.

![Figure 13-4  Widget elements in WebSphere Integration Developer](image)

**Content**

For each supported mode, the content of the widget can be specified in HTML syntax. You can place any valid HTML content here.

**Note:** At a minimum, a `<div>` tag should be placed as a root tag in the content definition, which is then referred by the JavaScript implementation to construct dynamic content at run time.

Example 13-1 on page 680 shows how to specify `<div>` tags for the modes view and edit (inside the tags `<iw:content mode="view">` and `<iw:content mode="edit">`) that are referable at run time by the implementation. The _IWID_ part of the ID is replaced at run time with the widget ID in order to distinguish between multiple widget instances on the same page.
Event

Typically, a widget has a very specific set of functions. Related widgets can combine their capabilities by using events to interact with each other. Events are used to communicate and share state and data with other widgets or the Business Space framework. There are two types of events:

- **Handled events**: Events that are consumed by a widget.
- **Published events**: Events that are fired by a widget.

Each event is identified by an unique ID and refers to an event description that specifies additional details about an event. By specifying events in the widget definition file, widgets can interact with their surrounding.

Figure 13-5 shows an example of an event published by the ITSO Movie DB Detail widget. To specify a published event, the property Published must be set to true.

![Figure 13-5 Event published by the widget](image)

Figure 13-6 shows an example of an event handled by the ITSO Movie DB Detail widget. To specify a handled event, the property Handled must be set to true. The onEvent field specifies the method that is called when the event is received by the widget.

![Figure 13-6 Event handled by the widget](image)
**Event description**

An event description adds a description (possibly in multiple languages in order to support internationalization) to an event. It also specifies the payload type for an event. It is identified by an unique ID that is referred by the event definition to the description of the corresponding event (Figure 13-7). At run time, the description is displayed when working with events in Business Space.

![Event description details](Figure 13-7 Event description details)

**Item set**

An item set is a collection of items that are persisted as properties by each widget instance. To make use of those persisted properties in Business Space, the item set must be named attributes.

In this scenario, the ITSO Movie DB Detail widget uses an item set to store which movie information should be displayed. With this item set, a user can specify if information about directors or actors should be displayed in Business Space.
**Item**

An item is a piece of data with a unique identifier, description, and value. Items can be grouped together in item sets. Figure 13-8 shows the showDirectors item. By default, the item has the value specified in the Value field.

![Figure 13-8  Item details](image)

In a widget's JavaScript implementation, items can be accessed as described (for the showDirectors item) in Example 13-2.

**Example 13-2  Access to items**

```javascript
//get item set attributes
var attributes = this.iContext.getiWidgetAttributes();
//read value of item showDirectors
var attrShowDirectors = attributes.getItemValue("showDirectors");
//assign new value to item showDirectors
attributes.setItemValue("showDirectors", "false");
//save item set attributes
attributes.save();
```
Resource
A resource is a reference to an additional resource used in the widget. You can refer to JavaScript files that contain the logic and the widget's implementation, as shown in Figure 13-9.

![Figure 13-9 Resource details](image)

13.2.2 Creating a widget definition for ITSO Movie DB Detail widget

**Note:** In order to have tooling support in WebSphere Integration Developer to develop custom widgets, make sure that the Web Development Tools feature is installed (check the WebSphere Integration Developer package group in the IBM Installation Manager for this feature). If this feature is not installed, you will not be able to use the iWidget wizard and the Universal Test Client for iWidgets.

To create a widget definition in WebSphere Integration Developer, perform the following steps:

1. Select **File → New → Other**.
2. Select **Web → Dynamic Web Project** and click **Next**.
3. Enter **ITSOMovieWidgets** into the Project name field.
4. Enter **ITSOMovieWidgetsEAR** in the EAR Project Name field and select **Add project to an EAR**.
5. Leave all the other defaults as they are and click **Finish**.
6. The new project is created; when asked, switch to the Web perspective.
7. Create a new folder under WebContent.
   a. Right-click **WebContent**.
   b. Select **New → Folder**.
   c. Enter widgets as the folder name.
   d. Click **Finish**.
8. Create a new folder under widgets.
   a. Right-click **Widgets**.
   b. Select **New → Folder**.
   c. Enter ITSOMovieDBDetailWidget as the folder name.
   d. Click **Finish**.

9. Create a new widget.
   a. Right-click **ITSOMovieDBDetailWidget**.
   b. Select **New → Other**.
   c. Select **Web → iWidget** and click **Next** (Figure 13-10).

   ![Figure 13-10 New widget wizard](image)

   d. A widget specific wizard page is shown (Figure 13-11 on page 689). Enter ITSOMovieDBDetailWidget as the iWidget name and /ITSOMovieWidgets/WebContent/widgets/ITSOMovieDBDetailWidget as the source folder.
e. There are four different iWidget types that can be selected.

- Simple Widget
- Event Publisher Widget
- Event Subscriber Widget
- Widget with JSP content

Select Simple Widget. Based on the iWidget type selected, different widget definition files are generated. Simple Widget is the simplest one, but all the necessary elements are added manually later.

**Note:** If you select a type of Event Publisher Widget or Event Subscriber Widget, the wizard generates widget skeletons that include sample events. This is useful to get a first look at how events are used in widgets. The type Widget with JSP content generates a basic widget to display the content of a JSP file in a widget, which is not further observed in this book.
f. Check the **Edit mode** check box and click **Finish**, as shown in Figure 13-11.

![Figure 13-11 ITSO Movie DB Details widget wizard window](image-url)
A new widget is created and shown in the iWidget editor, as shown in Figure 13-12.

![iWidget Editor](image)

**Figure 13-12  iWidget editor**

10. Enter ITSOMovieDBDetailWidget into the Name field and itsomovie.ITSOMovieDBDetailWidget into the iScope field.

11. Add the event getMovieDetails.
   a. Right-click **iWidget ITSOMovieDBDetailWidget**.
   b. Select **Add → Event**.
   c. Enter getMovieDetails in the ID field and getMovieDetailsDesc into the Description field.
   d. Select **true** for Published to mark the event as an event that is fired by the widget.
      
      If you want to specify an event that is consumed by the widget, you must select true for Handled. An event can be published and handled by a widget at the same time.

12. Add the two remaining events listed in Table 13-1 on page 691, repeating the steps to create an event. If the event is of type Handled, also specify the onEvent method.
13. Add the event description getMovieDetailsDesc.
   a. Right-click iWidget ITSOMovieDBDetailWidget.
   b. Select Add → Event Description.
   c. Enter getMovieDetailsDesc into the ID field and Contains detailed information about a movie into the Description field.
   d. Enter en in the Lang field and JSON into the Payload type field.

   **Note:** Depending on the structure of the event payload, different payload types can be specified. Structured objects are typically sent as event payload using JSON; for unstructured objects, you could specify string as the payload. As we are passing complex information in the events, JSON is chosen as the payload.

14. Add the two remaining event descriptions listed in Table 13-2, repeating the above steps.

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Event description</th>
<th>Published / handled</th>
<th>onEvent</th>
</tr>
</thead>
<tbody>
<tr>
<td>getMovieDetailsResult</td>
<td>getMovieDetailsResultDesc</td>
<td>handled</td>
<td>onGetMovieDetailsResult</td>
</tr>
<tr>
<td>movieSelected</td>
<td>movieSelectedDesc</td>
<td>handled</td>
<td>onMovieSelected</td>
</tr>
</tbody>
</table>

15. Add an item set.
   a. Right-click iWidget ITSOMovieDBDetailWidget.
   b. Select Add → Item Set.
   c. Enter attributes into the ID field.
16. Add two items.
   a. Right-click **Item Set attributes**.
   b. Select **Add → Item**.
   c. Enter showActors into the ID field and true into the Value field.
   d. Right-click **Item**.
   e. Select **Add → Item**.
   f. Enter showDirectors into the ID field and true into the Value field.

17. Add a resource.
   a. Right-click **iWidget ITSOMovieDBDetailWidget**.
   b. Select **Add → Resource**.
   c. Enter impl into the ID field and ITSOMovieDBDetailWidget.js into the Src field. You create the corresponding JavaScript file later.

18. Specify content for view mode.
   a. Click **Content (view)**.
   b. Enter the following HTML code to replace the existing one (Example 13-3).

   ```html
   Example 13-3  HTML code for view mode
   <div id="_IWID_ViewDiv">
      <div id="_IWID_LoadingDiv" class="LoadingDiv" style=""></div>
      <div id="_IWID_ContentDiv" class="ContentDiv" style="display:none"></div>
   </div>
   
   You might recognize the _IWID_ notation used for the ID attribute. It is replaced by the widget ID at run time and ensures that the DOM element ID is unique and does not interfere with other widget instances on the same page.
   
19. Specify content for the edit mode.
   a. Click **Content (edit)**.
   b. Enter the following HTML code (Example 13-4).

   ```html
   Example 13-4  HTML code for edit mode
   <div id="_IWID_EditDiv">
   </div>
   ```
Figure 13-4 on page 682 shows the created elements in the iWidget editor.

Create the ITSOMovieDBBrowserWidget and ITSOMovieDBConnectorWidget widgets by repeating these steps. The properties and elements to create are outlined in 13.2.3, “Creating a widget definition for ITSO Movie DB Browser widget” on page 693 and 13.2.4, “Creating a widget definition for ITSO Movie DB Connector widget” on page 695.

13.2.3 Creating a widget definition for ITSO Movie DB Browser widget

Use the settings shown in Table 13-3 through Table 13-6 on page 694 and Example 13-5 on page 694 to define the ITSO Movie DB Browser widget.

Table 13-3  ITSO Movie DB Browser widget properties

<table>
<thead>
<tr>
<th>Property name</th>
<th>Property value</th>
</tr>
</thead>
<tbody>
<tr>
<td>folder</td>
<td>/WebContent/widgets/ITSOMovieDBBrowserWidget</td>
</tr>
<tr>
<td>iWidget name (mapped to widget id)</td>
<td>ITSOMovieDBBrowserWidget</td>
</tr>
<tr>
<td>iWidget type</td>
<td>Simple Widget</td>
</tr>
<tr>
<td>Edit mode</td>
<td>Unchecked</td>
</tr>
<tr>
<td>widget id</td>
<td>ITSOMovieDBBrowserWidget</td>
</tr>
<tr>
<td>widget iScope</td>
<td>itsomovie.ITSOMovieDBBrowserWidget</td>
</tr>
</tbody>
</table>

Table 13-4  ITSO Movie DB Browser widget events

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Event description</th>
<th>Published / handled</th>
<th>onEvent</th>
</tr>
</thead>
<tbody>
<tr>
<td>getMovies</td>
<td>getMoviesDesc</td>
<td>Published</td>
<td></td>
</tr>
<tr>
<td>movieSelected</td>
<td>movieSelectedDesc</td>
<td>Published</td>
<td></td>
</tr>
<tr>
<td>setMovieAvailability</td>
<td>setMovieAvailabilityDesc</td>
<td>Published</td>
<td></td>
</tr>
<tr>
<td>addMovie</td>
<td>addMovieDesc</td>
<td>Published</td>
<td></td>
</tr>
<tr>
<td>removeMovie</td>
<td>removeMovieDesc</td>
<td>Published</td>
<td></td>
</tr>
<tr>
<td>getMoviesResult</td>
<td>getMoviesResultDesc</td>
<td>Handled</td>
<td>onGetMoviesResult</td>
</tr>
<tr>
<td>setMovieAvailabilityResult</td>
<td>setMovieAvailabilityResultDesc</td>
<td>Handled</td>
<td>onSetMovieAvailabilityResult</td>
</tr>
<tr>
<td>addMovieResult</td>
<td>addMovieResultDesc</td>
<td>Handled</td>
<td>onAddMovieResult</td>
</tr>
</tbody>
</table>
Table 13-5  ITSO Movie DB Browser widget event descriptions

<table>
<thead>
<tr>
<th>Event description ID</th>
<th>Event description</th>
<th>Lang</th>
<th>Payload type</th>
</tr>
</thead>
<tbody>
<tr>
<td>getMoviesResultDesc</td>
<td>Contains a list of movies. It is emitted to notify the emitter of a getMovies event of the returned results.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>addMovieResultDesc</td>
<td>Contains the result of a request to add a movie. It is emitted to notify the emitter of a addMovie event of the returned results.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>setMovieAvailabilityResultDesc</td>
<td>Contains the result of a request to set availability for a movie. It is emitted to notify the emitter of a setMovieAvailability event of the returned results.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>getMoviesDesc</td>
<td>Contains a list of movies.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>setMovieAvailabilityDesc</td>
<td>Sets the availability of a movie.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>addMovieDesc</td>
<td>Adds a movie to the DB.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>removeMovieDesc</td>
<td>Removes a movie from DB.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>movieSelectedDesc</td>
<td>Fires when a movie is selected.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>removeMovieResultDesc</td>
<td>Contains the result of a request to remove a movie. It is emitted to notify the emitter of a removeMovie event of the returned results.</td>
<td>en</td>
<td>JSON</td>
</tr>
</tbody>
</table>

Table 13-6  ITSO Movie DB Browser widget resources

<table>
<thead>
<tr>
<th>Resource ID</th>
<th>Resource src</th>
</tr>
</thead>
<tbody>
<tr>
<td>impl</td>
<td>ITSOMovieDBBrowserWidget.js</td>
</tr>
</tbody>
</table>

Example 13-5  ITSO Movie DB Browser widget content for view mode

```html
<div id="_IWID_ViewDiv">
  <div id="_IWID_LoadingDiv" class="LoadingDiv" style=""></div>
</div>
```
13.2.4 Creating a widget definition for ITSO Movie DB Connector widget

Use the settings shown in Table 13-7 through Table 13-10 on page 697 and Example 13-6 on page 697 to define the ITSO Movie DB Connector widget.

**Table 13-7  ITSO Movie DB Connector widget properties**

<table>
<thead>
<tr>
<th>Property name</th>
<th>Property value</th>
</tr>
</thead>
<tbody>
<tr>
<td>folder</td>
<td>/WebContent/widgets/ITSOMovieDBConnectorWidget</td>
</tr>
<tr>
<td>iWidget name (mapped to widget id)</td>
<td>ITSOMovieDBConnectorWidget</td>
</tr>
<tr>
<td>iWidget type</td>
<td>Simple Widget</td>
</tr>
<tr>
<td>Edit mode</td>
<td>unchecked</td>
</tr>
<tr>
<td>widget id</td>
<td>ITSOMovieDBConnectorWidget</td>
</tr>
<tr>
<td>widget iScope</td>
<td>itsomovie.ITSOMovieDBConnectorWidget</td>
</tr>
</tbody>
</table>

**Table 13-8  ITSO Movie DB Connection widget events**

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Event description</th>
<th>Published / handled</th>
<th>onEvent</th>
</tr>
</thead>
<tbody>
<tr>
<td>getMoviesResult</td>
<td>getMoviesResultDesc</td>
<td>Published</td>
<td></td>
</tr>
<tr>
<td>getMovieDetailsResult</td>
<td>getMovieDetailsResultDesc</td>
<td>Published</td>
<td></td>
</tr>
<tr>
<td>addMovieResult</td>
<td>addMovieResultDesc</td>
<td>Published</td>
<td></td>
</tr>
<tr>
<td>removeMovieResult</td>
<td>removeMovieResultDesc</td>
<td>Published</td>
<td></td>
</tr>
<tr>
<td>setMovieAvailabilityResult</td>
<td>setMovieAvailabilityResultDesc</td>
<td>Published</td>
<td></td>
</tr>
<tr>
<td>getMovies</td>
<td>getMoviesDesc</td>
<td>Handled</td>
<td>onGetMovies</td>
</tr>
<tr>
<td>getMovieDetails</td>
<td>getMovieDetailsDesc</td>
<td>Handled</td>
<td>onGetMovieDetails</td>
</tr>
<tr>
<td>setMovieAvailability</td>
<td>setMovieAvailabilityDesc</td>
<td>Handled</td>
<td>onSetMovieAvailability</td>
</tr>
<tr>
<td>addMovie</td>
<td>addMovieDesc</td>
<td>Handled</td>
<td>onAddMovie</td>
</tr>
<tr>
<td>removeMovie</td>
<td>removeMovieDesc</td>
<td>Handled</td>
<td>onRemoveMovie</td>
</tr>
<tr>
<td>Event description ID</td>
<td>Event description</td>
<td>Lang</td>
<td>Payload type</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>------</td>
<td>--------------</td>
</tr>
<tr>
<td>getMoviesResultDesc</td>
<td>Contains a list of movies. It is emitted to notify the emitter of a getMovies event of the returned results.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>getMovieDetailsResultDesc</td>
<td>Contains details for a movie. It is emitted to notify the emitter of a getMovieDetails event of the returned results.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>addMovieResultDesc</td>
<td>Contains the result of a request to add a movie. It is emitted to notify the emitter of a addMovie event of the returned results.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>removeMovieResultDesc</td>
<td>Contains the result of a request to remove a movie. It is emitted to notify the emitter of a removeMovie event of the returned results.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>setMovieAvailabilityResultDesc</td>
<td>Contains the result of a request to set availability for a movie. It is emitted to notify the emitter of a setMovieAvailability event of the returned results.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>getMoviesDesc</td>
<td>Contains a list of movies.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>getMovieDetailsDesc</td>
<td>Contains detailed information about a movie.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>setMovieAvailabilityDesc</td>
<td>Sets the availability of a movie.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>addMovieDesc</td>
<td>Adds a movie to the DB.</td>
<td>en</td>
<td>JSON</td>
</tr>
<tr>
<td>removeMovieDesc</td>
<td>Removes a movie from DB.</td>
<td>en</td>
<td>JSON</td>
</tr>
</tbody>
</table>
Table 13-10  ITSO Movie DB Connector widget resources

<table>
<thead>
<tr>
<th>Resource ID</th>
<th>Resource src</th>
</tr>
</thead>
<tbody>
<tr>
<td>impl</td>
<td>ITSMovieDBConnectorWidget.js</td>
</tr>
</tbody>
</table>

Example 13-6  ITSO Movie DB Connector widget content for view mode

```html
<div id="_IWID_ViewDiv">
  <div id="_IWID_LoadingDiv" class="LoadingDiv" style=""></div>
  <div id="_IWID_ContentDiv" class="ContentDiv" style="display:none"></div>
</div>
```

After having completed the steps, you should have created the artifacts shown in Figure 13-13.

![Figure 13-13  Widget definition files](image)

13.3 Creating a widget implementation

The widget definition files created in 13.2, “Creating a widget definition” on page 679 point to a resource that implements the widget logic for each widget. Our next step is to create a widget implementation for a custom widget.

13.3.1 Implementation of the ITSO Movie DB Detail widget

This section outlines a number of basic steps that are to be considered when implementing a widget. In our example, we implement the ITSO Movie DB Detail widget. The complete listing of the source code can be found in the customwidgets.zip project interchange file provided with the additional materials for this book.
Create an implementation file for the ITSO Movie DB Detail widget

Perform the following steps:

1. Right-click ITSOMovieDBDetailWidget folder in the Enterprise Explorer.
2. Select New → File.
3. Enter ITSOMovieDBDetailWidget.js into the File name field and click Finish.

An empty JavaScript file is created. JavaScript classes that implement a widget must follow some principals, which are discussed in “Class declaration”.

Class declaration

Each JavaScript class that implements a widget must start with a dojo.declare statement that declares a Dojo class. The class name must match the widget's iScope property. A dojo.declare statement has the three parameters:

- Class name
- Super class information
- A body, which implements the class

Note: When importing the customwidget.zip project interchange file, you might see some lines in the JavaScript marked as code errors when inspecting a JavaScript file. You can ignore them.
Example 13-7 shows the declaration for ITSOMovieDBDetailWidget.js without the body section. As the ITSO Movie DB Detail widget is not inherited from a parent class, the second parameter is null.

**Example 13-7  Dojo class declaration**

dojo.declare("itsomovie.ITSOMovieDBDetailWidget", null,{

/*
Here comes the body of the class.
*/

});

**Common methods**

Beside having class specific methods, a JavaScript class implementing a widget should provide common methods that are called by the Business Space framework to react on certain situations. All common methods here are implemented in the custom widgets for the scenario.

**onLoad method**

The onLoad method is called by the Business Space framework when the widget gets loaded. In this method, you should place code that loads dependencies and initializes objects for the widget. Dependencies could be dependencies to other Dojo classes or cascading style sheets used in the widget. Also, references to other JavaScript files could be added here.

**onView and onEdit method**

For each supported mode, a widget must implement the corresponding method to handle the mode. When a widget supports the modes view and edit, then the methods onView and onEdit must be implemented in the widget. The Business Space framework calls the methods when the corresponding mode is activated. The onView method is always called after the onLoad method.

The onEdit method is responsible for switching back to view mode (when the widget configuration is complete) by firing an onModeChanged event (Example 13-8).

**Example 13-8  Fire event to switch back to view mode**

```javascript
this.iContext.iEvents.fireEvent("onModeChanged", null,
    "{newMode:'view'}");
```
**onUnload method**
The onUnload method is called by the Business Space framework when the widget unloads. Put any code here to clean up objects that are no longer necessary and are not destroyed automatically.

**onRefreshNeeded method**
The onRefreshNeeded method is called every time the widget needs to refresh its content. Clicking Refresh in the widget's context menu results in a call to the onRefreshNeeded method.

**onModeChanged method**
The onModeChanged method is called every time a mode change is issued for the widget. The new mode can be accessed by the payload event (event.payload.newMode).

**onSizeChanged method**
The onSizeChanged method is called when a widget is resized. The payload contains the new dimensions of the widget to recalculate the size of the widget's objects and display them properly. Example 13-9 shows how to access the new widget dimensions.

*Example 13-9  onSizeChanged method*

```javascript
onSizeChanged:function(/*iEvent*/ event) {
    var newWidth = event.payload.newWidth;
    var newHeight = event.payload.newHeight;
    ...
},
```

**Embed cascading style sheets**
It is very common to specify style information in a cascading style sheet file instead of having it hardcoded in the widget's implementation code. To use cascading style sheets in a widget, the sheets must be loaded in the widget's onLoad method. Example 13-10 defines a method to load the cascading style sheet passed in the filename parameter. In the scenario, this function is called by the loadDependencies method in the onLoad method to include a cascading style sheet when the widget is initialized.

*Example 13-10  Method to load cascading style sheet*

```javascript
loadCss : function(/*string*/filename) {
    var fileref = document.createElement("link");
    fileref.setAttribute("rel", "stylesheet");
    fileref.setAttribute("type", "text/css");
```
Create a cascading style sheet file
All three widgets share the same style definition, so one cascading style sheet
must be created by performing the following steps:
1. Right-click the **Widgets** folder in the Enterprise Explorer.
2. Select **New → File**.
3. Enter ITSOMovieDBWidget.css into the File name field and click **Finish**.
4. Enter the content lines specified in Example 13-11.

```css
Example 13-11  ITSOMovieDBWidget.css
.LoadingDiv {
    display: block;
    text-align: center;
    color: RGB(95,128,173);
    font-size: 24px;
    line-height: 40px;
    overflow: hidden;
    background-color: RGB(239,235,239);
}

.ContentDiv {
    display: block;
}

.TitleDiv {
    font-size: 14pt;
    font-style: bold;
    height: 30px;
    padding-left: 2px;
}

.viewToolbar {
    height: 31px;
    background-image: url('../images/toolbar_bg.gif');
    padding: 3px;
}
```
5. Save the changes.

6. In the widget loadDependencies method, add the lines shown in Example 13-12.

   **Example 13-12  Load cascading style sheet**

   ```javascript
   var cssPath =
   this.iContext.io.rewriteURI("../ITSOMovieDBWidget.css");
   this.loadCss(cssPath);
   ```

   **Use cascading style sheets**

   To use the styles defined in cascading style sheets for the widget content, a class attribute must be set for an object. To add a class to an object, specify the className attribute. Example 13-13 shows how to set the className attribute of this.titleDiv to TitleDiv. The style TitleDiv is defined in the cascading style sheet and then used to render each object that has the corresponding class name with the specified style properties.

   **Example 13-13  Set className to an object**

   ```javascript
   this.titleDiv.className = "TitleDiv"
   ```

   **Reuse of Dijits**

   Business Space is based on Dojo, so it is very easy to use Dijits in custom widgets (see Chapter 10, “Web 2.0 introduction” on page 595). All required Dojo classes are loaded by the Business Space framework and are available for the widgets. The following two sections show how to reuse standard Dijits (Dijits that are provided by Dojo) and custom developed Dijits.

   **Reuse of standard Dijits**

   In the ITSO Movie DB Detail widget, the Dijit TitlePane is used to outline the integration of standard Dijits. This Dijit provides a title area to display a title and a content area to display information that matches the title. In this scenario, one title pane is used for directors and one title pane is used for actors. Based on the director title pane example, perform the following steps to reuse a Dijit:

   1. In the onLoad method, all required Dijits need to be referenced. To include the Dijit TitlePane in a custom widget, add the code line `dojo.require("dijit.TitlePane");` to the onLoad method.
2. In view mode, the directors title pane lists all directors of a movie. Add the code lines shown in Example 13-14 to the showDirectorsAndActors method, which is called by the onView method.

**Example 13-14  Add Dijit TitlePane to widget**

```javascript
if (this._attrShowDirectors == "true") {
    this.directorsDiv = new dijit.TitlePane(
        {
            title : "Directors",
            style : "font-size : 150%"
        }, "_" + this.iContext.widgetId + "_directorsTitlePane”);
    this.contentDiv.appendChild(this.directorsDiv.domNode);
    this.populateDirectors();
}

...

populateDirectors : function() {
    var directorList = "<ul>"
    for (var i in this._directors) {
        directorList += "<li>" + this._directors[i].firstName + " <b>" + this._directors[i].lastName + "</b></li>"
    }
    directorList += "</ul>";
    this.directorsDiv.setContent(directorList);
}
```

The code snippet creates a new DijitTitle Pane with the title “Directors”. The style attribute increases the font size to display the content of the title pane in a larger font size. The line `this.populateDirectors();` then calls the populateDirectors method, which adds a list directors to the content of the title pane using the TitlePane method `setContent`.

**Note:** The second parameter in the Dijit constructor assigns an ID to the title pane so that it can be retrieved by using the Dojo method `dojo.byId`. The widget ID is part of this ID, and it is used to get unique references to the title pane when using the same widget multiple times in a page.

The line `this.contentDiv.appendChild(this.directorsDiv.domNode);` adds the title pane as a child of the HTML object `contentDiv`. The title pane constructor creates a Dijit TitlePane, which cannot be added itself to another object in the DOM tree. This is why `this.directorsDiv.domNode` is used to append the title pane.
Figure 13-14 shows a Dijit TitlePane that is used in the ITSO Movie DB Detail widget to display a list of directors.

```
- Directors
  - Mike Director
```

*Figure 13-14  Dijit TitlePane used in a ITSO Movie DB Detail widget*

**Reuse of custom Dijits**

Beside using standard Dijits provided by the Dojo framework, Dojo also allows the creation of custom Dijits. The following steps outline the reuse of custom Dijits based on the custom Dijit MovieDetailConfig used in the ITSO Movie DB Detail widget. This custom Dijit is used to define the content of the Settings window for the edit mode of the widget. A custom Dijit can be used and embedded into widgets as any core Dijit.

**Note:** Detailed instructions about how to build custom Dijits is not given in this book. Instead, basic characteristics for a custom Dijit are outlined.

The Dijit MovieDetailConfig (Example 13-15) is a Dijit that uses Dojo’s support for Dijits based on templates through dijit._Templated. This object is used together with the object dijit._Widget as the parent class in the Dijit class declaration. Every time the Dijit gets instantiated, the Dijit uses the template to create the instance. The attribute templatePath points to the template definition.

**Example 13-15  Dijit MovieDetailConfig class declaration**

```javascript
dojo.provide("itsomovie.common.MovieDetailConfig");

dojo.require("dijit._Widget");
dojo.require("dijit._Templated");

dojo.require("dijit.form.CheckBox");

dojo.declare("itsomovie.common.MovieDetailConfig", [dijit._Widget, dijit._Templated],{
    showDirectors : null,
    showActors : null,

    CLASSNAME: "itsomovie.common.MovieDetailConfig",
```
templatePath: dojo.moduleUrl("itsomovie.common.MovieDetailConfig", "templates/MovieDetailConfig.html"),

constructor : function(params) {
    if (params.showDirectors == undefined) {
        this.showDirectors = true;
    } else {
        this.showDirectors = params.showDirectors;
    }
    if (params.showActors == undefined) {
        this.showActors = true;
    } else {
        this.showActors = params.showActors;
    }
    if (params.widgetCtx != undefined) {
        this.widgetCtx = params.widgetCtx;
    }
},

postCreate : function() {
    this.showDirectorsCB.checked = this.showDirectors;
    this.showActorsCB.checked = this.showActors;

    //connect onchanged methods of checkboxes
    dojo.connect(this.showDirectorsCB, "onchange", dojo.hitch(this, "onShowDirectorsCBChange"));
    dojo.connect(this.showActorsCB, "onchange", dojo.hitch(this, "onShowActorsCBChange"));
},

onShowDirectorsCBChange : function() {
    this.showDirectors = this.showDirectorsCB.checked;
},

onShowActorsCBChange : function() {
    this.showActors = this.showActorsCB.checked;
}
});
In the constructor, the parameters are mapped to the MovieDetailConfig attributes. In the postCreate method, the showDirectorCB and showDirectorCB check boxes defined in the template (Example 13-16) are either checked or cleared. Both check boxes can be accessed directly, because they specify a dojoAttachPoint attribute.

**Note:** The dojo.hitch method is used to make sure that a method is executed in a given scope. In this example, dojo.hitch ensures that the onRefreshClick method is executed in the class’ scope.

**Note:** A template definition can contain variable definitions. Variables are defined by ${<VARIABLE_NAME>}. When a Dijit based on a template is initiated, the variables in the template definition are replaced by the corresponding class attribute. Although this functionality is not used in the book, it is a very useful mechanism when using templates.

**Example 13-16  MovieDetailConfig template definition**

```xml
<table>
  <tr>
    <td><input dojoType="dijit.form.CheckBox" dojoAttachPoint="showDirectorsCB" value="showDirectors" type="checkbox"/>
    <label>Show Directors</label></td>
  </tr>
  <tr>
    <td><input dojoType="dijit.form.CheckBox" dojoAttachPoint="showActorsCB" value="showActors" type="checkbox"/>
    <label>Show Actors:</label></td>
  </tr>
</table>
```

The first code line of the MovieDetailConfig class declaration uses the dojo.provide statement. This ensures that the MovieDetailConfig.js is only loaded once when it is referenced multiple times via dojo.require.

To create the custom Dijit MovieDetailConfig, perform the following steps.

1. Create the folder structure:
   a. Right-click the **WebContent** folder in the Enterprise Explorer.
   b. Select **New → Folder**.
   c. Enter common as the folder name and click **Finish**.
   d. Right-click the **common** folder in the Enterprise Explorer.
e. Select **New** → **Folder**.

f. Enter MovieDetailConfig as the folder name and click **Finish**.

g. Right-click the **MovieDetailConfig** folder in the Enterprise Explorer.

h. Select **New** → **Folder**.

i. Enter templates as the folder name and click **Finish**.

2. Create the JavaScript class and template file:

   a. Right-click the **common** folder in the Enterprise Explorer.

   b. Select **New** → **File**.

   c. Enter MovieDetailConfig.js as the file name and click **Finish**.

   d. Enter the content of the Dijit class. The content is shown in Example 13-15 on page 704.

   e. Right-click the **templates** folder in the Enterprise Explorer.

   f. Select **New** → **File**.

   g. Enter MovieDetailConfig.html as the File name and click **Finish**.

   h. Enter the content of the template file, as specified in Example 13-16 on page 706.

The Dijit MovieDetailConfig is used in the onEdit method of the ITSO Movie DB Detail widget. Perform the following steps to include custom Dijits in your code:

1. Register the module paths to the custom Dijits in the onLoad method, as shown in Example 13-17.

   ```javascript
   var configpath = "../common/MovieDetailConfig";
   dojo.registerModulePath("itsomovie.common.MovieDetailConfig",
   this.iContext.io.rewriteURI(configpath));
   dojo.require("itsomovie.common.MovieDetailConfig");
   ```

2. Add the code line `dojo.require("itsomovie.common.MovieDetailConfig");` to the onLoad method.

3. You can now use the custom Dijit by instantiating it by running the following command:

   ```javascript
   new itsomovie.common.MovieDetailConfig({ ... });
   ```

A complete collection of artifacts used for custom Dijits is contained in the project interchange file customwidgets.zip, which is supplied in the additional materials accompanying this book (see Appendix B, “Additional material” on page 747 for more details).
13.3.2 Implementation for the ITSO Movie DB Browser widget

The implementation for the ITSO Movie DB Browser widget follows the same concepts and structures outlined in the previous section. Add the Dojo class declaration, the common methods, and the reference to the cascading style sheet. The complete code is provided with the project interchange file customwidgets.zip.

The ITSO Movie DB Browser widget uses various standard Dijits, such as buttons, different input fields, or a dialog. The onView method in the ITSOMovieDBBrowserWidget.js JavaScript class is a good starting point for examining the different Dijits. How to include Dijits is explained in “Reuse of standard Dijits” on page 702.

13.3.3 Implementation for ITSO Movie DB Connector widget

This section outlines the basic steps to implement the ITSO Movie DB Connector widget that encapsulates the Dojo client written in 12.3, “Creating a widget client implementation” on page 658. The complete listing of the source code can be found in the project interchange file customwidgets.zip, which can be found in the additional materials provided with this book.

Create an implementation file for the ITSO Movie DB Connector widget

Perform the following steps to implement the ITSO Movie DB Connector widget:

1. Copy the client code developed in 12.3, “Creating a widget client implementation” on page 658 to the ITSOMovieWidgets project’s WebContent folder, as shown in Figure 13-15.
2. In the project navigation tree view, right-click the **WebContent folder** and click **Widgets** to create a new JavaScript file. Select **New → File**.

3. Enter ITSOMovieDBConnectorWidget.js as the file name and click **Finish**.

Next, implement the code for the widget based on the principals outlined above.

For the loadDependencies method (see Example 13-18), create a new client based on the client created in 12.3, “Creating a widget client implementation” on page 658.

**Example 13-18  Sample loadDependencies method**

```javascript
loadDependencies : function(){

...

    this.itsomovieServiceRoot =
    this.getServiceEndpoint("itsomovieServiceRoot");
    this.itsomovieWidgetRoot =
    this.getServiceEndpoint("itsomovieWidgetRoot");

    var clientpath = "../..//client/itsomoviedbclient";
    dojo.registerModulePath("client.itsomoviedbclient",
    this.iContext.io.rewriteURI(clientpath));
    dojo.require("client.itsomoviedbclient");

    var self = this;
    client = new client.itsomoviedbclient({iContext: self.iContext,
        itsomovieServiceRoot : self.itsomovieServiceRoot}, null);

...

}
```


Implement the event handlers that process the events to which this widget subscribes. Example 13-19 is an example of the onGetMovies event handler. In essence, the widget receives the event and calls the Dojo client. After a response is sent from the Dojo client, a reply event is sent. Example 13-19 lists the implementation of the onGetMovies method.

Example 13-19  onGetMovies method

```javascript
onGetMovies : function(event) {
    var load = dojo.hitch(this, function(payload) {
        this.sendEvent("getMoviesResult", payload);
    });
    var error = dojo.hitch(this, function(payload) {
        alert("An error occurred in onGetMovies status =" + payload.status + ", message =" + payload.message);
    });
    client.getMovies(load, error);
}
```

13.3.4 Using endpoints registered in Business Space

Widgets can use endpoints that are registered in Business Space. Endpoint references provide a mechanism to point to URIs in XML files. These URIs are then resolved at run time and the widgets do not have to use hardcoded URIs.

There are three things you must do to use endpoints in widgets.

- Register endpoints. Refer to 13.4.1, “Registration files” on page 712.
- Add metadata to the widget in the widget catalog that wants to use an endpoint.
- Reference the endpoint in the widget implementation.

To demonstrate this task, the ITSO Movie DB Connector widget uses the ITSO Movie service endpoint to communicate with the service provider.
Catalog file

Each endpoint is identified by its endpoint ID, which is specified in the corresponding endpoint file (see Example 13-25 on page 715). To use an endpoint in a custom widget, the endpoint must be referenced in the widget entry in the catalog file. Example 13-20 shows the corresponding <metadata> tag to include the endpoint for the ITSO Movie service in the widget's catalog file. A full listing of the widget catalog file is given in 13.4.1, “Registration files” on page 712.

Example 13-20   ITSO Movie DB service endpoint reference in the widget catalog file

```xml
<metadata
name="com.ibm.bspace.serviceEndpointRefs">[
"name":"itsomovieServiceRoot", "required":"true",
"refId":"endpoint://{itsomovie}itsomovieServiceRoot",
"refVersion":"1.0.0.0"]
</metadata>
```

Widget implementation

If the endpoint is part of the widget catalog file, it can be referenced from the widget implementation. Business Space provides a helper class to retrieve an endpoint. Perform the following steps to retrieve an endpoint in the JavaScript class that implements the ITSO Movie DB Connector widget:

1. Include the Business Space helper class in the widget's implementation. Add the lines shown in Example 13-21 to the onLoad method of ITSO Movie DB Connector widget.

   Example 13-21   Add Business Space general helper class

   ```javascript
   dojo.mixin( this, new com.ibm.bspace.common.util.widget.BSpaceCommonUtilityLoader());
   this.require("com.ibm.bspace.common.util.widget.BSpaceGeneralHelper" );
   ```

2. Retrieve the endpoint URL of the ITSO Movie service provider using the code shown in Example 13-22. The parameter used in the method must match the name of the endpoint specified in the <metadata> tag in the widget catalog file.

   Example 13-22   Retrieve endpoint

   ```javascript
   this.itsomovieServiceRoot =
   this.getServiceEndpoint("itsomovieServiceRoot");
   ```
13.4 Packaging and registering a custom widget

To use custom widgets in Business Space, the custom widgets need to be registered in Business Space and the enterprise application that contains the custom widget must be deployed.

13.4.1 Registration files

The registration information about a custom widget is stored in registration files. There are catalog files that contain information about widgets and widget catalogs and there are endpoint files that specify endpoints that are used by the widgets.

For the execution of the registration scripts, there are two options presented in this book. The first one, useful for local servers like the test environments provided in WebSphere Integration Developer, is outlined in the box below. The second option, creating script files from scratch, is used in the remainder of the chapter.

**Note:** The sample scripts to register endpoints and widgets show how to use them in a stand-alone server environment. For clustered environments, the registration scripts must be run on the deployment manager node and point to the cluster where Business Space is deployed. You might need to change the node name and server name in the scripts.

The project interchange file provides sample Jython scripts in the resource folder. They can be used as a template for your own scripts or directly run from within WebSphere Integration Developer on a local server. To run a script in WebSphere Integration Developer, perform the following steps:

1. Right-click the script.
2. Select **Run As** → **Administrative script**.
3. Select a Scripting runtime environment and a Profile name.
4. Enter `-connType NONE` as **wsadmin** arguments and specify the security credentials if necessary.
5. In the arguments tab, enter the path to the project using double backslashes (for example, `C:\workspace\ITSOMovieWidgets`). Make sure every backslash is a double backslash.
6. Click **Run**.
Endpoint file
An endpoint file characterizes a specific endpoint. Each endpoint is identified by its ID and points to an URL using the <url> tag. For every endpoint, there can be multiple versions distinguished by the <version> tag. Example 13-23 lists the definition for the endpoint to the root of the ITSO Movie DB widgets.

Example 13-23  ITSO Movie widget endpoint file

```xml
<?xml version="1.0" encoding="UTF-8"?>
<!-- START NON-TRANSLATABLE -->
<tns:BusinessSpaceRegistry
   xmlns:tns="http://com.ibm.bspace/BusinessSpaceRegistry"
   xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
   xsi:schemaLocation="http://com.ibm.bspace/BusinessSpaceRegistry
   BusinessSpaceRegistry.xsd " >

   <tns:Endpoint>
     <tns:id>{itsomovie}itsomovieWidgetRoot</tns:id>
     <tns:type>{itsomovie}itsomovieWidgetRoot</tns:type>
     <tns:version>1.0.0.0</tns:version>
     <tns:url>/ITSOMovieWidgets/</tns:url>
     <tns:description>Location of widget root for ITSO Movie widgets</tns:description>
   </tns:Endpoint>

</tns:BusinessSpaceRegistry>
<!-- END NON-TRANSLATABLE -->
```

Register endpoint
The following XML and Jython script files can be created anywhere you like. Create a folder in which all the files can be placed.

To register an endpoint, perform the following steps.


Example 13-24  Endpoint registration script

```python
AdminTask.updateBusinessSpaceWidgets('[-nodeName <NODE_NAME>
   -servername <SERVER_NAME> -endpoints
   <PATH_TO_ITSOMOVIEENDPOINTS.XML>]')
```
3. Run the following command in the profile’s bin directory with admin user credentials:

```
wsadmin.bat -user <USERNAME> -password <PASSWORD> -f
(PATH_TO_REGISTERITSOMOVIEENDPOINTS.PY)
```

4. Verify the successful endpoint registration in the Integrated Solutions Console by performing the following steps:

   a. Log in to Integrated Solutions Console.

   b. Select **Resources** → **Resource Environments** → **Resource Environment Providers**.

   c. Select **Mashups_Endpoints** → **Custom Properties**.

   d. Verify that there are entries for ITSO Movie, as shown in Figure 13-16.

   ![Table of Custom Properties](image)

   **Figure 13-16  ITSO Movie endpoint configuration**
Repeat the steps to register a second endpoint that maps to the URL where the ITSO Movie service can be found (see Example 13-25).

**Example 13-25  ITSO Movie service endpoint file**

```xml
<?xml version="1.0" encoding="UTF-8"?>
<!-- START NON-TRANSLATABLE -->
<tns:BusinessSpaceRegistry
xmlns:tns="http://com.ibm.bspace/BusinessSpaceRegistry"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsi:schemaLocation="http://com.ibm.bspace/BusinessSpaceRegistry BusinessSpaceRegistry.xsd ">
  <tns:Endpoint>
    <tns:id>{itsomovie}itsomovieServiceRoot</tns:id>
    <tns:type>{itsomovie}itsomovieServiceRoot</tns:type>
    <tns:version>1.0.0.0</tns:version>
    <tns:url>/ITSOMovieService/ITSOMovieService/rest/v7.0/</tns:url>
    <tns:description>Location of service root for ITSO Movie service</tns:description>
  </tns:Endpoint>
</tns:BusinessSpaceRegistry>
<!-- END NON-TRANSLATABLE -->
```

**Catalog file**

A catalog file specifies widget categories and widgets. Widgets can be grouped together in categories. A category is identified by a name and contains a list of entries specifying the widgets that belong to the category. Example 13-26 on page 716 shows the catalog file for ITSO Movie widgets. It specifies a category named ITSOMovie and contains three widget entries.

Each widget entry is identified by an ID. The `<definition>` tag points to the widget’s definition file. The tags `<icon>`, `<preview>`, and `<previewThumbnail>` point to images that are used for widget representation in the list of available widgets in Business Space. The widget catalog uses the endpoint that was specified above (endpoint://{itsomovie}itsomovieWidgetRoot). The catalog file also specifies a help topic for each widget. Setting up a help plug-in for a widget is described in 13.5.2, “Creating a help plug-in” on page 725.

**Note:** For this scenario, we included the images for the widgets in the widget enterprise application in the WebContent/images folder. You could chose any URL to point to an image. The image for the icon has the dimensions of 28x28px, while the image for the preview has the dimensions of 160x125px.
The ITSO Movie DB Connector widget uses an endpoint reference to issue requests to a REST service. To be able to reference the endpoint from the widget implementation, it must be added in the catalog file by using the `<metadata>` tag named com.ibm.bspace.serviceEndpointRefs. See Example 13-26.

**Example 13-26  ITSO Movie catalog file**

```xml
<category name="ITSOMovie">
<title>
  <nls-string xml:lang="en">ITSOMovie</nls-string>
</title>
<description>
  <nls-string xml:lang="en">ITSO Movie widgets</nls-string>
</description>
<entry id="ITSOMovieDBBrowserWidget" unique-name="ITSOMovieDBBrowserWidget">
  <title>
    <nls-string xml:lang="en">ITSO Movie DB Browser Widget</nls-string>
  </title>
  <description>
    <nls-string xml:lang="en">Browse ITSO Movie DB</nls-string>
  </description>
  <shortDescription>
    <nls-string xml:lang="en">Browse ITSO Movie DB</nls-string>
  </shortDescription>


  <icon>endpoint://itsomovie/itsomovieWidgetRoot/images/itso_browser_icon.gif</icon>

  <preview>endpoint://itsomovie/itsomovieWidgetRoot/images/itso_browser_preview.gif</preview>

  <previewThumbnail>endpoint://itsomovie/itsomovieWidgetRoot/images/itso_browser_icon.gif</previewThumbnail>

  <metadata name="com.ibm.mashups.builder.autoWiringEnabled">true</metadata>
  <metadata name="com.ibm.bspace.version">1.0.0.0</metadata>
  <metadata name="com.ibm.bspace.owner">International Business Machines Corp.</metadata>
</entry>
</category>
```
Chapter 13. Developing a custom widget

<definition>endpoint://itsomovie/itsomovieWidgetRoot/widgets/ITSOMovieDBBrowserWidget/ITSOMovieDBBrowserWidget.xml</definition>
</entry>
<entry id="ITSOMovieDBConnectorWidget"
unique-name="ITSOMovieDBConnectorWidget">
<title>
<nls-string xml:lang="en">ITSO Movie DB Connector Widget</nls-string>
</title>
<description>
<nls-string xml:lang="en">Connect to ITSO Movie DB</nls-string>
</description>
<shortDescription>
<nls-string xml:lang="en">Connect to ITSO Movie DB</nls-string>
</shortDescription>
<icon>endpoint://itsomovie/itsomovieWidgetRoot/images/itso_connector_icon.gif</icon>
<preview>endpoint://itsomovie/itsomovieWidgetRoot/images/itso_connector_preview.gif</preview>
<previewThumbnail>endpoint://itsomovie/itsomovieWidgetRoot/images/itso_connector_icon.gif</previewThumbnail>
<metadata name="com.ibm.mashups.builder.autoWiringEnabled">true</metadata>
<metadata name="com.ibm.bspace.version">1.0.0.0</metadata>
<metadata name="com.ibm.bspace.owner">International Business Machines Corp.</metadata>
<metadata name="com.ibm.bspace.serviceEndpointRefs">
["name":"itsomovieServiceRoot",
"required":"true",
"refId":endpoint://itsomovie/itsomovieServiceRoot",
"refVersion":"1.0.0.0"]</metadata>
<definition>/ITSOMovieWidgets/widgets/ITSOMovieDBConnectorWidget/ITSOMovieDBConnectorWidget.xml</definition>
</entry>
<entry id="ITSOMovieDBDetailWidget"
unique-name="ITSOMovieDBDetailWidget">
<title>
Register widgets
To register widgets, perform the following steps.

1. Create the catalog_ITSOMovieWidgets.xml file with the content as listed in Example 13-26 on page 716.
2. Create the `installITSOMovieWidgets.py` Jython script file. Specify the contents shown in Example 13-27.

*Example 13-27  Install widgets script*

```python
AdminTask.updateBusinessSpaceWidgets('[-nodeName NODE_NAME
-serverName SERVER_NAME -catalogs PATH_TO_CATALOG.XML]')
```

3. Run the following command in the profile’s bin directory with admin credentials:

```bash
wsadmin.bat -user <USERNAME> -password <PASSWORD> -f
(PATH_TO_INSTALLITSOMOVIEWIDGETS.PY)
```

4. Verify the successful endpoint registration in the Integrated Solutions Console by performing the following steps:

   a. Log in to Integrated Solutions Console.
   b. Select **Resources** → **Resource Environments** → **Resource Environment Providers**.
   c. Select **Mashups_BlobConfigService** → **Custom Properties**.
   d. Verify that there is an entry for **catalog_ITSOMovieWidgets.xml**.

*Verify successful widget registration in Business Space*

Perform the following steps:

1. Log in to Business Space.
2. Click **Edit Page** on your current page.
3. Select **ITSOMovie (3)** from the left drop-down menu.
4. You should see three widgets, as shown in Figure 13-17.

   **Note:** You might see the widgets with blank icons instead of the icons shown in Figure 13-17. This is why the icons are part of the widget enterprise application. You need to deploy the enterprise application to see the icons.

   ![Figure 13-17  Registered ITSO Movie widgets in Business Space](image)
To complete the steps until the widgets are ready for use in Business Space, the enterprise application that contains the widget implementations (ITSOMovieWidgetsEAR) must be deployed on the server. Additionally, you must deploy the enterprise application, which contains the REST service for the widgets (ITSOMovieServiceEAR).

**Note:** It might be necessary to clear the browser cache or to restart the server to see the ITSOMovie widgets in the browser.

### 13.4.2 Creating a space with ITSO Movie DB widgets and establishing a wire connection between widgets

The ITSO Movie scenario uses three widgets. The widgets communicate via events with each other. This interaction must be established in Business Space.

Perform the following steps:

1. Create a new space with an empty page in Business Space.
2. Select **ITSOMovie (3)** in the left-most drop-down menu.
3. Drag all three widgets onto the page.
4. Open the ITSO Movie DB Connector widget context menu and click **Edit Wiring**.
5. Make sure to establish wires between the widgets, as described in Table 13-11. The working widget can be changed by the drop-down menu at the top of the window.

#### Table 13-11  Establishing wires between widgets

<table>
<thead>
<tr>
<th>Source widget</th>
<th>Target widget</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSO Movie DB Connector</td>
<td>ITSO Movie DB Browser</td>
<td>getMoviesResult</td>
</tr>
<tr>
<td>ITSO Movie DB Connector</td>
<td>ITSO Movie DB Browser</td>
<td>addMovieResult</td>
</tr>
<tr>
<td>ITSO Movie DB Connector</td>
<td>ITSO Movie DB Browser</td>
<td>removeMovieResult</td>
</tr>
<tr>
<td>ITSO Movie DB Connector</td>
<td>ITSO Movie DB Browser</td>
<td>setMovieAvailabilityResult</td>
</tr>
<tr>
<td>ITSO Movie DB Connector</td>
<td>ITSO Movie DB Detail</td>
<td>getMovieDetailsResult</td>
</tr>
</tbody>
</table>
6. Convert the ITSO Movie DB Connector widget to a hidden widget by clicking **Hide** in the widget's context menu.

<table>
<thead>
<tr>
<th>Source widget</th>
<th>Target widget</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSO Movie DB Browser</td>
<td>ITSO Movie DB Connector</td>
<td>getMovies</td>
</tr>
<tr>
<td>ITSO Movie DB Browser</td>
<td>ITSO Movie DB Connector</td>
<td>addMovie</td>
</tr>
<tr>
<td>ITSO Movie DB Browser</td>
<td>ITSO Movie DB Connector</td>
<td>removeMovie</td>
</tr>
<tr>
<td>ITSO Movie DB Browser</td>
<td>ITSO Movie DB Connector</td>
<td>setMovieAvailability</td>
</tr>
<tr>
<td>ITSO Movie DB Browser</td>
<td>ITSO Movie DB Detail</td>
<td>movieSelected</td>
</tr>
<tr>
<td>ITSO Movie DB Detail</td>
<td>ITSO Movie DB Connector</td>
<td>getMovieDetails</td>
</tr>
</tbody>
</table>
The following figures show the wiring for each widget (Figure 13-18, Figure 13-19 on page 723, and Figure 13-20 on page 724).

Figure 13-18  Widget wiring for ITSO Movie DB Browser widget
Figure 13-19   Widget wiring for ITSO Movie DB Detail widget
13.5 Creating a help plug-in for a custom widget

You can provide help for custom widgets that are displayed when clicking Help in the widget's context menu. Help content can be provided at any URL or integrated into the Business Space help. This section describes how to integrate help content for ITSO Movie DB widgets into the Business Space help.
13.5.1 Widget catalog file

The widget catalog file needs to contain a `<help>` tag that points to a URL where the help is located. This URL is called when clicking Help in the widget’s context menu. Example 13-26 on page 716 shows the catalog file used for ITSO Movie DB widgets. For each widget entry, it specifies a help tag. For the ITSO Movie DB Browser widget, for example, we use the tag shown in Example 13-28.

Example 13-28 Help tag

```xml
<help>endpoint://{com.ibm.bspace}bspaceWidgetHelpRootId/index.jsp?topic=/itsomovie.help/itso_movie_db_browser_widget.html</help>
```

The `<help>` tag uses the endpoint provided by the Business Space help and points to a topic provided by the ITSO Movie help plug-in.

13.5.2 Creating a help plug-in

A help plug-in for the widget is an Eclipse plug-in that uses the extension point org.eclipse.help.toc to integrate with the Business Space help.

To create the plug-in, perform the following steps.

1. Create the itsomovie.help folder in the
   `<PROFILE_ROOT>/config/BusinessSpace/help/eclipse/plugins` folder.

2. Create the `plugin.xml` file in the itsomovie.help folder. Example 13-29 shows the content of the file. Within the extension point, the `<toc>` tag points to a XML file that contains the table of content structure for the ITSO Movie help.

Example 13-29 plugin.xml for help plug-in

```xml
<?xml version="1.0" encoding="utf-8"?>
<?eclipse version="3.0"?>
<plugin id="itsomovie.help" name="ITSO Movie DB widgets help" provider-name="IBM" version="7.0.0">
  <extension point="org.eclipse.help.toc">
    <toc file="itso_movie_toc.xml" primary="true"/>
  </extension>
</plugin>
```
3. Create the `itso_movie_toc.xml` file in the `itsomovie.help` folder to define the table of contents for the ITSO Movie help, as shown in Example 13-30. The ITSO Movie help has its own primary topic called ITSO Movie with one topic (ITSO Movie DB widgets). Three subtopics provide help for each ITSO Movie DB widget. The `href` attributes point to the HTML file that contain the help content.

Example 13-30  Table of contents for ITSO Movie help

```xml
<?xml version="1.0" encoding="utf-8"?>
<?NLS TYPE="org.eclipse.help.toc"?>
<toc label="ITSO Movie" topic="itso_movie_main.html">
  <topic label="ITSO Movie DB widgets" href="itso_movie_db_widgets.html">
    <topic label="ITSO Movie DB Browser widget" href="itso_movie_db_browser_widget.html"/>
    <topic label="ITSO Movie DB Detail widget" href="itso_movie_db_detail_widget.html"/>
    <topic label="ITSO Movie DB Connector widget" href="itso_movie_db_connector_widget.html"/>
  </topic>
</topic>
</toc>
```

4. Create the following HTML files for the help content.

- `itso_movie_main.html`
- `itso_movie_db_widgets.html`
- `itso_movie_db_browser_widget.html`
- `itso_movie_db_detail_widget.html`
- `itso_movie_db_connector_widget.html`

Example 13-31 shows the HTML content for `itso_movie_main.html`. You can place any HTML code in a help content file.

Example 13-31  Help content for ITSO Movie

```html
<body>
ITSO Movie main help page
</body>
```

5. The HTML files containing the help content need to be packaged in a compressed file named `doc.zip`.

Note: The compressed file containing the help content must be named `doc.zip`.  

726  Building IBM Business Process Management Solutions Using WebSphere V7 and Business Space
Create the `doc.zip` compressed file in the `itsomovie.help` folder and place all the help HTML files in that file.

You should now have the following folder structure.

- `itsomovie.help`
  - `doc.zip`
  - `itso_movie_toc.xml`
  - `plugin.xml`

   
a. Stop the server where Business Space is deployed.

   b. Navigate to the
      `<PROFILE_ROOT>/temp/<NODE_NAME>/<SERVER_NAME>/BusinessSpaceHelpEA<br _="_"/>R_<NODE_NAME>_<SERVER_NAME>/BusinessSpaceHelp.war/eclipse/configuration`

   c. Delete only the folders in this folder. Do not delete the files.

   d. Start the formerly stopped server.

The Business Space help now has the new primary topic ITSO Movie. Click Help in one of the ITSO Movie DB widgets' context menu and the corresponding help topic is displayed. When the help is called for the first time, you should see a line in the server's `SystemOut.log` that shows `Primary Toc Found: /itsomovie.help/itso_movie_toc.xml`. Figure 13-21 shows the ITSO Movie help topics included in the Business Space help.

![Figure 13-21 ITSO Movie help embedded into the Business Space help](image-url)
13.6 Testing a widget

Widgets can be tested in various stages of the development process. WebSphere Integration Developer provides the Universal Test Client for iWidgets to test a widget before it is registered in Business Space. An additional tool for testing widgets is Mozilla Firebug, which is a plug-in that is available for Mozilla Firefox. It gives you additional debugging possibilities. For example, Mozilla Firebug shows all HTTP requests when a page is loaded and displays errors that occur when JavaScript code is executed.

When you use both Universal Test Client for iWidgets in WebSphere Integration Developer and Mozilla Firebug, you have good support for testing widgets.

It is also a best practice to test the widget frequently in Microsoft Internet Explorer to ensure that the widget behaves as expected there as well.

**Note:** Mozilla Firebug must be installed as a plug-in for Mozilla Firefox. Install it in Mozilla Firefox as an Add-on and search for the Add-on Firebug.

13.6.1 Testing with the Universal Test Client for iWidgets in WebSphere Integration Developer

The Universal Test Client for iWidgets in WebSphere Integration Developer provides the means to test a widget in a sandbox mode before it is registered in Business Space. You can test a widget in isolation. Events can be sent to the widgets and events that are fired by the widget are recorded, but there is no interaction with other widgets.

For example, to test the ITSO Movie DB Detail widget with the Universal Test Client for iWidgets in WebSphere Integration Developer, perform the following steps.

1. Right-click `ITSOMovieDBDetailWidget.xml` in the Enterprise Explorer.
2. Select **Run As** → **Run on Server**.
3. Select a server from the servers list and click **Finish**.
4. The Universal Test Client for iWidgets window opens. The top pane shows the ITSO Movie DB Detail widget, as shown in Figure 13-22.

![Image of ITSO Movie DB Detail widget in Universal Test Client for iWidgets]

Figure 13-22  ITSO Movie DB Detail widget in Universal Test Client for iWidgets

Using the bottom pane, you can send events to the widget. Events that are handled and published by the widgets are listed in this area as well (Figure 13-23).

![Image of event handling in Universal Test Client for iWidgets]

Figure 13-23  Event handling in Universal Test Client for iWidgets

5. Send an event to the widget.
   a. Select `getMovieDetailsResult` from the Event Target drop-down menu.
b. Enter the contents of Example 13-32 into the Data field and click **Send Events**.

**Example 13-32  Content for getMovieDetailsResult event**

```json
{movieDetails: { movieId : "1", title : "ITSO2 - The Sequel", directors : [{ firstName : "Mike", lastName : "Director" }], actors: [{ firstName : "Maria", lastName : "Actor" },{ firstName : "Michael", lastName : "Actor" }]}}
```

The widget handles the event and lists the directors and actors for the movie ITSO2 - The Sequel, as shown in Figure 13-24.

![ITSO Movie DB Detail widget shows event payload](image)

**Figure 13-24  ITSO Movie DB Detail widget shows event payload**

### 13.6.2 Testing Universal Test Client for iWidgets in combination with Mozilla Firebug

The Universal Test Client for iWidgets is a JSP that reads the contents of a widget definition file. To use the Universal Test Client for iWidgets together with Mozilla Firebug, the JSP must be opened in Mozilla Firefox. The URL for the Universal Test Client for iWidget JSP can be retrieved by right-clicking the Universal Test Client for iWidgets. Click **Properties**, and the URL will display in the Address field.

For the ITSO Movie DB Detail widget, the URL could look like the following URL:

Perform the following steps:

1. Enable Mozilla Firebug in Mozilla Firefox by clicking the bug icon in the bottom right corner.

2. Open the URL to the Universal Test Client for iWidgets JSP in Mozilla Firefox.

3. In the Console tab of Mozilla Firebug, you see a list of HTTP requests; if an error occurs, the error is displayed there as well.

After a widget is registered in Business Space, it can be tested within Business Space in combination with other widgets. The Universal Test Client for iWidgets only provides testing capabilities before using a widget in Business Space. Continue to use Mozilla Firebug to test widgets in Business Space after they have been registered in Business Space.
Appendixes
IBM Lotus Forms UI

This appendix covers the IBM Lotus Forms product.

The first topic in the appendix provides an overview of IBM Lotus Forms as a client user interface and forms description language. The second topic describes the development of Lotus Form clients.

Additional information can be found in the IBM Lotus Forms 3.5.1 Information Center at the following address:

http://publib.boulder.ibm.com/infocenter/forms/v3r5m1/index.jsp.
Overview of IBM Lotus Forms

This section introduces Lotus Forms, describes why you might use it, and provides details about its components.

What is Lotus Forms

IBM Lotus Forms provides a dynamic user interface for business processes and human tasks.

Lotus Forms can be used as a front end for process automation, helping users to collect data easily, accurately, and completely, with straight through integration to one or more run times on the back end.

Lotus Forms provides a dynamic, transportable XML document that creates an auditable transactional record of a process that contains UI, business logic, data schemas, and electronic signatures.

Lotus Forms are based on the Extensible Forms Description Language (XFDL) specification. The specification describes a class of XML documents and some of the behavior expected of computer programs that process them.

A number of features of XFDL have been incorporated into a W3C Recommendation called XForms since 2003. The XFDL language now incorporates XForms and augments its functionality with many additional features, such as precise layout and digital signatures.

The XFDL Specification V7.7 can be found at the following address:


Forms developed with Lotus Forms have a file type of XFDL.

Who uses Lotus Forms

Lotus Forms can be used in any situation that requires an intuitive user interface for complex business processes.

Lotus Forms can be used to simplify and speed up user interface development. It can also be used to provide transactional documents and visual audits for business processes.
Lotus Forms support integration devices, such as signature pads for electronic signatures.

Lotus Forms can also be used as a bridging technology across many IBM products, such as IBM WebSphere Process Server, IBM DB2® Content Manager, and IBM Lotus Mashup Center.

Lotus Forms can be deployed without the expense of client software.

Components of Lotus Forms software

The following Lotus Forms software is included with WebSphere Integration Developer.

**IBM Lotus Forms Designer**
The IBM Lotus Forms Designer is a powerful development environment that lets you build trusted forms by dragging and dropping form design elements onto a canvas.

Advanced users can also use the Designer to add business logic to create forms that complement complex workflows.

You can install Lotus Forms Designer as a stand-alone environment or as a plug-in to WebSphere Integration Developer or WebSphere Business Modeler.

**IBM Lotus Forms Viewer**
The Viewer is a client-side program that lets you open, edit, sign, save, and submit XFDL forms.

**IBM Lotus Forms Server API**
The IBM Lotus Forms Server API enables you to develop and run applications that interact with XFDL forms. Using the API, you can build applications that create, analyze, validate, and route electronic forms.

The Lotus Forms Server API provides a collection of programming tools for the C, Java, and COM programming environments, which lets you develop applications that interact with XFDL forms.

**IBM Lotus Forms Server Webform Server**
The IBM Lotus Forms Webform Server is a zero-footprint application that translates XFDL documents into HTML/JavaScript documents. This allows users to view, edit, sign, and submit XFDL documents using only a Web browser.
Installing Lotus Forms software

The Lotus Forms software is included with IBM WebSphere Integration Developer, and can be optionally installed.

The IBM WebSphere Business Modeler installation package includes the Lotus Forms Designer and Lotus Forms Viewer software, which can be optionally installed.

Lotus Forms client development

This topic describes some of the development processes for creating Lotus Forms clients, with particular emphasis on where they are used in business spaces.

Generating Lotus Forms

You can generate a client for your human task or business process based on the type of form that you specify in the user interface settings.

The process for using a Lotus Forms user interface is described in the following steps:

1. Generating a Lotus Forms UI in WebSphere Integration Developer:
   a. Right-click the Human Task in the Projects view, then select Generate Human Task User Interface from the menu, as shown in Figure A-1.

![Figure A-1 Generate Human Task User Interface](image)
b. Select **HTML-Dojo pages or Lotus Forms for Business Space** for the generation type and check the human task you want the user interface to be generated for, as shown in Figure A-2.

![Generate Human Task User Interface](image)

*Figure A-2  Select the generation type for the human task*
c. Select the **Lotus Forms** radio button, as shown in Figure A-3.
d. Click **Finish**.

The input and output forms for the human task are generated. The input form for the human task open for editing in the Lotus Forms Designer is shown in Figure A-4.

![Figure A-4](image)

*Figure A-4  One of the generated XFDL files for the human task*

2. Tell the human task to use the generated interface.

   a. Double-click the human task to open it with the editor.
b. Navigate in the editor to User Interface, click the + icon, and then select **Lotus Forms (for use in Business Space and a generated client)** from the menu, as shown in Figure A-5.

![Figure A-5 Choosing Lotus Forms as the UI type for the human task](image-url)
c. The Lotus Forms line appears underneath User Interface. If you place the cursor on this line, you can set the appropriate input and output forms in the Properties view, as shown in Figure A-6.

![Figure A-6](image)

**Figure A-6** Selecting the Lotus Forms line under User Interface displays the properties for this UI

### Importing Lotus Forms

You can import forms created in Lotus Forms Designer. You can import XFDL or XFD file types.

### IBM Lotus Forms Designer

The Designer workspace consists of the design canvas, the palette of tools, and the outline view. These three elements provide you with the resources to create and view forms.
The palette is a library of visual elements for building the client user interface, allowing the user to drag and drop these form design elements onto the design canvas.

A side-by-side view of the top and lower parts of the Lotus Forms Designer palette is shown in Figure A-7.

![Forms Designer palette diagram](image)

**Figure A-7** Top and lower portions of the Forms Designer palette

Advanced capabilities are supported by the Forms Designer, such as form input verification, attachments, e-mail, and electronic signatures.
If you click the Signature icon in the Designer palette, the window shown in Figure A-8 opens, where you can choose one of the many supported electronic signatures.

![Signature Editor - Create a new signature](image)

Electronic signatures can be used to establish identity, proof of acceptance, and document integrity.

**Summary**

Using Lotus Forms for the electronic transmission of data helps to optimize a company's business processes, especially when used together with human tasks. The electronic forms capture complete and accurate data at the source, simplifies the user interaction, and eases regulatory compliance by creating complete, accurate and auditable records.

Lotus Forms has a seamless integration with WebSphere Integration Developer and the WebSphere Process Server run time.
WebSphere Integration Developer Version 7.0 (and WebSphere Process Server) improves human task client support with Web-based forms through Business Space and Lotus Forms Server V3.5.1. You no longer need the Lotus Forms Viewer for rendering forms in the Business Space environment.
Additional material

This book refers to additional material that can be downloaded from the Internet as described below.

Locating the Web material

The Web material associated with this book is available in softcopy on the Internet from the IBM Redbooks Web server. Point your Web browser at:

ftp://www.redbooks.ibm.com/redbooks/SG247861

Alternatively, you can go to the IBM Redbooks Web site at:

ibm.com/redbooks

Select the Additional materials and open the directory that corresponds with the IBM Redbooks form number, SG247861.

How to use the Web material

Create a subdirectory (folder) on your workstation, and unzip the contents of the Web material compressed file into this folder.
## Abbreviations and acronyms

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>BI</td>
<td>Business Intelligence</td>
</tr>
<tr>
<td>BPEL</td>
<td>Business Execution Process Language</td>
</tr>
<tr>
<td>BPM</td>
<td>Business Process Management</td>
</tr>
<tr>
<td>BPMN</td>
<td>Business Process Modeling Notation</td>
</tr>
<tr>
<td>CBE</td>
<td>Common Business Event</td>
</tr>
<tr>
<td>CEI</td>
<td>Common Event Infrastructure</td>
</tr>
<tr>
<td>EAR</td>
<td>Enterprise Archive</td>
</tr>
<tr>
<td>ERP</td>
<td>Enterprise Resource Planning</td>
</tr>
<tr>
<td>EWMA</td>
<td>Exponentially Weighted Moving Average</td>
</tr>
<tr>
<td>HTTP</td>
<td>HyperText Transfer Protocol</td>
</tr>
<tr>
<td>IBM</td>
<td>International Business Machines Corporation</td>
</tr>
<tr>
<td>ISSW</td>
<td>IBM Software Services for WebSphere</td>
</tr>
<tr>
<td>ITE</td>
<td>Integrated Test Environment</td>
</tr>
<tr>
<td>ITSO</td>
<td>International Technical Support Organization</td>
</tr>
<tr>
<td>JSF</td>
<td>Java Server Faces</td>
</tr>
<tr>
<td>KPI</td>
<td>Key Performance Indicator</td>
</tr>
<tr>
<td>LOB</td>
<td>Line of Business</td>
</tr>
<tr>
<td>MFC</td>
<td>Mediation Flow Component</td>
</tr>
<tr>
<td>OU</td>
<td>Organizational Unit</td>
</tr>
<tr>
<td>PI</td>
<td>Project Interchange</td>
</tr>
<tr>
<td>RPC</td>
<td>Remote Procedural Call</td>
</tr>
<tr>
<td>SCA</td>
<td>Service Component Architecture</td>
</tr>
<tr>
<td>SLA</td>
<td>Service Level Agreement</td>
</tr>
<tr>
<td>SMO</td>
<td>Service Message Object</td>
</tr>
<tr>
<td>SOA</td>
<td>Service-oriented Architecture</td>
</tr>
<tr>
<td>SSL</td>
<td>Secure Sockets Layer</td>
</tr>
<tr>
<td>SSO</td>
<td>Single Sign-on</td>
</tr>
<tr>
<td>UML</td>
<td>Unified Modeling Language</td>
</tr>
<tr>
<td>WAR</td>
<td>Web Archive</td>
</tr>
<tr>
<td>WSDL</td>
<td>Web Services Description Language</td>
</tr>
<tr>
<td>XSD</td>
<td>XML Schema Definition</td>
</tr>
</tbody>
</table>
Related publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this book.

IBM Redbooks

For information about ordering these publications, see “How to get Redbooks” on page 752. Note that some of the documents referenced here might be available in softcopy only.

- Human-Centric Business Process Management with WebSphere Process Server V6, SG24-7477
- IBM HTTP Server (powered by Apache): An Integrated Solution for IBM eServer iSeries Servers, SG24-6716
- Service Lifecycle Governance with IBM WebSphere Service Registry and Repository, SG24-7793
- WebSphere Application Server Network Deployment V6: High Availability Solutions, SG24-6688
- WebSphere Business Process Management V7 Production Topologies, SG24-7854

Online resources

These Web sites are also relevant as further information sources:

- BPEL4People:
- Query Table:
- Query Table Builder:
WS-HumanTask:
http://www.sdn.sap.com/irj/scn/go/portal/prtroot/docs/library/uuid/a0c9ce4c-ee02-2a10-4b96-cb205464aa02?QuickLink=index&overridelayout=true

How to get Redbooks

You can search for, view, or download Redbooks, Redpapers, Technotes, draft publications and Additional materials, as well as order hardcopy Redbooks publications, at this Web site:
ibm.com/redbooks

Help from IBM

IBM Support and downloads
ibm.com/support

IBM Global Services
ibm.com/services
Building IBM Business Process Management Solutions Using WebSphere V7 and Business Space

Create BPM solutions using predefined Business Space widgets

IBM Business Space powered by IBM WebSphere is a common user interface framework for aggregating content and delivering it via a browser. A business space is a collection of related Web content that provides you with insight into your business.

Part 1 of this IBM® Redbooks® publication introduces Business Space and provides Business Process Management (BPM) usage patterns for it.

Develop custom widgets; build clients and servers for them

Part 2 of this book uses a fictional business scenario to show how business space widgets can be used to solve a variety of business problems, using products such as IBM WebSphere Process Server, IBM WebSphere Enterprise Service Bus, IBM WebSphere Business Monitor, IBM WebSphere Business Compass, and IBM WebSphere Business Services Fabric.

Learn by example with practical scenarios

Part 3 of this book shows how to build custom Business Space widgets, and how to build clients and servers for these custom widgets.

This book addresses Business Space powered by IBM WebSphere Version 7.0.

For more information: ibm.com/redbooks